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This Software product ("AxioVision") was designed, realized, verificated, 
validated and released in a certificated process environment. The quality 
management system is certified following the rule of DIN EN ISO 9001. 

The fields of application of the Software are common tasks and applications 
in microscopy respectively imaging (so called “Off-The-Shelf Software”). 
Though the user acknowledges that in any kind of use the end user of the 
Software is responsible for the validation of the Software for the end user’s 
dedicated intend of use considering all requirements of law and standards (e. 
g. FDA/21 CFR part 11, IvDD, etc.). If necessary the end user has to establish, 
to document, to implement and to maintain a special process to fulfill all the 
requirements to be conform with the validate rules of law and standards.  

CARL ZEISS DOES NOT WARRANT THAT THIS SOFTWARE IS USABLE FOR 
SPECIAL PURPOSES OTHER THAN IN THE FIELDS OF APPLICATION DEFINED 
ABOVE. 
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Refer to the safety notes and instructions in the manuals of all 
necessary devices (e.g. microscope peripherals, cameras, 
computers, computer additionals, etc.) before installing and 
using the software (see also "Safety Notes AxioVision, 
AxioVision AC, B 48-0044 e (SAP 000000-1339-887")). 
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Introduction 

N fåíêçÇìÅíáçå=

NKN qÜÉ=`çåÅÉéí=

AxioVision is a modular image-processing and analysis system for modern 
microscopy. The basic functionality for image acquisition and microscope 
control, image processing and annotations, image analysis, documentation 
and configuration can also be expanded by integrating additional modules 
into the system for specific tasks (see section 1.2 "The Modules"). 

The basic version comprises the following functionalities: 

fã~ÖÉ=^Åèìáëáíáçå=

A range of different camera types can be used with AxioVision, from simple 
TV cameras through to high-resolution and high-sensitivity cameras. The 
cameras of the Carl Zeiss AxioCam family guarantee optimum integration. As 
the cameras are integrated seamlessly into the AxioVision software, you are 
also able to generate complex images and image series with a simple mouse-
click.  

jáÅêçëÅçéÉ=`çåíêçä=

With AxioVision it is possible to control any motorized Carl Zeiss microscope 
fully automatically and interactively (you can of course also use manual 
standard microscopes). Software control offers the following advantages: the 
microscope’s setting parameters can be saved as required, and are therefore 
available for reuse during future tests, magnifications are determined auto-
matically, and complex procedures are significantly faster and can be easily 
reproduced at any time. 
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fåÅìÄ~íáçå=

AxioVision controls and monitors the Zeiss incubation components. Incubation 
parameters like temperature and CO2- or O2 concentrations can be stored as 
hardware settings and be reused for new experiments. All incubation 
parameters are accessible as measurement parameters for further evaluation 
of acquired multidimensional time series. 

fã~ÖÉ=mêçÅÉëëáåÖ=~åÇ=^ååçí~íáçåë=

The acquired image is immediately displayed on the monitor. It can then be 
optimized using a wide range of techniques: 

 Contrast, brightness and color adjustment 
 Noise suppression, smoothing and contour enhancement 
 Sharpness enhancement/emphasizing of details 
 Correction of illumination influences and white balance 

AxioVision can also be used to add any annotations that you may require to 
the images. All elements, from scale bars and colored markings through to 
text and graphics, have been integrated into the program. 

fã~ÖÉ=^å~äóëáë=

You are able to perform simple interactive measurements in the basic 
program. The measured values (e.g. lengths, areas and angles) are made 
available in a data table, and can be processed further using spreadsheet 
programs, such as Microsoft Excel. The interactive measurement can be 
executed via a special dialog, or freely via a menu or a toolbar. 

açÅìãÉåí~íáçå=

Besides the image itself, the AxioVision image format ZVI also saves additional 
data, such as the image number, date of acquisition, microscope settings, 
exposure values, size and scale details, contrast procedures used etc. 
Annotations and measured values are also saved with the image. Rather than 
being permanently "burnt" into the image, annotations are present in the 
form of a separate plane. This means that no image information is concealed, 
and changes can be made at any time. Consequently, an image can be 
reproduced years later under identical conditions. 
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The Image File Browser supports the management of the content of large 
databases. With this browser you can navigate quickly within your file folders, 
and obtain a clear display of all the key data acquired with the image. 

For the generation of reports or presentations, AxioVision offers you 
predefined report layouts. These can be modified or completely regenerated 
at any time on an individual basis. 

`çåÑáÖìê~íáçå=

AxioVision offers you a great deal of freedom in terms of the arrangement of 
your individual work environment. To speed up your work, it is possible to 
execute any commands using freely definable key combinations. You can 
configure your own toolbars and group functions together on your own 
menus. Relevant control elements for camera and microscope control in the 
form of individual dialogs are grouping together with just a few clicks of the 
mouse. For recurring routine processes, workflows make simple operation 
possible. As a result, operating errors can by and large be eliminated. 

 
NKO qÜÉ=jçÇìäÉë=

The following modules are currently available as extensions to the basic 
system: 

fã~ÖÉ=^Åèìáëáíáçå=jçÇìäÉë=

^ìíçÑçÅìë=

This module allows the optimum focus position to be calculated with 
motorized microscopes. It can be used in reflected light, transmitted light, 
bright field, dark field and fluorescence, and works with all cameras and 
frame grabbers controlled directly by AxioVision. 

bñíÉåÇÉÇ=cçÅìë=

Needle-sharp images are essential for carrying out precise analyses. 
Depending on the object and the setting, a microscope's depth of field is 
often insufficient to generate a single image which is sharp over the entire 
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plane. The AxioVision Extended Focus module solves the problem. A number 
of images are acquired from different focus planes, and the sharp details of 
each individual image are combined to produce an image that is sharp 
throughout. 

j~êâCcáåÇ=

This module is used to record and automatically relocate various positions on 
slides, in culture plates and in multiwell plates using a motorized x/y stage. 

c~ëí=^Åèìáëáíáçå=

This module expands the functionality of the modules multichannel 
fluorescence, z-stack and time lapse allowing image acquisition to be done in 
high speed. 

c~ëí=jçë~áu=

Fast MosaiX expands AxioVision with the option of acquiring a large number 
of high-resolution individual images in a very short time. The use of a flash for 
exposure ensures that your samples are protected, and, thanks to the 
optimum interaction between hardware and software, several hundred 
images per minute can be acquired. 

jìäíáÅÜ~ååÉä=cäìçêÉëÅÉåÅÉ=

This module allows you to acquire multichannel fluorescence images with up 
to 32 channels. It can be combined with the Z-Stack, Time Lapse, MosaiX and 
Mark&Find modules. 

jçë~áu=

MosaiX is developed to analyze large surfaces - MosaiX permits the area of a 
specimen to be scanned in order to generate one single large image. This 
electronically created image can thus serve as a map to navigate the specimen 
and provides a basis for further analyses. 
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m~åçê~ã~=

Panorama is ideal for specimens which do not fit into the image frame. High-
resolution panorama or overview images can be formed with pixel accuracy 
from individual shots. Even overlapping images can be combined so precisely 
that all the important details of your specimen are recorded in a single image. 

qáãÉ=i~éëÉ=

This module allows you to acquire time lapse images. It can be combined with 
the Z-Stack, Multichannel Fluorescence, MosaiX and Mark&Find modules. 

wJpí~Åâ=

This module allows you to acquire z-stack images. It can be combined with 
the Multichannel Fluorescence, Time Lapse, MosaiX and Mark&Find modules. 

aáÖáí~ä=eáÖÜ=péÉÉÇ=oÉÅçêÇÉê=

With this module time lapse sequences can be acquired in high speed and 
without compression artifacts. The raw data are streamed to a dedicated hard 
disk. Either the complete sequence or selected parts of the sequence can be 
converted into the ZVI image format using a Cutter function. 

aì~ä=`~ãÉê~=

This module enables Fast Acquisition to use two identical cameras 
simultaneously. This effectively doubles the speed of acquisition. Also, if 
configured with two different emission filters, acquisition of two colors can 
happen at the same time avoiding motion artifacts which may occur when 
acquiring images sequentially. 

eao=fã~ÖáåÖ=EeáÖÜ=aóå~ãáÅ=o~åÖÉF==

The HDR module is available in AxioVision to allow you to test out its function. 
This means that you can now try out this acquisition technique at your leisure 
and examine the positive effect it has for your specific application. Following 
image acquisition, a watermark is burnt into your HDR image. 
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Once you have licensed this module, it is available to you without any 
restrictions. 

HDR Imaging enables you to produce images with a greater dynamic range 
than the camera you are using would technically allow. 

In certain acquisition situations the dynamics of an image scene, i.e. the range 
of intensity differences present, can exceed the dynamic range offered by 
even a good digital camera. An example here would be the acquisition of 
polished steel sections in the field of materials science. Acquiring images of 
structures in the reflective surface and in black inclusions at the same time is 
no easy task. Another example could be taken from neurobiology, where you 
may wish to simultaneously capture in an image not only the brightly 
fluorescing GFP-labeled cell nucleus of a neuron, but also its axons and 
dendrites, which emit much darker signals. 

With the HDR technique, image sequences are generated during acquisition 
using a constantly increasing exposure time. An initial image that is not 
overexposed is taken as a starting point. The number of images and the 
extent of the increase in the dynamics can be adjusted. 

Image content that is concealed by noise in the first image is certain to be 
shown with good contrast in an image acquired using a longer exposure time. 
On the other hand, image content that is displayed clearly in the image with 
the shortest exposure time will be overexposed in an image for which a longer 
exposure time is used. 

By means of the weighted superimposition of the component images it is 
therefore possible to generate a resulting image that offers excellent contrast 
both in dark image regions and in bright zones. 

As pixels are saved with a maximum of 16 bits, 65,535 gray levels is the 
greatest possible dynamic range that can be stored in an image. 

With the help of the adjustable display characteristics curve in AxioVision, 
even data with such a high dynamic range can be presented in a meaningful 
way on a monitor. 

1-6 M 60-3-0024 e / printed 06.2010 



Introduction 

fã~ÖÉ=mêçÅÉëëáåÖ=jçÇìäÉë=

^éçqçãÉ=

An ApoTome system allows you, on the basis of the principle of fringe 
projection, to generate optical sections through fluorescence samples. The 
parts of the image that are out of focus are then removed, and an increase in 

 image sharpness 
 the signal to noise ratio (contrast) 
 and resolution in the axial direction 

can be achieved. 

fã~ÖáåÖ=mäìë=

The Imaging Plus module offers you all the main digital image processing 
techniques. This module comprises functions for image enhancement, gray 
morphology, image arithmetic and color space transformation. 

Oa=aÉÅçåîçäìíáçå=

Using this module you can improve the quality of 2-dimensional fluorescence 
images in both the lateral and axial direction in accordance with a predefined 
or self-generated Point Spread Function (PSF). 

Pa=aÉÅçåîçäìíáçå=

This module enables you to improve the quality of z-stack fluorescence images 
using deconvolution algorithms. Using the Point Spread Function (PSF) this 3D 
Deconvolution calculates out of focus light from all z planes back to its origin. 

Four methods are available: 

 Nearest Neighbor for fast contrast enhancement results 
 Regularized Inverse Filter for access to genuine 3D filtering 
 Fast iterative algorithm for high speed restoration 
 Iterative Maximum Likelihood Algorithm – the high-end method for 

maximum light efficiency and increased resolution 
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fåëáÇÉQa=

The Inside4D module allows you to display z-stack images in three dimensions 
in a very simple way. Three-dimensional structures can also be viewed as 
animations over time, and exported as digital video films into AVI format or in 
MOV format (compatible to QuickTime). Five projection methods are available: 
shadow, transparency, surface, maximum projection, and mixed. You also 
have access to a wide range of image processing options (display of cutting 
planes, anaglyph view, iterative 3D measurement). The zoom factor, for 
instance, can be freely selected, which also means that you can zoom into 
structures to view them from the inside. 

táÇÉÑáÉäÇ=jìäíáÅÜ~ååÉä=råãáñáåÖ=

Widefield Multichannel Unmixing is a module for the removal of crosstalk 
between fluorescent dyes in multichannel images. Crosstalk is a phenomenon 
which occurs, whenever dyes are excited by excitation light of more than one 
filter combination. Up to eight fluorescence channels using a traditional 
epifluorescence microscope can be separated using unmixing matrices 
determined either by automatic component extraction (ACE) or by measuring 
crosstalk in appropriate reference samples. 

fã~ÖÉ=^å~äóëáë=jçÇìäÉë=

fåíÉê~ÅíáîÉ=jÉ~ëìêÉãÉåí=

This module allows the interactive measurement of a variety of object 
parameters, such as size, circumference, number etc. Circle measurements 
can also be performed simply by clicking on several contour points. The 
measured data are saved together with the image, and are therefore available 
for additional evaluations. 

^ìíçjÉ~ëìêÉ=E^ìíçã~íáÅ=jÉ~ëìêÉãÉåíF=

With this module, measurement programs can be generated very quickly and 
simply with the help of a wizard. All of the functions required for an image 
analysis procedure are called up, one after the other. The parameters for the 
functions can then be set for the measurement task in question, and saved at 
the end as a measurement program. Once these measurement programs have 
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been defined, you can measure any number of images by performing series 
analyses. 

^ìíçjÉ~ëìêÉ=mäìë=E^Çî~åÅÉÇ=^ìíçã~íáÅ=
jÉ~ëìêÉãÉåíF=

This module expands the functions of the AutoMeasure module to include a 
wide range of additional functions for single segmentation and binary image 
processing. Here the functions are not executed in a wizard, but are available 
individually as menu functions. They can be freely combined, allowing you to 
create your individual measurement routines. 

`~äçííÉ=dêáåÇáåÖ=jÉ~ëìêÉãÉåí=qf`=jÉ~ëìêÉãÉåí=

During the process of coating materials, quality is controlled by measuring the 
thickness of layers in accordance with the DIN V ENV 1071 standard. The 
Calotte Grinding Measurement application module allows you to determine 
the thickness of calotte section layers. To prepare the calotte section samples, 
a grinding ball with a defined diameter generates a calotte-shaped hollow in 
the coating of the sample. This results in circular or elliptical indentations, the 
diameters of which are determined by drawing in measurement circles. The 
layer thickness is calculated automatically from the diameters of the 
measurement circles and the diameter of the grinding ball. 

qf`=jÉ~ëìêÉãÉåí=

The TIC module (Total Interference Contrast – only in combination with the 
TIC slider from Carl Zeiss) allows precise, contact-free and extremely simple 
determination of the optical height and thickness of object structures over a 
range from just a few nanometers through to several micrometers. The 
advantage of the TIC method over conventional thin-layer thickness 
measuring instruments (profilometers, atomic force scanning microscopes) lies 
in the combination of short measurement and analysis times with a high 
degree of accuracy. The use of circularly polarized light makes the orientation 
of the structures on the sample irrelevant, eliminating the need for stage 
rotation. It is even possible to analyze samples with large surface areas. 

AxioVision User's Guide, Release 4.8.2 1-9 



Introduction 

m~êíáÅäÉ=^å~äóòÉê=

The Particle Analyzer module allows you to create and carry out particle 
analysis projects. The aim is to classify particles based on a selectable 
measurement parameter (in most cases: largest diameter). This classification 
takes place on the basis of predefined norms or classes determined by the 
user. Every measurement is managed within an archive as an independent 
project. The results are analyzed graphically and statistically immediately after 
the measurement and can be printed out in the form of a report. Work using 
this module can be divided into two task areas: 

 Generating project templates to determine the sequence of an analysis: 
type of image acquisition (MosaiX, single images etc.), template for input 
form and report, sequence of image processing and measurement etc. 
(for administrators only). 

 Carrying out the measurement (for all users). 

kjf=

The NMI module allows you to determine the content of non-metallic 
inclusions in steel. Several samples with an area of 200 mm² can be analyzed 
in a single measurement. Analysis can be performed in accordance with up to 
5 standards at the same time.  

 ASTM E45-05 methods A and D 
 DIN 50 602:1998 methods K and M 
 JIS G0555:2003; methods A and B 
 ISO 4569:1998; methods A and B 
 EN 10247:2007; methods K, P and M 
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Every measurement is managed within an archive as an independent project. 
The results are analyzed graphically and statistically immediately after the 
measurement and can be printed in the form of a report. Work using the 
module can be divided into two task areas: 

 Generating project templates to determine the workflow for an analysis: 
type of image acquisition (single images from a camera or loaded from a 
file etc.), template for input form and report, workflow for image 
processing and measurement etc. (only for administrators). 

 Carrying out the measurement (for all users). 

dê~áåë=

The module Grains determines Grain sizes according to current international 
standards. There is a choice of three different modes: interactive, by means of 
a direct comparison with overlaid comparative images (Compare); semi-
automatic intercept method, using various chord patterns (chord) and a fully 
automatic analysis, based on a reconstruction of even complex grain 
boundaries (Auto). 

 Auto: automatic reconstruction of grain boundaries – DIN EN ISO 643, 
ASTM E 112, ASTM 1382 

 Chord: Intercept method – DIN EN ISO 643, ASTM E 112, ASTM 1382 
 Compare: Comparison with comparative diagrams – SEP151061, ASTM – 

Plate IA, ASTM– Plate IB, ASTM– Plate II, ASTM– Plate III, ASTM– Plate IV, 
BS4990 

Every measurement is managed within an archive as an independent project. 
The results are analyzed graphically and statistically immediately after the 
measurement and can be printed in the form of a report. Work using the 
module can be divided into two task areas: 

 Generating project templates to determine the workflow for an analysis: 
type of image acquisition (single images from a camera or loaded from a 
file etc.), template for input form and report, workflow for image 
processing and measurement etc. (only for administrators). 

 Carrying out the measurement (for all users). 
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jìäíáéÜ~ëÉ=

This module is used for the analysis of multiphase samples. It makes it possible 
to detect any number of phases in gray-level or color images. The following 
measurement parameters are available for measurement and classification: 

 area, diameter, maximum feret 
 perimeter, form factor, ellipse (major and minor) 
 volume of sphere, volume of ellipsoid, gray value, color value 

Every measurement is managed within an archive as an independent project. 
The results are analyzed graphically and statistically immediately after the 
measurement and can be printed in the form of a report. Work using the 
module can be divided into two task areas: 

 Generating project templates to determine the workflow for an analysis: 
type of image acquisition (single images from a camera or loaded from a 
file etc.), template for input form and report, workflow for image 
processing and measurement etc. (only for administrators). 

 Carrying out the measurement (for all users). 

`çãé~ê~íáîÉ=aá~Öê~ãë=

The Comparative Diagrams module allows the comparison of a micrograph 
with comparative diagrams interactively. 

The result is a table containing the comparative diagram numbers relating to 
each image and a table containing statistical analyses. You can also have a 
micrograph displayed with an overlaid comparative diagram.  

Every measurement is managed within an archive as an independent project. 
The results are analyzed graphically and statistically immediately after the 
measurement and can be printed in the form of a report. Work using the 
module can be divided into two task areas: 

 Generating project templates to determine the workflow for an analysis: 
type of image acquisition (single images from a camera or loaded from a 
file etc.), template for input form and report, workflow for image 
processing and measurement etc. (only for administrators). 

 Carrying out the measurement (for all users). 
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dê~éÜáíÉ=

The Graphite module automatically analyzes the size of graphite particles in 
cast iron samples in accordance with EN ISO 945 and SAE J 1887. The 
following analyses are available: 

 Spherolite: Size-Analysis of spheroidal graphite according to EN ISO 945 
 Lamellar: Size-Analysis of lamellar graphite according to EN ISO 945 
 SinterCast: nodularity analysis according to SAE J 1887 

Every measurement is managed within an archive as an independent project. 
The results are analyzed graphically and statistically immediately after the 
measurement and can be printed in the form of a report. Work using the 
module can be divided into two task areas: 

 Generating project templates to determine the workflow for an analysis: 
type of image acquisition (single images from a camera or loaded from a 
file etc.), template for input form and report, workflow for image 
processing and measurement etc. (only for administrators). 

 Carrying out the measurement (for all users). 

nì~åíácfpe=

The FISH technique (FISH = Fluorescence-In-Situ Hybridization) is used in the 
fields of cytogenetics and tumor research to localize specific DNA or RNA 
sequences in chromosomes. The QuantiFISH module offers you the 
quantitative determination of FISH signals in DAPI-stained, interphase cell 
nuclei of multichannel images or multichannel z-stack images. The results of 
the FISH analysis are displayed both in the image and in data lists.  

o~íáç=

To observe processes inside cells, use is often made of fluorescent dyes. This 
technique makes it possible to measure the concentration of messengers, e.g. 
Ca2++, over a certain period of time. The Ratio module offers you a suitable 
analysis method by means of the ratiometric processing of two fluorescence 
channels in multichannel time lapse images. The calculated ratio image can be 
displayed as a pseudo color image, making it possible to draw conclusions 
about the concentration, for example. In addition, the module allows you to 
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measure the intensity of the fluorescence of selected cells over time. The 
results are displayed graphically and in data lists after the measurement has 
been performed. 

qê~ÅâáåÖ=

It is often necessary to observe the movement of cells or other objects during 
biological processes. In many cases the processes in question are transport or 
growth processes that require quantitative analysis. With the Tracking module 
you can track moving objects in time lapse sequences using either an 
automatic or an interactive method. The calculated tracking parameters (e.g. 
distance, speed, direction etc.) are displayed in data lists.  

qj^=

Tissue micro arrays consist of numerous small, circular tissue samples with a 
defined diameter, which are fixed on a single slide. The TMA module makes it 
possible to acquire a composite image of the tissue micro arrays. And you can 
save the positions in a Mark&Find List. 

`çäçÅ~äáò~íáçå=

The acquisition of fluorescence images in several channels makes it possible to 
visualize the relationship between biological structures. The Colocalization 
module provides you with a tool that enables you to determine colocalization 
quantitatively. It is always the colocalization of two channels that is analyzed. 
For images with more than two channels the user must make a selection. 
Colocalization results from the pixel-by-pixel comparison of intensities per 
channel. 

qçéçÖê~éÜó=

With this module you can generate a height map (topographic image) from a 
z-stack and carry out roughness measurements in accordance with EN ISO 
4287. To allow you to display the various aspects of the topographic image, a 
rotation and a tilt mode are available in addition to four different 3D views 
(texture, projection, grid, surface). 
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låäáåÉ=jÉ~ëìêÉãÉåí=

This module allows you to perform measurements in an online image using 
interactive measurement tools. You can therefore generate measurement 
values very quickly without having to acquire the image. In addition, 
predefined or generated grids can be inserted into the online image and 
compared with the structures in the image (e.g. to inspect components). 

Pa=jÉ~ëìêÉãÉåí=

This module offers you a range of possibilities for the measurement of three-
dimensional objects. The image stacks are presented as a 3D volume model, 
which allows the user to define the surfaces of interesting objects 
interactively. A segmented data set is then generated from these settings. 
Using the binary image processing function you can further process the 
objects obtained, e.g. by means of interactive object separation. The 
measurement of the 3D objects then takes place automatically for the entire 
image stack or interactively by clicking on individual objects in the 3D view. 
The function calculates morphometric parameters (e.g. barycentric 
coordinates in x, y and z, volume or surface content) and densitometric 
parameters (such as mean density of the object or standard deviation of mean 
density of gray values) for all objects. In addition, field-specific parameters can 
be calculated for the entire 3D image, e.g. number of 3D objects in the 
image, total volume of all 3D objects or sum of the surfaces of all 3D objects. 

mÜóëáçäçÖó=

The Physiology module enables you to acquire time lapse images at a speed 
that is only limited by the technical limitations of the devices you are using 
(camera, light source) and the selected camera settings. To achieve such 
speeds, the Physiology module automatically uses a "streaming" technique, 
which involves the raw camera data being written directly to their own fast 
streaming hard disk (or a suitable empty partition). 

The results of the acquisition process are therefore a streaming document 
(*.ziAR) and the data measured during acquisition (online). 
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At the same time, enough memory is reserved so that the measurement data 
can also be managed. Physiology calculates the maximum possible number of 
individual images that can be acquired from the number of measurement 
regions drawn in and the memory available on the streaming hard disk. As 
this value is dependent on numerous factors (binning, ROI, number of 
measurement regions drawn in, demands made on available free memory by 
other applications etc.), the entire hard-disk space that is theoretically 
available cannot always be used. 

In a second step, which is separate from the acquisition process, the 
streaming document is converted into a regular ZVI image document. With 
the aid of a sort of video editor (Cutter) interesting regions in the image as 
well as interesting time sections can be selected and converted potentially 
reducing the data volume dramatically. Converted ZVI files are required for all 
further processing steps in AxioVision. 

Thirdly, a range of evaluation methods allows direct measurements of gray 
intensities or ratiometric measurements of various kinds (exitation- and 
emission ratio imaging) as well as a range of FRET (Förster resonance energy 
transfer) measurements. In addition a custom formula editor allows the 
generation of user defined evaluation formulas. 

pcj=

This module allows you to analyze multichannel fluorescence images of 
cytospin specimens. It also offers a predefined workflow for detecting and 
measuring the cells that can be adapted flexibly to the sample in question. 
The measurement results can be displayed in the form of an image gallery, 
data table, histogram or scatterplot and provide additional information to 
accompany the results of flow cytometry. 

`ç~ä=o~åÇçã=oÉÑäÉÅí~åÅÉ=

This module is used to analyze coal samples by measuring reflection in 
unpolarized light.  

The functionality comprises a flexible calibration process for user standards 
and multiple sample analysis with integrated autofocus function. During the 
analysis you can monitor the progress of the measurement in the online 
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reflectogram for the current field and the accumulated fields. The 
measurement results are presented clearly in a report with a reflectogram and 
V-type data.  

From the sample data generated it is also possible to produce a theoretical 
mixture by combining up to six individual profiles. 

`çãé~ê~íáîÉ=aá~Öê~ãë=

Using the Comparative Diagrams module it is possible to compare 
micrographs with comparative diagrams interactively. Various views can be 
used:  

 Micrograph and one comparative diagram 
 Micrograph and two comparative diagrams 
 Micrograph and four comparative diagrams 
 Micrograph and eight comparative diagrams 

The result you obtain takes the form of a table, along with the micrographs, if 
required. Comparative diagrams are possible for up to five freely definable 
dimensions. 

Every measurement is managed within an archive as an independent project. 
The results are analyzed graphically and statistically immediately after the 
measurement and can be printed in the form of a report. Work using the 
module can be divided into two task areas: 

 Generating project templates to determine the workflow for an analysis: 
type of image acquisition (single images from a camera or loaded from a 
file etc.), template for input form and report, workflow for image 
processing and measurement etc. (only for administrators). 

 Carrying out the measurement (for all users). 

^pp^vÄìáäÇÉê=

The ASSAYbuilder module is a so-called "high content analysis" module and 
efficiently generates high-quality and biologically relevant data from your 
image material. 
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ASSAYbuilder describes your fluorescence images in the form of numerous 
key parameters and provides objective, quantitative data that can be used as a 
basis for decisions relating to the planning of further experiments or to 
support published results. The module is operated using guided workflows 
and an intuitive graphical user interface. No programming knowledge is 
required.  

Five analyst modules support you with solutions that have been specially 
tailored to different biological tasks: Physiology Analyst, Morphology Analyst, 
Membrane Analyst, CellCycle Analyst, Motility Analyst. Examples of supported 
applications include cell-based toxicity tests, transcription factor activation, 
cell-cycle analyses, cell-movement analyses and morphology determination. 

bifpmlq=

The Elispot (Enzyme Linked Immuno Spot) analysis is a sensitive method for 
detecting and quantifying individual T lymphocytes that generate cytokine 
spots as a result of antigen contact in vitro. With the help of the ELISPOT 
system it is possible to determine the number, size and intensities of the spots 
automatically. Analysis is carried out immediately upon acquisition of the well 
images in 96 well plates or, alternatively, using saved well images. The 
ELISPOT system has been developed as a complete system solution for the 
precise and automatic analysis of Elispot assays, in particular also for use in 
routine laboratories. 

^êÅÜáîÉ=jçÇìäÉë=

^ëëÉíJ^êÅÜáîÉ=

With the Asset-Archive module you can save images, measurement data lists 
and reports etc. as "assets" in a hierarchically structured database. You have 
the option of creating various project types in which you can then save your 
assets. A contact management function allows you to allocate projects to 
different clients etc. You are also able to classify and structure your assets 
within your own customized categories. The option of a full-text search 
enables you to find individual data sets quickly. In addition, asset- or project-
related filters allow you to carry out targeted searches for information in 
individual data fields. 
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Long-term archiving is also possible, and gives you the option of transferring 
your projects and the corresponding assets onto CD, DVD or magnetic tape. 

`çåÑáÖìê~íáçå=jçÇìäÉë=

`çãã~åÇÉê=

The Commander module allows you to record steps for image acquisition, 
processing, and measurement in a single command – a script. Finally a script 
can be executed on any number of images automatically. 

s_^=

Should any users find that even the wide-ranging functions offered by 
AxioVision do not meet all of their requirements, they can increase the 
available options still further and adapt the program to their needs. This 
process is based on Visual Basic for Applications. VBA offers a complete, 
integrated development environment with which programmers are familiar. 
As VBA has been directly integrated into AxioVision, it offers the advantage of 
fast interaction and the possibility of developing solutions without additional 
programs. 

 
NKP ^ñáçsáëáçå=~åÇ=jáÅêçëçÑí®=táåÇçïë=

AxioVision fully supports the usual Microsoft Windows standards: 

Files are stored in accordance with Microsoft Windows rules in the folders 
provided for the purpose ("My Documents", "Documents and Settings"), so it 
is easy to locate the files you need. 

In multi-user environments, there is no need to make separate settings for 
AxioVision in order to keep the configurations and data of individual users 
separate and to protect them from unauthorized access. User administration is 
also based entirely on the settings in Microsoft Windows. 
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NKQ rëÉêDë=dìáÇÉ=~åÇ=låäáåÉ=eÉäé=

The AxioVision manual and online help should not be regarded as separate 
entities. When used in combination, they offer you immediate access to 
comprehensive information. The User's Guide contains a broad overview of all 
program modules, with detailed step-by-step instructions covering all the 
basic functions and describing the activities that arise most frequently. 

At the beginning of each chapter you will find information describing the 
background to the relevant section of the program or the relevant module in 
more detail. This may be conceptional information or a description of 
theoretical details. The introduction also contains a step-by-step description of 
operation. Due to the extremely wide range of functions offered by 
AxioVision, it is not possible to describe every conceivable operational 
situation in detail. However, once you have worked through the steps 
described in the manual, you should be able to apply these procedures to your 
specific task. 

The Online Help provides full details of the parameters and setting options of 
a function. It is therefore the ideal complement to the manual. If you have a 
question about a specific parameter, press the F1 key to obtain further 
information on it. The online help does not, however, contain descriptions of 
procedures of the type found in the manual. 

We strongly recommend that you familiarize yourself with the program using 
the examples described in the manual before you start working on concrete 
projects with AxioVision. Once you are familiar with the general operating 
procedures, you will find all the information you require in the online help. 

NKR _~Åâìé=`çéáÉë=

We strongly recommend that all users save the data they create, such as 
images, measurement data, archives, reports, forms and documents, at 
regular intervals on an external medium. Otherwise it cannot be excluded that 
access to this data may be lost as a result of operational errors or hardware 
defects. Carl Zeiss and Carl Zeiss Vision accept no liability for consequential 
damage resulting from insufficient data protection. 
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O lîÉêîáÉï=~åÇ=léÉê~íáåÖ=

OKN lîÉêîáÉï=

AxioVision’s main window is divided into two main areas: the Workarea and 
Workflow on the left-hand side, and the document area on the right-hand 
side. The elements of the Workarea and the Workflow are used to select 
and operate image processing functions and functions for controlling the 
camera and microscope. 

In the document area, all document types (images, archives, reports, forms) 
are displayed and edited. The main window also contains the Microsoft 
Windows specific control elements, such as the main menu, toolbar and 
status bar.  

 

AxioVision’s main window 
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OKO tçêâ~êÉ~=

The elements within the workarea (see figure below) can be used to 

 select processing functions on the work tab. 
 set parameters for processing functions on the property pages. 

By dragging the title bar you can 
separate the Workarea and the 
Workflow, or move one on top of the 
other. 

Activated Microscope property page 
 
 
 
 
 
 
 
Setting of functional parameters. 
 
 
 
 
 
 
 
 
 
 
 
 
Tabs for switching between Workflow 
and Workarea. 
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Notes: 
• All of the workarea’s functions can also be found in AxioVision’s main 

menu. 

• The workarea and workflows are displayed one on top of the other by 
default. To switch between them, use the tabs at the bottom of the 
workarea. 

• If you have hidden the workflows, when displayed again they are shown 
next to the workarea. You can, however, move them back on top of the 
workarea by dragging the title bar. This gives you more room to display 
documents. 

• You can show and hide the workarea using two different methods: either 
via the menu commands View ⇒ Windows ⇒ Workarea or via the 

button on the Standard toolbar . 

• If the Standard toolbar is hidden, select the menu commands View ⇒ 
Windows ⇒ Standard. 

 
OKP tçêâÑäçï=

One very simple way to operate AxioVision is to use workflows for routine 
tasks that need to be performed again and again. All you have to do is click 
on the functions in the workflow one after the other. You will then achieve 
the desired results quickly and smoothly. 

If you also hide all the elements that are not required, such as the workarea 
and toolbars, you can concentrate fully on the work you are actually 
performing. 
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Activated Standard workflow. 
 
 
 
The last function executed is indicated with 
an arrow. 
 
 
 
 
 
 
 
 
To activate other workflows, click on them. 
They then scroll upwards. 
 
 
 
 
 
 
 
Tabs for switching between the Workarea 
and Workflow. 

 

Notes: 
• All the functions available in AxioVision can be used in a workflow (see 

also chapter 8 "Configuration"). 

• The workarea and workflows are displayed one on top of the other by 
default. To switch between them, use the tabs at the bottom of the 
workarea. 

• If you have hidden the workflows, when displayed again they are shown 
next to the workarea. You can, however, move them back on top of the 
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workarea by dragging the title bar. This gives you more room to display 
documents. 

• You can show and hide the workarea using two different methods: either 
via the menu commands View ⇒ Windows ⇒ Workflow or via the 

button on the Standard toolbar: . 

• If the Standard toolbar is hidden, select the menu commands View ⇒ 
Windows ⇒ Standard 

 
OKQ lïå=qççäÄ~êë=~åÇ=aá~äçÖë=

You have the option of generating your own toolbars and dialogs to create a 
system that is tailored entirely to your own needs. If the range of setting 
options in the dialogs for camera and microscope control is too detailed for 
the work you are performing, you can therefore (with just a few clicks of the 
mouse) generate your own dialog containing only those control elements that 
you require for your work. This dialog can then be placed on a self-generated 
toolbar, and all the other default elements can be hidden. You then have a 
unique system that is optimized to meet your own individual requirements. 

You can call up the My Dialog function 
here via My Toolbar. 
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Notes: 
• You can generate as many personal toolbars as you want. 

• Your own dialogs can also be used on default toolbars. 

The My Dialog dialog contains 
options for Setting the exposure 
time and changing the objectives, 
and for the focus bar. 

Functions for controlling the 
scanning stage can be found on a 
second tab sheet: Scanning 
Stage. 

 

 
OKR pÜçêíÅìí=jÉåìë=

Shortcut menus contain functions that are frequently required in connection 
with documents (e.g. images) and certain elements of the AxioVision 
interface. They are the easiest way to select these functions. 

Shortcut menus are available for every element of the user interface. They can 
be activated at any time by right-clicking on an element (see shortcut menu 
for an image below): 
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OKS mêçéÉêíáÉë=táåÇçï=

The Properties window is required whenever you want to look over or to 
change the appearance, the behavior or certain additional information 
relating to a document (e.g. an image) or a particular element of the 
AxioVision interface. In this window, behind the tab sheets (Display, 
Attributes, Colors, ...), you will find a list of the relevant information (e.g. at 
an image) and/or will be given the option of entering or modifying certain 
elements. 

This may be information on the date of saving and the location where an 
image file is to be saved, for example, but may also relate to the formatting 
(Attributes) of text, lines and other objects you have drawn into the image 
(Annotations). See Property window of an image below: 
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As the property window plays a central role in the operation of AxioVision, it 
can be opened in a number of different ways: 

 Via the Properties function in the shortcut menu (see previous section). 
 Via the Properties function in the View menu. 
 By pressing the key combination Alt+Enter. 
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P fã~ÖÉ=^Åèìáëáíáçå=

PKN dÉåÉê~ä=

In order to process images using a computer, you must first acquire them in a 
form which the PC can understand. This requires an electronic camera, which 
acquires the image information from the microscope and converts it into 
electrical signals. These signals are digitized and then processed and displayed 
on the computer. 

Compared to analog camera technology, modern digital camera technology 
offers advantages in terms of the signal quality and camera resolution that 
can be achieved. With this technology, the data are digitized directly in the 
camera. 

To transfer the data to the PC, you need to use frame grabbers, interface 
boards or standardized digital interfaces. These are operated using special 
software programs (known as drivers). With these device drivers integrated 
into AxioVision it is now possible to acquire images via them. 

When installing framegrabbers, interface boards and interfaces, use the 
corresponding drivers supplied by Carl Zeiss and the associated manuals/the 
manuals from the respective manufacturers.  

The description below assumes that the frame grabber or interface board and 
the corresponding driver have been successfully installed. 

Detailed information on the cameras/framegrabbers supported by 
AxioVision can be found in the current AxioVision online help, in the 
AxioCam HR, MR and MRc5 installation and reference manuals, and in 
the PDF files of the manuals, which can be found on the product DVD. 
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PKO cáêëí=píÉéë=

When taking your first steps with the system, if possible use a simple sample 
so that it will be relatively easy for you to determine whether the resulting 
image is good or bad. 

Place the sample under the microscope, and set the microscope in such a way 
that you can see a good image through the eyepiece. Switch the microscope’s 
beam path to the TV adapter, e.g. 50% Topport and 50% Ocular. 

  

Notes: 
• If you are not yet familiar with your camera's functions, make sure that 

you have the respective manuals to hand so that you can look up any 
relevant information. 

• This text describes the main procedure for image acquisition. For 
explanations of the functions and setting options of all the cameras 
supported by AxioVision, please refer to the manual for the camera 
concerned. The description for the Carl Zeiss AxioCam product family 
serves as an example for all supported cameras. 

 
PKP `çåÇáíáçåë=

The text below describes how to achieve your first image in AxioVision with 
just a few clicks of the mouse (here with the AxioCam HR). The Standard 
workflow is the easiest way to control image acquisition. If the workflows are 
not displayed, in the View menu select the Windows function, and there 
select the Workflow command. 
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Note: 
• The workarea may in fact be open but covered by the workarea. If that is 

the case, simply click on the Workflow tab at the bottom edge of the 

workarea . 

qÜÉ=pí~åÇ~êÇ=ïçêâÑäçï=

 

Live starts and closes the live window. 

Live Properties opens and closes the 
window for adjusting the display 
characteristic curve and for controlling the 
camera (exposure time, white balance etc.). 

Snap acquires an image using the active 
camera. 

Show Properties adapts the image display 
using a characteristic curve and shows the 
parameters of the image. 

Scale bar inserts a scale bar. 

Draw Annotations inserts a caption and 
scale bar into the acquired image. 

Navigator opens the navigator window for 
zooming. 

Save saves the image. 

As the icons are identical on all menus, the following description applies both 
to operation via the toolbar and to the workflow. 
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píÉé=Äó=ëíÉé=íç=íÜÉ=Ñáêëí=áã~ÖÉ=

 Select the camera you want to use (if only one camera is installed, this 
step is not necessary). 

 Set the light path to the camera. 
Then click on the live image icon. 
The live window is opened to display 
the camera image. 

 This function can also be called up via 
the Acquisition ⇒ Live menu. 

 Now focus the camera image and 
select the frame you want to acquire. 

 In the footer you can select a suitable 
scaling for the objective you are using 
from the List of available scalings. 

 

 

 Clicking on this icon overexposed (too 
bright) areas will be displayed in red 
in the live image.  

 Clicking on the gamma icon in the 
bottom line of the live image 
accomplishes the optimum color 
reproduction. 

 

 In this drop-down list box you can 
select the speed of the live image 
(Slow, Middle, Fast).  
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 Click on the icon Live Properties to 
open the live properties. 

 

Here you can see the settings for the display of the image like Brightness, 
Contrast and Gamma. Settings made here are passed on the acquired image. 

Note: Only the display is adapted, the camera data remain unchanged. 
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Make changes for the camera settings on the following controls: 

 The central element is the setting for 
the exposure time on a digital 
camera. The Measure button can be 
used to determine an optimum 
exposure time. Check the quality of 
the exposure in the live image. 

 The arrow keys and sliders can be 
used for fine adjustment of the 
exposure time. 

 

 Exposure time can be edited via the keyboard. 

 Auto Snap performs an exposure measurement before the acquisition of 
each image. Auto Live adjusts the exposure time continuously in the live 
image. 

 If you are using a color camera, you 
need to perform a white balance for 
the image. If you select the automatic 
balance (Automatic button), the 
camera tries to determine an 
optimum value itself. 

 

 Using the Warmer/Colder slider you can shift the target value of the 
white balance to warmer (→ redder) or colder (→ bluer) tones. 

 The Show Channels check box allows you to switch to an alternative 
setting option if you wish to influence the target value of the white 
balance manually for each channel. 
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 If you are using a color camera, you 
need to perform a white balance for 
the image. If you select the automatic 
balance (Automatic button), the 
camera tries to determine an 
optimum value itself. 

 

 Move the slider to increase or 
decrease the color intensity of the 
acquired images. 

 

 Enter further settings for the selected 
camera on the Adjust, Frame and 
General property pages.  

 Click on the camera icon to acquire 
an individual image, or in the 
Acquisition menu click on Snap.  

 

 Click on the Show Properties icon 
and activate the Display tab. Any 
changes you make here are displayed 
in real time in the image window. 
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 Move the sliders 
Gamma

Contrast
Brightness

up or down to adjust the image. 
Good color reproduction on a 
monitor is achieved with a gamma 
value of around 0.45. 

 To find the optimum setting for 
contrast and brightness, click on 
Min/Max. 

 To undo all your changes, click on 
Linear. 

 
 

 You can use this icon to insert a scale 
bar into your image. The appropriate 
scaling must have been generated 
and selected in advance. 

 
 

 This icon is used to open the window 
for generating annotations. 
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 Lettering and marking can be 
inserted in the Draw Annotation(s) 
window. 

 

 In the dialog window Draw 
Annotation(s) the icons scalebar, 
text, line, rectangle, outline, curve 
und ellipse are available in the menu 
line. 

 

 In the dialog window Draw 
Annotation(s) a field for Settings 
for selected items as well as for 
Font are available. If Display tag 
name is activated, you can use the 

 icon in the drop-down list box 
Tag. The dialog window Select tag 
opens where parameters for lettering 
can be selected. 

 

 In the dialog window Draw 
Annotation(s) zoom symbols and 
two buttons to toggle the color 
channels are available at the bottom 
of the image window. 

 

 

 Using the navigator you can magnify 
or reduce the image and position the 
displayed image area in the overview 
window. 
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 Click on this icon to save the image 
you have generated to the 
computer’s hard drive.  

Notes: 
• Once you have found a good camera setting, you can save it with the 

Settings Editor in the Tool menu and load it again automatically in the 
future. This allows you, for example, to acquire particular samples under 
the same conditions every time. 

• To allow correct scalings to be selected in the footer of the live image 
during acquisition, you need to have generated these before you start 
your work. If you are using a motorized or encoded microscope, the 
scalings can be allocated automatically. For further information see Chapt. 
9 "Configuration". 

 
PKQ mê~ÅíáÅ~ä=kçíÉë=çå=léÉê~íáçå=áå=^ñáçsáëáçå=

Below you will find a few practical notes on the speed of the live image, color 
adjustment, working with exposure times, fluorescence images and 
configurable toolbars. 

péÉÉÇ=çÑ=íÜÉ=äáîÉ=áã~ÖÉ=

There are three speed modes available for the AxioCam HR live image. If you 

use the pointer to click on the  icon at the bottom edge of the live 
image, a pop-up menu with the possible setting options appears. The current 
setting is displayed at the bottom edge of the live image. 

Each mode has its own particular compromises. 

Live mode Description 
Fast Greatly reduced resolution, fast frame rate 
Medium Medium resolution, moderate frame rate 
Slow High resolution, slow frame rate 
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The image rate can be further increased by deactivating certain AxioVision 
features: 

 Deactivating the focus bar. 
 Deactivating the live image scaling (1:1 representation of the image). 
 Activating a frame for the live image (Size) on the camera property page 

Frame. 
 Set image orientation to original on the General property page (no 

rotation). 

Notes: 
• Note that the above mentioned notes are only valid for short exposure 

times, as for very long exposure times the speed of the acquisition is 
mainly dominated by the exposure time. 

• For very long exposure times, the live image will appear grainy, as 
automatic amplification is active. However, this will not influence the 
quality of the final image. 

kçíÉë=çå=léíáãìã=`çäçê=oÉéêçÇìÅíáçå=áå=^ñáçsáëáçå=

Below you will find a detailed description of how best to set up AxioVision to 
achieve optimum color reproduction with the AxioCam HR. 

Note: 
• For an optimum color reproduction the monitor first has to be adjusted. 

To do so please use a well-suited image. 

Adjusting the display characteristic curve in AxioVision: 

In order to achieve optimum reproduction of color images of the AxioCam 
HRc data on a monitor, the display characteristic curve must be used to set 
gamma compensation. The advantage here is that only the display is 
influenced and the actual data remain unchanged. Further details on this can 
be found below. The settings can be done as follows: 
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 With the mouse click on the icon  in the footer of the live image. 
This adjusts the display characteristic curve automatically for an optimum 
color reproduction of the monitor (gamma = 0.45). 

Or in an already acquired image: 

 In the Properties dialog window, set the gamma characteristic curve in 
the histogram image on the Display property page. 

Notes: 
• This also influences the reproduction of the color saturation. 

• For fluorescence images, background correction can also be carried out 
simply by shifting the offset of the characteristic curve. 

• Clicking on this icon  returns to a linear display of the data. 
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PKR eao=J=eáÖÜ=aóå~ãáÅ=o~åÖÉ=

dÉåÉê~ä=

The HDR module is available in AxioVision to allow you to test out its function. 
This means that you can now try out this acquisition technique at your leisure 
and examine the positive effect it has for your specific application. Following 
image acquisition, a watermark is burnt into your HDR image. 

Once you have licensed this module, it is available to you without any 
restrictions. 

HDR imaging offers you the possibility of increasing the camera-specific 
dynamic range. If you want to capture all the information from objects that 
are extremely rich in contrast, it is usually necessary to acquire several images, 
which need to be adapted to the relevant exposure situation. Either the very 
bright or the dark structures can be correctly exposed. With the HDR module 
it is possible to document all the information in a single image. 

To achieve this effect, depending on the parameters set, several images are 
automatically acquired with different exposure times and subsequently 
merged into a single image with an increased contrast range.  

To achieve the best possible result with your image, it is crucial to set the 
exposure time precisely. No position on the specimen may appear 
overexposed. This is the only way to guarantee that the information acquired 
in the brightest structures is differentiated and contributes to the HDR image. 
In this case a simple measurement to determine the correct exposure time 
prior to acquisition is not suitable, as this involves performing average 
metering that is subject to tolerances. Instead, the overexposure warning 
should be activated and the display characteristics in the non-logarithmized 
display should be adjusted in such a way that there genuinely is no 
overexposure of any pixel.  

The advantages of the technique depend to a great extent on the specimen 
and on the microscopy technique being used. A sample in transmitted-light 
bright field generally has only a relatively flat dynamic range. This means that 
the effect you notice from the use of the HDR method will not be an increase 
in contrast, but merely a reduction in image noise. Images of specimens 
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acquired using other contrast techniques, such as dark field, reflected light or 
fluorescence, exhibit a stronger increase in contrast, depending on the 
structure in question, as they often have a higher dynamic range than that of 
the cameras used.  

In many cases, it is not possible at first sight to see a clear improvement in the 
acquired HDR image compared to a normal image. This is due to the limited 
display depth of monitors, which usually have a contrast range of 8 bits. As no 
further tone mapping is performed in AxioVision to map the increased 
dynamic range to a monitor, an adjustment can only be made with the help 
of the gamma setting (non-linear bending of the display curve).  

The additional information gained from expanding the dynamic range is most 
noticeable when performing measurements. Thanks to the more 
differentiated display, more brightness gradations are available to the user, 
which means that as well as a distinction in bright structures there is also 
nuancing in dark areas of the image. This allows segmentations to be 
performed more precisely and measurement results to be refined.  

Note: 
• For detailed information on the individual functions and parameters, 

please simply refer to the online help (F1 key). 

eao=áã~ÖáåÖ=

In the following sections you will see that acquiring an HDR image using an 
AxioCam is extremely simple. By bearing a number of fundamental aspects in 
mind, you will quickly achieve good results. 

If you are using a camera from another manufacturer, it may be necessary to 
change parameters in HDR Setup, even for simple HDR imaging. This will be 
mentioned at the relevant points and the procedure will be explained in more 
detail under the final point “Basic settings in HDR Setup”. 
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HDR Mode 

The quickest way to obtain an HDR image using an AxioCam is to use HDR 
Mode. 

This mode is independent of the other image acquisition modules and can be 
activated individually for all acquisition functions. 

Using the HDR button  on the Acquisition menu you can activate and 
deactivate the HDR Mode very simply. 

This button can make your work with the HDR module much easier as it also 
informs you of the current status of the function. When the HDR Mode is 
active, the HDR button is highlighted in blue. If, on the other hand, the 
module has been deactivated, the button is no longer highlighted. 

Tip: 
• The button for the HDR Mode can be found on the Acquisition toolbar. 

To allow you to maintain a constant overview of the HDR function and, 
consequently, avoid any undesired extension of the acquisition time, you 
can place the button on your own predefined toolbar using the My 
AxioVision function (Tools menu ⇒ My AxioVision). 

You will find this function under the following menu item: Acquisition ⇒ 
HDR ⇒ HDR Mode. 
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If you activate HDR Mode, all subsequent images will be generated with an 
increased dynamic range. 

HDR Mode can be operated in two different settings. On the one hand, there 
is Simple Mode, in which only the dynamic extension can be set. In this case 
the other information required is completed automatically. Beneath the slider 
you will find the information on the number of images used, the source for 
merging the dark value and the extension factor. This is therefore a good way 
to get to know HDR Mode without having to set a large number of 
parameters. Expert Mode, on the other hand, contains all the setting options 
required to individually adapt the HDR image.  
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 Simple Mode Expert Mode 

The acquisition parameters should be selected carefully, especially in Expert 
Mode, as these define the duration of the exposure and therefore the burden 
placed on the sample. To give you an idea of the exposure time to be 
expected, a factor for the extension of the overall acquisition time is shown 
underneath the acquisition parameters. 

As a rule of thumb for the correct setting of HDR Mode, the following should 
apply: a dynamic extension of 2 bits should result in the exposure count 
increasing by 2. This guarantees good information density in the HDR image. 

The predefined settings with an extension by 2 bits using 3 images and the 
source “Input Tag” for merging the dark value are a good starting point for 
working with an AxioCam. 

Note: 
• If you are using a camera from another manufacturer, it cannot be 

guaranteed that an “input tag" for merging the dark value will be 
transferred to AxioVision and consequently that the result will be free of 
errors. If the source "Input Tag" is not available for the calculation, the 
dark value set is used instead (see also the section "Basic settings in HDR 
Setup"). 
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Simplest way to generate an HDR image 

Following this brief explanation of the different versions of HDR Mode, we will 
now return to a description of the quick acquisition of an HDR image. 

Activate HDR Mode in the simple display and set the slider to a dynamic 
extension of 2 bits. If you are using HDR Mode for the first time, the following 
data will be completed automatically and displayed in the information rows 
underneath the slider: an exposure count of 3 images, an exposure time 
extension by a factor of 7 and the dark source “Input Tag”. If you have 
already used HDR Mode and have changed the input parameters, these values 
will be displayed and applied. 

Please therefore always pay attention to the settings to ensure that your HDR 
image is acquired as you want it to be. 

Now you need an object that is rich in contrast and must determine the 
correct exposure time. To do this, activate the overexposure warning. This 
makes it easy to determine the right acquisition time. Adjust the exposure 
time in such a way that no overexposed pixels are displayed. The more 
precisely you do this, the more gradations you will be able to differentiate 
later in the bright structures of the HDR image. 

Once the correct exposure time has been determined, you now only need to 

click on  or the F2 key.  

Everything else takes place automatically and the output image will already 
show the HDR image with a dynamic range that has been increased by 2 bits. 
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An individually adapted HDR image step by step 

Another way to obtain an HDR image is to make use of the individual 
functions.  

These can be opened either via the Acquisition menu or in the work area 
under HDR ⇒ HDR Functions. 

The individual functions allow you to enter individual settings for an HDR 
image and adapt it to the properties of the various cameras. Using the 
individual functions is also an excellent way to familiarize yourself with the 
operation of the program and the various merging and setting options. 

A good HDR image can be improved even further by means of a calculation 
using an adapted dark value. This means that an individual black-reference 
image is subtracted for each exposure time. Only a few additional operations 
are necessary to do this. Black references are normally created before the 
actual acquisition of the image. In this case, due to the individually adapted 
exposure times, it is easier and less time-consuming to acquire the black 
reference after actual image acquisition. One condition for achieving a 
flawless result with your image is to ensure that the beam path is absolutely 
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free of stray light. You should therefore always make sure that the camera 
sensor is not receiving any light at all. 

For the HDR image you must first adjust the specimen and define the 
appropriate exposure time. As with the use of HDR Mode, make sure that 
there are no overexposed areas in the image (activate overexposure warning). 
This is the only way to guarantee that you will gain the maximum information. 

 Open the HDR Series function 
and set the Image Count and 
Extra Bits parameters for the 
increase in the dynamic range. 

With these two details you have 
defined all the important data for 
acquisition itself. 

 Once everything has been set 
to your satisfaction, click on 

the  button.  

HDR Series generates an image series consisting of images with different 
exposure times. The various component images are displayed in a 
multichannel image. This means that you can view all the exposure times 
separately from each other, analyze them and save them for other uses. 

To generate the black reference you only need to close the light path to the 
camera and acquire a black-reference image using the same settings as before 
for the HDR image.  

Note: 
• The display of the series initially shows you an overlay of all images 

acquired. Click on the  icon to view the individual images. 

To obtain a finished HDR image, all that you now need to do is merge the 
individual components. To do this, select the HDR Merge function. 
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 To merge the black-reference 
series previously acquired, set 
the parameter Dark Image as 
the dark source. 

 Select the image by clicking on 

. 

 Lastly, activate the previously 
acquired HDR image. To do 
this, all you have to do is click 
once on the image’s 
Acquisition tab. 

 

No other changes to the parameters are required if you are using an AxioCam 
camera. If you are operating an AxioCam ICc 1 or ICc 3 in 8-bit mode, the 
output bias should be reduced to the value 3 (more detailed explanations can 
be found in the following section or in the online help). 

 starts the merging process. The HDR image is now finished. 

Basic settings in HDR Setup 

The settings in HDR Setup determine all the parameters that cannot be 
changed individually in the various HDR functions. This function is therefore of 
central importance. 
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HDR Setup can either be opened via the Acquisition menu or in the work 
area under HDR ⇒ HDR Functions ⇒ HDR Setup. 

  

The default values in HDR Setup have been set in such a way that they can 
be adopted without any further changes for an AxioCam. 

It may be necessary to change the dark value for the merging of the HDR 
image if you are using a camera from another manufacturer. To determine 
the actual dark value, it is helpful to take the value of the darkest areas of a 
simple image as a reference. 

The second setting that you should change, if necessary, if you are using an 
AxioCam ICc 1 or AxioCam ICc 3 in 8-bit mode or a camera from another 
manufacturer is the Output Bias parameter. This determines the brightness 
value of the darkest pixel in the output image and should be set to the value 3 
in the case of the AxioCam ICc. 
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Q jáÅêçëÅçéÉ=`çåíêçä=

QKN dÉåÉê~ä=

AxioVision has been specially designed to support motor-driven microscopes 
from Carl Zeiss.  

The introduction of the new microscope types from the Axio Imager, Axio 
Observer and SteREO series means that the established Axioplan, Axiovert, 
Axioskop and Stemi systems are being replaced. These systems will no longer 
be developed or produced, but will naturally still be supported by AxioVision. 

As the Axio Imager, Axio Observer and SteREO microscopes open up 
completely new opportunities for computer-aided microscopy, new 
requirements are also necessary with regard to the configuration of the 
systems. Therefore, a distinction is made in AxioVision between the 
established systems Axioplan, Axiovert, Axioskop and Stemi and the new Axio 
Imager, Axio Observer and SteREO systems. Various configuration programs 
are available for both generations of instruments. However, there is only a 
difference as far as operation in AxioVision is concerned where functional 
differences actually exist. Therefore, if you change your system, you will be 
immediately familiar with the new microscope without having to readapt. 

The microscope is either controlled via a property page containing all 
configured components or via control elements for individual components.  

The property page for controlling the microscopes can be activated up by 
clicking the Microscope entry in the work area or by selecting from the 
Microscope menu the function Microscope. 

Alternatively you can select single controls from the five functions General, 
Transmitted Light, Reflected Light, Stage/Focus and Extra. 

A more detailed description of the controls can be found in the Online help. 
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QKO `çåÑáÖìê~íáåÖ=ãáÅêçëÅçéÉë=ïáíÜ=jáÅêçëÅçéÉ=
`çåÑáÖìê~íáçå=

At the time of AxioVision‘s release the following Carl Zeiss microscopes are 
supported: 

 Axioplan 2 
 Axioplan 2 imaging 
 Axioplan 2 imaging e 
 Axioplan 2 imaging e man 
 Axiovert 200 man 
 Axioskop 2 mot plus 
 Axioskop 2 mot 

Your microscope type and its individual facilities are selected in the separate 
program Microscope Configuration. This configuration program can be 
found on the Microsoft Windows Desktop. 

  

Here you can define your microscope‘s type and components. 
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QKP `çåÑáÖìê~íáåÖ=ãáÅêçëÅçéÉë=ïáíÜ=jq_OMMQ=
`çåÑáÖìê~íáçå=

The following microscopes are currently supported: 

 Axiovert 100 M 
 Axiovert 200 M 
 Axiovert 200 M MAT 
 Axiovert 200 MAT 
 Axio Imager (A1, D1, M1, Z1) 
 Axio Observer (A1, D1, Z1) 
 Axio Observer MAT (A1m, D1m, Z1m) 
 SteREO Discovery (V8, V12, V20) 
 SteREO Discovery (V8, V12, V20) o.EMS 
 SteREO Lumar.V12 
 SteREO Lumar.V12 o.EMS 

The microscope type and the individual equipment you are using on your 
microscope are selected in the separate MTB2004 Configuration program. 
his configuration program is located on the Microsoft Windows Desktop. 
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QKQ ^Åíáî~íáåÖ=ãáÅêçëÅçéÉ=ÅçåÑáÖìê~íáçåë=

In order to activate a new microscope configuration, you must first exit 
AxioVision. You can then start the relevant configuration program 
(Microscope Configuration or MTB2004 Configuration) to activate the 
appropriate configuration or to make the desired changes to the current 
configuration. 

A new feature of AxioVision release 4.3 is the opportunity to change the 
configuration directly at the start. The following dialog is displayed when 
AxioVision is started: 

 

Here you can choose the microscope type and then start the corresponding 
configuration program via Configuration. 

If this dialog is not displayed, you should check the settings in the Tools ⇒ 
Options ⇒ General function: 
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Here, you can specify your type of microscope and activate the Microscope 
Selection dialog by activating the Show selection dialog at startup check 
box. 

In addition, for the new Axio Imager, Axio Observer and SteREO microscopes 
only, it is possible to change the configuration of the microscope when 
AxioVision is running: 

 

The MTB2004 Configuration program can be started via the Microscope ⇒ 
Configure microscope function. You can then make changes to the current 
microscope configuration. These changes are adopted immediately. 

The possibility of changing a configuration is limited, however: 

 Changes to the current configuration are limited to the objectives and the 
reflector. You will need to restart AxioVision to make any further changes. 

 Only the current configuration can be changed. You will also need to 
restart AxioVision in order to activate a different configuration or to 
generate a completely new configuration. 

 
QKR qÜÉ=pÉííáåÖë=bÇáíçê=

Under the Tools menu you can open the Settings Editor dialog (keyboard 
command Alt+S). In this dialog you can generate, save and retrieve settings 
for your current hardware, i.e. for your microscope, camera or other external 
components such as filter wheels or shutters. You can also apply these 
settings to the hardware. 

These settings are intended to make it easier for you to operate your 
microscope. They are also used for microscope control when you are 
generating complex experiments, e.g. with the Multichannel Fluorescence or 
Z-Stack modules. The settings are saved as a document (*.zvhs). 
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eçï=aç=f=dÉåÉê~íÉ=~=e~êÇï~êÉ=pÉííáåÖ\=

The text below explains step by step how to generate and modify a hardware 
setting document and how to apply it to the microscope. In this example, the 
reflector nosepiece is to be switched to the Rhodamine position, and the 
integrated fluorescence shutter is to be opened so that light falls on the 
sample. The setting is to be saved as a document with the name 
"Rhodamine.zvhs". 

 In the Tools menu, open the 
Settings Editor. It can also 
be opened using the key 
combination Alt+S. 

 

 In the window that is now 
open, click on New, enter a 
suitable name, such as 
"Rhodamine", in the dialog 
window,  and click on OK. 
You can decide, whether you 
only (User) or other persons 
(Workgroup) can use the 
settings file  

 Now add hardware settings to 
the empty document. To do so, 
select from the list Available 
Components. 
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 Click on  to open the 
microscope branch, and then 
open the branch for the 
Reflected Light component 
group. The tree should now 
look like this: 

 

 Select the Reflector component, and add it to the Rhodamine setting by 

clicking on . Repeat this step for the Internal Shutter. 
You can also add this component by using Drag&Drop. 

You will now see these two components listed in the setting window: 

 

Both components contain a certain setting. In our example, the component 
Reflector is set to the filter set "[1]49 DAPI BP", and the Internal Shutter is 
Closed. These parameters correspond to the current setting status on your 
microscope. What you see may therefore differ from the examples shown 
here. 
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 Select the component 
Reflector and click on the 

 button. This selection 
dialog is opened: 

 

 From the drop-down list box, 
select the reflector position 
for Rhodamine (in this case it 
is 15 Ex.546/12 at position 
3), and confirm with OK. 

 

 Now select the component 
Internal Shutter, click on 

the  button, and then 
click in the dialog on Open. 
Confirm your selection with 
OK. 

 

 Save your settings by clicking on . This button then 

becomes inactive ( ). 

 Test your new hardware setting by clicking on . The 
reflector block should now swing to position 3, and the shutter for the 
fluorescence lamp should open. 
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The hardware setting "Rhodamine.zvhs" has now been saved and can be 
assigned to a function key (for more information, please refer to chapter 8 
"Configuration" - " Define key combinations for functions") or used in an 
experiment as part of the acquisition of a multichannel image, for example. 

 
QKS aÉÑáåáíÉ=cçÅìë=

lîÉêîáÉï=

The Definite Focus functionality in AxioVision enables control of Definite 
Focus, an LED-based  focus stabilizer. Definite Focus can e.g. be used to 
compensate changes in the distance between microscope objective and 
specimen caused by temperature fluctuations.  

Notes: 
• Definite Focus control is also possible without using AxioVision, although 

depending on the application, this may only be possible with limited 
functionality.   

• For further information on the working principle, operation and 
compatibility with hardware components (e.g. objectives), please refer to 
the Definite Focus operating manual. 

In this section several examplary use cases are given for operation of definite 
Focus by AxioVision. However, the quality of the actual results that can be 
obtained, not only depends on the software settings but also on many other 
parameters like e.g. type of sample, microscope objective, speed of focus-
drift, etc.  

bñ~ãéäÉ=NW=^ìíçã~íáÅ=ÑçÅìëJëí~Äáäáò~íáçå=~í=çåÉ=
éçëáíáçå=çÑ=~=ÅìäíìêÉ=ÇáëÜ=çîÉê=íáãÉ=EjìäíáÇáãÉåëáçå~ä=
^ÅèìáëáíáçåF=

In this example Definite Focus automatically stabilizes the focus-position (Z) at 
a single xy-Position in a culture dish, without needing further settings or 
interactions made by the user.  
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The following schematic representation (not to scale) shows how Definite 
Focus operates during such an experiment. 

 

 Make sure that Definite Focus control by AxioVision is running in default 
mode. Default handling of Definite Focus is the preferred working mode. 

The box  in the menu Tools ⇒ 
Options… ⇒ Acquisition must not be checked for this mode. Activation 
and deactivation of Definite Focus during the experiment will now be 
carried out automatically by AxioVision. 

 Place your specimen on the microscope stage and focus it. 

 Open the Definite Focus window in the menu microscope ⇒ XYZ ⇒ 
Definite Focus: 
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 Define the activity interval of Definite Focus by entering a Period value. 
The faster the expected focus drift is, the smaller the value has to be. 

 Activate Definite Focus by clicking the  button. 

Activity of Definite Focus is displayed in the Status area of the Definite Focus 
window by a periodic indication of „Waiting…” and “Setting focus…”, as 

well as by an animated icon . 

 Now start the image acquisition experiment as you are used to it. This can 
be e.g. a single- or multichannel timelapse experiment. 

AxioVision User's Guide, Release 4.8.2 4-11 



Microscope Control 

Note: 
• Definite Focus keeps the distance from the bottom of your sample (e.g. 

the culture dish) constant. Please note that movement of individual cells in 
the culture dish can nevertheless lead to a situation where these cells are 
not in focus anymore. In this case use of the software- (image-) based 
autofocus functionality of AxioVision is recommended. The AxioVision 
software-autofocus can also be used additionally to Definite Focus. 

bñ~ãéäÉ=OW=^ìíçã~íáÅ=ÑçÅìëJëí~Äáäáò~íáçå=~í=çåÉ=
éçëáíáçå=çÑ=~=ÅìäíìêÉ=ÇáëÜ=çîÉê=íáãÉ=Ec~ëí=^ÅèìáëáíáçåF=

Definite Focus operation in Fast Acquisition experiments is different from that 
in Multidimensional Acquisition experiments. Due to the nature of Fast 
Acquisition experiment, Definite Focus has to be restricted to not interfere 
with the highly efficient image acquisition process. 

It is not recommended to use Definite Focus in Fast Acquisition Experiments 
including z-stacks. For Acquisition of fast timeseries only, we suggest to 
perform experiments aiming at the optimization of a suitable Definite Focus 
period for the desired image acquisition interval. 

Note: 
• If you should observe a continuous focus jitter, please increase the 

Definite Focus period to restrict the effect to a subset of (defined) images. 

• In case you observe periodic changes in image brightness (especially when 
multibandpass- or longpass-fluorescence filters are used), please install 
the IR-blocking filter delivered with you Definite Focus device. Please also 
see the Definite Focus hardware manual for this procedure. 

bñ~ãéäÉ=PW=^ìíçã~íáÅ=ÑçÅìë=ëí~Äáäáò~íáçå=ÇìêáåÖ=
~Åèìáëáíáçå=çÑ=~=jçë~áu=áã~ÖÉ=

In this example Definite Focus automatically stabilizes the focus-position (Z) at 
tile images of a MosaiX.  

The following schematic representation (not to scale) shows how Definite 
Focus operates during such an experiment. 
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 Make sure that Definite Focus control by AxioVision is running in default 
mode. Default handling of Definite Focus is the preferred working mode. 

The box  in the menu Tools ⇒ 
Options… ⇒ Acquisition must not be checked for this mode. Activation 
and deactivation of Definite Focus during the experiment will now be 
carried out automatically by AxioVision. 

 Place your specimen on the microscope stage and focus it. 

 Open the Definite Focus window in the menu microscope ⇒ XYZ ⇒ 
Definite Focus: 

 Activate Definite Focus by clicking the  button. 
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 Check the box on the MosaiX 
property page. If the box is checked, Definite Focus will be activated 
during the MosaiX acquisition the same the software autofocus would 
get activated. This means you are free to choose between Off, At 
Center, At 1. tile, Every nth tile. Please see the MosaiX help and 
manual for a description of these options. 

 Start the image acquisition. 

bñ~ãéäÉ=QW=^ìíçã~íáÅ=òJéçëáíáçå=~ÇàìëíãÉåí=~í=
ãìäíáéäÉ=éçëáíáçåë=áå=ÉñéÉêáãÉåíë=ìëáåÖ=ãìäíáïÉää=
éä~íÉë=çê=ëáãáä~ê=ë~ãéäÉ=Å~êêáÉêëK==

In this example Definite Focus automatically stabilizes the focus-position (Z) at 
multiple xy-positions of a multiwell plate.  

The following schematic representation (not to scale) shows how Definite 
Focus operates during such an experiment. 
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 Make sure that Definite Focus control by AxioVision is running in default 
mode. Default handling of Definite Focus is the preferred working mode. 

The box  in the menu Tools ⇒ 
Options… ⇒ Acquisition must not be checked for this mode. Activation 
and deactivation of Definite Focus during the experiment will now be 
carried out automatically by AxioVision. 

 Place your specimen on the microscope stage and focus it. 

 Open the Definite Focus window in the menu microscope ⇒ XYZ ⇒ 
Definite Focus: 

 Activate Definite Focus by clicking the  button. 

 Check the box on the XY property 
page. If the box is checked, Definite Focus will be activated before image 
acquisition at every single position of the active positionlist. 

 Start the image acquisition. 

Note: 
• When multiwell plates or holders are tilted too much or the bottom of the 

plate is very uneven, the difference in the z-position of xy-positions that 
are very far apart, can be greater than the lock-in range for Definite Focus 
with the used objective. 

bñ~ãéäÉ=RW=^ìíçã~íáÅ=òJéçëáíáçå=~ÇàìëíãÉåí=~åÇ=
ëí~Äáäáò~íáçå=çîÉê=íáãÉ=~í=ãìäíáéäÉ=éçëáíáçåë=áå=
ÉñéÉêáãÉåíë=ìëáåÖ=ãìäíáïÉää=éä~íÉë=çê=ëáãáä~ê=ë~ãéäÉ=
Å~êêáÉêëK==

In this example Definite Focus automatically adjusts the focus-position (Z) at 
multiple xy-positions of a multiwell plate and at the same time compensates a 
z-drift over time. 
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The following schematic representation (not to scale) shows how Definite 
Focus operates during such an experiment. 

 

 Proceed as described in example 4. 

 Open the Definite Focus window in the menu microscope ⇒ XYZ ⇒ 
Definite Focus: 
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 Define the activity interval of Definite Focus by entering a value into the 
Period field. The faster the expected focus drift is, the smaller the value 
has to be. You should also take into account the time interval that you 
use for the image acquisition.  When a time interval of 120 seconds is 
used for image acquisition, it could e.g. make sense to use a Definite 
Focus period of perhaps 5 or 10 seconds. 

 Start the image acquisition. 

Note: 
• When multiwell plates or holders are tilted too much or the bottom of the 

plate is very uneven, the difference in the z-position of xy-positions that 
are very far apart, can be greater than the lock-in range for Definite Focus 
with the used objective. 
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bñ~ãéäÉ=SW=rëÉêJÇÉÑáåÉÇ=aÉÑáåáíÉ=cçÅìë=çéÉê~íáçå=

In this example, Definite Focus is controlled by user-defined hardware-
settings. This mode is only recommended if the results obtained by the 
automatic Definite Focus control are not satisfying. It is also recommended 
that only users, experienced in generating hardware-settings are using this 
mode. 

 Deactivate the default handling of Definite Focus by AxioVision by 

checking the box  in the menu 
Tools ⇒ Options… ⇒ Acquisition. Activation and deactivation of 
Definite Focus during an Experiment is not done automatically anymore 
by AxioVision, but has to be defined by the user in an experiment with 
hardware-settings. 

 You will find the Definite Focus Control-Components for the creation of 
hardware-settings in the menu Tools ⇒ Settings-Editor in the category 
Microscope ⇒ XYZ. 

  

 Create a hardware-setting „Definite Focus active“ that activates Definite 
Focus for focus stabilization with an interval (period) of 5 seconds.  
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 Create a hardware-setting „Definite Focus inactive“ that deactivates 
Definite Focus.  

  

 Use these hardware-settings to enable focus stabilization and correction 
by Definite Focus in between the timepoints of a timelapse experiment, 
while disabling Definite Focus immediately before image acquisition. For 
this use the submenu Settings before/after Timepoint in the Tab T of the 
Multidimensional Acquisition. 
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 You may now start you experiment. Definite Focus will correct the focus 
position between all timepoints every 5 seconds. During image acquisition 
it will be inactive to minimize the possibility of any putative negative 
influence of Definite Focus on image quality. 
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QKT qfoc=

mÉêÑçêãáåÖ=~ìíçã~íáÅ=Å~äáÄê~íáçå=

Function 

In quantitative TIRF microscopy it is important to know the exact angle at 
which the sample is being illuminated so that additional parameters of the 
evanescent field and the sample (penetration depth, refractive index, critical 
angle of total reflection etc.) can be determined from this. The angle is 
generally set using a motorized deflection unit and is influenced by the opto-
mechanical tolerances of the microscope components being used (e.g. filter 
set, objective).  

It is therefore necessary to calibrate the deflection system. For this purpose, 
use is made of the effect that causes the depth to which the illumination light 
penetrates into the sample to decrease exponentially when the critical angle 
of total reflection is reached and exceeded. This penetration depth then 
amounts to just a few tens or hundreds of nanometers. The consequence of 
this is that the background fluorescence from parts of the sample that are 
further away from the cover slip drops rapidly.  

It is possible to measure the intensity via the surface brightness of the 
objective pupil. To do this, the deflection unit is moved automatically in such a 
way that the laser focus passes directly across the entire objective pupil once. 
(The position of the laser focus in the objective pupil determines the angle at 
which the sample is illuminated.) 
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Laser focus in objective pupil 

 

 

 
The angle setting ß of the deflection unit and the integrated intensity of the 
pupil image at this angle are always measured. 

The resulting integrated intensity curve (see below) depending on the angle 
setting of the deflection unit is subsequently analyzed. 

Two jumps in intensity can be identified in the graph. These occur at the 
moment the sample illumination reaches the critical angle of total reflection, 
when the intensity of the background fluorescence increases/decreases. The 
sample-illumination angles are equal in size and differ only in the sign that 
precedes them.  

4-22 M 60-3-0024 e / printed 06.2010 



Microscope Control 

The graph shows the integrated intensity depending on the angle ß of the 
deflection unit: 

 

Critical angle of total 
reflection +-αg 

ß2ß1 

Light intensities in the objective pupil or a plane conjugated to it: 

 

The angle setting ß0 of the deflection unit at a sample-illumination angle α of 
0 degrees is therefore calculated as follows: 

ß0(α=0°) = ß1 -ß2 

ß1 and ß2 are the angle settings of the deflection unit at which the critical 
angle of total reflection is realized in the sample. 

The signs preceding the angles must be observed. 

The deflection unit has therefore been calibrated and there is a direct 
relationship between the angle setting of the deflection unit and the angle of 
sample illumination. In other words, you know what deflection angle results in 
a sample-illumination angle α of 0°. 
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It is now possible to set defined sample-illumination angles, as sample-
illumination angle α and deflection angle ß are in a fixed relationship to each 
other as a result of the optical and mechanical structure. 

α = f(ß- ß0),          ß = f(α) + ß0 

From the critical angle α1 or α2 you can now calculate the refractive index of 
the sample. 

n1 = n2 x sin ( f(ßg-ß0) ) 
n2 = refractive index of cover slip  
n1 = refractive index of sample 

The angle must be calibrated for each combination of objective and 
fluorescence filter set, as each filter set causes slightly different deviations in 
the beam path due to manufacturing tolerances. 

To automatically correct the TIRF slider’s offset from the zero position, follow 
the procedure below: 

 Insert your sample into the microscope’s sample holder. Only aqueous 
samples are suitable for calibration purposes. Fixed specimens are not 
suitable! 

 Focus on the lowest layer of your sample. No air bubbles or impurities 
must be present in the oil. 

 Set the laser intensity to the lowest possible level. 

 Move the Bertrand slider installed in front of the camera into the beam 
path. 

 Restrict the camera frame to roughly the diameter of the imaged 
objective pupil. 

 Switch the display characteristics of the live image to Linear. 
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 Select the laser intensity and camera exposure time in such a way that the 
image is neither overexposed nor underexposed at the middle setting for 
the illumination angle. 

 Select the combination of filter, objective and laser line that you wish to 
calibrate. 

 Start the calibration run by clicking on the Automatic Calibrate button. 

 Calibration now begins. 

When calibration is complete, a display appears of the measured average gray 
values as a function of the angle set. 

  

If automatic calibration fails, follow the procedure below: 

 Reactivate the laser and set the angle to the left-hand detected edge, 
denoted as B1. Take note of the image displayed. Now repeat this for B2 
by changing the uncorrected angle until it is at the point of the steepest 
slope. Repeat the step until the image intensity has equal values. Exit the 
dialog by clicking on the Apply button. 

Open the live display and set the beam to the zero position using the 
corresponding button for setting the illumination angle. If the fluorescence 
returning from the sample is at the center of the objective pupil. 
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R fã~ÖÉ=mêçÅÉëëáåÖ=

RKN dÉåÉê~ä=

The task of image processing essentially consists of two fields of activity: 
correction and optimization of the acquired image data. 

In many cases digital image processing functions are required to make up for 
the technical limitations of the available devices. However, we should point 
out that often (in fact probably in most cases) image processing functions are 
needed to compensate for carelessness during image acquisition. 

It is therefore essential to make sure that you fully utilize the capabilities of 
your technology both prior to and during image acquisition. This is the only 
time when the actual original information is available. It is also your best 
opportunity to ensure good image quality.  

One area that is often neglected is the preparation of the sample. The 
principle here is that a poor sample inevitably results in a poor image. For this 
reason you need to be self-critical and check whether the quality of your 
sample is suitable to provide optimum acquisition results. 

Whatever you use image processing functions for, make sure that wherever 
possible original data are not overwritten. You should always be able to return 
to the original image to ascertain whether executing a function has actually 
brought about an improvement or has in fact resulted in relevant image 
information no longer being available. 

qÜÉ=ÇáÑÑÉêÉåí=ï~óë=çÑ=éêçÅÉëëáåÖ=áã~ÖÉë=

In AxioVision there are two different ways to process images. They each have 
different features and have been devised for different areas of application. On 
the one hand, all functions can be executed via the Processing menu or the 
Workarea. Alternatively, via the Properties window, you can optimize the 
quality of the image display (brightness, contrast and gamma value) for your 
monitor using a characteristic curve. 
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In both cases AxioVision ensures that initially your original data are not 
modified: 

 If you are using the functions via the Processing menu, by default the 
result is displayed in a new image document. You can then decide 
whether you want to save the result in a new file or overwrite the existing 
file. 

 If you are working via the Properties window, the numerical values of 
the brightness and color information of your images are not modified. 
Only the display of the saved values on the monitor is adapted. As long as 
you save your images in AxioVision "ZVI" format, in addition to the 
original data it is only the settings in the Properties window that are 
saved in the file. 

 When you open the file, it is then the optimized display that is initially 
made available. You can revert to the original display at any time via the 
Properties window. If you export the image into a different format, the 
settings of the Export function can be used to specify whether you want 
to save the original data or whether you want the settings in the 
Properties window to be adopted before saving. In the latter case, 
however, the gray or color values are changed, and you are no longer 
able to restore the original data. 

Note: 
• We recommend that initially you always save your images in ZVI format, 

and only export them to an external format if you need to do so. 

fã~ÖÉ=Ñçêã~íë=

In the section that follows, image format should not be understood to mean 
the file format (ZVI, BMP, TIF etc.), but rather the way in which brightness and 
color are displayed in an image. 

Conventional TV cameras are able to distinguish 256 gray levels. The entire 
spectrum from black to white is displayed using this number of brightness 
levels. To be able to distinguish 256 gray levels on a PC, 8 bits are required. 
These images are therefore known as 8 bit images. 
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To display color images, three of these gray level images are required – one 
for red, one for green and one for blue. These images are essentially gray level 
images. This means that a color image is made up internally of 3x8-bit images. 
We therefore also talk of 24 bit images. With these kinds of image it is 
possible to distinguish up to 16.8 million color values. 

Modern digital cameras, however, are not only able to distinguish 256 gray 
levels, but can actually distinguish as many as 65536. This means that 8 bits 
are no longer sufficient to save the data. 16 bits are required in such cases. 
However, 16 bit images are essentially only gray level images too. If three of 
these images are combined to form a color image, we talk of 48 bit images. 

Note: 
• Some file formats are not able to save 16 and/or 48-bit images. We 

therefore recommend that you always save your images in ZVI format 
initially, and only export them to an external format if you need to do so. 

 
RKO ^ååçí~íáçåë=

Annotations are additional drawing elements (scale bars, captions, arrows 
etc.) that can be drawn into an image. The word "into", however, is not 
strictly accurate, as the annotations are in fact drawn on top of the image. In 
other words, the annotations are drawn into their own plane on top of the 
actual image information, ensuring that initially the original information is not 
overwritten. 

Provided that you save your images in AxioVision "ZVI" format, this plane 
information can be retained. The annotations are therefore saved separately 
from the actual image information. When you open the file, any annotations 
that are present can be changed, deleted or hidden or new annotations can 
be added. 

The AxioVision ZVI format is the only format that supports this plane 
technique. Consequently, if you save the image in a different format, in the 
settings of the Export function you must specify whether or not you wish to 
"burn" the annotations into the image. You have the following options: 
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 If you burn the information into the image, the pixels that lie beneath the 
annotations are overwritten and you will then be unable to restore them. 

 If you decide not to burn the annotations into the image, the annotations 
are lost. 

 Alternatively, you can save the image twice (once in its original form and 
once with the annotations burnt in). 

Note: 
• As there are considerable limitations involved in saving images in external 

formats, we recommend that initially you always save your images in ZVI 
format and only export them to an external format if you need to do so. 

 
RKP tçêâáåÖ=ïáíÜ=íÜÉ=fã~ÖÉ=mêçÅÉëëáåÖ=cìåÅíáçåë=

dÉåÉê~ä=

The text below outlines the principal method for operating the image 
processing functions. The steps described are identical for all functions. A 
description of the operation of the individual functions and their parameters 
can be found in the online help under the Processing menu entry. 

The individual steps in the following examples can also be practiced using the 
original images that were employed. The sample images can be found on the 
Product DVD. 

pãççíÜáåÖ=~å=áã~ÖÉ=EÄ~ëáÅF=

Images frequently contain noisy regions or inhomogeneous brightnesses, 
which impair the detection of the objects to be measured (segmentation). To 
achieve satisfactory segmentation, these kinds of images are processed using 
smoothing filters. 
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All filter functions work using filter matrixes, the size of which can be set 
using the KernelSize parameter. During the filtering process, the central pixel 
in the matrix is combined with the gray values within the matrix, and is 
therefore given a new value. 

Which smoothing filter is most suitable depends on the structures that are 
present in the image. You should therefore try out various filters initially. 

The Sigma function is particularly appropriate if you wish to remove uneven 
brightnesses from within structures without influencing the edges of these 
structures. Fine structures are also preserved. 

To suppress noise, the Gauss function can be used. This reduces the dynamic 
range of the image and smoothes the entire image, including the object 
edges. 

The following example explains step by step how to smooth the structures in 
an image using two different filter functions. 

 From the Product-DVD load the image "Bone-overview.zvi" from the 
folder Demo Images and Scripts\AxioVision Images  via the function File 
⇒ Open Image, or acquire an image with the camera. The image is 
displayed in AxioVision’s image window. 
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Select from the Processing menu the Smooth functional group and then the 
Sigma function. 

 You will now see the dialog 
window of the Sigma function. 

 If the Automatic Preview check 
box is activated, you will see the 
reduced input and output images. 

 Set CreateNew to Off so that a 
different filter function can later 
be executed with the same image. 

 Set the value 13 for KernelSize 
and the value 31 for Sigma by 
clicking on the arrow keys or by 
entering the values directly. 

 Click on the Splitter Display icon 

 to display the original and the 
result image side by side. 

 Click on OK to close the dialog.  
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Select from the Processing menu the Smooth functional group and then the 
Gauss function. 

 You will now see the dialog 
window of the Gauss function. 

 If the Automatic Preview check 
box is activated, you will see the 
reduced input and output images. 

 If you click on the  button in 
the Input field, the image gallery 
appears. Select the original image 
"Bone-overview.zvi" by clicking 
on it. 

 Set the value 13 for KernelSize 
by clicking on the arrow keys or by 
entering the value directly. 

 Click on the Splitter Display icon 

 to display the original and the 
result image side by side. 

 Click on OK to close the dialog.  
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Compare the two resulting images. 

 With the Sigma filter, strong smoothing has been achieved without the 
edges becoming blurred: 

  

 With the Gauss filter, weak smoothing has been performed using the 
same KernelSize. The edges of the object have also been smoothed: 

  

Note: 
• Adjust the display characteristic curve in the resulting image if necessary. 

5-8 M 60-3-0024 e / printed 06.2010 



Image Processing 

pÜ~ÇáåÖ=`çêêÉÅíáçå=EÄ~ëáÅF=

Uneven illumination, vignetting in the optical system or inhomogeneous 
sensitivity of the camera sensor can sometimes lead to a so-called shading 
effect in images. This means that the brightness of the image is uneven, 
which greatly impairs the detection of the objects to be measured. 

To eliminate this disruptive effect, shading correction must be performed 
using a reference image. As a rule, an empty field with no structures is used 
as a reference image. Often, however, the image has already been acquired, 
and the sample is no longer available to allow the acquisition of an empty 
field. In this case a pseudo-shading reference image can be used. This is 
generated by applying particularly strong smoothing (e.g. using a strong 
Lowpass filter) to the original image. The smoothing can, however, take place 
automatically within the shading correction function, which renders the 
generation of a shading reference image superfluous. 

The following example explains step by step how to perform shading 
correction. 

 From the Product-DVD load the image "SAND.ZVI" from the folder Demo 
Images and Scripts\AxioVision Images  via the function File ⇒ Open 
Image, or acquire an image with the camera. The image is displayed in 
AxioVision’s image window. 
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Select from the Processing menu the Adjust functional group and then the 
Shading Correction function. 

 You will now see the dialog 
window of the Shading 
Correction function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear.  

 Set CreateNew to Off so you 
can select the images freely. 

 Select the loaded image as 
Input and Reference. 

 Set the Auto parameter to On. 
This will result in a pseudo-
shading reference image being 
generated automatically in the 
background and combined with 
the original image. 

 Click on the Splitter Display 

icon  to display the original 
and the result image side by 
side. 

 Click on OK to close the dialog. 
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The resulting image then contains homogeneous illumination. 

 

Note: 
• Adjust the display characteristic curve in the resulting image if necessary. 

`çêêÉÅíáçå=çÑ=uv=éáñÉä=ëÜáÑí=áå=ãìäíáÅÜ~ååÉä=áã~ÖÉë=
EÄ~ëáÅF=

During the acquisition of multichannel images using a manual microscope, 
you switch from one fluorescence filter to another by moving the fluorescence 
slider manually. In the acquired images, this can result in a shift of a few pixels 
between the individual channels in the horizontal and vertical directions. The 
individual fluorescence channels are shown in a pseudo color display. The XY 
pixel shift that has occurred must be subsequently corrected, to ensure that 
the individual fluorescence channels lie precisely on top of one another in the 
horizontal and vertical directions in the pseudo color image. 

The following example explains step by step how to correct this XY pixel shift. 
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 From the Product-DVD load the image "Endothelial_cells_FL_shifxy.zvi" 
from the folder Demo Images and Scripts\AxioVision Images  via the 
function File ⇒ Open Image, or acquire an image with the camera. The 
image is displayed in AxioVision’s image window. 
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Now select from the Processing menu the Geometric functional group, and 
then the Shift function. 

 You will now see the dialog 
window of the Shift function. 

 If the Automatic Preview check 
box is activated, the reduced 
input and output images appear.

 Activate Enable channel 
selection, so that you can enter 
the XY shift for an individual 
channel. 

 Click on Subset. 
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 Activate only the channel that 
you want to be corrected 
(channel 1 in the example). 

 Deactivate Copy selected items 
only, so that all channels are 
present in the resulting image 
(including the uncorrected ones), 
and click OK.  

 In the dialog window, activate 
the channel to be corrected 
(channel 2 in the example). 

 Set the shift for ShiftX and 
ShiftY by clicking on the arrow 
keys, or by entering the values 
directly.  

 

Notes: 
• The value for ShiftX and/or ShiftY always relates to the number of pixels 

that you want to be shifted. 

 Click on the Splitter Display icon  to display the original and the 
result image side by side. 

 Click OK to close the dialog window. 

Note: 
• Adjust the display characteristic curve in the resulting image if necessary. 
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`çêêÉÅíáçå=çÑ=ò=éáñÉä=ëÜáÑí=áå=ãìäíáÅÜ~ååÉä=òJëí~Åâ=
áã~ÖÉë=

During the definition of multichannel z-stack images, the focus plane is 
normally set for one channel only. This means that the acquisition of the 
various fluorescence channels always starts with the same focus plane. When 
you switch from one fluorescence filter to another, the excitation and 
emission wavelengths, which also influence the focus plane, change. If the 
objective is not corrected for this chromatic aberration, the focus planes 
between the individual fluorescence channels in the acquired image will not 
correspond. 

The individual fluorescence channels are shown in a pseudo color display. 
When you switch between the individual channels, a small shift is visible in the 
z direction. This can be subsequently corrected, so that in the pseudo color 
image the individual fluorescence channels lie exactly next to each other in the 
z direction. 

The following example explains step by step how to balance out this z pixel 
shift. 

 From the Product-DVD load the 
image "Hela_DsRed 
_RevGFP_Zshift.zvi" from the 
folder Demo Images and 
Scripts\AxioVision Images  via 
the function File ⇒ Open 
Image, or acquire an image 
with the camera. 

 The image is displayed in 
AxioVision’s image window.  
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Select from the Processing menu the Geometric functional group, and then 
the Shift function.  

 You will now see the dialog 
window of the Shift function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear. 

 Activate Enable channel 
selection, so that you can enter 
the Z shift for an individual 
channel. 

 Click on Subset to enter the 
specific settings in the Select 
Subset window. 
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 Activate only the channel that 
you want to be corrected 
(channel 2 in the example). 

 Deactivate the Copy selected 
items only check box, so that 
all channels are present in the 
resulting image (including the 
uncorrected ones). 

 Click on OK. 

 

 In the Shift dialog window, 
activate the channel to be 
corrected (channel 2 in the 
example).  

 Set the shift for ShiftZ by 
clicking on the arrow keys, or 
by entering the values directly.  

 

Notes: 
• The value for ShiftZ always relates to the number of sections by which 

you want the shift to be made. 

• Example: If ShiftZ is set to the value 5, the stack in the resulting image 
starts at section 6. The first 5 sections remain empty, whilst the last 5 
sections of the original image are omitted. 
If a value of -5 is set, the first 5 sections of the original image are omitted. 
The first section of the resulting image is section 6 of the original image. 
The last 5 sections of the resulting image remain empty. 

• It is also possible to perform a shift by a fraction of a section (e.g. 0.3). 
The value to be entered can be calculated from the distance between the 
individual sections. 
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 Click on the Splitter Display icon  to display the original and the 
result image side by side. 

 Choose a z-level in the middle (here 13) using the player. 

This is the resulting image obtained. 

  

Note: 
• Adjust the display characteristic curve in the resulting image if necessary. 
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RKQ båÜ~åÅáåÖ=íÜÉ=fã~ÖÉ=aáëéä~ó=çå=íÜÉ=jçåáíçê=

The fastest and easiest way to display an image that is optimally adapted to 
the monitor is to use the Standard workflow. A description of this workflow, 
including all the steps involved in image acquisition, can be found in chapter 3 
"Image Acquisition". 

 
RKR aê~ïáåÖ=áå=~åÇ=cçêã~ííáåÖ=^ååçí~íáçåë=

 Make sure that the Annotations toolbar 
is visible: right-click on the main menu or 
any toolbar and activate Annotations (a 
tick must be visible in front of it). 

 

 Now activate the image into which you 
want to draw annotations. To do this, 
simply click on the image or select it via 
the tabs at the top of the document 
area. 

 

 From the Annotations toolbar select the 
tool you want to use, e.g. the Scale Bar. 
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 Now draw in the scale bar: click once on 

the starting point, drag out the desired 
length and then click on the end point. 

 

 To format the annotations (change the 
line color, font etc.), right-click in the 
image and select Properties. 

 

 In the Properties window activate the 
Attributes tab. 

 Select an element from the list. 

 Change the Settings for selected 
items: 
1: Line thickness 
2: Line style 
3: Fill mode 
4: Line type 
5: Line color 
6: Fill color 
7: Text color 
8: Text alignment 
9: Font 

 

The settings only apply to the selected element. To specify standard settings, 
please read the next section. 

3 41 2

85 76

9
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RKS péÉÅáÑóáåÖ=pí~åÇ~êÇ=pÉííáåÖë=Ñçê=^ååçí~íáçåë=

 Activate the image for which you want to 
specify standard settings. To do this, 
simply click on the image or select it via 
the tabs at the top of the document area. 

 

 To enter the settings (line color, font 
etc.), right-click in the image and select 
Properties. 

 

 In the Properties window activate the 
Attributes tab. 

 Make sure that no elements are selected 
in the list of annotations and displayed 
above the Default settings formatting 
options. 

 Now change the: 
1: Line thickness 
2: Line style 
3: Fill mode 
4: Line type 
5: Line color 
6: Fill color 
7: Text color 
8: Text alignment 
9: Font 

 

3 41 2

85 76

9

Note: 
• The settings are now used for all elements that are subsequently drawn 

in. If you save your images in ZVI format, the settings are saved with the 
image. 
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S fã~ÖÉ=^å~äóëáë=

SKN dÉåÉê~ä=

With AxioVision Version 4 you are now able to perform interactive 
measurements in the basic program.  

mçëëáÄäÉ=ï~óë=íç=éÉêÑçêã=ãÉ~ëìêÉãÉåíë=

Measurements can, as a rule, be performed in two different ways: 

 The individual measurement tools, e.g. line, circle etc., can be accessed 
via the Measure menu and/or toolbar. Individual values can be 
determined quickly using this method. 

 Via the Measure ⇒ Interactive Measurement ⇒ Start Measurement 
function. This function contains the image to be measured with all the 
measurement tools in a single dialog. It is, therefore, particularly suitable 
for use in workflows and Commander scripts, and for this reason is also 
integrated into the Measure workflow. This method gives you the option 
of being led through the entire procedure, from image acquisition 
through to the saving of the image, via measurement and evaluation. 

`çåÇáíáçåë=Ñçê=ãÉ~ëìêÉãÉåíë=

^ääçÅ~íáçå=çÑ=ëÅ~äáåÖë=

To obtain measurement values in real units, you must have allocated the 
correct scaling to the image you want to measure. This usually takes place 
during image acquisition (see chapter 3 "Image Acquisition"). 
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fÑ=íÜÉ=ëÉäÉÅíÉÇ=áã~ÖÉ=ÇçÉë=åçí=Ü~îÉ=~=ëÅ~äáåÖ=

If a scaling has not been allocated to the image you have selected, you can 
allocate one now: 

 Make sure that the image is selected (simply click on it). 
 From the Measure menu, select the Scalings function. 
 Select the corresponding scaling from the Scalings Control list. 
 Click on the Apply scaling to image button. 

aáëéä~óáåÖ=ãÉ~ëìêÉãÉåí=Ç~í~=

The measurement data can be displayed in different ways: 

In principle, all measurements are displayed in the graphics plane as 
annotations. Which measured values are displayed for the relevant tool is 
freely configurable (please also see the "Configuring measurement tools" 
section). The display itself (color, line thickness etc.) can be formatted via the 
View ⇒ Properties ⇒ Attributes dialog. 

If you use the View ⇒ Properties ⇒ Measurement dialog, the measured 
values are displayed in table form. In this dialog you also have a direct link 
between the table of measured values and the image that is currently 
selected. This means that when you activate a tool in the image, the 
corresponding values are automatically displayed in the table, and vice versa. 

p~îáåÖ=Ç~í~=

p~îáåÖ=ãÉ~ëìêÉãÉåí=Ç~í~=

The simplest and most convenient way to save the data is to save your images 
in AxioVision ZVI format. This is because this format saves the measurement 
data together with the image. Consequently, all data (pixel data, 
measurement data, annotations etc.) are present in the image file. There is no 
need to perform an additional saving procedure. 
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If you save your image files in an external format (BMP, JPEG etc.), the 
measurement data, together with all other additional information 
(annotations, acquisition data etc.), are saved in a separate file. As long as you 
open the images using AxioVision, the data in this separate file are 
automatically read in again and displayed. Read also section 7.2 "Saving 2D 
Images" in chapter 7 "Documentation". 

p~îáåÖ=~ë=ëÉé~ê~íÉ=Ç~í~=í~ÄäÉ=

To save the measured values in a separate file, you should use the Measure 
⇒ Create Data Table function. This function writes the measurements 
relating to the selected image in a data table. This data table is a completely 
normal document in AxioVision and can then be saved as a file. The data table 
no longer has a direct link to the image. To combine the values of several 
images in a single file, the Measure ⇒ Append Data Table function can be 
executed. 

`çåÑáÖìêáåÖ=ãÉ~ëìêÉãÉåí=íççäë=

The interactive measurement tools can configured to your own requirements. 
Using the Measure ⇒ Interactive Measurement ⇒ Configure 
Measurement Tools function, you can generate configurations for the 
application scenarios of your choice. In a configuration you can determine 
which measurement parameters should actually be measured for a 
measurement tool and then displayed later in a data table, and which 
measurement parameters should be displayed in the graphics plane. A 
measurement can then be loaded via the Measure ⇒ Interactive 
Measurement ⇒ Load Configuration function. The defined settings are 
automatically active for a special measurement application. You can specify 
the default behavior of the measurement tools in the same way. 
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SKO jÉ~ëìêÉãÉåí=ïçêâÑäçïW=É~ëó=~åÇ=ë~îÉ=
ãÉ~ëìêÉãÉåí=

The easiest way to perform interactive measurements is to use the Measure 
workflow. This can be found on the Workflow. If the workflow is not 
displayed, in the View menu select the Windows list, and there select the 
Workflow command. 

Note: 
• The Workflow may in fact be open but covered by the Workarea. If that 

is the case, simply click on the Workflow tab of the work area: 

. 
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jÉ~ëìêÉ=ïçêâÑäçïW=çîÉêîáÉï=

 
Live opens and closes the Live window. 

Live Properties displays a window 
containing the camera parameters and 
the display characteristic curve. 

Snap acquires an image using the active 
camera. 

Show Properties opens the image 
Properties dialog window with the 
property pages Display, Attributes, 
Color, etc. 

Scale bar inserts a scale bar. 

Draw Annotations inserts annotations 
into the acquired image. 

Load Tools opens a dialog to select and 
activate a specific configuration. 

Start Measurement starts the 
measurement. 

Save saves the image. 
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bñÉÅìíáåÖ=íÜÉ=fåíÉê~ÅíáîÉ=jÉ~ëìêÉãÉåí=cìåÅíáçå=

Go through the toolbar function by function: 

 Acquire an image, or load an image from the hard drive. 
 Adapt the display on the monitor. 
 Insert a scale bar, if necessary. 
 Draw in annotations, if required. 
 Load a measurement tools configuration. 

The next button starts the interactive measurement. 

 Start the Start 
Measurement function.

 

 Perform any 
measurements by 
selecting a measurement 
tool from the toolbar. 

1: Distance 
2: Circle 
3: Curve 
4: Curve (Spline) 
5: Angle 3 
6: Angle 4 
7: Events 

The measurements are 
performed directly in the 
image. 

 

Click on OK. 

 Now save the image 
with the measurement 
results via the Measure 
workflow.  

7654321
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aáëéä~ó=~åÇ=Éñéçêí=ãÉ~ëìêÉãÉåí=Ç~í~=

The measurement data from an image can be 

 displayed as a list; 
 exported into an Excel-compatible text format; or 
 combined with the measurement data from other images to perform an 

overall evaluation. 

 Select the function 
Measure –Create 
Table. 

 

 If you do not save your 
images in ZVI format, 
export the 
measurement data by 
clicking on Save. 

 To exit the dialog, click 
on Close. 
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SKP pçêíáåÖ=~åÇ=éÉêÑçêãáåÖ=Å~äÅìä~íáçåë=ïáíÜ=
ãÉ~ëìêÉãÉåí=Ç~í~=

The interactive and automatic measurement functions produce measurement 
data tables which, as a rule, contain raw data. In the AxioVision menu 
Evaluate, a range of analysis functions are available to allow you to process 
these data. 

To measure several images in a measurement loop, you need to accumulate 
all the measurement data in a data table (Append table function). This 
measurement data list can be used to calculate statistical values, such as the 
mean and standard deviation (Calculate statistical values function), or to 
classify the measurement data (Calculate classified table function). 

It is also possible, however, to combine individual columns from the same or 
from different data tables in the form of a new data table (Concatenate 
table function). In many cases you will need to filter out only specific 
measurement values from a data table, e.g. only the measurement values of 
the FITC channel (Filter table function), or to perform calculations using the 
measurement values of different columns (Calculate table columns 
function). 

To obtain a clear presentation of the measurement data from time lapse 
images, the pivot table (Calculate Pivot table function) is a useful tool. 

Note: 
• Sample scripts of all evaluation functions can be found on the Product 

DVD in the folder Demo Images and Scripts\Commander Script Examples. 
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SKQ `êÉ~íáåÖ=Ç~í~=êÉéçêíë=

jçÇáÑóáåÖ=~åÇ=ÅêÉ~íáåÖ=êÉéçêí=íÉãéä~íÉë=ïáíÜ=íÜÉ=ÑáäÉ=
ÉñíÉåëáçå=wao=

A report is used for printing out images, sample information, data tables and 
histograms. A template, in which the layout and formatting for the individual 
report elements (image, data table, etc.) are defined, always forms the basis 
for a report. 

In AxioVision, a selection of sample report templates is available. All reports 
have the file extension *.zdr and can be modified for a specific application. 
Please also read the section "Modifying a report template" and "Creating a 
report template" which you will find further down this section.  

Newly created files or modified files are saved in the user folder My 
Documents\Carl Zeiss\Templates\Data Report Templates or in the work group 
folder Shared Documents\Carl Zeiss\Templates\Data Report Templates. 

Reports will be connected to the respective documents (images, data tables): 

 with an archive 
 with a folder 
 with a gallery 

To create a report correct links are mandatory. If you move the documents, 
which are linked to the current reports to another location, the links in the 
report have to be updated accordingly. 

Note: 
• A description about reports with the file extension ZVR can be found in 

chapter 7.3 " Generate, print and export reports with the file extension 
ZVR". 
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oÉéçêí=íÉãéä~íÉë=íççäÄ~êë=

 

 

The meaning of each icon will be displayed when you move the cursor on one 
of the icons. 

jçÇáÑóáåÖ=~=êÉéçêí=íÉãéä~íÉ=

The following example will show you how to modify an existing template for 
another application (displaying user data and an image) and save it as a new 
template.  

 First enter your user data on the Tools menu ⇒ Options ⇒ ID. 

 Use the Snap function to acquire an image with the camera, or load the 
image "Cat-Cerebellum(1300).zvi" from the Product DVD from the folder 
\Demo Images and Scripts\AxioVision Images\Imaging Plus using the 
Open image function on the File menu. 
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 From the File menu, select the New function, and then activate the 
Reports (zdr) tab sheet. Select the Timelapse template. Then click on 
OK. 
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The report is now displayed in the Edit  mode. 
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 With the left-hand mouse button depressed, drag out a rectangle over 
the object in Section2. 

  

 Press the Del key to delete the selected fields. Click on  and create a 
large image field. 

 Now show the property window by clicking on the  icon. 
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 In the Data Origin field, select "From Gallery" under Origin of Date 
and under File "[Active Image]". The original image now appears in the 
image field. 
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 Adjust the size of the image field to the size of the image. 

  

 Use the  icon in the toolbar to switch to Preview mode to allow you 

to check the report. Then use the  icon to return to Edit mode. 

The new report template can be saved and a name entered, e.g. 
"Image+userdata", using the Save Report As Template function on the File 
menu. 

Note: 
• The information relating to the user, company and address only appears if 

this has been entered on the Tools menu ⇒ Options ⇒ ID. 

AxioVision User's Guide, Release 4.8.2 6-15 



Image Analysis 

`êÉ~íáåÖ=~=êÉéçêí=íÉãéä~íÉ=

The following example shows you how to create a template for a z-stack from 
an empty layout. The images of individual z-planes are displayed with focus 
positions as annotations. 

 Use the Snap function to acquire an image with the camera, or load the 
image "Anaphase-chromosomes.zvi" from the Product DVD from the 
folder \Demo Images and Scripts\AxioVision Images\Imaging Plus using 
the Open image function on the File menu. 

 From the File menu, select the New function, and then activate the 
Reports (zdr) tab sheet. 

 Select the Blank template and then click OK. To see a preview of a 
template, click on Apply. The corresponding template is then opened 
without the New dialog being closed. 

An empty layout is now displayed in Edit mode. 
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 Click on , drag out a 
text field in Section1 and 
position it in the top part of 
the report. A description 
field automatically appears 
next to the text field. 

 

 Now click on any position in 
Section1 outside the text 
field / label field. 

 Click on the text field to 
position it in the desired 
location, independently of 
the label field, and, if 
necessary, to adjust the size.

 

 Double-click on the text in 
the label field and replace it 
with the text "Sample". To 
change the display of the 
word "Sample" do the 
following: 
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 Click on  to open the 
property window for the 
label field. 

 In the Format field, select 
14 and Bold under Font. 
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 In the Working Object 
field, select the TextField1 
function from the drop-
down list box. 

 In the Data Origin field, 
select "From Gallery" under 
Origin of Date, "[Active 
Image]" under File and the 
file "FileName" under File 
Field. 

 In the Format field, select 
12 and Bold under Font. 
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 Use the  icon to switch to Preview mode to allow you to check the 
image name in the text field. 

  

 Then use the  icon to return to Edit mode. 

 Downsize Section1 of the report template by positioning the mouse on 
the bottom edge and dragging upwards with the left-hand mouse button 
depressed. 
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 Click on  and insert a new section below Section1. Now increase the 
size of Section2 of the report by positioning the mouse on the bottom 
edge and dragging downwards with the left-hand mouse button 
depressed. 

  

 Click on  and with the left-hand mouse button depressed, drag out an 
image container. 

 In the Data Origin field, select "From Gallery" under Origin of Data 
and "[Active Image]" under File. 
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In the Properties window enter the following settings: 

  

Field General Left 0.05, Top 0.05, Width 6.51, Height 
2.5 

Field Gallery View Setup Column Count 3 

Field Cell Setup  Image Area Size (%) 80 

 Show Cell Frame off 

 Tags FokusPosition, RelFokusPosition  

Field Image Setup Show Image Frame off 

Feld Tags Setup Tag Name Column Width (%) 70 

 Show Tags Frame on 

 Show Tags Grid on 

Field Subset Mode Setup Z-Stack Supset Enabled (28) on 

 Z-Stack Condition 7,9,11,13-18,20-
22,24,26,28 
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 Now click in the headline on the label field (Header) and enter in the 
Properties window any text (e.g. name of the company) in the Format 
field under Text. 

 Adapt the size of the region field by dragging out with the left-hand 
mouse button depressed. 
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 Click on  and insert a new image field to position a company logo. 
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 In the Properties window enter the following settings: 

  

Field General Left 15.4, Top 0.5, Width 1.5, Height 1.5 

Field Data Origin Origin of Data Company Logo 

Field Format Show Annotations off 

 Show Image Frame off 
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The logo selected in the Tools menu ⇒ Options ⇒ Logo will be displayed 
automatically. 

 In the footer click on the text field at the right edge and enter the 
following settings: 

  

Field General Left 15, Top 0.2, Width 1.9, Height 0.6 

Field Data Origin Format Page Number M / N 
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 Now click on the label field (Footer), positon it close to the text field at 
the right edge and enter the following settings in the Properties 
window. 

  

Field General Left 13, Top 0.2, Width 1.5, Height 0.6  

Field Format Text Page 

 Alignment Left 

 Text Color Black 

 

AxioVision User's Guide, Release 4.8.2 6-27 



Image Analysis 

 Use the  icon to switch to preview mode to allow you to check the 
report. 
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The new report template can be saved and a name entered, e.g. "z-stack", 
using the Save Report As Template function on the File menu. 
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`êÉ~íáåÖ=~=êÉéçêí=ïáíÜ=ëÉîÉê~ä=çéÉåÉÇ=áã~ÖÉë=

The following example will show you how to display automatically in a report 
several images among each other together with information about the 
images. 

 Use the Snap function to acquire any number of images with the camera, 
or load the images "graphite and ferrite with perlite obj20x 01.zvi", 
"lamellar graphite obj20x 01.zvi" und "spherolite graphite obj20x 01.zvi" 
from the Product DVD from the folder \Demo Images and 
Scripts\AxioVision Images\Graphite using the Open image function on 
the File menu. 

 Select the function Create Data Report from the Evaluation menu. 
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 In the dialog window select the 
function Connect to Gallery 
from the drop-down list 
Connection in the Create 
Data Report field. 

 From the drop-down list 
Template select the 
"1Image.zdr" template. 

 In the edit field Report Name 
enter a name for the report to 
be create, e.g. "Testreport5". 

 Click the OK button. 

 

 Select one after another Section3, Section4, Section5 and delete the 

respective section by clicking on . 

 Click on the image in Section1 and delete this image using the Del key. 

 Click on  and insert an image container. 
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In the Properties window enter the following settings: 

  

Field General Left 0.3, Top 0.5, Width 10, Hight 5 
Field Data Origin  Origin of Data From Gallery 
Field Gallery View Setup Column Count 1 

The number of culumns indicates how many 
images can be displayed side by side. 

Field Cell Setup Packing Style Image left 
 Tags Filename 
 Image Area Size (%) 55 
 Show Cell Frame off 
Field Bildeinstellungen Bildrahmen anzeigen aus 
Field Einstellungen Felder Feldbezeichnung Spaltenbreite (%) 40 
 Gitternetzlinien für Felder anzeigen aus 
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To check the report template click on  to select the Preview mode. 

  

You can save the new report template and entering a name (e.g. "3images") 
using the Save Report As Template in the File menu 
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`êÉ~íáåÖ=êÉéçêíë=ïáíÜ=íÜÉ=ÉñíÉåëáçå=waoI=éêáåíáåÖ=
íÜÉã=~åÇ=ë~îáåÖ=íÜÉã=~ë=~=mac=ÑáäÉ=

`êÉ~íáåÖ=~=êÉéçêí=Ñçê=~å=áã~ÖÉ=

This example shows you how to incorporate an open image into a report and 
display it with the associated microscope and camera information. 

 Use the Snap function to acquire an image with the camera, or load the 
image "Material_sample.zvi" from the Product DVD from the folder 
\Demo Images and Scripts\AxioVision Images\Imaging Plus using the 
Open image function on the File menu. 

 To create a report, select the Create Data Report function on the 
Evaluation menu. 
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 In the dialog window, select 
the Connect to Gallery 
function via the Connection 
drop-down list box in the 
Create Data Report field. 

 In the Template drop-down 
list box select the template 
1Image.zdr. 

 In the Report text field enter a 
name for the report to be 
created, e.g. "Testreport5". 

 Click on OK. 

 The new report is displayed 
and you can save it using the 
Save Report As Template 
functions on the File menu. 

 

Notes: 
• The microscope and camera information only appears if the camera and 

microscope were connected and configured in MTB2004 prior to image 
acquisition. 

• When the report is saved, the files linked to the gallery (images, data 
tables) are automatically stored in a folder with the same name as the 
report. 
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^ÇçéíáåÖ=~=åÉï=áã~ÖÉ=áåíç=~å=çéÉå=êÉéçêí=íÉãéä~íÉ=

The following example shows you how to replace an image present in a 
report with another image. 

You can work through this example after you have followed the example in 
the section "Creating a report for an image". 

  

 Use the Snap function to acquire an image with the camera, or load the 
image "Color_grains.zvi" from the Product DVD from the folder \Demo 
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Images and Scripts\AxioVision Images\Imaging Plus using the Open 
image function on the File menu. 

 The current image will be adopted. 

 The modified report can be saved using the Save or Save As functions 
on the File menu. 

mêáåíáåÖ=~=êÉéçêí=

The following example shows you how to print out a saved report or one that 
you have just created. 

 Activate the report you have created by clicking on it or open a saved 
report using File menu ⇒ Open Report. 

 From the File menu, select the Print function to open the standard dialog 
for printing documents. 

 Enter the desired settings and click on Print to print the report. 

p~îáåÖ=~=êÉéçêí=~ë=~=mac=ÑáäÉ=

The following example shows you how to create a PDF file from a saved 
report or one that you have just created. This can be sent and printed out 
again at any time on any system. 

 Activate the report you have created by clicking on it or open a saved 
report using File menu ⇒ Open Report. 

 From the File menu select the Save to PDF function. 

 Under File name enter the desired name and click on Save to save the 
report as a PDF file. This report can then be opened using Adobe Acrobat 
Reader. 
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`êÉ~íáåÖ=~=êÉéçêí=Ñçê=~=ãìäíáÅÜ~ååÉä=ÑäìçêÉëÅÉåÅÉ=
áã~ÖÉ=

The following example shows you how to display a pseudo color image and 
the images of the individual fluorescence channels with the corresponding 
channel names for a 3-channel fluorescence image. 

 Use the Snap function to acquire an image with the camera, or load the 
image "CHO-3-channel_fluorescence.zvi" from the Product DVD from the 
folder \Demo Images and Scripts\AxioVision Images\ Multichannel 
Fluorescence Z-Stack using the Open image function on the File menu. 

 To create a report, select the Create Data Report function on the 
Evaluation menu. 

 In the Create Data Report field, 
select Connect to Gallery from the 
Connection drop-down list box. 

 In the Template drop-down list 
box select the template 
3channelfluorescence.zdr. 

 In the Report Name field enter a 
name for the report to be created, 
e.g. "Testreport4". 

 Click on OK.  

 

6-38 M 60-3-0024 e / printed 06.2010 



Image Analysis 

 The new report is displayed and you can save it using the Save or Save 
As functions on the File menu. 

  

Note: 
• When the report is saved, the files linked to the gallery (images, data 

tables) are automatically stored in a folder with the same name as the 
report.  
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Note: 
• The information relating to the user, company and address only appears if 

this has been entered on the Tools menu ⇒ Options ⇒ ID. 

The following example shows you how to display the images of individual 
time points for a 2-channel time lapse image. 

 Use the Snap function to acquire an image with the camera, or load the 
image "4-Channel-timelapse.zvi" from the Product DVD from the folder 
\Demo Images and Scripts\AxioVision Images\ Multichannel Fluorescence 
Timelapse using the Open image function on the File menu. 

 To create a report, select the Create Data Report function on the 
Evaluate menu. 

 In the Create Data Report field, select Connect to Gallery from the 
Connection drop-down list box. 

 In the Template drop-down list box select the template Timelapse.zdr. 

 In the Report Name field enter a name for the report to be created, e.g. 
"Testreport5". 

 Click on OK. 
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For the two channels (DIC, FITC) the time points 1,5-10, 20 and 30 will be 
displayed in the report. 
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 The new report is displayed and you can save it using the Save Report 
As Template function on the File menu. 

  

Note: 
• When the report is saved, the files linked to the gallery (images, data 

tables) are automatically stored in a folder with the same name as the 
report.  
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Sample scripts can be installed from the Report Script Examples folder of the 
Product DVD by launching the setup.exe function.  

The following example shows you how to present the data of a measurement 
in a report with output images, a statistics table and a histogram. 

 Carry out the measurement for a 
number of images. To do so, select the 
Repeat script function on the 
Commander menu. 

 

 In the Select Source field select from the drop-down list box Folder, 
from the drop-down list box Look in the directory Shared 
Documents\Carl Zeiss\Images and mark the two images "round1.zvi" and 
"round2.zvi". 
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 Select in the Script selection field the sample script "AV48Example11a-
Evaluate_batch_EN.ziscript" and then click on Start. 
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 To create a report, select the Create Data Report function on the 
Evaluate menu. 

 In the Create Data Report 
field, select Connect to Gallery 
from the Connection drop-
down list box. 

 In the Template drop-down 
list box select the template 
Image+Datatable+Histogra
m.zdr. 

 In the Report Name text field 
enter a name for the report to 
be created, e.g. "TestreportA".

 Click on OK. 
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The new report is displayed and you can save it using the Save Report As 
Template function on the File menu. 

  

Note: 
• When the report is saved, the files linked to the gallery (images, data 

tables) are automatically stored in a folder with the same name as the 
report. 
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Sample scripts can be installed from the Report Script Examples folder of the 
Product DVD. by launching the setup.exe function. 

The following example shows you how to perform a measurement with a 
Commander script, display the measurement values that are saved in files in 
a two-page report and automatically save this report both in ZDR format and 
as a PDF file. 

 Carry out the measurement for a number of 
images. To do this, select the Repeat script 
function on the Commander menu. 

 

 In the Select Source field select from the drop-down list box Folder, 
from the drop-down list box Look in the directory Shared 
Documents\Carl Zeiss\Images and mark the two images "round1.zvi" and 
"round2.zvi". 
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 Select in the Script selection field the sample script "AV48Example12a-
Evaluate_batch_EN.ziscript" and then click on Start. 
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 The script automatically saves 
the generated raw-data, class 
and statistics tables in the 
directory C:\guest and opens 
the Create Data Report 
dialog. 

 In the Template drop-down 
list box select the template 
3datatables.zdr. 

 A report with three data tables 
will be created automatically. 

 Click OK. 
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The report can anytime be loaded and printed out from the folder C:\guest. 

Note: 
• When you are using a report template that contains file links to a folder, 

the linked files need to be retained if the report is to be printed out again 
at a later point in time. 
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Sample scripts can be installed from the Report Script Examples folder of the 
Product DVD. by launching the setup.exe function.  

The following example shows you how to display images and measurement 
values saved in an archive together in a report. 

 First, use the New function on the File menu to create a new Asset 
Archive with the name "Test" in the folder C:\guest. 
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 Create a new project with the name "P0001" using the Add New 
Project function on the Archive menu, using the template Default. 

  

 Carry out the measurement for a number of 
images. To do this, select the Repeat script 
function on the Commander menu. 

 In the Select Source field select Folder from the drop-down list box, 
under Look in the directory Shared Documents\Carl Zeiss\Images" and 
mark the two images "round1.zvi" and "round2.zvi". 
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 In the Script selection field select the sample script "AV48Example13a-
Evaluate_batch_EN.ziscript" and then click on Start. 

  

 In the menu Commander ⇒ Scripts ⇒ Workgroup open the file 
"AV48Example13a2-Evaluate_batch.ziscript" 

 Click Start. 
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All files, created with the script are saved automatically in the project 
"00001" of the archive. 
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 To create a report, select the Create Data Report function on the 
Evaluate menu. 

 In the Create Data Report field, 
select Connect to Archive from the 
Connection drop-down list box. 

 In the dialog Create Report select 
in the drop-down list box Template 
"P0001". 

 In the Template drop-down list box 
select the template 
Image+Datatable+Histogram+ 
Archive.zdr. 

 In the Report Name text field enter 
a name for the report to be created, 
e.g. "TestreportB". 

 Click on OK. 
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The new report is displayed and you can save it using the Save or Save As 
functions on the File menu. 

  

Note: 
• When you are using a report template (e.g. 

Image+Datatable+Histogram+Archive.zdr) that contains file linked to a 
project within an archive, the linked files need to be retained in this 
archive/project, if the report is to be printed out again at a later point in 
time. 
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A chart is used for the graphic display of measurement data that are available 
in a data table. 

In AxioVision it is possible, in the opened data table, to switch directly from 
the table view to the chart view. The type of chart is defined in the chart view 
(e.g. bar chart, line chart). From this, it is possible to generate an image or a 
meta file. The chart settings can be saved as well as loaded. 

Newly created or modified chart settings are saved in the Eigene Dateien\Carl 
Zeiss\Data\Evaluate user folder or in the Gemeinsame Dokumente\Carl Zeiss\ 
Data\Evaluate" work group folder with the file extension *.zdcs. 

`êÉ~íáåÖ=Ç~í~=í~ÄäÉë=ïáíÜ=~=ëÅêáéí=

Sample scripts can be installed from the folders Report Script Examples and 
Evaluate Script Examples of the Product DVD by launching the setup.exe 
function. 

The following example shows you how to generate various data tables (raw 
data table, statistic table, classification table). You need these tables to carry 
out the bar charts and line charts, which are descriped on the following 
pages. 

 Carry out the measurement for a number of 
images. To do so, select the Repeat script 
function on the Commander menu. 
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 In the Select Source field select from the drop-down list box the function 
Folder. Select from the drop-down list box Look in: the directory Shared 
Documents\Carl Zeiss\Images. Now mark the two images "round1.zvi" 
and "round2.zvi". 

 Select in the Script selection field the sample script "AV48Example11a-
Evaluate_batch_EN.ziscript" and then click on Start. 

 

The result are three data tables: 

 Raw data table (OutputTableRegion) 
 Statistic table (StatisticTable) 
 Classification table (ClassificationTable) 
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In order to create a bar chart, the data must be available in a classified table. 
In the example below, the number of measurement values in each class is 
displayed as an individual bar. First, execute the sample script described in the 
" Creating data tables with a script" section.  

Click on the table ClassificationTable and switch-on the Chart View at the 
lower edge of the dialog window. 

  

 In the Chart Data field, select 
under Chart Type "Series in 
Rows". 

 In the Series Values Columns 
field, select the column with the 
desired measurement values, in 
this example "Count 
(Diameter)". Only the bars of 
this column will be displayed. 
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 Activate the check box Show 
Graph Values to display the 
measurement values in the 
corresponding bars. 

 Under Series Captions enter 
the name of the classes (e.g. 
Class1, Class2, Class3, …) by 
double-cklicking on the chart 
title. 

 

 In the Legend field activate the 
check box Legend Visible. The 
name of each individual class 
will be displayed in the 
respective color at the right side 
of the chart. 

 Alternatively you can activate 
the check box Legend from 
Column. Select under Series 
Caption Column the column 
"Description. The class 
boundaries will be adopted. 
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 Instead of the legends you can 
display the names of the series 
in rows below the bars. To do 
so switch off Legend Visible in 
the Legend field. 
 
In the X Axis field switch on 
Show Series On X Axis.   
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 In the Caption field unter Chart 
Type enter a title, e.g. 
"Diameter distribution". 

 

 In the Chart Data field, under 
Rows Condition, enter e.g. 
"4-10", if you will display only a 
part in a sorted  

 Under Sorting Type select 
"Ascending" and under Series 
Values Columns select "Count 
(Diameter)". 
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The bar chart will be displayed. You can save the chart settings by clicking on 
the Save As button. 

`êÉ~íáåÖ=~å=uJv=éçáåí=ÅÜ~êí=

In order to create an X-Y point chart (so-called scattergram), the data must be 
available in a raw data table. In the example below, area and diameter are 
plotted against one another. First, execute the sample script described in the 
"Creating data tables with a script" section. 

  

Click on the table OutputTableRegion and switch on the Chart View at the 
lower edge of the dialog window. 
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 In the Chart Data field select under 
Chart Type "X-Y-Point". 

 Under Series Values Columns select 
this column, which displays the 
measurement values on the y axis, in 
this example "Area". 

 Under X Axis Values Type select 
"Values in Column". 

 Under X Axis Values Column select 
this column, which displays the 
measurement values on the x axis, in 
this example "Diameter".  

 

 In the X Axis field activate the check 
boxes X Axis Caption Visible and X 
Axis Caption. 

 Under X Axis Caption enter 
"Diameter". 

 

 In the Y Axis field activate the check 
boxes Y Axis Caption Visible and Y 
Axis Caption. 

 Under Y Axis Caption enter "Area". 
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 In the Caption field enter a title 
under Chart Caption, e.g. "Area (Y), 
Diameter (X)". 

 

 

  

The X-Y point chart will be displayed. You can save the chart settings by 
clicking on the Save As button. 
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To create a X-Y line chart the data should be available in a raw data table. In 
the following example area the mean gray value is plotted against the time 
points to demonstrate the changing of the fluorescence intensity of the cells 
over the time. 

 Carry out the measurement for a time series. 
To do so, select the Repeat script function on 
the Commander menu. 

 

 In the Select Source field select from the drop-down list box Folder, 
from the drop-down list box Look in the directory Shared 
Documents\Carl Zeiss\Images and mark the image 
"2ChannelTimelapse.zvi". 
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 Select in the Script selection field the sample script "AV48Example7a-
Evaluate_batch_EN.ziscript" and then click on Start. 
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The result is a filtered table (FilterTable2). 

  

 Click on the table FilterTable2 and switch on the Chart View at the 
lower edge of the dialog window. 

 In the Chart Data field, select "X-Y-
Line" under Chart Type. 

 Under Series Values Columns select 
the column, which displays the 
measurement values on the y axis, in 
this example " Densitometricmean". 

 Under X Axis Values Type select 
"Values in Column". 

 Under X Axis Values Column select 
the column, which displays the 
measurement values on the x axis, in 
this example " ImageIDTime". 
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 In the X Axis and Y Axis fields switch 
on the check boxes Show X (Y) 
Values and X (Y) Axis Caption 
Visible. 

 In the X Axis field enter "Timepoint" 
under X Axis Caption and in the Y 
Axis field enter "Mean gray value" 
under Y Axis Caption. 

 In the X Axis field enter the value 
"0" under Precision, to display the 
timepoints as integer values. 

 

 In the Legend field switch off the 
function Legend Visible.  

 In the Caption field enter a title 
under Chart Caption, e.g. 
"Fluorescence intensity". The mean 
gray values of each individual cell at 
each timepoint will be displayed. 
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The X-Y line chart will be displayed. You can save the chart settings by clicking 
on the Save As button. 

p~îáåÖ=~åÇ=êÉëÉííáåÖ=ÅÜ~êí=ëÉííáåÖë=

 To save chart settings click on the Save As button in the Chart View of 
the data table. Enter a name for the chart, e.g. "line chart". 

 To reset chart settings click on the Reset button. 

 To import chart settings, use the  icon in the report's design mode. 
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 First, generate a data table containing several measurement values, e.g. 
by measuring an image interactively. Click on the Load button in the 
chart view. 

Alternatively you can also call up the Create Data Chart function from the 
Evaluate menu.  

 Select "Use External Settings" under the Data settings type parameter. 

 Then select your file containing the settings under the External chart 
settings file parameter. 

 Now make the necessary adaptations. 

`êÉ~íáåÖ=~å=áã~ÖÉ=Ñêçã=~=ÅÜ~êí=

 In the Chart View of the data table click on the Create Image button 
and enter a name. The chart will be saved in bmp format. 

bñéçêíáåÖ=~=ÅÜ~êí=~ë=~=ãÉí~=ÑáäÉ=

 In the chart view of the data table, click on the Create EMF button and 
enter a name. You can choose between two formats: EMF (enhanced 
meta file) and WMF (Windows meta file). 

Alternatively you can also call up the Create Data Chart function from the 
Evaluate menu.  

 Select "Use External Settings" under the Chart settings type parameter 
to select your file under External chart settings file or select "Use 
Settings From Table" if you wish to adopt the settings from the table. 
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Documentation is probably the most important part of your work. This term is 
often used to cover a number of different procedures: 

In one case it may simply be a question of saving image files under a definable 
name; in others it may be a question of storing additional information with 
the images, so that the conditions of acquisition can be traced and recreated 
identically, or so that individual images can be found again quickly using this 
additional information. 

Even in the basic version of AxioVision, the Image Browser offers a wide 
range of options that enable you to manage your images efficiently. 
Additionally you can save your images in a folder-based archive.  

Via the AxioVision module Asset Archive, you can archive even extremely 
large quantities of data. 

Note: 
• Important information about "Saving" can be found in chapter 8.2 "User 

and File Administration". 

 
TKO ^ñáçsáëáçå=wsf=J=íÜÉ=fã~ÖÉ=cçêã~í=Ñçê=aáÖáí~ä=

jáÅêçëÅçéó=

^Çî~åí~ÖÉë=çÑ=íÜÉ=wsf=Ñçêã~í=

The AxioVision ZVI image file format is central to documentation with 
AxioVision. Compared to external formats, such as BMP, JPG, TIF etc., the ZVI 
format offers you numerous advantages: 

 Saving without loss of quality. AxioVision also saves the current 
display settings for brightness, contrast and gamma value, without 
modifying the original data. You can, therefore, reactivate the original 
display of the image at any time. For external formats, you either have to 
go through the laborious process of finding the relevant display again or 
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the pixel information has to be saved in modified form. However, in this 
case the original data are lost. 

 Incorporation of additional data (e.g. microscope and camera 
configurations, comments, information on the sample etc.). 

 Separate saving of image and annotations. This means that 
annotations can also be changed or deleted at a later time. When 
external formats are used, annotations have to be "burnt" into the 
image. However, they can then no longer be deleted or changed. In this 
case, of course, the pixel data beneath the annotations are overwritten. 

 Incorporation of measurement data for interactive measurements 
into the image file. 

 Management of all data in a single file. This makes it much simpler to 
handle the files, particularly when working with multidimensional images. 
If you use external formats, every single image has to be saved separately. 
This can quickly result in several hundred individual image files. 

None of the above features are available with other formats. In short, the ZVI 
format has been specially developed for use in the field of digital microscopy. 
This is not the case with any of the other formats. 

p~îáåÖ=Oa=áã~ÖÉë=

AxioVision gives you the option, for images saved in external formats, saving 
all additional information (additional data, annotations, interactive 
measurements etc.) separately from the actual image data. An additional file 
is created, containing these data, for each image. The format of the file is 
XML. This XML file is saved in the same folder as the image. The name of the 
XML file is composed of the name of the image + the extension + "XML". 
Therefore, if the saved image is called "Testimage.jpg", a file is generated 
with the name "Testimage.jpg. meat.xml", which then contains all the 
additional information. 
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When you open an image with AxioVision that has been saved in an external 
format, the system will always check automatically whether a file containing 
the corresponding additional data is present. If one is, these data are read out 
and displayed accordingly. Of course, this only applies if you are working in 
AxioVision. When you open an image such as this in a different image 
processing program, the image is displayed without the additional 
information. 

To save an image with a format larger than 8 bits such that it can be displayed 
in another application program just like it is displayed in AxioVision, we 
recommend that you activate the Apply display mappings check box when 
saving the image (File ⇒ Save As). Please note, however, that this will 
change the pixel values. 

p~îáåÖ=ãìäíáÇáãÉåëáçå~ä=áã~ÖÉë=

In principle, multidimensional images can be saved using the standard 
function for saving images (File ⇒ Save As). Images can also be saved in 
external formats using this function. For multidimensional images, however, 
all single images then have to be saved in separate files. In order to retain an 
overview, only the first image is saved under the specified name and folder for 
each multidimensional image. A separate subfolder is created for the single 
images that belong with it: 

 

A MosaiX image saved as a jpg file.  The single images are saved in the 
MosaiX TMA.jpg_Files folder. 

An XML file with the additional information is also saved in the folder with the 
single images. The XML file containing the additional information always 
bears the name "_Meta.xml": 
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Subfolder containing single images and XML file 

When you open an image with AxioVision that has been saved in an external 
format, the system will always check automatically whether such a folder is 
present. If one is, the single images are read out and combined to form a 
multidimensional image. In the course of this process, the information from 
the "_meta.xml" file is analyzed. 

Note: 
• The File ⇒ Export function offers special functions for saving 

multidimensional images. These include, for example, functions for 
generating video formats or special functions for saving multichannel 
fluorescence images. 

 
TKP j~å~ÖáåÖ=fã~ÖÉë=ïáíÜ=íÜÉ=fã~ÖÉ=cáäÉ=_êçïëÉê=

The Image File Browser allows you to display the images contained in the 
folders on all of your PC’s drives as a gallery or list, or with a form for entering 
additional data; you are able to search for and load images and view a slide 
show. The image browser is a convenient, easy-to-use tool to help you 
manage your images. 

To open the image browser, select File ⇒ Image File Browser. 
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The left-hand side shows your system’s folder structure, in the familiar 
Microsoft Windows Explorer format. 

The Image File Browser can be operated fully using the functions on the 
toolbar. 

If you select a particular folder, all the image files it contains are displayed 
automatically in the selected mode (here Gallery mode). 
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Refreshes all views. 

 
Opens the dialog window Scan drive. 

 
Creates a new folder or edits an existing one. 

 
Loads the selected image(s) from the archive. 

 

Moves to the first record. 

 

Moves to the previous record. 

 

Moves to the next record. 

 
Moves to the last record. 

 
Deletes the currently selected record. 

 
Selects the Data Grid mode. 

 
Selects the Form mode. 

 

Selects the Gallery mode. 

 

Runs the slide show using all records. To stop the slide show, press the 
Esc key or right-click in the image and deselect Slide show. 

 

Runs the slide show using selected records. To stop the slide show, 
press the Esc key or right-click in the image and deselect Slide show. 

7-6 M 60-3-0024 e / printed 06.2010 



Documentation 
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 Grid View 
Displays the image files contained in the 
selected folder in grid view. 

 Gallery View 

Displays the image files contained in the 
selected folder in gallery view. 

 Form View 
Displays the image files contained in the 
selected folder in form view. 

 First, 
Previous, Next, Last 

Selects the first, previous, next or last image 
in the selected view. 

 Load Image 
Loads the selected image. 

Purche deleted files Purches the deleted image files from the 
cache. 
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32x32, 64x64, 128x128 Selects the size of the image files displayed. 

 Slide show 

Shows all image files as a slide show. 

 Slide show (selected) 

Shows all selected image files as a slide 
show. 

 Properties 
Opens the image’s property window. 

 
`çåíÉñí=ãÉåì=çÑ=íÜÉ=ëäáÇÉ=ëÜçï=

 

 First, 
Previous, Next, Last 

Selects the first, previous, next or last image 
of the selected view. 

 Use Timer 
Activates the timer: the slide show 
automatically proceeds to the next image 
or 
Deactivates the timer: in this case use the 
arrow keys on the keyboard to go to the 
next (⇒) or previous (⇐) image. 

 Slide show 
Stops the slide show. 

 Auto Zoom 
Continuously adjusts the zoom factor of the 
image display to the size of the window. 
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A form is used to enter data and to display information on the monitor. 

To display image information and enter additional information switch to the 

Form view by clicking on the  icon. In the Form view, the form 
"Archive.zvf" is used: 

 

The form "Archive.zvf". 

This form must be in the folder Programs\Carl Zeiss 
Vision\AxioVision4\0009\Templates\Form. 
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To use a different form for the form view in the Image Browser, generate a 
new form on the basis of the installed templates, and save this form in the 
folder mentioned above. 

 From the File menu select the New function and there the Form tab. 

 Select one of the templates and click on OK. To see a preview of 
templates, click on Apply. The corresponding template is then opened 
without the New dialog being closed. 

 Now select the Save As function from the File menu, and go to the data 
directory "C:\Programs\Carl Zeiss 
Vision\AxioVision4\0009\Templates\Form". Open the form folder, or 
create it if it does not already exist, and save the template under the 
name "Archive.zvf". 

 Now open the image browser and refresh the image gallery . If the 

form view is not active, click on the  button on the image browser’s 
toolbar. 

 
TKQ dÉåÉê~íÉI=éêáåí=~åÇ=Éñéçêí=êÉéçêíë=ïáíÜ=íÜÉ=

ÑáäÉ=ÉñíÉåëáçå=wso=

Reports are used to display and print out saved images and the additional 
information relating to them (title, author, comments, keywords etc.). Each 
report is based on what is known as a report template. Templates specify the 
layout and formatting for the report and its individual elements (image, data 
etc.). 

You can modify report templates yourself, or generate completely new ones. 
Please also read the section "Templates for forms and reports", which you will 
find further down this section. The template files are saved in the folder 
Programs\Carl Zeiss Vision\AxioVision4\0009\Templates\Report. 
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To allow reports to be incorporated into other documents (e.g. Word files), 
the option of exporting them is available. AxioVision offers export into the so-
called Microsoft Windows Metafile Format (WMF). This format allows you to 
incorporate reports into virtually any Microsoft Windows program. The 
individual fields of a report can be modified in most cases. However, the 
precise range of functions depends on the program in question. 

dÉåÉê~íáåÖ=åÉï=êÉéçêíë=

 Activate the image for which you 
want to generate a report. 

 

 Select from the File menu the New function, and activate the Reports 
(zvr) tab. 

  

 Select one of the templates and 
click on OK. To see a preview of 
templates, click on Apply. The 
corresponding template is then 
opened without the New dialog 
being closed. 
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 The new report is now displayed. 
You can save it just like any other 
file via File ⇒ Save or ⇒ Save As.

 

mêáåíáåÖ=~=êÉéçêí=

 Activate the report that you want to 
print. 

 Select from the File menu the Print 
function. The standard dialog for 
printing documents is then displayed. 

 Enter the desired settings and click on 
OK to print the report. 
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bñéçêíáåÖ=~=êÉéçêí=

 Activate the report that you want 
to export. 

 

 Right-click in the report and select 
the Export to WMF function. 

 

 A standard Microsoft Windows dialog for saving the file is then opened. 
Select the target folder under Save As and enter a file name. 

 Then click on OK to save the report. 
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qÉãéä~íÉë=Ñçê=Ñçêãë=~åÇ=êÉéçêíë=

Reports are mainly used to print out saved images and the additional 

Forms are used for displaying information in a structured way and for 

mplates. Templates 
specify the layout and formatting of the individual elements (image, data etc.). 

es\Forms or Report. 

ver, a 
 

neration of templates can be very time-consuming, depending on 

 more time-consuming process). 

Note: 
• The following example runs through the steps required to edit a template, 

using the example of a report. These steps also apply, however, to form 
templates. 

information relating to them (title, author, comments, keywords etc.). 

entering information on screen. 

Reports and forms are based on what are known as te

You can modify templates yourself, or generate completely new ones. The 
template files are saved in the folder Programs\Carl Zeiss 
Vision\AxioVision4\0009\Templat

AxioVision is supplied with a range of different templates. This means that 
you do not necessarily have to generate templates yourself. Often, howe
modification will be necessary to bring the templates into line with company
or project-specific requirements. 

As the ge
their complexity, we recommend that you use an existing template as a 
starting point wherever possible. This avoids having to generate them from 
scratch (an even
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pÉííáåÖë=Ñçê=ÉÇáíáåÖ=~=íÉãéä~íÉ=

 Select from the File menu the New function, and activate the Reports or 
Forms tab. 

  

 Select one of the templates (e.g. 
Reports - Standard) and click on 
OK. To see a preview of templates, 
click on Apply. The corresponding 
template is then opened without 
the New dialog being closed. 
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 The report is now displayed with its 
current layout. 

 

Notes for report templates: 
• The details in the header (logo, company name etc.) do not have to be 

defined as individual fields, but can be entered directly via a dialog. To do 
this, select Tools ⇒ Options ⇒ ID. Enter the corresponding data here. 
These data are then displayed automatically in the report’s header. 

• If you have not yet entered this information, this area is empty. 
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 To modify the template, you need 
to switch to Design mode. 

 To do this, right-click in the 
template and activate the Design 
mode command from the shortcut 
menu. 

 The draft mode is active if the tick 
can be seen to the left of the 
Design mode command.  

 To see the position and size of all 
elements, activate the Show 
bounding box option from the 
shortcut menu. All fields are then 
displayed with a blue frame. 

 

To make positioning easier, you can activate a grid, with which all elements 
can then be automatically aligned. 

 Select from the shortcut menu the 
Grid settings function. 

 Activate the Show Grid and Snap 
to Grid options, and click on OK. 

 

 A yellow grid is now displayed on 
top of the template. 
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jçîáåÖ=~åÇ=ÇÉäÉíáåÖ=ÑáÉäÇë=

 To move one or more fields, you 
need to select the field(s) in 
question. To do this, click on an 
individual field, or drag out a frame 
around the fields you want to 
move with the left-hand mouse 
button depressed. 

 If you hold down the Shift key 
while clicking, you can also select a 
number of individual fields. 

 

 To move the fields, left-click in the 
selected area, and drag the fields 
with the left-hand mouse button 
depressed. The pointer changes to 
a cross during this process. 

 The fields are automatically aligned 
with the grid. 

 

 To delete the selected fields, simply 
press the Del key on your 
keyboard. 

 The fields are then deleted, but can 
be restored via the menu function 
Edit ⇒ Undo provided you have 
not saved the template. 
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fåëÉêíáåÖ=åÉï=ÑáÉäÇë=~åÇ=ÅÜ~åÖáåÖ=ÑáÉäÇ=î~äìÉë=

 If you want to insert a new field, 
you can select the Text tool from 
the Annotations menu and then 
position it in the desired location. 

 

 The simplest way to do this, 
however, is to copy an existing 
field. In this case all of the 
attributes (size, color, font etc.) are 
adopted. 

 

 To do this, click on an individual field, or drag out a frame around several 
fields with the left-hand mouse button depressed. 

 If you hold down the Shift key while clicking, you can also select a 
number of individual fields. 

 To duplicate the field and move it 
at the same time, hold down the 
control key (Shift key), and left-
click in one of the two selected 
fields. Drag it to the desired 
location with the left-hand mouse 
button depressed. 

 

 To change the name of a field, 
switch to editing mode by double-
clicking in the field.  

 You can now enter a new name: 
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 So far you have only changed the 
field name! Now you need to 
specify that relevant information 
should also be entered to the right 
of the identifier. 

 To do this, select the empty field to 
the right of the field name, and 
open the Properties window by 
right-clicking in the field. Activate 
the Item tab. 

 A particularly important element 
here is the Tag parameter, which 
displays the information available in 
AxioVision images. Click on the 

 button to make a selection. 

 

 Now complete the other parameters according to your requirements.  

 Carry out these steps for all of the fields that you wish to use in your 
template. 

 Then save the template in the folder Programs\Carl Zeiss 
Vision\AxioVision4\0009\Templates\Report. 

The templates are now available in the list of available templates on the File 
⇒ New dialog. 
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`Ü~åÖáåÖ=ÑáÉäÇ=~ííêáÄìíÉë=

Changing field attributes means modifying the appearance (color, line 
thickness, text type, text size etc.) of fields. 

 To change the attributes for individual 
or several fields, you need to select 
the field(s) in question. To do this, 
click on an individual field, or drag 
out a frame around the fields you 
want to change with the left-hand 
mouse button depressed. 

 If you hold down the Shift key while 
clicking, you can also select a number 
of individual fields. 
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 Now right-click in the report and 
select from the shortcut menu the 
Properties command. 

 In the Properties dialog, activate the 
Attributes tab. 

 Now change the attributes using the 
tools under Settings for selected 
items. 

 If necessary, select a different Font. 

 Save the template in the folder 
Programs\Carl Zeiss 
Vision\AxioVision4\0009\Templates\ 
Report". 

 

 
TKR bÇáíçê=Ñçê=jìäíáÇáãÉåëáçå~ä=fã~ÖÉë=

Using the image editor, it is possible to generate a large number of images in 
a targeted way from large, complex ZVI images. The result is always a new, 
unsaved image with reduced complexity. It is possible to influence the 
following dimensions: 

 x/y pixel resolution 
 channels 
 instants of exposure 
 z-stack positions 
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When you select the Change Image Dimensions function on the Edit menu, 
a wizard is opened. This wizard always uses the active image in the 
foreground. When you are working in the image editor, it is not possible to 
execute any other functions in AxioVision. Only the pages that are relevant for 
the image are displayed in the wizard. 

 Open a multidimensional image. In this example, a 3-channel z-stack 
fluorescence image will be modified. Channel 1 and z-planes #1-6 are to 
be removed from the image, and the x/y resolution is to be reduced by a 
factor of 2. 

 Select from the Edit menu the Change Image Dimensions function. A 
dialog is opened in which the image located in the foreground is 
displayed. All the control elements that are required to operate the image 
(Player) can be found at the bottom image edge. 

  

 As the first step, indicate that you want to remove the selected images, 
and click on Next. 

  

 Now select channel 1 (which is to be removed), and click on Next. 
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 From the drop-down list box, select the desired reduction in resolution 
(1:2). 

  

 This setting means that every second pixel in both the x and y dimensions 
is removed. This reduces the image resolution to a quarter. Click on Next 
to proceed to the next step. 

 Now define the z plane range that you want to be removed from the 
image. 

 To do this, move the z slider to position 1 

. 

 Click on the top Get player position button 

. Now move the slider to z-position # 
6, and click on the bottom Get player position button 

. 

 To check the result, click on the  button. A preview of the 
reduced image is created. If you are happy with the selection, click on 

. The wizard is closed, and a new image with the reduced 
complexity is generated. Save this image under a new name. 
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TKS `êÉ~íáåÖ=~å=^ëëÉí=^êÅÜáîÉ=

What is an asset archive? 

Using the Asset Archive module, you can store images, measurement data 
lists, reports, etc. as “assets” in a hierarchically structured database. Different 
projects can be created in which your assets can be stored. A contact 
management feature enables you to allocate the projects to different clients 
etc., and you can classify and structure your assets in your own customized 
categories. A full-text search function makes it possible to find individual data 
sets again quickly. Using asset or project-related filters, you can carry out 
targeted searches for information in individual data fields.  

The long-term archiving feature allows you to transfer your projects and the 
associated assets onto CDs, DVDs or tape drives.  

File – New – Archive 

In order to archive assets, you must first create an asset archive. We 
recommend that you create just one archive and manage your assets using 
the organizational structures that the archive offers.  

To create an archive, open the File menu and select the New command.  

In the next dialog, select the Archive tab sheet. There, select the Asset 
Archive entry and click on OK.  

Asset archives are SQL databases. In the next dialog SQL-Archive, give the 
new archive a name. You can also specify the work folder in which the 
archived images will be stored. To do this, click on the “…” button and select 
the desired folder. Naturally, you can also create a new folder.  

Click on OK to generate the asset archive.  

The new asset archive is now ready for you to use. 
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`êÉ~íáåÖ=åÉï=éêçàÉÅíë=

Structuring your asset archives 

The asset archive gives you the opportunity to structure your assets in 
different ways. On the one hand, you can divide your work into different 
projects. All the images, data lists and reports that you can allocate to a 
project can also be stored in a project in the asset archive. An asset archive 
allows you to create any number of projects. 

If, however, you do not want to make use of this structuring option, you can 
archive all your assets in a single project, although this means that at least one 
project must exist. 

Creating projects 

In order to create a (new) project, execute the Add New Project function in 
the Archive menu. In the Add New Object dialog window, you can select a 
name for the project.  It is also possible to enter a description and comments 
in the appropriate fields. 

In addition, you can allocate a contact to the project, and the project will then 
also be listed under this contact. To do this, click on the “…” button in the 
Contact group. You can now select a contact from the Select Record list. 
You can amend this entry or carry out this selection step later at any time if, 
for example, you did not create any contacts when you created the project. 

`êÉ~íáåÖ=Åçåí~Åíë=

Allocating projects to clients 

Projects are often allocated to individual clients, customers or patients. It is 
frequently necessary to process several projects from one client. To make it 
possible to allocate these projects to particular clients, the asset archive gives 
you the opportunity to manage these clients in a list of Contacts. 
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Creating contacts 

In order to create one or more contacts in an archive, execute the Add New 
Contact function in the Archive menu.  

In the Add New Object dialog window, you can now enter the name of a 
company, as well as the surname, first name and any other personal details 
relating to the new contact.  

If you click on OK, the contact is incorporated into the list of contacts and can 
then be allocated to individual projects.  

If you now click on Contacts in the project tree, you will see a list of all the 
contacts that have been created. 

^ÇÇáåÖ=~å=~ëëÉí=íç=~å=~êÅÜáîÉ=

What are assets? 

Assets are digital resources. In AxioVision, assets are simply archived files or 
data. An image, a list of measurement values or a report layout – these are all 
examples of files that are commonly managed using AxioVision. 

What are data sets? 

Data sets represent assets. Every data set refers to an asset. Data sets contain 
information about assets, such as the file size and type, storage location, 
creation date and much more. 

Activating the project 

Assets, as data sets, are always allocated to a project. This means that you are 
currently working on a project and add the assets to this project.  Click on a 
project from the project list in the project tree to activate it. You can now 
make this project the default active project. To do this, right-click on the 
project and select the Set Start Folder function. 
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Adding assets 

 Image 

In order to archive an image, select it and execute the Add to Archive 
function in the Archive menu. 

You will see a form containing the information that AxioVision already has on 
this image. You can now give the asset a title and a subject; keywords and 
comments can also be added. 

If the image was not acquired using an automatic Zeiss microscope, you can 
also complete the fields relating to image information. 

The asset archive will store this image in the allocated work folder and it will 
automatically be given a file name. 

If you archive an image that has already been saved as a file, a second file will 
be created. 

 Data list 

If you have obtained measurement data from an image, this information is 
available in AxioVision in the form of data lists. These data lists can also be 
archived as assets. To do this, select the data list and execute the Add to 
Archive function in the Archive menu. 

You can also archive data lists that have already been saved. 

 Archiving from Microsoft Windows Explorer 

As a rule, you can select any files in Microsoft Windows Explorer and use drag 
and drop to move them into an active project in the asset archive. Please note, 
however, that in this case the asset archive saves each asset archived in this 
way again as a file in the allocated work folder. 
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tçêâáåÖ=ïáíÜ=î~äìÉ=äáëíë=

If you click in the relevant entry fields, it is possible to select the content of the 
field from a value list that you have created. To do this, click in the entry field, 
and the “…” button will appear at the edge of the field. Click on this button 
if, for example, you wish to insert keywords from a pre-defined list. 

You will find the available values in the list above. Select a value and insert it 
into the current data field by means of a double-click or by clicking on the 
Append button. Clicking on the Replace button replaces all the values that 
were previously contained in the field with the selected value. 

You can expand the value list by clicking on Add New, entering the new 
value in the Enter value to add window and confirming the entry with OK. 

A selected value can be removed from the value list using the Delete button. 

sáÉïë=

Using the Gallery View and Grid View commands, you can specify how the 
contents are displayed for each selection – project lists, contacts, assets within 
a project, categories and user-defined search queries. 

`~íÉÖçêáÉë=

Using categories, you can structure your assets in different ways. This is useful 
when saving similar assets in different projects and if you want to work with 
cross-project organizational criteria. You can define and manage the 
categories yourself; an asset can be allocated to one or more categories, or 
none at all. 

Creating a category 

Execute the Add New Category command in the Archive menu. Enter the 
name of the new category in the Add New Object dialog and confirm by 
clicking on OK. The category is then available and listed under Categories in 
the archive tree. 
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Allocating an asset to a category 

To allocate an asset to a category, you first need to activate a project. Select 
an asset in the active project and, using the mouse, drag it to the desired 
category. Now, when you activate the category in the archive tree, all the 
assets that belong to this category will be displayed. You can also drag an 
asset to several categories one after the other. 

Within a project it is possible to highlight several assets. To do this, hold down 
the Ctrl or Shift key as you highlight the assets using the mouse. 

pÉ~êÅÜáåÖ=

You can search for different types of data sets in an asset archive: 

 You can start a keyword search across all the data fields of an asset. All 
the assets in which the search text has been found are then displayed. 

 Using a wizard, you can generate search queries. This allows you to 
search through the contents of one or more data fields of assets or 
projects and to display the hits. 

hÉóïçêÇ=ëÉ~êÅÜ=

To search for a text in all assets, select the Search function in the Archive 
menu. You can then enter the keywords in the Enter search keywords 
dialog field. Click on OK to see the search results.  

The Search command will now have opened in the archive tree and the 
Keywords entry will be activated. Here, you will see the result of the search 
query.  

You can enter a new search term or switch back to all the available projects at 
any time.  

`êÉ~íáåÖ=~=ìëÉêJÇÉÑáåÉÇ=ëÉ~êÅÜ=

To create a user-defined search, open the Search entry in the archive tree and 
right-click on the User defined entry. Select the Add New Filter command 
in the shortcut menu. This starts the filter wizard. 
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 In the first step, you can define which objects you wish to search for in 
the asset archive. You can search for assets or projects which should meet 
certain search criteria. Searching for projects results in a list of all projects 
which meet the search query criteria. When you search for assets, the 
data sets which meet the criteria of the search query are listed, 
irrespective of the projects. Click on Next. 

 In this step, you must select a data-set field in which a search will be 
carried out for certain values. Different attributes will be displayed 
depending on the types of objects that you are searching for. Select the 
first attribute and click on Next. 

 This step allows you to define how the values in the data field should be 
compared. You can choose between:  
1. An exact, case-sensitive match. 
2. A non case-sensitive match. 
3. A check to establish whether certain text is contained in a field 
4. A comparison of numerical values: “less than”, “less than or equal 

to”, “greater than”, “greater than or equal to”. 
5. You can then define whether the exact opposite of the formulated 

condition should be met by activating the “Condition MUST NOT 
match” check box.  

6. Click on Next. 

 In this step, enter the value with which the comparison should be made. 
Click on Next. 

 You can now choose whether you wish to add additional criteria to the 
search query. If you wish to add further conditions, you can select 
whether at least one condition (“Yes, OR additional possible 
conditions…”) or every individual condition should be met (“Yes, AND 
additional required conditions…”). If you add additional conditions, 
proceed as in step 2. When you have completed the definition of the 
search query, select No, finish filter… and click Next.  

 You can now define whether the search query should be stored. In the 
drop-down list box, you can choose between Don’t save and Save for 
all users. If you select Save for all users in the drop-down list box, you 
can enter a name for the search query in the Name field.  
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 The search will then appear under this name in the list of user-defined 
searches. If you click on Finish, the search query is stored and the 
definition process is concluded.  

In the archive tree, you can now open the Search entry and activate the 
newly created search under User defined.  

j~å~ÖáåÖ=~êÅÜáîÉë=

Asset archives can be adapted specifically to the requirements of the user. In 
order to make such adjustments, however, you, as the user, will need special 
“administrator rights”. 

If you wish to execute one of the following functions for an asset archive, the 
first time you call up the function you will be asked to enter the password for 
the administrator user. The default setting for this password is zeiss. 

pÉííáåÖ=~=é~ëëïçêÇ=

We recommend that you first set a new password for the administrator.  

To do this, start the Change Password function from the Archive ⇒ 
Manage Archive menu. Before you can change the password, you must first 
log on as the “administrator”. You will then be asked to enter a new 
password and to confirm this a second time. After successfully executing this 
function, you will also be logged on as the administrator. This mode will 
remain active for as long as you have the current archive open.  

cáÉäÇ=ã~å~ÖÉãÉåí=

For each data field in an Asset-Archive you can specify certain parameters. 
There are three types of objects: ADDRESSES, IMAGES, PROJECTS. Select a 
type first an then select a field from the list of fields. You can modify the 
following parameters of a field: Name, Data type, Maximum Length, Input 
Validation Rules. The Input Validation Rules allow you to specify rules 
which apply when a user enters data into that field.  

7-32 M 60-3-0024 e / printed 06.2010 



Documentation 

Long-term archiving 

You can also transfer your archived assets onto external storage media. The 
long-term archiving function is used for this purpose. If you use this function, 
assets are transfered onto CD, DVD or tape drives and are deleted from the 
hard drive of your computer. The entries relating to the individual assets and 
preview images will remain on your computer so that you continue to have 
direct access to the information about the assets. 

Select the projects and/or assets in the archive that you want to transfer. 

Now start the Long Term Archivation function in the Archive ⇒ Manage 
Archive menu. When you call up this function for the first time, you will be 
asked to identify yourself as the administrator of the archive.  

In the first step of the wizard, you will see how many projects and assets you 
have selected to be archived and how much memory will be required for this. 
Click on Next.  

In this step, select a storage medium by double-clicking on the <New 
Medium> entry in the Media available for writing area. If you have more 
than one drive for writeable media, you can select a Drive Type in the New 
Medium dialog window. Select an unambiguous name for the transfer 
medium in the Medium Name field. The transfer medium will later be 
referenced using this name should you wish to open the transferred assets in 
AxioVision. Click on Next. 

In this step, you can determine whether the data carrier to which you have 
written the data should be compared with the original data at the end of the 
process. Click on “Finish” to start the actual transfer. Depending on the 
volume of data, this process may take some time.  

péÉÅáÑóáåÖ=íÜÉ=ëíçê~ÖÉ=äçÅ~íáçå=

Using this function, you can specify the basic folder in which your archive(s) 
will be saved. The default setting for this is the folder for My Pictures.  
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During the creation of a new asset archive, you had the option of specifying a 
work folder for the new archive. Using this function, you can change this 
work folder.  

Please note: if you have already archived assets, you must move ALL the files 
from the previous storage location to the new storage location manually.  

`Ü~åÖáåÖ=éêçàÉÅí=éêçéÉêíáÉë=

If you are logged on as the administrator you can change other properties of 
the asset archive. Activate the Root entry in the archive tree that displays the 
name of your archive and execute the Properties function in the View menu.  

Activate the General tab sheet in the Properties window. You can now 
change the following properties:  

Copy data from last record 

Here you can specify how the input form of a new asset will be treated. You 
can copy the values from the previously added asset always or never or you 
can select to be asked for each new asset, whether or not the values shall be 
copied. 

Storage format for images in archive” 

Select the format in which images should be stored. You can choose from the 
following formats: ZVI, JPEG and TIFF. 

Name for Projects Folder 

If necessary, you can also replace the name “Project” with another expression. 

Name for Addresses Folder 

If necessary, you can also replace the name Addresses with another 
expression. 

 



Configuration 

U `çåÑáÖìê~íáçå=

UKN dÉåÉê~ä=

One of the most striking new features of AxioVision Version 4 is the fact that 
it allows you to adapt the interface and the way you operate the program 
almost entirely to suit your own requirements. A great deal of attention has 
therefore been devoted to ensuring that the configurations of individual users 
can be managed separately. This is guaranteed by saving individual data, such 
as toolbar configurations, customized dialogs and workflows, general system 
settings and, of course, the data generated on an individual basis, separately 
from the data of other users. The Microsoft Windows user administration is 
used entirely. In AxioVision additional settings are not required.  

The settings of an individual configuration can be exported easily and can be 
accessed to other users or to all users (see also chapter 8.7 "Exporting and 
Importing User Configurations"). 

 
UKO lîÉêîáÉïW=pÉííáåÖ=ìé=^ñáçsáëáçå=

This chapter gives you a brief overview of the steps to setup up AxioVision. In 
the appropriate subchapter you will find further information. 

fåëí~ää~íáçå=

 Installation must be carried out with administrator rights. 

 AxioVision is then available to all users of the system (including new users 
who are set up after installation). Installation is not carried out individually 
for each user. 

 Remain in administrator mode during the following steps described 
below. Read also Chapter 1 and 2 of the Installation Manual AxioVision 
Product Suite. 
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pÉííáåÖ=ìé=^ñáçsáëáçå=

AxioVision can now be set up as desired: 

 Microscope configuration and/or MTB2004 Configuration 
 Scalings 
 Hardware settings files and experiments 
 Toolbars, keyboard shortcuts, workflows and user dialogs 
 Measurement programs 

_~ÅâáåÖ=ìé=íÜÉ=ÅçåÑáÖìê~íáçå=~åÇ=êÉëíçêáåÖ=áí=Ñçê=
áåÇáîáÇì~ä=ìëÉêë=

 After configuration the settings and user files can be backed up via the 
Tools menu ⇒ Import/Export Configuration. 

 In step 1 select Export. 

 Important: Please ensure that Save 
all user documents in ZIP-file is 
also activated in step 2  Select 
sources so that the user files 
(scalings, hardware settings etc.) are 
also exported: 

 

The result is two files with the name given to them during the export and the 
extensions AVCONF and ZIP. You can select the folder for these two files. 

The relevant settings for individual users can be imported using the same 
function. 

 To do so select Import in step 2. 
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Notes: 
• The relevant user must naturally be logged on under Microsoft Windows 

during the import – not the administrator. 

• The channel pool, used for simple definition of multichannel 
fluorescence images, cannot be exported. If necessary, the corresponding 
file must be copied via Microsoft Windows Explorer. 

j~âáåÖ=ìëÉê=ÑáäÉë=~î~áä~ÄäÉ=Ñçê=~ää=ìëÉêë=

 To make the user files available for all users, the files in the ZIP file must 
be extracted into the Shared Documents folder of the All Users user 
account.  

 The directory structure required by AxioVision is generated automatically. 

 
UKP rëÉê=~åÇ=a~í~=^Çãáåáëíê~íáçå=

jáÅêçëçÑí=táåÇçïë=ìëÉê=~Çãáåáëíê~íáçå=

Under Microsoft Windows XP there are three fundamental levels of security 
that are allocated to users. These are granted to end users through their 
membership of the groups Users, Power Users or Administrators. 

 The Users group is the most secure group, as the standard rights of this 
group do not allow the members to change operating system settings or 
the data of other users. Members of the Users group are able to carry out 
most general tasks, such as running applications, using local and network 
printers, as well as shutting down and blocking the work station. Users 
are not entitled to release directories or set up new local printers. 

•  Under certain circumstances, members of the Users group are not 
able to execute AxioVision, e.g. if cameras from other manufacturers 
are being used or a Matrox Meteor frame grabber is installed.  
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 Power Users are able to execute the following tasks: installing programs 
that do not change operating system files, or installing system services. 
Adjusting system-wide resources, including printers, date, time, energy 
options and other control panel resources. Creating and managing local 
user accounts and groups. Stopping and starting system services which 
are not started by default. Power Users have no access to the data of 
other users on an NTFS volume unless they are granted this right by the 
users concerned. 

•  In order to use AxioVision, users should always belong to the 
Power Users group. 

 The Administrators group carries out maintenance tasks on the 
computers. The standard rights for this group give members complete 
control over the entire system. For this reason, only reliable employees 
should belong to this group. 

rëÉê=ÑáäÉë=

Each user under Microsoft Windows XP has a personal folder for the files that 
he has created. These personal folders are created by Microsoft Windows for 
each user of the computer. If a computer is used by more than one user, the 
individual personal folders are indicated by the name of the corresponding 
user. In addition, Microsoft Windows provides the Shared Documents folder 
for files that you want to release for other users.  

When a new user is created under Microsoft Windows XP, a user account is 
set up for each user. 
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Theoretically, user data should only be saved in the My Documents folder. This 
folder has a link to the Microsoft Windows Desktop as well as in Microsoft 
Windows Explorer. The personal folders can be accessed very easily via these 
links: 

   

However, the folder is actually located within the folder structure of the user 
account.  

For reasons of data security, however, we recommend that you separate 
program and data files. This means that the data created by a user should be 
stored on a different drive from the programs. 

AxioVision User's Guide, Release 4.8.2 8-5 



Configuration 

Advantages of this procedure: 

1. After installation and configuration an image of the system partition can be 
created, which makes it possible to restore the system very quickly in the 
event of a disaster. “Images” represent a 1:1 copy of the hard drive, 
irrespective of whether or not there are files in the memory. An attempt is 
therefore made to limit the size of the system partition. 

2. When you are making regular data backups, it is not always necessary to 
back up the complete system partition as well – only the user data needs to 
be backed up. 

3. The data folder can be moved to a separate drive with sufficient memory, 
even for multidimensional images (see also point 1). If the folder is on a 
network drive, automatic backup by the relevant IT department is often 
ensured.  

qÜÉ=ëÜ~êÉÇ=~ÅÅçìåí=?^ää=rëÉêë?=

Microsoft Windows always creates a default user account with the name All 
Users. Files saved here can be used by all users of the system. This "shared 
account" can be used to save files (e.g. scalings and measurement programs) 
that are used centrally by all users, without the need to copy these files 
individually to each user’s personal account in the event that the files are 
modified. 

`êÉ~íáåÖ=åÉï=ìëÉêë=

Set up new users (or create new user accounts) via the computer 
administration function (Microsoft Windows Desktop ⇒ My Computer 
shortcut menu ⇒ Manage ⇒ Local Users and Groups): 
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Notes: 
• Administrator rights are required to create a new user or to allocate a 

profile. 

• When you add a new user, the Users profile is allocated by Microsoft 
Windows by default. A different profile can be allocated after the user has 
been set up. 

• AxioVision is released for use with the Power Users profile only. This is 
mainly for reasons of hardware support. The Matrox Meteor drivers, for 
example, do not function with the Users profile. 
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a~í~=~Çãáåáëíê~íáçå=ìåÇÉê=^ñáçsáëáçå=

a~í~=ÑáäÉë=

AxioVision stores all files created by the user in the My Documents\Carl 
Zeiss\Data folder. There you will find additional subfolders for the individual 
documents, such as automatic measurement programs, calibrations, 
experiments etc.: 

 

Folder structure of the AxioVision data folder 
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^ñáçsáëáçå=áã~ÖÉë=

Within the My Documents folder, you will also find the Microsoft Windows 
default folder My Pictures, which is suggested by AxioVision as a location for 
saving your images. 

 

qÉãéçê~êó=ÑáäÉë=

During the acquisition of 
multidimensional images using the 
Time Lapse Imaging module, if the time 
intervals are less than 1s, images are 
only stored in the user memory. 
However, if the experiment is too 
complex, it is possible that the user 
memory may not be able to hold all the 
images, which are then stored 
temporarily in the folder for temporary 
files.  

 

AxioVision User's Guide, Release 4.8.2 8-9 



Configuration 

AxioVision draws your 
attention to this by 
means of an 
appropriate message 
before acquisition: 

 

This folder is also located within the user account. As huge amounts of data 
can accumulate as part of this process, this folder should also be moved. 

Notes: 
• Since the highest possible speed is important for this procedure, you 

should either create a reference to a different drive on the same hard 
drive, or use a different, faster, hard drive.  

• On no account should you transfer the folder for the temporary files to a 
network drive. Data transmission is clearly too slow here.  

^ñáçsáëáçå=ÅçåÑáÖìê~íáçå=ÑáäÉë=

Files that are important for AxioVision to function (INI files for devices etc.) are 
also saved within the user account in the folder Application Data\Carl 
Zeiss\AxioVS40. 

This subfolder is not displayed if you are a normal user. It is only available to 
administrators. 

jçîáåÖ=íÜÉ=“jó=açÅìãÉåíëÒ=ÑçäÇÉê=

 Select the Properties function in the shortcut menu of the My 
Documents folder (right click on the desktop or in Explorer). 

 Click on the Move... button in the My Documents Properties dialog 
and select the target folder. If you click on OK, the folder is adopted into 
the Properties dialog. 
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 Exit the My Documents Properties dialog by clicking on OK. All 
subfolders and files from My Documents will now be moved into the new 
folder. 

 Repeat these steps for each user. 

Notes: 
• This step must be performed for each user before AxioVision is executed 

for the first time. AxioVision remembers this path in "plaintext" after the 
first program start. If the My Documents folder is not moved until after 
the first program start, AxioVision creates the folder and all subfolders in 
the original place again! 

• The following tip should only be followed by specialists (and even 
specialists should be reminded to save data beforehand.) 
The following action can be taken if AxioVision is accidentally started 
BEFORE the folder has been moved, resulting in the problem described 
above: 

• Close AxioVision. 

• Delete the UserOptions.xml file in the Application Data\Carl 
Zeiss\AxioVS40\Profiles\Default folder of the appropriate user 
account.  

• The file is automatically recreated and the current path settings for 
My Documents are read in again the next time AxioVision is started. 

• Never simply move the My Documents folder via Explorer. Always follow 
the procedure described above, as only then will all the links and 
references to this folder work.  

• In AxioVision the paths for user and work group files and templates are 
displayed in the Tools menu ⇒ Options function ⇒ Folder tab sheet. It 
is also possible to change the paths here. However, you should avoid 
doing this for the reason given above. 
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jçîáåÖ=íÜÉ=ÑçäÇÉê=Ñçê=íÉãéçê~êó=ÑáäÉë=

 Select System in the control panel.  

 Click on Environment Variables on the Advanced property page. 

 Repeat these steps for each user. 

 Change the settings of the 
user variables for TMP and 
TEMP via Edit in the 
Environment Variables 
dialog. 

 

UKQ pÅ~äáåÖë=

dÉåÉê~ä=

Scalings are required to allow you to display scale bars and measurement 
values in real units instead of pixel values. This requires configuration of the 
system for every combination of objective, optovar and camera resolution. If 
you are using a camera of the AxioCam family, please be aware of the 
following! 

Notes: 
• Only the basic resolution needs to be calibrated for the cameras of the 

AxioCam family. All other resolutions (higher resolution levels and binning 
modes) are then derived from this basic calibration automatically. 

• For theoretical scaling there is no need using a stage micrometer, but 
special settings in the microscope configuration are necessary, which are 
described in the Online Help. 

The theoretical scaling offers you the option of having scalings calculated 
automatically for a microscope that contains motorized or encoded elements. 
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This means that there is no need for the time-consuming generation of 
scalings using a stage micrometer.  

Calibration is usually performed using a stage micrometer. The scale depicted 
on the stage micrometer allows you to specify a known length simply and 
precisely. 

Each scaling is saved in its own file with the extension "ZVSC". 

Notes: 
• You can also use scalings from AxioVision Version 3, simply by copying 

them into this folder. 

• As scalings are often also of interest to other users, in some cases it may 
be useful to save them in the shared account All Users  (please read 
section 8.7 "Exporting and Importing User Configurations"). 

dÉåÉê~íÉ=ëÅ~äáåÖë=

 Acquire an image 
of the stage 
micrometer. 

 Make sure that 
you position as 
much as possible 
of the scale in the 
image. 
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 From the 
Measure menu, 
select the 
Scalings 
function. 

 

 In the Scalings 
Control window 
click on New. 

 The scaling 
wizard is started. 
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 Right-click in the 
image and select 
Auto Zoom to 
view the entire 
image. 

 Enlarge the 
window, if 
necessary. 

 Click on Next. 

 

 Select the mode 
Single Distance 
(X=Y). 

 Click on Next. 
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 In the image click 
on the start and 
end points of the 
scale. 

 Enter this distance 
into the Distance 
field, and select 
the Unit. 

 Then click on 
Finish. 

 

 Enter a name for 
the scaling and 
click on OK. 

 

 The new scaling 
now appears in 
the Scalings 
Control window, 
and is activated 
automatically. 

 The scaling is 
used as the 
default for 
subsequent image 
acquisition 
procedures.  
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Notes: 
• As scalings are often also of interest to other users, in some cases it may 

be useful to save them in the shared account All Users (please also read 
the previous section and section 8.7 "Exporting and Importing User 
Configurations"). 

• The Save As button is a simple way to save individual scalings for the 
work group. 

 
UKR ^Ç~éíáåÖ=íÜÉ=rëÉê=fåíÉêÑ~ÅÉ=

The Customize function in the Tools menu allows you to customize the user 
interface. This function gives you a great deal of freedom in configuring 
AxioVision. You can therefore design "your own" AxioVision, showing only 
those functions that you actually need. 

Any changes made in the Customize dialog are immediately displayed on the 
AxioVision interface. The dialog does not therefore contain "traditional" 
buttons, such as OK or Cancel. Once you have made the desired changes, 
simply close it using the  button in the top right-hand corner. 

`êÉ~íáåÖ=íççäÄ~êë=

How do you create a toolbar for quick access to the image processing 
functions? 

 From the Tools menu select the 
Customize function. 

 

 Make sure that the Toolbar 
property page is active in the 
Customize dialog. 
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 To create a new toolbar: 

 Click on New. 

 Specify a name for the new 
toolbar. 

 Click on OK. 

 Define the size of the icons 
and indicate whether labels 
should be assigned to the 
buttons as well. 

 

 In the Available commands 
field, select the commands that 
you would like to use on the 
toolbar. 

 Select the command 
Processing ⇒ Adjust ⇒ 
Brightness/Contrast/Gamma 

 Then click on Add to apply it to 
the toolbar. 

 Apply further functions from 
the Processing menu in the 
same way. 
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The toolbar now contains the 
commands displayed. 

 To create the toolbar 
definitively, click on OK. 

 

The Processing toolbar is now 
displayed at the top of the 
AxioVision window. 
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Notes: 
• You will also find the toolbar in 

the toolbar list if you right-click 
in the main menu or on another 
toolbar. 

• This procedure can also be used 
to modify existing toolbars. 

 

 To do this, simply select one of 
the existing toolbars in the 
Select Toolbar drop-down list 
and then proceed as described 
above. 

 

aÉÑáåÉ=âÉó=ÅçãÄáå~íáçåë=Ñçê=ÑìåÅíáçåë=

You can execute any command that is available in AxioVision by pressing 
shortcut keys. This is particularly useful for quickly calling up commands that 
you require time and again, such as image acquisition or the activation of a 
camera or microscope setting that you often need (requires a motorized 
microscope). 

 From the Tools menu select the 
Customize function. 

 

 Make sure that the Keyboard 
property page is active in the 
Customize dialog. 
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 In the Available commands field, 
select the commands that you 
would like to use on the toolbar. 

 Select, for example, the command 
Acquisition ⇒ Snap. 

 

 Click in the Press Shortcut key 
field using the mouse. 

 Then press the shortcut key(s) on 
your keyboard that you would like 
to use to execute the command. 

(If possible, the shortcut key should not 
already be assigned to any other 
command.) 

 Now click on Assign. 

 

 Close the dialog by clicking on the 
button in the upper-right corner of 
the window. 
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`êÉ~íÉ=çïå=Çá~äçÖë=

The creation of your own dialogs allows you to take complex control dialogs 
for, say, microscope and camera operation and pick out precisely the elements 
that you need to operate your applications. This considerably simplifies parts 
of the operation. Create a dialog that enables you to control the objective 
nosepiece and lamp voltage on a motorized microscope as well as to set the 
camera’s exposure time. 

 From the Tools menu select the 
Customize function. 

 

 Make sure that the Dialogs 
property page is active in the 
Customize dialog. 

 

 To create a new dialog, click on 
New. 

 

 Enter the following data: 

Name (dialog + button) 
Tooltip Text 
Status Text (status line) 
Button Symbol 
Toolbar, on which the button 
should be created to open the 
dialog. 

 Click on OK to create the 
dialog. 
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 Now select the entry Tab 1. 

 To change the name, click on 
Edit Tab. 

 

 Specify a Name and a Tooltip 
Text. 

 Then click on OK to create the 
tab. 

 

 Now select Exposure in the 
Select control field. 

 To insert both into the dialog, 
click on Add. 

Notes: 
• The control elements depend 

on your system configuration 
and may differ from those 
displayed here. 

 

 To create a second property 
page in your dialog for 
controlling the microscope 
components, click on New Tab.
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 Specify a Name and a Tooltip 
Text. 

 Then click on OK to create the 
property page. 

 

 Now select Objective and 
Halogen lamp in the control 
elements field. 

 To insert both into the dialog, 
click on Add. 

Note: 
• The control elements depend 

on your system configuration 
and may differ from those 
displayed here. 

 Close the dialog by clicking on 
the button in the upper-right 
corner of the window. 

 

The button is now displayed on the toolbar you have chosen. The result now 
looks like this:  

The dialog contains two property pages: Camera and Microscope. 
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 The Camera property page 
contains the element for 
controlling the Exposure time. 

 

 The Microscope property page 
contains the elements for 
controlling the objectives and 
for controlling the lamp voltage.

Note: 
• Also check the Tooltip text and 

the texts in the status line. 

 

aÉÑáåÉ=ïçêâÑäçïë=

Workflows are the most efficient way to operate AxioVision. They are the 
"central element" for executing the functions required to perform a specific 
task. All you have to do is click on the buttons they contain one after the 
other to achieve the desired results quickly and without problems. If you also 
hide all the control elements that you do not need, you can concentrate fully 
on the work you are actually performing. 

Note: 
• You can also place dialogs you have created yourself and all the toolbars 

on a workflow. 
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 From the Tools menu select the 
Customize function. 

 

 Make sure that the Workflows 
property page is active in the 
Customize dialog. 

 

To create a workflow: 

 Click on New Folder and then on 
Folder name. 

 Specify a name for the new 
workflow. 

 Click on OK. 
 

In the Available commands field, select 
the commands that you would like to 
use on the toolbar. 

 Select, for example, the menu 
command File ⇒ Image File 
Browser. 

 Then click on Add to apply it to the 
workflow. 

 Also apply the menu commands  

View ⇒ Show Properties 
Annotations ⇒ Scale bar 
File ⇒ Save 
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 Close the dialog by clicking on the button in the upper-right 
corner of the window.  

The workflow is now located under the 
My Workflow bar. 

 

UKS dÉåÉê~ä=pÉííáåÖë=

In this dialog you can enter settings for the configuration of AxioVision. The 
settings are grouped by topic on property pages. 

The settings comprise: 

 AxioVision’s starting performance. 
 Selection of language. 
 Specification of user-specific paths for AxioVision documents. 
 Image display. 
 Automatic saving of images after acquisition. 
 Entry of user information. 
 And much more. 

From the Tools menu select the Options function. The Options window 
with the General, Layout, Folder, Storage, Acquisition, Naming, Display, 
ID and Commander property pages is opened. 

Details on the settings used there, and how they influence the system, can be 
found in the online help. 
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UKT bñéçêíáåÖ=~åÇ=fãéçêíáåÖ=rëÉê=`çåÑáÖìê~íáçåë=

dÉåÉê~ä=

The term user configuration is understood to mean all the settings you have 
made to adapt AxioVision to your own personal requirements after 
installation. 

The Import/Export Configuration function allows you to back up your 
personal work environment in a convenient way, so that you can restore it 
quickly and easily in the event of problems with the system. On multi-user 
systems, you therefore have the option of making settings that are of interest 
to all users (e.g. scalings, toolbars etc.) available very quickly to all users by 
offering access to this configuration via the shared account All Users. 

Please also read section 8.3 "User and Data Administration", as well as the 
section "Importing user files" later in this section. 

The following elements of AxioVision can be exported: 

 All settings made in the Customize dialog on the Tools menu. This 
means all the toolbars, shortcut keys, workflows and dialogs you have 
generated. (Please also read section 8.5 "Adapting the User Interface".) 

 All settings in the Options dialog on the Tools menu. (Please also read 
section 8.6 "General Settings".) 

 You can also save a record of which modules have been activated. See 
the Modules Manager function on the Tools menu. 

To allow you to make your personal files available to other users, if necessary, 
all files from the folder My Documents\Carl Zeiss are placed together in a 
compressed archive (ZIP file). The folder structure from the Carl Zeiss data 
folder is retained. 
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bñéçêí=

 Select from the Tools menu the Import/Export Configuration function. 

A wizard is started. This guides you through the individual steps of the export 
process. 

 Select the elements to be exported, and the folder and file name for the 
target file. 

This will result in two files (if you have also exported the user files) in the 
selected folder. One file has the extension *.avconf. This file contains all the 
elements of your configuration. The second file has the extension *.zip. All 
the user files are saved in this file. 

Note: 
• If you want to make your exported configuration available to other users, 

make sure that you save the files in a generally accessible folder. 

fãéçêí=

fãéçêíáåÖ=íÜÉ=ÅçåÑáÖìê~íáçå=ÑáäÉë=

 To import the configuration of another user, select from the Tools menu 
the Import/Export Configuration function. 

A wizard is started. This guides you through the individual steps of the import 
process. At the end of the process, all of the other user’s elements are 
available. 

NOTES: 
 A configuration can only be imported by the relevant user. 
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fãéçêíáåÖ=ìëÉê=ÑáäÉë=

User data cannot be copied via the import function. This has to be performed 
separately by unpacking the ZIP file. The reason for this is to avoid files you 
have created yourself being inadvertently overwritten. 

 Start Microsoft Windows Explorer, and go to the previously selected 
folder containing the ZIP file with the other user’s files. 

 Double-click on the ZIP file to unpack it. 

 Now select the folder My Documents as the target folder. The user files 
are copied automatically into the correct folder structure. If the Carl Zeiss 
subfolder does not yet exist in your My Documents folder, it is created  

Notes: 
• You need appropriate software to unpack ZIP files. A program is available 

automatically under Windows XP Professional. Ideally contact your system 
administrator. Usually these kinds of tools will be present anyway. 

• If you want to make the files available to all users, select the shared 
account All Users (Shared Documents) as the target folder for unpacking 
the files. All users of the system will then be able to share use of the files 
(e.g. scalings). 

 
UKU `êÉ~íáåÖ=î~êáçìë=^ñáçsáëáçå=ÅçåÑáÖìê~íáçåë=Ñçê=

~=ìëÉê=

_~ÅâÖêçìåÇ=

Anyone who finds the management of users too complicated can continue to 
use the procedure supported under AxioVision Release 3 (see below). Other 
subfolders with new profiles are created for the different configurations in the 
Application Data\Carl Zeiss\AxioVS40\Profiles folder of the relevant user 
account, in addition to the default profile Default. The name of the profile is 
allocated while it is being created. The description from the earlier manual 
follows: 
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`êÉ~íáåÖ=áåÇáîáÇì~ä=ÅçåÑáÖìê~íáçåë=

 Right-click on the AxioVision icon on the Microsoft Windows desktop. 

 Select the Create Shortcut function from the shortcut menu. 

  

 A new AxioVision icon is created on the desktop. 

  

• Now right-click on the new AxioVision icon, and select the 
Properties function from the shortcut menu. 
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 The Properties window is opened. 

  

 Enter the following at the end of the Target field: -u=Name (N.B. Insert a 
space before -u!). Here 'Name' is the description for the configuration. 
Use, for example, -u=Test to create a configuration with the name Test. 

 

 Adopt the setting by clicking on OK. 
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 To change the description of the new configuration on the Microsoft 
Windows desktop, right-click again on the new AxioVision icon, and from 
the shortcut menu select the Rename command. You can now enter a 
name of your choice in the icon's description field. 

  

 Enter, for example, Test Configuration and then click on any area of the 
desktop to adopt the entry. 

  

 You can now start AxioVision from the new icon and configure it 
accordingly. 
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V fã~ÖÉ=^Åèìáëáíáçå=jçÇìäÉë=

VKN ^éçqçãÉ=

dÉåÉê~ä=

The ApoTome software module controls the ApoTome hardware (control box 
and slider) and coordinated image acquisition using a digital camera, such as 
the AxioCam MRm. An ApoTome system allows you to generate optical 
sections through fluorescence samples. The parts of the image that are out of 
focus are then removed, and an increase in  

� image sharpness 
� the signal to background ratio (contrast) 
� and resolution in the axial direction 

is achieved. 

The following units are required for an ApoTome imaging workstation: 

� Microscope: Axio Imager.Z1, Axio Imager.D1, Axio Observer.Z1,  
Axio Observer.D1, Axiovert 200 or Axioplan 2 imaging e 

� Anti-vibration system 
� Digital camera with more than 10-bit dynamic range 
� ApoTome control box and slider (release for Axio Imager, 

Axioplan 2 imaging e and Axiovert 200) 
� PC with monitor 
� AxioVision basic package and the optional ApoTome software module 

For details on setting up and using the hardware components, such as the 
microscope and ApoTome control box/slider, please refer to the manuals 
enclosed with the corresponding devices. 

Note: 
• Before using the ApoTome, familiarize yourself with the basic functions of 

the AxioVision software. You should be familiar with the operation of the 
camera and microscope components in particular. 
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The optics of a microscope are optimized for analyzing very thin samples. For 
a cover-glass-corrected objective, all optical calculations are performed for 
very thin objects that lie directly beneath the cover glass. All cover-glass-
corrected objectives from Carl Zeiss are optimized for this particular usage, 
and exhibit an optimum Point Spread Function (PSF) for the wavelengths for 
which the corresponding objective has been specified. 

In biological applications, however, the vast majority of samples used do not 
satisfy these optimum requirements. Sometimes thicker biological tissue slices 
are used, e.g. to analyze cells in the tissue using specific fluorescent markers. 

In such cases, during microscopic analysis, and particularly during 
documentation, the set focus plane is hidden by parts of the image that 
originate from above and below the actual focus plane. As a result the image 
appears "faded", the contrast is reduced, and the background becomes 
bright. In extreme cases important structures and image details may be 
completely hidden. 

  

The above representation of a microscopic image of cell nuclei in tissue shows 
this effect. 

A number of methods can be used to prevent or reverse this effect, such as 
confocal laser scanning microscopy or 3D Deconvolution. 
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With the ApoTome the principle of "fringe projection" has been employed. 
This technology involves inserting a grid structure with grid lines of a defined 
width into the plane of the field diaphragm of the reflected light beam path. 
As the plane of the field diaphragm is matched to the focal plane, this grid 
structure can be displayed on the microscope. When you look into the 
eyepiece you can therefore see the grid, superimposed onto the actual 
sample. 

  

Above is a schematic representation of the reproduction of the grid. In reality 
the grid lines are much thinner. 

A scanning mechanism in the ApoTome slider is used to move the grid 
structure in three defined steps within the sample plane. The movement of 
the grid takes place very quickly (in less than 20 ms). A digital image is 
acquired at each grid position. 

The movement of the grid is represented schematically below: 

   

Grid Position 1 Grid Position 2 Grid Position 3 
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The three raw images are combined online on the PC to form a resulting 
image. The time it takes to process the image depends on the image size: 

� 512 x 512: approx. 30 ms 
� 1300 x 1000: approx. 100 s 

The processed resulting image is an optical section through the sample with 
the following characteristics: 

� The grid structure has been removed from the raw images. 
� The parts of the image that are out of focus are no longer visible. 
� The sharpness and contrast of the image have been increased. 
� The image’s resolution in the axial direction has been increased. 

  

A corresponding resulting image is represented schematically above. 

  

The above image is an application image of cell nuclei (tadpole brain section) 
in black and white. 

� Top left: conventional fluorescence 
� Bottom right: optical section 
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One possible way to explain this is to use the image of the grid in the sample: 

  

The image of the grid provides the necessary information on the distance of 
the various sample structures from the set focal plane (see figure above). 
Some sample structures are in focus, while others lie above or below the focal 
plane, and enter the set focal plane. 

The technique of grid projection makes use of the fact that the image of the 
grid above and below the actual focal plane is blurred, and enters the blurred 
areas of the sample. When the grid line is moved, significant brightness 
differences (= contrast) appear in the focal plane. Outside the focal plane only 
minor differences are produced, as the sample and the image of the grid are 
practically "blurred" together. The brightness differences are detected by the 
algorithm used to combine the three raw images, and are used to remove the 
parts of the image that are out of focus. 

e~êÇï~êÉ=ÅçåÑáÖìê~íáçå=

For information on setting up the devices, please refer to the manuals of the 
devices concerned. 

¾ First switch on the microscope, then the fluorescence switched-mode 
power supply, followed by the ApoTome control box and the camera. 

¾ Then switch on the PC. 

AxioVision User's Guide, Release 4.8.2 9-5 



Modules  - ApoTome 

^éçqçãÉ=`çåÑáÖìê~íáçå=Ñçê=^ñáçéä~å=O=áã~ÖáåÖ=É=

¾ Open the Microscope Configuration program on the Microsoft 

Windows desktop by double-clicking on the  icon. 

  

¾  Configure the microscope. To use the 
ApoTome, the ApoTome check box must be activated. 

If the ApoTome control box has been connected directly to a free COM 
port on the PC via a serial RS 232 cable, select the corresponding COM 
port in the list box. 

If the ApoTome control box has been connected directly to the 
microscope via a CAN bus cable, in the list box select the same COM port 
that you selected under Microscope. 

¾ Close Microscope Configuration by clicking on the Exit button, and 
confirm the changes by clicking on the Save & Exit button in the dialog 
that then follows. 
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^éçqçãÉ=`çåÑáÖìê~íáçå=Ñçê=^ñáç=fã~ÖÉêI=^ñáç=
lÄëÉêîÉê=çê=^ñáçîÉêí=OMM=

¾ Open the MTB2004 Configuration program on the Microsoft Windows 

desktop by double-clicking on the icon . 

Note: 
• Configurations for various microscopes are created and managed in 

MTB2004 Configuration. Please refer to the manual or online help for 
MTB2004 Configuration for detailed information on creating 
configurations.  

¾ For the description of the ApoTome configuration below, it will be 
assumed that the microscope itself has already been configured. 

¾ Make sure that the ApoTome control box is connected to the PC and is 
switched on. 

¾ Open the configuration tree under Reflected Light Path. 

¾ Click on the No ApoTome entry. The entry will be shown with a blue 
background. 
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¾ Select the ApoTome by clicking on ApoTome in the selection area on 
the right-hand side of the user interface and assign it. 

  

¾ In the information area, you can now select the connection type (RS232 
or CAN bus) and the COM port being used (port 1 to 5). 

 

¾ Check the connection by clicking on the Check Connection button. If 
the ApoTome is found at the specified port, a green symbol is displayed 
next to the button. 

Note: 
• If you activate the Simulate Hardware check box, for example, the 

function of the ApoTome can be adjusted virtually in the AxioVision 
microscope control and imaging software (simulation mode). 
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¾ Start the AxioVision software by double-clicking on the  icon 
on the Microsoft Windows desktop. 

For subsequent steps it is useful to have easy access to the following control 
elements. Please bear in mind that, depending on the features of the device, 
some control elements may not be present, or may appear different: 

: Reflector nosepiece for switching between 
fluorescence wavelengths. 

 Internal shutter for opening and closing the 
shutter. 

 Camera exposure time. 
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 Light path for switching the light path, e.g. 
with an Axiovert 200. 

You can also create a user-specific dialog containing all the control elements 
required, including the control elements for the ApoTome functions. 
Information on creating dialogs can be found in chapter 8 "Configuration". 

`~äáÄê~íáçå=çÑ=éÜ~ëÉ=éçëáíáçå=

To set the optimum angle of deflection for the ApoTome’s scanner unit, you 
need to carry out a fine adjustment of the scanner calibration in accordance 
with the system structure. The mirror sample and the special reflected light 
reflector cube, both of which are supplied with the ApoTome, are used for 
this purpose. Insert the Push&Click filter cube into an empty reflector 
nosepiece position, and enter this filter set as Refl. BF, for example, in the 
Microscope Configuration or the MTB2004. The calibration must be 
performed for each of the two grids provided. 

It is advisable to calibrate the grid for the low magnification range (grid 
marked with "L" for "Low magnification") using a 20x objective. 

In the phase calibration dialog the positioning of the camera is also optimized. 
To achieve optimum performance, the camera horizontal should be aligned 
parallel to the ApoTome grid lines with as much precision as possible. 

The calibration process is supported by a wizard. Start the function by 
selecting from the Acquisition menu the ApoTome function, and then 
Phase Calibration. 
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The software wizard guides you through the calibration process in 5 steps. 
The most important instructions are displayed in the wizard’s text field. 

Step 1: Select Start Conditions 

 

¾ Move the ApoTome slider to the iris position (click stop position 1). 

¾ Use the reflector position with the ApoTome bright-field reflector. 

¾ Place the mirror sample supplied under the microscope, open the 
reflected light shutter, and focus (directly on the microscope) on the 
reticle at the center of the sample. 

¾ Now switch to operation of the software on the PC. 

¾ In the software, enter settings for grid, reflector, and objective, if you 
have not already done so. Pay particular attention to ensuring that the 
grid is correctly selected. 

Note: 
• It is possible to use the ApoTome in combination with a Colibri, an 

excitation filter wheel, a Sutter DG-4 or DG-5 or a T.I.L.L. Photonics 
Polychrome V. In this case, carry out the relevant settings in addition to 
the microscope settings (grid, reflector, objective). 

¾ Click on Next to proceed to the next step. The live image is opened 
automatically. 
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Step 2: Optical Focusing 

 

¾ Set an optimum exposure time by clicking on the  button. 

¾ Display the reticle as sharply as possible in the live image. The green 
focusing rectangle in the live image can help you find the optimum focus 
position. Position the focusing rectangle over the center of the reticle. 

  

Notes: 
• On the Microscope property page you can enter general settings for the 

microscope. 

• Click on Next to proceed to the next step. 
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Move the ApoTome slider carefully to the second click stop position 
(ApoTome mode). 

¾ Move the focusing rectangle in the Live window to a position where no 
part of the reticle is present. 

  

¾ Click on the Full Scan button. The grid will now move through its 
adjustment range automatically, in increments of ten steps. A sharpness 
value for the reproduction of the grid will be determined, and displayed 
as a histogram, following each increment. When the end of the 
adjustment range has been reached, the grid position with the highest 
sharpness value will be set automatically. 
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¾ You can choose to carry out a fine adjustment around the grid position 
with the highest sharpness value by clicking on the Local Scan button. A 
local area above and below the sharpness maximum that has been 
identified will be covered automatically in individual steps, and the 
sharpness value will be determined for each individual step. The data 
from the local scan will be included in the histogram, and the grid 
position with the highest sharpness value will again be located 
automatically. 

  

Note: 
• You can determine the grid position freely using the buttons for coarse 

focusing,  and , and fine focusing,  and . You may 
need to use this function if, for example, a sharpness maximum cannot be 
determined automatically. 
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Step 4: Camera Alignment 

 

The purpose of this step is to achieve precise alignment of the camera. To 
achieve optimum results, the camera horizontal should be aligned parallel to 
the grid lines with as much precision as possible. The software automatically 
detects a grid line and calculates the camera horizontal’s deviation from this 
grid line in degrees. 

As the vertical line of the reticle interferes with the detection of the grid lines, 
please first move the reticle out of the camera’s field of view. 

A green rectangle marks the software’s search area, a yellow line indicates a 
detected grid line and a small dark-green rectangle shows you the starting 
point for line detection. 
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If the contrast in the image is insufficient to detect a grid line automatically, a 
corresponding error message appears: 

  

In this case you should take steps to increase the contrast (e.g. increase the 
exposure time, refocus the grid (step 3)). 

If it is still not possible to detect a grid line, a corresponding error message 
appears: 

  

In this case the deviation of the grid lines from the camera horizontal is 
probably too great. Rotate the camera until the long side of the camera's field 
of view is roughly parallel to the grid lines. To do this, loosen the 
corresponding lock on the camera adapter and realign the camera. 

If a grid line can be detected but the deviation is still greater than 5 °, you will 
see a message to this effect: 
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In this case, rotate the camera further to minimize the deviation. For fine 
adjustment you can use the red bar in the dialog. Try to achieve a deviation < 
0.1 °. 

  

Once the camera has been aligned with sufficient precision, please lock the 
camera adapter in this position. 

Notes: 
• If you change the ApoTome grid, the new grid should be inserted with 

the same alignment, if possible. The grid mount in the ApoTome slider 
has a small amount of play to make it as simple as possible to change the 
grid. You should always align the grid, if possible, with the same edges in 
the grid mount. If you wish to check the camera alignment following a 
change of grid, you can run through the phase calibration dialog up to 
step 4. Should you not wish to perform a new phase calibration, cancel 
the dialog after step 4, once the camera has been aligned. 

Step 5: Final Full-Phase Calibration 

 

This step is used for the actual setting of the scanner calibration. In each case, 
two images are acquired. The grid is displaced by precisely the width of a line 
between the first and second image. The two images are subtracted from 
each other, and the resulting image is displayed. If the system is perfectly 
calibrated, the two images cancel each other out – a black image with a noise 
component is shown. 
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Phase calibration is performed automatically in accordance with the focus 
calibration of the grid, carried out in the preceding step. 

¾ Click on the Full Scan button. A predefined area around the specified 
phase calibration value will be covered in coarse steps. At each position, 
the calibration value will be determined, and displayed in the histogram. 
When the end of the area has been reached, the minimum value 
(minimum number of residual lines present in the image) will 
automatically be selected in the histogram. 

  

¾ You can choose to perform an additional fine adjustment using the Local 
Scan button. An area close to the minimum on either side will be covered 
in individual steps, and the data included in the histogram. This may 
enable you to identify an even lower minimum, where there are even 
fewer residual lines in the image. 
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Notes: 
• Optional you can change the phase value stepwise by clicking on the 

buttons    and   . You may need to use 
this function if, for example, a sharpness maximum cannot be determined 
automatically. 

• Click on the Close button to end the phase calibration. 

• Repeat the procedure to calibrate the phase shift for the second grid, if 
necessary. 

• Although the settings do not change once calibration has been 
performed, from time to time you should check that the system is 
perfectly calibrated. This applies in particular after dismantling and 
reassembling the system. 

`~äáÄê~íáçå=çÑ=íÜÉ=ÖêáÇ=ÑçÅìë=

For the ApoTome to function optimally, the grid must be displayed precisely in 
the focus set on the objective. The grid’s focus depends on the objective and 
the excitation and emission wavelengths of the fluorescence. This means that 
the grid focus needs to be calibrated for every fluorescent dye (e.g. DAPI, 
FITC, Rhodamine etc.). It is best to perform calibration using your own 
fluorescence sample, although this must exhibit flat fluorescence to allow the 
focusing of the grid. Alternatively, you can also use the fluorescence sample 
provided. 

A wizard is available for the calibration of the grid focus. This guides you 
through the calibration process in 3 steps. Start the function by selecting from 
the Acquisition menu the ApoTome function, and then Grid Focus 
Calibration.  

The most important instructions are displayed in the wizard’s text field. 
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Step 1: Select Start Conditions 

 

¾ Move the ApoTome slider to the iris position (click stop position 1). 

¾ Use a reflector position with a fluorescence filter (e.g. 10 Ex. 470/40). 

¾ Place the fluorescence sample under the microscope, and open the 
reflected light shutter. 

¾ Focus on the sample on the microscope. 

¾ Switch to operation of the software on the PC. 

¾ In the wizard, select the settings for Grid, Reflector and Objective, if 
you have not already done so. 

Notes: 
• Make sure that the correct transmission grid is selected for the objective 

being used. The table at the end of this chapter provides an overview 
explaining which transmission grid should be assigned to which objective. 

• It is possible to use the ApoTome in combination with a Colibri, an 
excitation filter wheel, a Sutter DG-4 or DG-5 or a T.I.L.L. Photonics 
Polychrome V. In this case, carry out the relevant settings in addition to 
the microscope settings (grid, reflector, objective). 

• Click on Next to proceed to the next step. The live image is opened 
automatically. 
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¾ Set an optimum exposure time by clicking on the  button. 

¾ Focus the sample as sharply as possible in the live image. 

Note: 
• On the Microscope property page you can enter general settings for the 

microscope. 

¾ Click on Next to proceed to the next step. 

píÉé=PW=dêáÇ=cçÅìëáåÖ=

 

¾ Move the ApoTome slider carefully to the second click stop position 
(ApoTome mode). 

¾ Move the focusing rectangle in the live window to a position where the 
fluorescence is as flat and bright as possible. 
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¾ Click on the Full Scan button. The grid will now move through its 
adjustment range automatically, in increments of ten steps. A sharpness 
value for the reproduction of the grid will be determined, and displayed 
as a histogram, following each increment. When the end of the 
adjustment range has been reached, the grid position with the highest 
sharpness value will be set automatically. 

 

¾ You can choose to carry out a fine adjustment around the grid position 
with the highest sharpness value by clicking on the Local Scan button. A 
local area above and below the sharpness maximum that has been 
identified will be covered automatically in individual steps, and the 
sharpness value will be determined for each individual step. 

The data from the local scan will be included in the histogram, and the grid 
position with the highest sharpness value will again be located automatically. 

 

Note: 
• You can determine the grid position freely using the buttons for coarse 

focusing,  and , and fine focusing,  and . You may 
need to use this function if, for example, a sharpness maximum cannot be 
determined automatically.  

9-22 M 60-3-0024 e / printed 06.2010 



Modules  - ApoTome 

¾ When you click on Close to end the calibration, the following dialog 
window is displayed: 

  

¾ Click Yes, if you want to carry out a further calibration, or click No if you 
want to end the calibration. 

Once calibration is complete, a corresponding message is displayed in the 
status window of the ApoTome dialog window (Acquisition menu ⇒ 
ApoTome function ⇒ ApoTome Dialog ⇒ Settings). 

`~äáÄê~íáçå=ãçÇÉ=

There are two possibilities for managing ApoTome calibration data: 

� User mode (conventional): An individual file containing the calibration 
data is generated in each Windows user account, i.e. each user generates 
his own calibrations and then works with these. Other users do not have 
access to these data. In this case, the file containing the calibration data 
can be found in the My Documents folder of the user account in question 
under My Documents\Carl Zeiss\Data\ApotomeSetting\Default.ini". 

� Administrator mode: A user generates calibration data which are then 
made available to all other users. In this case, only the user who has 
generated calibrations in the ApoTome administrator mode is able to 
change these or add to them. The file containing the calibration data can 
be found in the folder Shared Documents\Carl 
Zeiss\Data\ApotomeSetting\Default.ini. 
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The user mode is activated automatically following a new installation of 
AxioVision. If you want to change the mode, open the calibration mode 
dialog (Acquisition menu ⇒ ApoTome function ⇒ Calibration mode): 

  

The administrator mode is password-protected. The default password is 
"zeiss" and can be replaced by a password of your choice following the first 
log in. 
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Once administrator mode has been activated, all users are only able to access 
the calibrations that can be found in the shared files. However, any individual 
calibrations that have previously been generated remain in the relevant user 
accounts (although they cannot be used). If you switch back from the 
administrator mode to the user mode, the file containing the calibration data 
that has been saved in the shared files will be copied to the Windows user 
account of the ApoTome administrator. Users of other Windows accounts can 
then use their old calibrations again or may have to generate new calibrations. 

fã~ÖÉ=~Åèìáëáíáçå=

As an ApoTome imaging system works with a digital CCD camera, the 
ApoTome mode can be regarded as an expansion of the camera’s 
functionality. 

pÉäÉÅíáåÖ=íÜÉ=Å~ãÉê~=

In principle, a cooled monochrome CCD camera (AxioCam MRm, AxioCam 
HRm etc.) is used in combination with the ApoTome for fluorescence images.  
When you start AxioVision, a monochrome camera is automatically selected (if 
possible) for operation with the ApoTome. 

If several monochrome cameras are connected to the system, you need to 
define the one that you want to be used in ApoTome mode. To select the 
camera, follow the procedure below: 

¾ Click on ApoTome in the work area or open the ApoTome dialog  
(Acquisition menu ⇒ ApoTome function ⇒ ApoTome Dialog). Select 
the Extras property page 

¾ In the ApoTome: Camera drop-down field, select the camera that you 
want to use in ApoTome mode. 
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For single image acquisition, follow the procedure below: 

¾ For efficient operation, open the control elements for the camera 
exposure time (Acquisition menu ⇒ Adjust function ⇒ Exposure), the 
shutter and the reflector (Microscope menu ⇒ Reflected Light function 
⇒ Reflector or Internal Shutter). 

¾ Make sure that the ApoTome slider is in the second click stop position 
(ApoTome mode). 

¾ Click on ApoTome in the work area or open the ApoTome dialog  
(Acquisition menu ⇒ ApoTome function ⇒ ApoTome Dialog ⇒ 
Settings property page). 

¾ Make sure that in the ApoTome: Grid field the grid that is currently 
inserted has been selected. On the basis of the objective that is currently 
being used, a recommended grid will also be displayed in this field.  

¾ Select the Camera property page.  

The live image is opened using the  button on the toolbar. The shutter is 
opened automatically with the live image. 

¾ Click on the  button to set an optimum exposure time for 
the specimen. To achieve optimum results with the ApoTome, the images 
should be illuminated in the best possible way. Full use should be made of 
the camera’s dynamic range. However, no pixels should be overexposed. 
The histogram displayed will help you achieve optimum illumination. 
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Various settings can be made for the ApoTome mode. Three settings are 
available for the live image in ApoTome mode (Settings property page in the 
ApoTome dialog). 

  

Grid Visible: The behavior of the live image is the same as in conventional 
camera mode. No processing takes place. As the grid is located in the beam 
path, it is also visible in the live image. The grid is moved up and down 
constantly, to prevent grid lines being "burnt" into the sample as a result of 
the bleaching effects of the fluorescent dye. 

Optical Sectioning: In this mode three images are acquired, combined online 
into an optical section, and displayed. As this mode requires the acquisition of 
three raw images, the speed of the live image is reduced accordingly. 

Note: 
• In this mode, if you change the focus on the microscope or the position 

of the sample, artifacts, in the form of lines, may appear in the live image 
for a short time. The same effect can occur if vibrations are passed on to 
the microscope. The lines disappear from the live image as soon as the 
sample is stabilized again. 

Conventional Fluorescence: In this mode two raw images are acquired, and 
the grid position is displaced in each case by precisely the width of the lines. 
From these two raw images, an image that corresponds to the conventional 
fluorescence image (wide field) can be calculated. This mode enables you to 
make comparisons between the conventional fluorescence image and the 
optical section. 
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Image acquisition is triggered using the  button on the toolbar. 

Four settings are available for image acquisition in ApoTome mode (Settings 
property page in the ApoTome dialog). 

¾ No Processing: The behavior of image acquisition is the same as in 
conventional camera mode. No processing takes place. As the grid is 
located in the beam path, but is moved constantly up and down, the 
image acquired corresponds to a conventional fluorescence image. This 
setting is only used if you are carrying out automated image acquisition in 
several channels, and processing needs to be switched off, e.g. to acquire 
a transmitted light or a phase contrast image. 

¾ Optical Sectioning: In this mode three images are acquired, combined 
online into an optical section, and displayed. 

¾ Conventional Fluorescence: In this mode two raw images are acquired, 
and the grid position is displaced in each case by precisely the width of 
the lines. From these two raw images, an image that corresponds to the 
conventional fluorescence image (wide field) can be calculated. This mode 
enables you to make comparisons between the conventional fluorescence 
image and the optical section. 

¾ Raw Data Mode: In this mode the raw image acquisition data are saved 
(i.e. the individual images with the various grid positions are saved 
internally). The advantage of this mode is that it allows you to switch 
between the algorithms (Optical Sectioning versus Conventianal 
Fluorescence) after image acquisition: 

• To do this, open the shortcut menu for the acquired image by clicking 
on the Properties icon at the bottom edge of the image. screen 
Alternatively, you can also open the shortcut menu by right-clicking in 
the acquired image. 
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ApoTome Image property page: 

  

¾ Click on the WF (Widefield = Conventional Fluorescence) or SEC 
(Section = Optical Sectioning) buttons to switch between the 
corresponding algorithms. The filter used to remove residual lines in the 
image (Filter drop-down list box) and the display scaling (Auto Display 
Scaling) can also be adjusted. The application of the algorithm takes 
place purely in the display plane of the image data and does not change 
the original raw data. 

Note: 
• In order to process ApoTome data in AxioVision using the 3D 

Deconvolution module, you must acquire the image in the Raw Data 
Mode. 

Acquiring images in the Raw Data Mode substantially increases the memory 
required for the image data. In the Averaging default setting, for example, it 
is increased by a factor of 3 in comparison to an image acquired with 
ApoTome in the Conventional Fluorescence or Optical Sectioning modes. 
If the Averaging value is increased by 2 or 3, the resulting memory 
requirement increases by a factor of 6 or 9. We therefore recommend that 
you use the SIMConvert function to convert the raw data to an optical 
section or a conventional fluorescence image, thereby substantially reducing 
the data volume again (e.g. after using 3D Deconvolution or for 3D 
reconstruction of an image stack using the Inside 4D module.) 
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The thickness of the Optical Section can be displayed in the Depth Info field 
on the Extras property page. 

  

Notes: 
• Depending on the sample, fluorescent dye, exposure time etc., fine 

residual lines may be visible in the resulting image in ApoTome mode. 
These lines can be removed using the filter. You can select Off, Weak, 
Medium and Strong. 

• The residual lines are displayed in the Fourier space as points along a 
vertical line. The filter "removes" a defined group of points from the 
Fourier spectrum. 

Start with the setting Weak. If residual lines can still be identified in the 
image, increase the setting step by step. As the filter is used during the 
calculation of the optical section, a new image must be acquired whenever 
changes are made to the filter setting. 

A further increase in image quality can be achieved if you use a value of 2 or 
higher in the Averaging field. 

  

If you use the value 2, for example, two ApoTome images are acquired and 
averaged. This method significantly reduces the noise component. An 
additional effect is the reduction or removal of residual lines in the image. 
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The ApoTome functions are fully integrated into AxioVision’s automatic image 
acquisition modes. You can perform acquisition of multichannel fluorescence 
images, z-stack images, time lapse images, MosaiX and any combination of 
these modes using the ApoTome. The images are acquired in accordance with 
the settings made under Acquisition menu ⇒ ApoTome function ⇒ 
Acquisition Mode. A precise description of the Multidimensional Acquisition 
functionality can be found in section "Multidimensional Acquisition". 

A prerequisite for the above is calibration of the system as described in 
chapter 8 under the headings "Configuration" and "Scalings". Essentially, for 
multidimensional acquisition the same functions as those described in the 
previous sections apply. 

If, during multichannel image acquisition, components that are responsible for 
the fluorescence wavelength being used are operated automatically, for 
example, a focus calibration must be available for each combination. The 
crucial components are: 

� Reflector nosepiece 
� Colibri 
� External excitation filter wheel (e.g. Ludl, Sutter) 
� Sutter DG-4 or DG-5 
� T.I.L.L. Photonics Polychrome V 

If a grid focus calibration is not available for a combination of the above 
external components, a single image is acquired automatically without any 
shifting of the grid. This artifact is usually easy to identify as an image with 
clearly pronounced fringes. For better control of image acquisition, open the 
ApoTome: Status window (Acquisition menu ⇒ ApoTome ⇒ Status 
function). This window will inform you if, during multidimensional image 
acquisition, a microscope status is set for which no ApoTome focus calibration 
is available. 

AxioVision User's Guide, Release 4.8.2 9-31 



Modules  - ApoTome 

^ÅÅÉäÉê~íÉÇ=áã~ÖÉ=~Åèìáëáíáçå=ïáíÜ=íÜÉ=^éçqçãÉ=
EÄìêëí=ãçÇÉF=

With the ApoTome, the speed of image acquisition (image rate) is limited by 
the following: 

1. At least three raw images have to be acquired for a resulting image. 

2. During image acquisition, as much as possible of the gray-value range of 
the camera in question should be used. This generally results in exposure 
times that prevent high acquisition speeds from being achieved. 

However, provided that acquisition takes place in one fluorescence channel 
only, it is possible to increase the image acquisition rate to a value in the 
region of 4 to 5 images/s. To achieve these values, follow the procedure 
below: 

¾ Open the ApoTome: Status window (Acquisition menu ⇒ ApoTome 
⇒ Status function). 

¾ In the ApoTome Dialog on the Camera property page, set a frame that 
is as small as possible (e.g. 512 x 512 pixels or smaller). 

Tip: 
If your requirements with regard to optical resolution allow, you can 
increase the binning on the camera to 2x2 (Camera work area⇒ Frame 
property page). This function makes it possible to reduce the camera’s 
exposure time by around a factor of 4, at the expense of the resolution in 
the image. 
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¾ For the ApoTome: Acquisition Mode, select the Raw Date Mode 
setting (ApoTome property page ⇒ Settings property page).  

  

¾ In the work area, select the Multidimensional Acquisition entry and 
then the C (Channels) property page. 

¾ Make sure that no Hardware Settings has been selected for the During 
Acquisition and After Acquisition drop-down list boxes. 

  

¾ Determine an optimum exposure time by clicking on the 

button. A pop-up window containing a live image opens. 

Confirm the exposure time by clicking on . If necessary, the 
measured exposure time can be reduced manually by around 10 to 20%. 
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¾ Select the T (Time) property page and activate the 
 check box. 

¾ Set the Interval Settings to Maximal Speed or alternatively the 
Interval to 0. 

 

¾ In the Duration Settings field, define either the number of cycles 
# Cycles (e.g. 50) or the Duration.(e.g. 15s). 

 

¾ Click on the button to start acquisition of the image sequence. 
In the ApoTome Status dialog the message Calibrated Burst Mode: 
ON is displayed. 

In this mode the image data are acquired as quickly as possible, with the 
grid being constantly shifted. The optical sections are only calculated after 
acquisition (and following a staggered pattern, i.e. the last 3, 6, 9 raw 
images etc.), according to the setting of the ApoTome‘s Averaging 
function, with different grid positions. 

This technique increases the image rate by around a factor of 3, but not 
the temporal resolution, as rapidly moving particles on the sample can 
nevertheless lead to movement artifacts in the resulting image due to the 
exposure times selected during the acquisition of the raw data. 
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The image view (Optional Sectioning / Conventional Fluorescence) 
can be switched at any time, on the basis of the raw data acquired. The 
corresponding settings are made on the ApoTome property page in the 
shortcut menu of the acquired image.  

Notes 
• A further slight increase in acquisition speed can be achieved by 

deactivating the Show preview at Start check box in the 
Multidimensional Acquisition work area ⇒ Experiment property 
page. 

 

lÄàÉÅíáîÉ=Ó=ÖêáÇ=~ääçÅ~íáçå=

The following tables provide an overview of the allocation of grids to 
objectives. 

Axio Imager 

Objective V NA Immersion DAPI 
recom. 

grid 

optical section 
thickness @ 490 nm 

(RU/µm) 
EC-Plan-Neofluar 
10x/0,3 10 0.3 Air 9 L1 1.01 / 11.04 
EC-Plan-Neofluar 
20x/0,5 20 0.5 Air 9 M 1.03 / 4.05 
EC-Plan-Neofluar 
40x/0.75 40 0.75 Air 9 H1 1.09 / 1.89 
EC-Plan-Neofluar 
40x/1,3 Oil  40 1.3 Oil 9 M 1.07 / 0.94 
EC-Plan-Neofluar 
63x/0.95 Korr 63 0.95 Air 8 H1 0.7 / 0.76 
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EC-Plan-Neofluar 
63x/1,25 Oil  63 1.25 Oil 9 H1 1.08 / 1.03 
EC Plan-Neofluar 
100x/1,3 Oil 100 1.3 Oil 8 H1 0.71 / 0.63 
       
LCI Plan-Neofluar 
25x/0,8 Imm. Korr. 25 0.8 

Oil, water 
or glycerine 9 L1 0.88 / 1.35 

LCI Plan-Neofluar 
63x/1.3 Imm. Korr. 63 1.3 

water or 
glycerine 9 H1 1.08 / 0.96 

       
Plan-Apochromat 
10x/0,45 10 0.45 Air 9 L1 1.45 / 6.88 
Plan-Apochromat 
20x/0,8 20 0.8 Air 9 L1 1.08 / 1.65 
Plan-Apochromat 
40x/0.95 Korr 40 0.95 Air 9 H1 1.07 / 1.16 
Plan-Apochromat 
40x/1.0 Oil 40 1.0 Oil 9 H1 0.85 / 0.84 
Plan-Apochromat 
40x/1.3 Oil 40 1.3 Oil 9 M 1.07 / 0.94 
Plan-Apochromat 
63x/1.0 W 63 1.0 water 9 H1 0.93 / 1.22 
Plan-Apochromat 
63x/1,4 Oil  63 1.4 Oil 9 H1 1.06 / 0.81 
Plan-Apochromat 
100x/1,4 Oil  100 1.4 Oil 9 H1 0.7 / 0.53 
       
LD-LCI-Plan-
Apochromat 25x/0.8 25 0.8 

Oil, water 
or glycerine 9 L1 0.88 / 1.35 

       
C-Apochromat 
10x/0,45 W  10 0.45 water 9 L1 1.42 / 6.88 
C-Apochromat 
40x/1,2 W  40 1.2 water 9 M 0.94 / 0.85 
C-Apochromat 
63x/1,2 W  63 1.2 water 9 H1 0.95 / 0.86 
       
LD C-Apochromat 
40x/1.1 W 40 1.1 water 9 M 0.94 / 1.02 
       
alpha Plan-Fluar 
100x/1.45 oil 100 1.45 Oil 8 H1 0.67 / 0.48 
alpha Plan-
Apochromat 
100x/1,46 Oil 100 1.46 Oil 8 H1 0.67 / 0.47 
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Axio Observer / Axiovert 200 

Objective V NA Immersion DAPI 
recom. 

grid 

optical section 
thickness @ 490 nm 

(RU/µm) 
EC-Plan-Neofluar 
10x/0,3 10 0.3 Air 9 VL 0.90 / 9.81 
EC-Plan-Neofluar 
20x/0,5 20 0.5 Air 9 VH 1.37 / 5.36 
EC-Plan-Neofluar 
40x/0.75 40 0.75 Air 9 VH 0.93 / 0.90 
EC-Plan-Neofluar 
40x/1,3 Oil  40 1.3 Oil 9 VL 0.75 / 0.66 
EC-Plan-Neofluar 
63x/0.95 Korr 63 0.95 Air 8 VD 0.82 / 0.89 
EC-Plan-Neofluar 
63x/1,25 Oil  63 1.25 Oil 9 VH 0.93 / 0.89 
EC Plan-Neofluar 
100x/1,3 Oil 100 1.3 Oil 8 VD 0.83 / 0.73 

       
LCI Plan-Neofluar 
25x/0,8 Imm. Korr. 25 0.8 

Oil, water or 
glycerine 9 VL 0.78 / 1.20 

LCI Plan-Neofluar 
63x/1.3 Imm. Korr. 63 1.3 

water or 
glycerine 9 VH 0.93 / 0.82 

Plan-Apochromat 
10x/0,45 10 0.45 Air 9 VL 1.26 / 6.09 
Plan-Apochromat 
20x/0,8 20 0.8 Air 9 VL 0.95 / 1.46 
Plan-Apochromat 
40x/0.95 Korr 40 0.95 Air 9 VH 0.92 / 0.99 
Plan-Apochromat 
40x/1.0 Oil 40 1.0 Oil 9 VH 1.28 / 1.91 
Plan-Apochromat 
40x/1.3 Oil 40 1.3 Oil 9 VL 0.75 / 0.66 
Plan-Apochromat 
63x/1.0 W 63 1.0 water 9 VD 1.09 / 1.42 
Plan-Apochromat 
63x/1,4 Oil  63 1.4 Oil 9 VH 0.91 / 0.69 
Plan-Apochromat 
100x/1,4 Oil  100 1.4 Oil 9 VD 0.81 / 0.62 

       
LD-LCI-Plan-Apochromat 
25x/0.8 25 0.8 

Oil, water or 
glycerine 9 VL 0.78 / 1.20 

       
C-Apochromat 10x/0,45 
W  10 0.45 water 9 VL 1.26 / 6.09 

C-Apochromat 40x/1,2 W 40 1.2 water 9 VH 1.25 / 1.13 

C-Apochromat 63x/1,2 W 63 1.2 water 9 VH 0.82 / 0.74 
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LD C-Apochromat 
40x/1.1 W 40 1.1 water 9 VH 1.25 / 1.35 

       
alpha Plan-Fluar 
100x/1.45 Oil 100 1.45 Oil 8 VD 0.79 / 0.56 
alpha Plan-Apochromat 
100x/1,46 Oil 100 1.46 Oil 8 VD 0.78 / 0.54 
 
Axioplan 2 imaging e 

Objective V NA Immersion DAPI 
recom. 

grid 

optical section 
thickness @ 490 nm 

(RU/µm) 
EC-Plan-Neofluar 
10x/0,3 10 0.3 Air 9 PL 0.95 / 10.30 
EC-Plan-Neofluar 
20x/0,5 20 0.5 Air 9 PL 0.77 / 3.02 
EC-Plan-Neofluar 
40x/0.75 40 0.75 Air 8 PH 0.98 / 1.71 
EC-Plan-Neofluar 
40x/1,3 Oil  40 1.3 Oil 9 PL 0.79 / 0.70 
EC-Plan-Neofluar 
63x/0.95 Korr 63 0.95 Air 8 PH 0.64 / 0.69 
EC-Plan-Neofluar 
63x/1,25 Oil  63 1.25 Oil 9 PH 0.98 / 0.93 
EC Plan-Neofluar 
100x/1,3 Oil 100 1.3 Oil 8 PH 0.65 / 0.57 

       
LCI Plan-Neofluar 
25x/0,8 Imm. Korr. 25 0.8 

Oil, water or 
glycerine 9 PL 0.82 / 1.26 

LCI Plan-Neofluar 
63x/1.3 Imm. Korr. 63 1.3 

water or 
glycerine 9 PH 0.98 / 0.86 

       
Plan-Apochromat 
10x/0,45 10 0.45 Air 9 PL 1.32 / 6.40 
Plan-Apochromat 
20x/0,8 20 0.8 Air 9 PL 1.00 / 1.54 
Plan-Apochromat 
40x/0.95 Korr 40 0.95 Air 9 PH 0.96 / 1.05 
Plan-Apochromat 
40x/1.0 Oil 40 1.0 Oil 9 PH 0.77 / 0.76 
Plan-Apochromat 
40x/1.3 Oil 40 1.3 Oil 9 PL 0.79 / 0.70 
Plan-Apochromat 
63x/1.0 W 63 1.0 water 9 PH 0.85 / 1.10 
Plan-Apochromat 
63x/1,4 Oil  63 1.4 Oil 9 PH 0.96 / 0.73 
Plan-Apochromat 
100x/1,4 Oil  100 1.4 Oil 9 PH 0.63 / 0.48 
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LD-LCI-Plan-Apochromat 
25x/0.8 25 0.8 

Oil, water or 
glycerine 9 PL 0.82 / 1.26 

       
C-Apochromat 10x/0,45 
W  10 0.45 water 9 PL 1.32 / 6.40 

C-Apochromat 40x/1,2 W 40 1.2 water 9 PH 1.31 / 1.19 

C-Apochromat 63x/1,2 W 63 1.2 water 9 PH 0.86 / 0.78 

       
LD C-Apochromat 
40x/1.1 W 40 1.1 water 9 PH 1.32 / 1.42 

       
alpha Plan-Fluar 
100x/1.45 oil 100 1.45 Oil 8   0.61 / 0.43 
alpha Plan-Apochromat 
100x/1,46 Oil 100 1.46 Oil 8   0.60 / 0.42 
 

líÜÉê=^éçqçãÉ=pÉííáåÖë=

In addition, the following control elements can be found on the Extras 
property page: 

ApoTome: Auto Shutter 

If Automatic Shutter Control is activated, the shutter is controlled 
automatically if 

1. the live image is opened or closed 
2. an image is acquired 

This function is useful in order to protect the sample against the bleaching of 
fluorescence and is activated as a default setting when the software is 
installed. 

ApoTome Display Normalization 

The algorithm used to calculate the optical section reduces the image’s gray 
value range. If the Display Normalization function is activated, the display 
characteristic curve is automatically adjusted to guarantee a bright, high-
contrast display of the gray values. This function is activated as a default 
setting when the software is installed. 
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ApoTome: Status 

This field displays status information relating to the ApoTome and image 
acquisition with the ApoTome. It makes sense to have this window open or to 
integrate it into your own customized dialogs so that any problems with the 
system can be analyzed quickly. 

`çåîÉêëáçå=çÑ=^éçqçãÉ=áã~ÖÉë=Ñêçã=ê~ï=Ç~í~=ãçÇÉ=

If you select the Raw Data Mode for image acquisition with the ApoTome, 
the size of the data is increased by a factor of 3, 6, 9 etc. in accordance with 
the settings under Averaging. If you are acquiring z-stack images, images in 
several fluorescence channels or time lapse images, this can lead to enormous 
volumes of data that can be difficult to work with during subsequent 
analyses. The SIMConvert function converts the raw data to an optical 
section or a conventional fluorescence image with a substantially reduced 
data volume. 

Use of this function is strongly recommended after you have acquired a z-
stack in Raw Data Mode and processed it using the AxioVision 3D 
Deconvolution module. 

To perform conversion, follow the procedure below: 

¾ Click on the ApoTome image that you want to convert. 

¾ Click on the ApoTome entry in the work area. 

¾ Open the function tree by clicking on screen in front of the ApoTome 
entry – click on SIMConvert. The parameters for the function are listed 
underneath the work area. 
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¾ Adopt the settings in the top Parameters field. The default settings 
ensure that the selected image is processed and a new image is created 
automatically (the original file is retained). The Enable channel selection 
check box should be deactivated, as generally all the channels in an image 
should be converted in the same way. 

Four parameters are available in the lower area of the property page for the 
actual conversion Combine Mode, Filter, Image Normalization und 
Display Normalization: 

¾ Combine Mode: This parameter determines the algorithm used to 
convert the image. You can select from Conventional Fluorescence or 
Optical Sectioning. 

¾ Filter: Depending on the sample, fluorescent dye, exposure time etc., fine 
residual lines may be visible in the image that results from the conversion. 
These lines can be removed using the filter. The options Off, Weak, 
Medium and Strong are available. 

The filter function makes use of the fact that the residual lines are 
displayed in the Fourier space as points along a vertical line. The filter 
"removes" a defined group of points from the Fourier spectrum, thereby 
removing the residual lines. 
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¾ Display Normalization: The algorithm used to calculate the Optional 
Sectioning reduces the gray value range of the image data, depending 
on the specimen and the acquisition conditions. The On functional 
parameter automatically sets the image‘s display characteristic curve so 
that a bright, high-contrast image is displayed. The Min/Max function of 
the display characteristic curve is used, which sets the display 
characteristic curve on the basis of the darkest and brightest gray value in 
the image histogram. If a z-stack is converted, the image plane that is 
currently set in the active image is used to determine the Min/Max value 
for the entire image stack. 

¾ Image Normalization: As described under "Display Normalization", the 
algorithm used to calculate the Optional Sectioning reduces the gray 
value range of the image data, depending on the specimen and the 
acquisition conditions. As the so-called floating point format is used for 
raw data acquisition with the ApoTome and the subsequent combination 
of the gray value data, during the conversion from floating point back to 
gray value, a normalization function can be applied directly to the data to 
display a bright, high-contrast image. The On parameter activates this 
form of normalization.  

Note: 
• If Image Normalization is switched on, Display Normalization is no 

longer necessary, as the result of both functions has the same effect for 
the user. For the conversion of a z-stack, the Image Normalization 
function offers advantages, as the gray value distribution of all image 
planes can be taken into account. 
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By activating the HDR Mode, images with an expanded dynamic range can 
also be acquired in ApoTome mode. For further details, please refer to the 
description of HDR Snap and the AxioVision manual. 

If the ApoTome is operated in HDR Mode, the corresponding number of 
images will be acquired for each grid position with various exposure times 
and, from this, an HDR image will be calculated for each grid position. The 
ApoTome calculation will then be performed on these three HDR images. This 
will ultimately result in an optical section with an expanded dynamic range. 

Because in the HDR Mode several images are acquired with very long 
exposure times, residual fringes may occur in the ApoTome optical section as 
a result of bleaching effects. In this case, it is necessary to use the ApoTome 
filters in order to suppress the residual fringes. 

The additional time required for calculating the HDR image can lead to delays 
in the displaying of the preview when multidimensional images are acquired. 
In this case, the preview should be deactivated. 
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Autofocus enables you to focus a sample automatically. To do this, you need 
a microscope with a motorized z-drive. Autofocus can be operated with all 
cameras that are available for use with AxioVision, with the exception of those 
that are only controlled via a TWAIN interface. You can use this functionality 
for the illumination methods reflected light, transmitted light, bright field and 
dark field, as well as fluorescence. 

Note: 
• The Autofocus functionality is not suitable for the contrasting methods 

Phase Contrast and DIC. 

To make it possible to focus samples automatically with the different 
microscopy procedures and at all possible magnifications, it is necessary to 
carry out calibration in advance on a sample which has been focused 
manually. The calibration requires information on the objective and optovar 
magnification, the numerical aperture of the objective being used, the 
illumination method and, if you are using a digital camera, the corresponding 
resolution. 

If all the components of your microscope are motorized, AxioVision 
determines these parameters automatically. Otherwise the missing calibration 
data have to be entered manually. 

Note: 
• We recommend that you recalibrate the system whenever microscope 

components have been changed. 
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Switch the light path to the camera. Open the live image window by clicking 

on the icon for the live image in the Standard toolbar . Alternatively, 
select the Live function in the Acquisition menu. 

¾ Now focus the camera image and select the frame to be acquired. 

`~äáÄê~íáçå=

¾ Select the Autofocus function in the Acquisition menu. 

¾ Activate the Settings property page. 

¾ Make sure that the settings for the 
type of Illumination, Objective, 
Optovar and live image speed match 
those on your system. 

 

Note: 
• The setting options depend on your system configuration and may differ 

from those shown here. 
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¾ Now activate the Calibration 
property page. 

¾ Check the settings for Microscope 
and Camera. 

Note: 
¾ If individual components are not 

encoded or motorized, you must 
enter the relevant information here 
using the keyboard. 

¾ Then click on New to create a new 
calibration with these settings. 

 

¾ Enter a name for the calibration and 
click on OK. 
The calibration process is now started 
automatically. 

 
rëáåÖ=^ìíçÑçÅìë=

The quickest and easiest way to use the Autofocus is to run it directly via the 
toolbar at the bottom of the live image window. 

If the results are unsatisfactory, you can make fine adjustments via the 
Autofocus property page. A detailed description of the parameters available 
there can be found in the online help. 
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Use of the Autofocus together with the other modules for image acquisition is 
described in the relevant sub-sections. 

Notes: 
• Before the Autofocus can be used, calibration must be carried out for the 

microscope and camera setting you are using. See the preceding chapter. 

• If problems arise during execution or if execution is not possible for 
certain reasons, please check the Autofocus function in the Acquisition 
menu. Activate the Focus tab and look under Status. There you will 
receive an indication as to why the execution process has failed. 

¾ Make sure that the Standard 
toolbar is displayed: right-click 
on the menu or any toolbar and 
activate Standard (there must 
be a tick in front of it). 

 

¾ Switch the light path to the 
camera. Then click on the icon 
for the live image in the 
Standard toolbar. 
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¾ If the tool bar of the live image 
window is not displayed, right-
click in the live image and 
activate the Live tool bar 
On/Off entry (there must be a 
tick in front of it). 

  

¾ Now select the frame to be 
acquired on the sample, and 
then click on the Autofocus 
button in the live image toolbar.  

¾ Now click on Snap to acquire an 
individual image. 
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Images with more than two dimensions cannot be acquired using your 
camera’s normal acquisition function. These kind of images may consist, for 
example, of several channels or a time lapse series. For these images 
AxioVision requires additional information, such as the number of channels, z-
planes etc. This collection of information is referred to within AxioVision as an 
"experiment". 

In the work area you will find Multidimensional Acquisition. If you click 
here the Experiment property page opens. The control elements for the 
modules Multichannel Fluorescence, Z-Stack, Mark&Find and Time Lapse 
appear here, depending on which modules you have purchased. 

The Experiment property page contains an overview of the modules that are 
installed and a selection of important control elements. From this page you 
can perform a wide range of functions to control, modify, save and execute a 
previously prepared experiment. 

On this page you can re-use settings of already acquired images via the Reuse 
function. 

Each module also has its own tab, on which the essential settings can be 
made. 

Notes: 
• Please note that you may not have access to all of the modules and 

functions described here. This depends on the options you have 
purchased. 

• For detailed information on the individual functions and commands, 
please refer to the online help (F1 key). 
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¾ In the work area click on Multidimensional Acquisition. 

  

¾ In the work area you will now see the Experiment property page. 
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Note: 
• Please bear in mind that the options listed here are only displayed if the 

corresponding modules are available. 

¾ In the Options field the dimensions for your experiment can be selected. 

  

¾ In the Experiment window the name of the current experiment is 
displayed. 

  

The default experiments name is "Default_Setting". The default name for 

an acquired image is . A serial number will 
be attached to this name after acquisition. You can specify the basic 
name for the acquired image here before acquisition. 

¾ Make the desired settings for your experiment and click on . 
A dialog is then opened. Save your new experiment. 

¾ Click on , select an experiment from the list of experiments 
and click on OK. 
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Once this experiment has been loaded, the settings it contains are 
adopted. 

¾ If you want to adopt these settings from a ZVI image that has already 

been saved, click on , select the desired image, and confirm 
with OK. Only the acquisition settings used for this image are adopted. 
The image itself is not loaded. This function makes it easier for you to 
acquire images under reproducible conditions. 

¾ To execute the experiment, click on . 
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With the Multichannel Fluorescence module you can define up to 8 channels 
to be used for acquisition. These channels are saved together in a ZVI 
document. This allows you, for example, to switch quickly back and forth 
between the various views to compare different channels. 

Notes: 
• Please note that you may not have access to all of the modules and 

functions described here. This depends on the options you have 
purchased. 

• For detailed information on the individual functions and commands, 
please refer to the online help (F1 key). 

eçï=Çç=f=ÅêÉ~íÉ=~=ãìäíáÅÜ~ååÉä=ÉñéÉêáãÉåí\=

In the following example a 3 channel fluorescence image should be 
generated. The channels should be configured for the fluorochromes 
Rhodamine, FITC and DAPI. Please use a test sample to test the settings. 

Notes: 
• The following instructions require use of a motorized microscope. 

• You should also be able to generate, edit and apply settings in the 
Settings Editor and should already have generated channel-specific 
settings (see chapter 8 "Configuration" - "Settings Editor"). The 
hardware components available to you may differ from those shown in 
this example. 

¾ In the Workarea activate the property pages under Multidimensional 
Acquisition: 
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¾ Go to the C property page . To generate various channels, you 
need to enter the channel-specific parameters here.  

¾ From the Dye field select the Rhodamine fluorochrome. 
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Once the dye has been selected, a suggested channel color with 
wavelengths for excitation and emission maximums are assigned to the 
channel. 

¾ If you do not like the suggested color, you can change it (e.g. to 100% 
red) by making a selection from the list: 

  

¾ A channel name is automatically generated from the dye 

 but can be changed if needed, e.g. to reflect the 

type of exposure used . 

¾ Now allocate a hardware setting to the channel. To do this, select 
"Rhodamine.zvhs" from the list in the field During Acquisition:  

  

¾ You can test this setting by clicking on the  button. This opens the 
fluorescence shutter, and switches the reflector to the correct filter 
position. 
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¾ Repeat the procedure for the next field, and select the setting "shutter 
closed.zvhs". This ensures that the shutter is closed immediately after 

acquisition . 

¾ To determine the exposure time for the Rhodamine channel, click in the 

Exposure field and then click on the  button. The hardware 
settings you have selected are now applied to the microscope and a 
dialog is opened: 

  

¾ To set the correct exposure time, click on the  button and 

close the dialog by clicking on . The new exposure time is now 

entered and used for the channel ( ). 

¾ Add a new channel to your experiment. To do this, click in the Extended 

Channel Parameters dialog on . A copy of the channel 
you have already configured is then added to the experiment. 
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¾ Now change the settings that are relevant for the new channel (channel 
name, dye, hardware setting during acquisition, exposure time 
measurement): 

  

¾ Duplicate the second channel, and change it accordingly for the DAPI dye: 
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¾ You can add together up to 8 channels in this way. 

¾ You should now save the settings you have made as a new experiment 
(see above), so that you can use them again in the future. 

¾ To acquire your 3-channel image, click on . During acquisition 
a progress bar informs you about the procedure: 

  

¾ If you want to cancel the acquisition, click on Cancel. 
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The resulting image appears in the image area, where it can be operated 
using the player: 

  

This image has not been saved, as you can see from the * symbol in the 
image name. Save the image. The program remembers the last storage 
location that you searched for.  

eçï=Çç=f=ã~å~ÖÉ=ÅÜ~ååÉä=ëÉííáåÖë=EïçêâáåÖ=ïáíÜ=íÜÉ=
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Above you have seen how to configure channels for multichannel images and 
save them as an experiment. An experiment therefore contains settings that 
are specifically intended for that particular experiment. As time goes by you 
will find channel settings that can be applied in many different cases. You 
may also wish to combine channels from different experiments. The "channel 
pool" has been created for these kinds of requirement. These instructions 
describe how to work with the channel pool. 
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Note: 
• The following instructions require use of a motorized microscope. The 

hardware components available to you may differ from those shown in 
this example. You must also be able to generate, save and load 
experiments and have already created a multichannel experiment. 

¾ Load an available multichannel experiment. In this example a 3-channel 
experiment (Rhodamine/FITC/DAPI) is loaded. If you go to the Channel 
property page, you should see e.g. the following channel parameters: 
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¾ Select the Rhodamine channel: In the Channels field click on 

. 

¾ Repeat this for the other channels. 

¾ Now remove the channels from the experiment by clicking repeatedly on 

. The C (channel) property page should now only 
contain one channel. 

¾ Now click on the  button. The channel pool opens as a 
new dialog: 

  

The size of this dialog can be changed to give you sufficient space to 
work with the channel parameters. 
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¾ Now select the Rhodamine channel … 

  

and add it to the empty experiment by clicking on the  

button. Clicking on  the channel pool is closed and the 
channel now appears on the C property page: 

  

¾ To add another channel to the experiment, repeat the last steps. 

¾ In the channel pool you can also duplicate, modify or remove channels. 
To do this, select the desired channel and click on the corresponding 
button. 
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Using the Z-Stack module you can acquire series of images over a defined z-
focus range. The resulting image is known as a z-stack. These kinds of image 
are required for the calculation of three-dimensional displays. 

Z-stack images are essential for the 3D Deconvolution module. The ApoTome 
module benefits from z-stack images, as they can be used to generate 
impressive 3D images quickly. Using the Extended Focus module a sharp 
image can be calculated from a z-stack. 

The AxioVision module Z-Stack allows the easy determination of the correct z-
distance between individual images of a z-stack if the maximum of axial 
resolution of the objectives should be achieved. This optimum step size (also 
called the Nyquist criterion) is a function of the numerical aperture of the used 
objective and the recorded wavelength (in the case of fluorescence usually the 
emission maximum). It is calculated as follows: 

The axial resolution d is approximated from the following formula: 

  

At a given wavelength λ = 540 nm and a numerical aperture N.A. = 1.3 at a 
refractive index η of 1.52 daxial= 0.970 µm. According to Nyquist a twofold 
oversampling (approximately 485 nm between neighboring z-planes) all 
available information will be collected. This sampling rule is a prerequisite for 
reconstructing z-stacks with the module AxioVision 3D-Deconvolution. 

Notes: 
• Please note that you may not have access to all of the modules and 

functions described here. This depends on the options you have 
purchased. In order to follow this introduction, you need to know what 
an AxioVision "experiment" is. Please read the documentation on 
experiments in section "How do I create an experiment?". 

• For detailed information on the individual functions and commands, 
please refer to the online help (F1 key). 
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¾ In the work area activate the property page under Multidimensional 
Acquisition. 

   

¾ On the Experiment property page select the  (Z-Stack) function. 

¾ From the two possible definition modes select the Top/Bottom mode: 

  

9-64 M 60-3-0024 e / printed 06.2010 



Modules  - Multidimensional Acquisition 

¾ Click on the  button in the  control 
element. A dialog is opened that contains a live image and the control 
element for focusing. Please note that light will only fall on the sample if 
it has been directed onto the sample manually, or if a hardware setting 
have been configured for the selected channel. On the microscope, focus 
on the area where you want the z-stack to begin. To adopt this 
z-position, close the dialog by clicking on OK. The new z-position is then 
automatically adopted into the start field. 

¾ Repeat this procedure to determine the Stop position using the  

button from the  control area. 

¾ Now define the desired interval between the individual z-planes. You can 
enter any value here. To guarantee maximum resolution in the z-direction, 

click on the  button. 

¾ The correct value is calculated, taking into consideration the numerical 
aperture of the objective and the emission wavelength of the 
fluorochrome (this takes place automatically if a fluorochrome has been 
selected from the list). If no emission wavelength is stated, a wavelength 
of 500 nm is taken as a basis. 

¾ To check your selection, you can navigate through the z-stack using the 
z-stack navigation function. To do this, open a live image, and activate 
the hardware settings for the desired channel (e.g. on the channel page 

via the  button . 

¾ You can now position the focus drive at the upper  or lower  limit 

or the center  of the defined z-stack. 
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¾ If you are not satisfied with the definition of the z-stack, you can modify it 

step by step (with the set increment) using the  or  buttons. 

Adopt the new definition by clicking on the /  
buttons in the control area for z-stack settings. 

¾ Click on  to begin acquisition. During acquisition a progress bar 
informs you about the procedure: 

  

If you want to cancel acquisition, click on Cancel. 

¾ The resulting image appears in the image area, where it can be operated 
using the player. This image has not been saved, as you can see from the 
* symbol in the image name. Save the image. The program remembers 
the last storage location you have chosen. 
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The Time Lapse module can be used to acquire series of images over a defined 
period of time. The resulting image is a time lapse series. These kinds of image 
are required for time lapse acquisition of changing processes. 

Note: 
• Please note that you may not have access to all of the modules and 

functions described here. This depends on the options you have 
purchased. In order to follow this introduction, you need to know what 
an AxioVision "experiment" is. Please read the documentation on section 
"How do I create an experiment?". For detailed information on the 
individual functions and commands, please refer to the online help (F1 
key). 

eçï=Çç=f=ÅêÉ~íÉ=~=íáãÉ=ä~éëÉ=ëÉêáÉë\=

¾ In the work area activate the property pages under Multidimensional 
Acquisition. 
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¾ On the Experiment property page select the Time lapse function . 

¾ Enter the desired time interval, e.g. 2 minutes. The unit can be selected 
from the drop-down list box. 

¾ Now enter the desired number of images (# Cycles). The total duration of 
the experiment is calculated from this. 

¾ Alternatively, you can enter the interval and the total duration, and this 
information will be used to calculate the number of cycles. Select the 
function that you want to be calculated 

. 

¾ It is also possible to enter numerical values directly into the input fields. To 
calculate the dependent value, click on the 

 button. 

¾ Click on  to begin acquisition. During acquisition a progress bar 
informs you about the procedure: 

  

If you want to cancel acquisition, click on Cancel. 

¾ The resulting image appears in the image area, where it can be operated 
using the player. This image has not been saved, as you can see from the 
* symbol in the image name. Save the image. The program remembers 
the last storage location that you searched for. 
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The Mark&Find module allows you to acquire images of various positions on 
your sample, also in combination with the Multidimensional Acquisition 
modules. All the dimensions offered by AxioVision can also be used for a 
position list. The output images are saved automatically in a folder that you 
have defined, and from this a folder-based archive is generated. This makes it 
easy to manage the individual images. 

Notes: 
• Please note that you may not have access to all of the modules and 

functions. This depends on the options you have purchased. 

• In order to follow this introduction, it is useful to know what an 
AxioVision "experiment" is. You will find the relevant information in the 
“How do I create an experiment?“ section. 

• For detailed information on the individual functions and commands, 
please refer to the online help (F1 key). 
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¾ In the work area, activate the Multidimensional Acquisition function: 

  

¾ Select the Experiment property page and load an experiment. 
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¾ Select the  (Positionlist) tab sheet. 

  

¾ Open the Mark&Find dialog by clicking on the  button. 
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¾ Load a saved Mark&Find database from the list box 

• or define a new list by clicking on New/modify an existing list by 
selecting Edit (please read section 9.5 Mark&Find "How do I 
generate a Mark&Find list?", or call up the online help (F1 key)).  

 

The Mark&Find control element now shows a graphic display of the 
selected list. 

 c 
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Note: 
• The graphic will only have the expected appearance if both the reference 

point on the sample and the sample holder have been centered. Please 
read section 9.5 Mark&Find "How do I generate a Mark&Find list?", or 
consult the online help (F1 key). 

If you click on the Positions tab sheet, you will see a tabular display of the 
position list. 

  

¾ Close the dialog by clicking on . The Mark&Find control element now 
displays the number of positions and the name of the position list: 
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¾ Click on  to begin acquisition.  

During acquisition a progress bar informs you about the procedure:  

  

¾ If you want to cancel acquisition, click on .  

A preview containing acquisition parameters is also displayed: 
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At the end of the above procedure, a folder-based archive showing all output 
images is created. 

  

These can be loaded and handled in the same way as normal individual 
images. 

Note: 
• No images are displayed during the acquisition of a position list. To view 

the images, you need to exit the experiment. 
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The Extended Focus function is available as an optional module for 
AxioVision. This function enables you to display the sharp areas of different 
focus positions of your sample in a single image. 

Essentially, the Extended Focus module is operated interactively. You do not 
need a motorized microscope. Several images are acquired at different focus 
positions. The sharp areas are extracted from each of the images and 
automatically combined. You immediately obtain a sharp 2D image. The 
individual images of the different focus positions are not saved, but are 
combined straight away. The focus is driven manually across the entire z-
range until all the details have been displayed sharply. There are no 
specifications, recommendations or formulae that say how many images have 
to be acquired or how large the distance between two focus positions should 
be. This always depends on the sample in question. Generally speaking, it can 
be said that it is better to acquire too many images than too few. 

Alternatively, an image with extended depth of field can also be calculated 
using a z-stack. To do this, you need a z-stack image, the acquisition of which 
requires a motorized microscope and the Z-Stack module (see also section 9.8 
"Z-Stack Images"). 

^ÅèìáêáåÖ=áã~ÖÉë=ïáíÜ=bñíÉåÇÉÇ=cçÅìë=

The Extended Focus function can be run via the work area on the left of the 
AxioVision window. If the work area is not displayed, activate it using the 

Standard toolbar . 

Alternatively, select the Windows function in the View menu and then select 
the Workarea entry. 

Note: 
• The work area may be open but covered by the workflows. If that is the 

case, simply click on the Workarea tab at the bottom of the work area. 
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¾ Switch the light path to the camera. Open 
the live image window by clicking on the 
live image icon in the Standard toolbar. 
Alternatively, select the Live function in the 
Acquisition menu. 

 

¾ In the work area select the Acquisition  
entry in the Extended Focus section. 

 

¾ If you capture images with a Stereo 
microscope, select an appropriate value for 
Quality of alignment. This will correct the 
lateral shift which occurs when you are 
focusing through the specimen. 

¾ Select Wavelets as the Method for 
calculation. 

¾ Click the Interactive button to capture the 
single images by pressing the Ctrl key. 

 

Note: 
• As an alternative you can click the Start button to capture the images. 

¾ Press the Ctrl key to capture the first image 

¾ Now go to the next focus position. 

¾ Press the Ctrl key to acquire the next 
image. 
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Notes: 
• The image of the second focus position is now automatically combined 

with the first image. 

• You can now acquire further images until the result is satisfactory. 

rëáåÖ=òJëí~Åâ=áã~ÖÉë=Ñçê=bñíÉåÇÉÇ=cçÅìë=

¾ Activate the image to which 
you would like to apply the 
Extended Focus function. To 
do this, click on the image or 
select it via the tabs at the top 
of the document area. 

 

¾ Now select the Extended 
Focus (Computation from Z-
stack) function in the 
Processing menu. 

 

¾ The two thumbnails show the 
original image (left) and the 
resulting image (right). 

To select a specific frame, you 
can magnify, choose any frame 
from, or reduce the thumbnails. 
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¾ If the z-stack was acquired with 
a Stereo microscope, select an 
appropriate value for Quality 
of alignment. This will 
compensate the lateral shift 
which usually occurs during 
acquisition of the z-stack. 

¾ Select Wavelets as the 
Method for calculation. 

 

¾ Click on Apply to check the 
result. 

¾ Now click on Cancel to exit the 
function. 
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The Mark&Find module allows you to record the positions of an encoded or 
motorized x/y stage and relocate them in the future. 

Open the Mark&Find window using the Microscope ⇒ Mark And Find 
menu command. 

The recorded positions are saved in a database, which is able to store the 
position lists of several carriers. You can select the size of the carrier 
concerned. The following types are available: Petri dish, Slide/Dish holder, 
Multiple slides and Multiwell plates. 

The module supports slides with sizes of 76 mm x 24 mm, 76 mm x 50 mm, 
48 mm x 25 mm and 48 mm x 27 mm, or any user-defined size. Petri dishes 
can have a diameter of 35 mm, 60 mm or a user-defined diameter. Multiple-
slide plates are supported in a format with 8 slides per plate or may have a 
user-defined format. Multiwell plates are supported in formats with 6, 12, 24, 
48, 60, 96, 384 and 1536 wells per plate. 

To make it possible to display the recorded positions graphically, when you 
first use the module you will need to define the center of the carrier on the x/y 
stage. If you also want to work with your carriers and the recorded positions 
on other Carl Zeiss microscopes using AxioVision, you will need to work with 
absolute stage positions for each carrier (please also refer to “Microscope” in 
the online help (F1 key)). 

Note: 
• Many control elements in Mark&Find control both the microscope stage 

and the focus drive. If used incorrectly, damage can therefore be caused 
to objectives and/or carriers lying in the stage’s traveling range. 
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The following two examples explain how to define a Mark&Find position list 
for a slide (example 1) and a multiwell plate (example 2). The same procedure 
should be followed for other types of carrier, e.g. Petri dishes. 

bñ~ãéäÉ=NW=ëäáÇÉ=

In the following example, a new database is created and 3 positions on a 
standard slide are created and saved. The slide is centered to ensure that a 
correct graphic display of the positions is achieved. A reference point is also 
selected on the slide. In this example positions are only recorded in relation to 
the center of the slide. 

¾ Open the Mark&Find dialog using the Microscope ⇒ Mark And Find 
menu command: 
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¾ Select a database from the drop-down list box of slide/dish collections or 

create a new database. To do this, click on   in the left-hand field. The 
Manage carrier collections dialog is opened: 

  

¾ If you click on , a dialog is opened in which you can select a slide/dish 

collection file.  deletes the selected slide/dish collection. 

¾ opens another dialog where you can give the database a 

name.  allows you to change the name of the database. 

 saves your current database, whilst  deletes 
existing position lists and creates an empty database. In addition, 

 enables you to save the file in 

Excel format (.xls). Click on  or  to exit the dialog. 

¾ Now add a new slide to the database. To do this, click on the New icon 
in the Slide / dish holder field: 

  

9-82 M 60-3-0024 e / printed 06.2010 



Modules  - Mark&Find 

This opens the following dialog: 

  

¾ Give the new carrier a name, e.g. "Slide 2“. 
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¾ Select the standard slide from the Type drop-down list box: 

  

¾ It is also possible to import positions from a position list in a text 

document by clicking on . A position list to 
be imported should have the following structure, for example:  

Slide,,,, 
Name,Width,Height,, 
Slide,76000.00,24000.00,, 

 
Positions,,,, 
Comments,PositionX,PositionY,PositionZ,Color 
"Position(1)",-11058.36,-4043.66,1.00,Blue 
"Position(2)",-2382.21,5485.68,-1.55,Red 
"Position(3)",10049.20,-4067.70,-2.25,Green 
"Position(4)",3674.27,-1514.12,3.00,Yellow 

 
To ensure that Mark&Find is able to understand this document, it must be 
saved in the form of a CSV document (Comma Separated Values). This 
export option is available in Microsoft Excel, for example. 

9-84 M 60-3-0024 e / printed 06.2010 



Modules  - Mark&Find 

¾ Confirm your selection by clicking on . 

You will now see the new carrier as an entry in the list of carriers in the 
Mark&Find dialog: 

  

¾ Now insert the "home slide" (Carl Zeiss part number 453583) into the 
holder. The center of this slide is marked with a high degree of precision, 
and the slide has polished edges to ensure precise insertion into the 
holder. 

¾ Make sure that the control elements for stage control are displayed in the 
foreground: 

  

¾ Manually set the stage position to 0 by clicking on the  button. 

¾ Make sure that you are in the graphic view of Mark&Find: 
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¾ Define the center by clicking on the  button. The graphic display of 
the carrier should now be centered as follows: 

  

¾ The white cross indicates the current stage position (in relation to the 
optical axis of the microscope). 

¾ Remove the home slide and insert your carrier into the holder. Define a 
reference point on your carrier. This should be a conspicuous structure on 
your carrier that you will be able to find again easily in the future. If you 
do not set a reference point, all coordinates refer to the zero position of 
the motorized x/y stage. 

¾ Click on the  button. In the graphic view, a small gray cross indicates 
the current reference position. The coordinates are also displayed (in µm 
for the x, y and z axes): 
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This reference position can be automatically relocated at any time in the 

future by clicking on . 

Once these preparatory steps have been completed, you can locate and save 
any desired positions on your carrier. 

¾ To do this, move the stage to the desired position, bring the sample into 
focus (this is best done in the live image) and click on one of the colored 

icons . 

Repeat this procedure until you have defined all the positions of interest 
on your carrier. The selected positions are shown in the graphic as colored 
crosses. The white cross indicating the current stage position covers the 
current position, the name of which is also visible. 

    

 Position 1 Position 2 Position 3 

¾ These positions can be relocated. To do this, double-click on one of the 
positions: 
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The large white cross indicating the current stage position shows the 
movement of the stage as it travels to the new position: 

  

¾ Alternatively, if you click on , you can also have a number of positions 
generated automatically as a sample selection. Here you only need to 
define the number of positions in the x and y dimensions. Please note 
that any previously saved positions are lost. 

  

¾ Now go to the Positions property page:  

  

All defined positions are listed here in tabular form on the basis of the 
parameters Name, X, Y, Z, Color, Classification, Enabled and 
Position. 
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¾ Name: name of the position. If you click in the corresponding field, you 
have the option of changing this name. 

  

¾ X: the x-coordinate in μm. The value displayed can be changed manually. 
To do this, click in the number field and enter the desired value. 

¾ Y: the y-coordinate in μm. The value displayed can be changed manually. 
To do this, click in the number field and enter the desired value. 

¾ Z: the z-coordinate in μm. The value displayed can be changed manually. 
To do this, click in the number field and enter the desired value. 

¾ X: the x-coordinate in mm. The value displayed can be changed manually. 
To do this, click in the number field and enter the desired value. 

¾ Color: indicates the color used when the position was defined. The color 
can be changed with the help of the color selection dialog, which opens if 
you click in the field. 

¾ Classification: a number of different positions can be combined in the 
form of a group by assigning the same names to them. Change the name 
of the classification by clicking in the field. Division into groups allows you 
to sort position lists on the basis of specially defined conditions and travel 
to the positions they contain. 

¾ Enabled: indicates the activation status of a position. Only positions that 
are marked with a "*" symbol are used in the experiment. Click twice in 
the corresponding field to deselect the position via a check box, and to 
reselect it again as required. 

¾ Position: indicates the sequence in which the positions were originally 
created. 

AxioVision User's Guide, Release 4.8.2 9-89 



Modules  - Mark&Find 

It is possible to select several positions by making a multiple selection (Shift + 
mouse click) or by selecting them individually (Strg + mouse click). These 
positions can then be modified together. 

By double-clicking on the name of a parameter, you can sort the position list 
on the basis of that parameter. 

¾ Once you have selected a position, you can delete it by clicking on . 

¾ Clicking on   undoes an action, whilst  redoes an action that has 
previously been undone.  

¾ The selected position is located automatically by clicking on . 

¾ Clicking on  moves the stage to the previous position in the list, 

whilst clicking on  moves it to the next position. 

¾ You also have the option of zooming into the graphic display by clicking 

on  or zooming out of it by clicking on . Hold down the Shift 
key and move the mouse wheel to make use of a stepless zoom function. 

Clicking on  restores the full view of the entire slide. 

¾ Select  to resort your position list. The criteria X Position, Y 
Position, Z Position, Name, Index and Shortest distance are available 
for selection from a drop-down menu. 
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¾ Further selection options can be found on the Options property page: 

  

¾ Include focus in move: if this check box is activated, the z-position 
(focus position) saved when the position was defined is also restored 
when you travel to a position. 

¾ Wrap around during move next/previous: if this check box is 
activated, when "traveling forwards" you move from the last position to 
the first position in the list, and when "traveling backwards" from the 
first position to the last position. 

¾ Prompt for name of new positions: if this check box is activated, a 
dialog for entering the position name is displayed automatically after each 
new position is created. 

¾ Move focus drive to load position between wells and multiple 
slides: if this check box is activated, the objectives are moved to the load 
position while you are moving to another well or slide, in order to prevent 
damage. 
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¾ To make it easier to locate positions for the Mark&Find list, the option is 
available of having the carrier scanned fully automatically at a low 

magnification to obtain a preview. To do this, click on . Provided that 
the MosaiX module is licensed and selected in the module list, the 
following dialog appears: 

  

¾ You can now click on the  button to generate an overview 
image containing the set number of columns and rows with a defined 
overlap. You have the option of setting the objective for acquisition, the 
exposure time and the size of the tile image in μm (300, 512, 1024 or 
2500). 
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¾ Click on  to transfer this overview to the graphic display in 
your Mark&Find dialog. 

The overview dialog is otherwise operated in the same way as the MosaiX 
dialog (please also read the manual and the online help entries on MosaiX, 
F1 key). 

¾ Now save the changes. To do this, click on the  button. 

You have now successfully generated a position list and can use this at any 
time to relocate the saved positions. This list can also be used within the 
context of Multidimensional Acquisition. 

bñ~ãéäÉ=OW=ãìäíáïÉää=éä~íÉ=EVSF=

Position lists for multiwell plates are created in the same way as for slides, 
although there are a number of additional control elements and functions. 
These additional, divergent functions are presented below, without explaining 
all the functions that are identical to those in example 1 again. For details of 
the general functions, please also refer to the section “Example 1: slide”. 

To ensure that you can work sensibly with multiwell plates, the coordinates of 
the plate need to be adapted to the stage coordinates by means of 
calibration. The more wells your plate has, the more important it is to perform 
precise calibration. 

Note: 
• If the stage has already been calibrated and a standard plate has been 

selected, the program tries to locate the correct position after you call up 
the wizard. Please first ensure, therefore, that there are no obstacles 
within the stage’s travel range. 
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¾ Select a low objective magnification (e.g. 10x) and transmitted light 
illumination. Place a multiwell plate of the type that you wish to use in the 
holder on the microscope stage. 

¾ Click on the  icon. This opens the calibration wizard. If you have 
already performed calibrations, you are asked whether you wish to retain 
the calibration data. Select No if you wish to perform a new calibration 
and reject the old calibration data. Select Yes to continue working with 
the old calibration data. 

  

Note: 
• The orientation of the camera and the stage axes must be correctly 

configured to allow error-free calibration. The movement of the camera's 
field of view must correlate with the movements of the slider (or joystick) 
for stage control in all four directions. The camera orientation, the camera 
port being used and the settings for the image orientation and axis 
orientation of the stage all influence this behavior. 
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¾ Use the stage control to move interactively to the positions on the 
multiwell plate that correspond to the well marked in yellow. The aim is 
to travel to the calibration points symbolized in the control area at the 
bottom left and to move them to the center of the live image (reticle). The 
first position to be located could look something like this in the live 
image: 

  

¾ By clicking on the  button, which is currently active, you can 
now define this calibration point. It then becomes possible to calibrate the 
next position. In total, the following positions need to be located and set 
for a calibration: 

• Top left well: 12, 6, 9 and 3 o’ clock position 
• Top right well: 12 and 9 o’ clock position 
• Bottom right well: 12 o’clock position 

Wells that have already been calibrated are shown green in the graphic. 
Wells that have yet to be calibrated are marked in yellow. 
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¾ Click on  to go back to the previous step of the calibration. 

Click on  to return the calibration wizard to its original state. 

Click on  to exit the wizard without saving any changes you 
have made. 

¾ The  button under the live image only becomes active once all 
the necessary calibration steps have been performed. Click on it to save 
the calibration and exit the wizard. 

¾ As an alternative to calibrating on the basis of the well edges, it is 
possible to calibrate using the well center only. To do this, activate the 
Center positions only check box. You then only need to define the 
center positions of the top left, top right and bottom right wells. You 
should use a low objective magnification for this that allows you to view 
the entire well in the live image. 

¾ Go to the Multiwell graphics property page. Double-clicking on a well 
automatically moves the stage to the center of the selected well. The 
current stage position is marked with a red cross. The selected well (B3) is 
outlined in blue: 
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¾ By outlining several wells with the left-hand mouse button depressed or 
performing a multiple selection using the Strg key, combinations of 
different wells can also be selected (in the example B3, B4, B5, row C): 

  

¾ To automatically generate positions in the selected wells and save them in 

a Mark&Find position list, click on . A position at the center of the 
well is now generated for all selected wells, using the current focus 
position. Wells in which positions have been set are marked with 
hatching: 
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¾ Alternatively, by clicking on , it is also possible to have a number of 
positions generated automatically for each well. Here you only need to 
define the number of positions in the x and y dimensions. Please note 
that any previously saved positions are lost. 

  

¾ You can, of course, also locate positions manually and add individual 

positions by clicking on the  icons.  

¾ A special function that is available for multiwell plates allows you to 

overwrite the focus position of the selected position by clicking on . 
This function makes it possible to adapt a position list that has already 
been created to a multiwell plate with a different focus position (e.g. due 
to a different base thickness). 

¾ In the case of multiwell plates, you can also define a rule on the Options 
property page that will be used to automatically name the positions in the 
list: 
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The Panorama module creates large images from individual images, enabling 
you, for example, to display objects that would otherwise not fit into an 
image field. The images are combined with pixel precision, either interactively 
by superimposing the images, or (with support from the software) using 
Stitching (automatic image combination). It is also possible to combine 
displaced images so that they fit together perfectly. 

 

Panorama image consisting of four different images. 

Panorama images can be created in two different ways: 

� Combining images acquired directly via a camera. 
� Using already saved images. 
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There are no special technical requirements for generating Panorama images. 
The operation of the module has been specially designed for the use of 
manual microscopes and single image acquisition. 

Notes: 
• The automatic acquisition of large composite images is possible using the 

MosaiX module and requires a scanning stage. 

If you wish to combine images acquired directly from the camera, however, 
you will require a camera that has been integrated into AxioVision. It is not 
possible to use TWAIN devices, but you can acquire images using a camera 
integrated via the TWAIN interface, and then create Panorama images from 
the individual files. 

It is not necessary to use a scanning stage, but this does make it easier to 
position the individual images. AxioVision will then adjust the resulting image 
size automatically, and suggest a position for the newly acquired image. The 
known stage coordinates are converted directly into the image position. A 
correct image can then usually be generated using Stitching (automatic 
image combination). 

You should bear in mind that the resulting images may sometimes require a 
very large amount of storage space. In particular, if you are using high-
resolution digital cameras, such as those in the AxioCam family, the Panorama 
images can easily take up as much as several hundred megabytes. The 
computer you are using should therefore have an appropriate user memory 
and hard disk capacity. You should also consider the possibility of external 
storage (network, CD/DVD writer etc.), as otherwise local hard-disk capacities 
may be quickly used up. 
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Generally, an image that has been acquired using the Panorama module is the 
same as any other – it is just larger, and made up of several component 
images. For Panorama images, a special view which allows you to work more 
efficiently with the individual images is therefore available via the image 
window: Tile View. 

In this view you have access to the individual images (the "tiles") that make 
up a Panorama image. Here you can "pick up" the tiles individually, and 
change their position or alignment. You can also display information on the 
individual tiles, and insert circumscribing rectangles. 

  

 Pane to activate the tile view in the display window. 

^Åèìáëáíáçå=çÑ=m~åçê~ã~=áã~ÖÉë=

The Panorama Acquisition function can be executed via the work area on 
the left-hand side of the AxioVision window. If the work area is not displayed, 

activate it via the Standard toolbar . 

Alternatively, select the Windows function on the View menu and then the 
Workarea entry. 

Notes: 
• The work area may in fact be open but covered by the workflows. If that 

is the case, simply click on the Workarea tab at the bottom edge of the 

work area . 
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¾ Set the light path to the camera. Then 
open the live window by clicking on the 
icon for the live image on the Standard 
toolbar. Alternatively, select the Live 
function from the Acquisition menu. 

 

¾ Select the scaling for the chosen objective 
from the List of available scalings 
underneath the live image, if automatic 
scaling is not available. 

 

¾ To adjust the live image, click on the 
Properties button. Alternatively, select the 
Properties function from the View menu. 

 

Notes: 
• To guarantee a stitching result without annoying shading on the image 

border, you should execute or activate the shading correction. Go to the 
General tab in the Properties dialog. Make sure that the camera is 
viewing a completely empty image. To ensure that this is the case, move 
your sample on the microscope completely out of the field of view. 

• Click the Shading Correction button to acquire the shading correction 
image. 

• To ensure that dirt particles from the slide are not visible in the correction 
image, use a clean slide and a clean objective and completely defocus the 
microscope. 

• Please note that if the objective is changed the white reference has to be 
generated again. 

• A detailed description of the steps involved in preparing for image 
acquisition can be found in the section "Step by Step to the First Image" 
in section 3.3 "Quick Guide to the First Image". 
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¾ Close the Live display and select the 
Acquisition entry under 
Panorama in the work area. 

 

¾ The camera’s live image is now 
displayed at the center of the 
Panorama Acquisition dialog. To 
ensure that you have sufficient 
space to position several images, 
we recommend that you reduce 
the display accordingly. To do this, 
use the buttons on the toolbar of 
the Panorama image. 

 

 

¾ Move the scanning stage to the starting point of the region you want to 
acquire, and focus. Then click on Snap Image or use the F2 key of the 
keyboard. 

¾ The live image (marked by a white circle in 
the center) and the acquired image overlap 
partially. To acquire the next image, drag 
the live image (with the left mouse button 
depressed) to the position where you want 
the next image to be acquired. The images 
should clearly overlap. 

¾ Do not attempt to put adjacent images 
together with pixel precision. The function 
for automatic alignment (stitching) requires 
a overlap of good visible structures. The 
guide value is around 20%. And: There 
must be  

  

ca. 20%
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¾ Now move the specimen to the new 
position. The areas where the live image 
overlaps with the images already acquired 
are displayed in semi-transparent form. 
This makes it easier to position the next 
image. 

¾ The images do not have to be aligned 
precisely, as they can be placed in the 
correct position automatically later on 
using the stitching function. However, if 
the image regions that belong together are 
positioned too far away from each other, 
automatic stitching may not work. 

 

¾ Repeat the previous steps until you have acquired the entire region. 

¾ If the result is unsatisfactory, you can shift the individual tiles of the 
Panorama image manually.  

¾ To do this, make sure that the 
editing mode is active. (The Turn 
on/off tile mode button at the 
bottom edge of the Panorama 
image has to be depressed.) Then 
click inside a tile. The tile is 
highlighted by a white circle at its 
center. Hold down the left mouse 
button, and move the tile to the 
desired position. As before, areas of 
overlap with other images are 
displayed in semi-transparent form. 
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¾ To delete individual tiles, click on a 
tile. Then press the Delete selected 
tile button at the bottom edge of 
the Panorama image.  

¾ Click on OK to adopt the completed Panorama image into AxioVision. 

¾ At the bottom of the image window click on Tile View. 

¾ To align the tiles in relation to each 
other, click on the button for 
automatic tile alignment on the 
toolbar directly under the image 
window. 

 

Alternatively, select the Stitching entry under Panorama in the work area. 

Notes: 
• It is also possible to add extra images to an existing Panorama image. To 

do this, click on the  button in the top right-hand corner of the 
Panorama Acquisition dialog window. A gallery of all images currently 
loaded in AxioVision is displayed. Select the desired image, and carry out 
the steps described to add further single images to the existing Panorama 
image. 

• If you click on the  button in the upper right corner of the 
Panorama Acquisition dialog, you can start generating a new Panorama 
image directly, without having to close the dialog first. 
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If the individual tiles of a Panorama image are already available as individual 
files, they can be put together manually. The most frequent problem and 
source of errors here is the overlap of the individual tiles. If the overlap is too 
large or too small, this can lead to problems when using the function that 
automatically combines the tiles (stitching). 

In principle, we therefore recommend that you create the images using the 
Panorama acquisition function, and ensure that there is an appropriate area of 
overlap. Please note, that the images must be of the same type (color/gray 
values, size) to put them together. 

The Import from Files function can be executed via the work area on the 
left-hand side of the AxioVision window. If the work area is not displayed, 
activate it via the Standard toolbar. 

Alternatively, select the Windows function on the View menu and then the 
Workarea entry. 

Notes: 
• The work area may in fact be open but covered by the workflows. If that 

is the case, simply click on the Workarea tab at the bottom edge of the 

work area . 

• All the steps involved in the generation of a Panorama image can be 
found in sequence in the Panorama workflow. 

¾ Select the Import from files entry under 
Panorama in the workarea. 
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¾ Select the folder containing the 
individual tiles of your Panorama image. 
To do this, click on the  button above 
the gallery. The Microsoft Windows 
standard dialog Select folder is opened. 
Select the desired folder and confirm by 

clicking on . All the 
available images are now displayed as 
thumbnails in the gallery. 

 

 

¾ To put the Panorama image together, 
drag the first image into the Panorama 
image area. 

¾ The image fills the whole of the 
Panorama image area. To ensure that 
you have sufficient space to position 
additional images, we recommend that 
you reduce the display accordingly. To 
do this, use the buttons on the toolbar 
of the Panorama image. 

 

 

¾ The selected image is now marked with 
a red cross in the gallery, to show that it 
has already been used. 
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¾ Select the next image from the gallery 
and drag it to the desired position. The 
images should clearly overlap. The 
function for automatic alignment 
(stitching) requires a certain overlap. The 
guide value is around 20%. 

  

¾ Drag all the other images into the Panorama image one after the other in 
the same way, and position them. 

¾ If the result is unsatisfactory, you can of course subsequently shift the 
individual tiles of the Panorama image manually.  

¾ Click inside a tile. The tile is highlighted 
by a white circle at its center. Hold down 
the left mouse button, and move the tile 
to the desired position. As before, areas 
of overlap with other images are 
displayed in semi-transparent form. 

 

¾ To delete individual tiles, click on a tile. 
Then press the Delete the selected tile 
button at the bottom edge of the 
Panorama image. 

 

¾ Click on OK to adopt the completed Panorama image into AxioVision. 

¾ At the bottom of the image window click on Tile View. 

¾ To align the tiles in relation to each 
other, click on the button for automatic 
tile alignment on the toolbar directly 
under the image window. 

¾ Alternatively, select the Stitching entry under Panorama in the work 
area. 
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Notes: 
• It is also possible to add extra images to an existing Panorama image. To 

do this, click on the  button in the top right-hand corner of the 
Import from files dialog window. A gallery of all images currently 
loaded in AxioVision is displayed. Select the desired image, and carry out 
the steps described to add it to the image. 

• If you click on the New button, you can start generating a new Panorama 
image directly, without having to close the dialog first. 

`çåîÉêíáåÖ=~=íáäÉ=áã~ÖÉ=áåíç=~=êÉÖìä~ê=^ñáçsáëáçå=
áã~ÖÉ=

As tile images are a special format, they cannot be further processed or 
measured using the AxioVision functions. You have to convert them into a 
regular AxioVision image first. 

¾ Acquire a tile image, or load one from the hard drive. 

¾ Select the Convert Tile Images 
function from the Processing menu. 

¾ The current tile image is displayed, 
with a frame, on the left-hand side. 
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¾ You are now able to position the 
frame freely and change its size. 

¾ If the mouse cursor is inside the 
frame, keep the left mouse button 
pressed and you can move the whole 
frame. 

¾ If you move the mouse cursor onto 
one of the frame handles, keep the 
left mouse button pressed and resize 
the frame.  

¾ Once you have selected the desired region, click on OK. A regular 
AxioVision image is then generated. This image can now be processed 
and measured in the usual way. 

Note: 
• The size of the resulting image is reduced to 4096 pixels by default. If the 

frame size set exceeds this value, the resulting image is automatically 
reduced accordingly. The region you have selected is always used, 
however. If you want to avoid reduction, you can freely configure the size 
of the AxioVision image. 

• Select the Options function from the Tool menu. Activate the 
Acquisition tab sheet. 

¾ Under Multidimensional image 
acquisition you can adjust the Max. 
MosaiX image size parameter 
accordingly. The size of the value that 
you can select for this setting is 
essentially dependent on your 
computer’s user memory.  

 

If the setting you select is too large, you may not be able to process the 
resulting images optimal. The processing speed will in any case be reduced 
dramatically, constricting optimal working. 
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The MosaiX module has been developed to resolve a classic microscopy 
problem: the insufficient size of the field of view. At high magnifications in 
particular, the region that can be seen through the eyepiece is never large 
enough. If you are working with cameras, the problem is frequently 
exacerbated by the fact that the camera’s rectangular sensor cuts off regions 
of the round field of view when it is viewed through the eyepiece. 

The ideal situation, therefore, would be to display the entire region of interest 
in a single image, even at high magnifications. 

A number of different application scenarios are conceivable: 

� Acquisition of image overlapping objects 
 
In the simplest case, the object of interest cannot be displayed in full in a 
single image at the selected magnification. This means that several 
individual images have to be combined to form a larger overall image, 
and if the number of images in question is small, or if the system you are 
using does not have a scanning stage, you may be well advised to make 
use of the Panorama module too. 
 

 

� Archiving of a complete slide ("virtual slide") 
 
The archiving of specimen over al long period requires a high amount of 
space and its always associated with loss of quality (i.e. bleaching). The 
digital archiving of complete specimen is because storage media are 
becoming cheaper all the time is a realistic way to save them permanently 
with consistent quality. 
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� Correction of objects cut by the image border 
 
If you want to measure large areas, usually several single images have to 
be acquired. In this case always the questions comes up, how to handle 
objects that are not visible in full in the image. These objects should not 
be measured, as this would distort the measurement result. Using MosaiX 
images, you can avoid this problem completely. 

With MosaiX, a specimen is scanned with a scanning stage extensively to 
generate a large "virtual" representation. This electronically generated image 
of the specimen serves as a map for navigating around the sample, and as a 
basis for further analyses. The advantage of this method is that you only have 
to scan the specimen once, and it is then available for all subsequent 
processing or analysis steps. 
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There are two ways to combine the individual images with the highest 
possible pixel precision: 

� Ensure that the stage calibration and camera alignment are correct. The 
images are then "simply" put together. No check is performed to 
establish whether this has been done correctly. This is a fast method, but 
a certain amount of care is required when you are configuring the system. 

� The second option automatically guarantees that all images are correctly 
positioned in relation to each other. This is what is known as Stitching. 
Here the image structures of adjoining images are used as a basis to 
check that the boundaries actually fit together correctly. If this is not the 
case, the images are automatically placed in the correct position in 
relation to each other. 

As the focus plane does not always remain the same if samples are large, or if 
the scanning stage has to travel large distances, automatic focusing is often 
required during acquisition. Two options are available here: the Autofocus 
function and Focus Correction. 

� Autofocus: here every nth selected tile image is focused in accordance 
with the calibration performed. The focus plane found is retained for the 
acquisition of the following tile images, until the next nth tile is reached. 

� This is Focus Correction: With this method a “focus landscape” is 
defined. Several focused positions are used to calculate the three-
dimensional surface curves of the object and the individual tiles are 
focused accordingly. At least three positions need to be set. The larger 
the desired MosaiX, the more positive the effect of setting more focus 
positions will be on the sharpness of all the tile images. 
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A scanning stage is essential for generating MosaiX images. To make use of 
the options for automatic focusing, you will require a microscope with a 
motorized z-drive. The Autofocus function requires the AxioVision 
Autofocus module. 

You should also bear in mind that the resulting images may sometimes 
require a very large amount of storage space. Images with several hundred 
MB, or even several GB, are not uncommon. This means that the computer 
you are using must have an appropriate user memory and hard disk capacity. 
You should also consider the possibility of external storage (network, CD/DVD 
writer etc.). 

péÉÅá~ä=ÑÉ~íìêÉë=çÑ=jçë~áu=áã~ÖÉë=

Generally, an image that has been acquired using the MosaiX module is the 
same as any other – it is just larger, and made up of several component 
images. For MosaiX images, a special view which allows you to work more 
efficiently with the individual images is therefore available via the image 
window: TileView. In this view you have access to the individual images (the 
"tiles") that make up a MosaiX image. Here you can "pick up" the tiles 
individually, and change their position or alignment. You can also display 
information on the individual tiles, and insert circumscribing rectangles. 

 

Button to activate the tile view in the display window. 
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jìäíáÇáãÉåëáçå~ä=jçë~áu=áã~ÖÉë=

The MosaiX module can also be used together with the modules for 
multidimensional image acquisition. It can therefore be combined freely with 
the Multichannel Fluorescence, Z-Stack, Time Lapse and Mark&Find modules. 
If you are using MosaiX together with the Mark&Find module, you can define 
a region around any position in a Mark&Find position list for which you want 
to acquire a MosaiX image. 

 

Muscle specific GFP tag (yellow), nuclear stain (blue), stage 10.5 embryo, 2 channel 
fluorescence Z-stack ApoTome acquisition of 3x3 Camerafields, stitched together with 
the new MosaiX module of AxioVision 4.2. Dr. Frederic Relaix and Emanuelle Perret, 
PFID, Pasteur Institute, Paris, France. 

The Extended Focus module is only useful in combination with the MosaiX 
module if you are using Z-stack images. A microscope with a motorized Z-
drive is required. 

If you want the individual planes of a region of a specimen to be acquired 
manually for the extended focus, the Panorama module is also required, to 
put the individual images together. 

AxioVision User's Guide, Release 4.8.2 9-115 



Modules  - MosaiX 

pÉííáåÖ=ìé=íÜÉ=Å~ãÉê~=~åÇ=ëÅ~ååáåÖ=ëí~ÖÉ=

If you want to acquire good quality MosaiX images, you need to ensure that 
certain requirements relating to the interaction of the camera and 
microscope/scanning stage are met. This is firstly to guarantee the correct 
movement of the stage, and secondly to prevent the individual tiles from 
being shifted or rotated in relation to each other during acquisition. 

fã~ÖÉ=çêáÉåí~íáçå=

The image orientation in the eyepiece and the image on the monitor must be 
identically. This means that the image on the monitor must not be rotated in 
relation to the eyepiece display. If the alignment in the live image is wrong,  it 
can be corrected either by rotating the camera or by adjusting the image 
alignment: 

¾ Set the light path to the camera. Open the 
live window by clicking on the icon for the 
live image on the Standard toolbar. 
Alternatively, select the Live function from 
the Acquisition menu. 

 

¾ To change the image alignment, click on 
the Live Properties button. Alternatively, 
select the Live Properties function from 
the View menu.  
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¾ In the Live Properties dialog, select the 
General tab. 

¾ Select the appropriate Image Orientation 
from the drop-down list box, so that the 
live image and eyepiece image will 
correspond. 

Notes: 
• A detailed description of the steps involved 

in preparing for image acquisition can be 
found in the section "Step by Step to the 
First Image" in section 3.3 "Quick Guide to 
the First Image". 

 

 
aáêÉÅíáçåë=çÑ=ãçîÉãÉåí=çÑ=íÜÉ=ëí~ÖÉ=

To guarantee that the stage moves correctly,  the direction of movement must 
be set in such a way that a movement of the camera is simulated when the 
control function in AxioVision is used to move the stage. This means that  if 
the stage control function is moved to the right, the objects in the live image 
move to the left. If the stage control function is moved up, the objects move 
down. If the directions of movement are wrong, they can be adjusted via the 
Microscope Configuration program. 
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¾ Set the light path to the camera. 
Open the live window by clicking on 
the icon for the live image on the 
Standard toolbar. Alternatively, 
select the Live function from the 
Acquisition menu. 

 

¾ Select the Stage/Focus entry from 
the Microscope menu, and open the 
stage control function via the Stage 
entry. 

 

¾ Now check the directions of 
movement in the x- and y-directions. 

¾ First move the stage to the right. 

¾ The objects in the image should move 
to the left. 

¾ If the objects also move to the right, 
you need to change the direction of 
movement via the Microscope 
Configuration program. 
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¾ Before you do this, however, test the 
movement in the y-direction. 

¾ Move the stage up. 

¾ The objects in the image should move 
down. 

¾ If, instead of moving as described 
above, the objects move in the exact 
opposite direction, the directions of 
movement of the stage can be 
reversed.  

¾ Close AxioVision and start the MTB 
2004 Configuration program. If the 
program is not available as an icon on 
the Microsoft Windows desktop, 
select MTB 2004 Configuration via 
Start Æ Programs Æ Carl Zeiss 
Vision. 

 

¾ In MTB 2004 Configuration select 

the  
drop-down menu. You can change 
the direction of travel by clicking on 
the quadrants. 

 

¾ If you are using the MAC 5000 as 
stage controller, the movement can 
be reversed by the check boxes of the 
parameter Invert x-Axis and Invert 
y-Axis. 
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¾ Click on  to come out of the MTB 2004 Configuration 
program and save the settings. 

¾ Start AxioVision again, and follow the steps described above to check the 
direction of movement. 

Note: 
• If you are working with a joystick, you may find that the direction of 

movement cannot be changed when the joystick is being used. This 
means that  the hardware and software joysticks have different directions 
of movement. 

^äáÖåãÉåí=çÑ=Å~ãÉê~=~åÇ=ëí~ÖÉ=

The camera and stage must be aligned with each other in such a way that 
objects move parallel to the x- and y-axes when the stage is moved. 
Otherwise, the individual tiles of the MosaiX image would have to be rotated 
in relation to each other in order to combine them exactly. 

 
The home slide (part number 453583) offers you optimum definition 
conditions. The center of this slide is marked with a high degree of 
precision, and the slide is covered and has polished edges. This 
ensures that it can be placed precisely into the slide holder. 
Alternatively, you can use a point that stands out clearly on a slide of 
your choice. 

¾ Set the light path to the camera. Open 
the live window by clicking on the icon 
for the live image on the Standard 
toolbar. Alternatively, select the Live 
function from the Acquisition menu. 
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¾ Find a point that stands out clearly on 
your slide,  or position the center of the 
home slide (as shown in the example) in 
the top left-hand corner of the live 
image. 

 

¾ Select the Stage/Focus entry from the 
Microscope menu, and open the stage 
control function via the Stage entry. 

 

¾ Now move the stage to the left. The 
selected point moves to the right. 

Note: 
• If the point moves to the left, you need 

to change the direction of movement. 
Please refer to the previous section. 
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¾ The selected point should move parallel 
to the top edge of the image over the 
entire image width, up to the top right-
hand corner. If it does, the edges of the 
stage and the camera are aligned 
parallel to each other. 

 

If it does not, you need to rotate the camera slightly, and then move the point 
across the image again. Keep doing this until parallel movement is achieved. 

Note: 
• If you are no longer able to combine your MosaiX images correctly, this 

check should be repeated. It is quite possible that the camera has been 
inadvertently rotated. 

^Åèìáëáíáçå=çÑ=jçë~áu=áã~ÖÉë=

¾ Set the light path to the camera. Open the 
live window by clicking on the icon for the 
live image on the Standard toolbar. 
Alternatively, select the Live function from 
the Acquisition menu. 

 

¾ Select the scaling for the chosen objective 
from the List of available scalings 
underneath the live image. 

 

¾ To adjust the live image, click on the Live 
Properties button. Alternatively, select the 
Live Properties function from the View 
menu.  
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Notes: 
• To guarantee a stitching result without annoying shading on the image 

border, you should activate the shading correction. Go to the General 
tab in the Live image properties dialog. Make sure that the camera is 
viewing a completely empty image. To ensure that this is the case, move 
your sample on the microscope completely out of the field of view. 
 
To ensure that dirt particles from the slide are not visible in the correction 
image, use a clean slide and a clean objective and completely defocus the 
microscope. 
 
Please note that if the objective is changed the shading correction has to 
be generated again. 

• A detailed description of the steps involved in preparing for image 
acquisition can be found in the section "Step by Step to the First Image" 
in section 3.3 "Quick Guide to the First Image". 

¾ Select the Acquisition entry under 
MosaiX in the work area. 
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¾ The MosaiX Acquisition property page 
displays the current MosaiX settings. 

¾ In order for automatic alignment 
(stitching) to be performed successfully, 
the images need to be acquired with an 
overlap. A value of 10-20% is 
recommended. 

¾ The MosaiX-Setup dialog is available if 
you wish to adjust these settings. To 

open the dialog, click on . 

 

¾ The MosaiX Acquisition Setup 
dialog is the central dialog for 
defining the position and size of the 
MosaiX image to be acquired of your 
specimen. 

 

¾ To define a new MosaiX image, reset 
any existing settings. To do this, click 

on the  button below the 
Navigator. 

¾ The size is reset to one tile.   The 
starting point is the current stage 
position. You can choose between 
the rectangle or circle mode or the 
overview image.  

As a reference point you can choose between the tile in the top left-hand 
corner or the center of the entire MosaiX image. 
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¾ Now, starting from the current 
point, move to the furthest points of 
the MosaiX area using the control 
elements for the Stage in the 
Microscope and camera group. 

 

¾ First, move to the left edge of the 
area you wish to acquire, for 
example, or double-click on the 
corresponding position in the 
Navigation window. 

 

¾ Click on the button to enlarge the 
MosaiX image to the current 
position. 
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¾ The MosaiX area is now enlarged to 
the current position. 

 

¾ Repeat these steps for the right, top 
and bottom edges of the area you 
wish to acquire. 

Note: 
• To check that the MosaiX area has 

been correctly defined, you can 
move to individual tiles directly by 
double-clicking on a tile in the 
navigator. 

 

¾ If you wish to reduce the area for 
the MosaiX image, move to the new 
edge positions (top, bottom, right, 
left) and click on the appropriate 
button for clipping the MosaiX 
image. 
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¾ Click on OK to adopt the settings. 

¾ The settings are now adopted into 
the MosaiX Acquisition property 
page. 

¾ Start acquisition by clicking on Start.

 

¾ AxioVision now covers the defined 
area and displays the result step by 
step. 
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píáíÅÜáåÖ=é~ê~ãÉíÉêë=

Scanning stages deviate from their exact positioning as they move. To ensure 
that it is nevertheless possible to assemble an overall image correctly when 
you are acquiring combined images (MosaiX), the single images (tiles) are 
acquired with overlapping regions and are subsequently fitted together using 
the so-called stitching method. It is essential that sufficient structures are 
displayed within these overlapping regions. The stitching algorithm attempts 
to recognize the precisely matching regions of two tile images that are located 
side by side and tries to position them accordingly. 

Tile 1 Tile 1 
Tile 2 Tile 1 

Tile 2 Overlap region 

Tile 2 

 

The idea of the stitching algorithm is based on pattern recognition. A 
structure is detected in the overlapping region of a tile image. An attempt is 
then made to find this structure again in the overlapping region of the 
neighboring tile. 
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 MinimumOverlap = 3% → 30 Pixel 

Tile 1 
Tile 2 

15% MosaiX-Overlap

 pattern region 

SearchDepth =  
15 % = ±150 Pixel

„Error“ of the scanning stage movement 

search space 

 

The tile images in the diagram overlap by 15%. The Overlap parameter is set 
in the MosaiX Acquisition function. 

Note: 
• Tiles that do not overlap cannot be fitted together! 

Three parameters are important for the stitching algorithm: 
MinimumOverlap, Search Depth and SobelSize. 

� The MinimumOverlap parameter indicates the size of the pattern 
region. The size is given as a percentage of the tile size. If, for example, a 
tile image contains 1000x800 pixels and the MinimumOverlap has been 
set to 3%, this results in a pattern region of 30 pixels. 

In the diagram, this region is shaded dark gray. An attempt is now made 
to find the structures contained here in the overlap region of the 
neighboring tile (light gray rectangle). 

The stitching algorithm can only be applied successfully if visible structures 
are present in the search space. If only a few structures are present, you 
can increase the MinimumOverlap parameter. This means that the 
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pattern region that you wish to look for is expanded and the possibility of 
finding a clear structure is increased. 

The MinimumOverlap region selected should not be larger than the 
MosaiX-Overlap, however. This means that, when acquiring objects that 
contain few structures, you should select a 20-30% overlap for the 
MosaiX Acquisition function so that you can subsequently set the 
MinimumOverlap to a high value, such as 10%. 

The lower the value set for the MinimumOverlap parameter, the quicker 
the stitching process takes place. 

� The SearchDepth parameter indicates the percentage of the tile size in 
which the best match for the defined structure should be searched for in 
the 1st tile image. If you use an accurate scanning stage, the 
SearchDepth can be kept low (e.g. 5%), as the pattern region can be 
found close to the original position. 

For stages that are less accurate, you will need to work with a larger 
SearchDepth in order to have a chance of finding the structure. 
However, you should bear in mind that if too large a SearchDepth is 
selected, an incorrect stitching position may be found – particularly if the 
specimen displays similar or recurring structure patterns. 

Remember that a lower value for the SearchDepth parameter speeds up 
the stitching process. 

� The SobelSize parameter indicates the way in which the stitching 
algorithm deals with the structures in the defined pattern region for an 
optimum search result. In most cases, you can retain the preselected value 
Low. 

However, if your tile images contain blurred structures which cause 
stitching problems, you can set this value to Off. In this case, it is essential 
that you perform shading correction during the acquisition of the tile 
images. Should the problems continue with the Low or Off values, you 
can use the High parameter value. This selection then takes larger image 
structures into account for pattern recognition. 
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`çåîÉêíáåÖ=~=íáäÉ=áã~ÖÉ=áåíç=~=êÉÖìä~ê=^ñáçsáëáçå=
áã~ÖÉ=

As tile images are a special format, they cannot be further processed or 
measured using the AxioVision functions. You have to convert them into a 
regular AxioVision image first. 

¾ Acquire a tile image, or load one from the hard drive. 

¾ Select the Convert Tile Images 
function from the Processing menu. 

¾ The current tile image is displayed, 
with a frame, on the left-hand side. 

 

¾ You are now able to position the 
frame freely and change its size. 

¾ If the mouse cursor is inside the 
frame, keep the left mouse button 
pressed and you can move the whole 
frame. 

¾ If you move the mouse cursor onto 
one of the frame handles, keep the 
left mouse button pressed and resize 
the frame. 

 

¾ Once you have selected the desired region, click on OK. A regular 
AxioVision image is then generated. This image can now be processed 
and measured in the usual way. 
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Note: 
• The size of the resulting image is reduced to 8192 pixels by default. If the 

frame size set exceeds this value, the resulting image is automatically 
reduced accordingly. The region you have selected is always used, 
however. If you want to avoid reduction, you can freely configure the size 
of the AxioVision image. 

¾ Select the Options function from the 
Tool menu. Activate the Image tab 
sheet.  

¾ In the Multidimensional acquisition 
field you can adjust the Max. MosaiX 
image size parameter accordingly. 
The size of the value that you can 
select for this setting is essentially 
dependent on your computer’s user 
memory.  

 

If the setting you select is too large, you may not be able to process the 
resulting images optimal. The processing speed will in any case be reduced 
dramatically, constricting optimal working. 
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VKU qj^=

_~ÅâÖêçìåÇ=

Tissue microarrays consist of hundreds of small tissue samples of cores fixed 
on a single: 

  

Biopsies embedded in paraffin Composite image of a tissue microarray 

This technique makes it possible to analyze a wide variety of tissue samples in 
parallel, under the same conditions and without variability in the staining. In 
connection with automated image acquisition and analysis, tissue microarrays 
are fed into an efficient high-throughput procedure.  

The functions of the TMA module are integrated into AxioVision, expanding 
the software with the option of acquiring tissue microarrays. On the other 
hand, all the modules available in AxioVision can also be combined with TMA, 
e.g. with the quantitative analysis methods. 

^ééäáÅ~íáçå=

The TMA module enables the acquisition of an overview "map" of the tissue 
microarray. Tissue cores are automatically detected and identified with a grid 
position and a coordinate list is created. Using the detected core positions, 
TMA acquires high resolution images of immuno-histochemically stained or 
fluorescence labeled core samples (e.g. FISH) and can acquire images with 
multiple separately labeled fluorochromes. 
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The AxioVision measurement functions provide all the tools for counting cells 
and quantifying staining intensity, percent positive marked elements and 
other parameters. 

cìåÅíáçåë=~åÇ=áåíÉÖê~íáçå=áåíç=^ñáçsáëáçå=

TMA adds two functions to AxioVision – one for generating a composite 
image and one for deriving a position list from the composite image. The 
functions are available via the Applications ⇒ TMA menu. Consequently, 
they can be used in your own toolbars and workflows etc. via the Extras ⇒ 
Customize function. 

The TMA workflow can also be used for routine work. 

  

Detailed descriptions relating to the individual functions can be found in the 
online help. Simply start a function and then press the F1 key. 
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Captures a low magnification overview map of the array using a mosaic 
technique. This is a quick and easy to use function with re-usable templates 
for different tissue microarray layouts. Make Map can acquire an overview in 
brightfield or fluorescence illumination. 

aÉíÉÅí=`çêÉë=

Automatically detects the cores from the overview map image and assigns 
grid coordinates. A highly sensitive algorithm is used that can cope with 
distorted array patterns or missing cores. The grid coordinates of each core 
are used to create a Mark&Find list. Coordinates can be referenced to marker 
cores on the sample, allowing cores to be relocated after the slide has been 
replaced on the microscope. Additionally, the reference point is required for 
using the TMA position list correctly with other modules of AxioVision. 

mêÉêÉèìáëáíÉë=

In order to work with TMA, the Mark&Find and MosaiX modules must also be 
installed on your system in addition to TMA. Depending on what you wish to 
use the TMA module for, other modules may also be useful, e.g. Multichannel 
Fluorescence, Z-stack, Autofocus, AutoMeasure. Your microscope must be 
equipped with a scanning stage, to facilitate automatic location of the 
sample. 
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VKV c~ëí=^Åèìáëáíáçå=

^Åèìáëáíáçå=éêáåÅáéäÉë=

The Fast Acquisition module enables you to acquire multidimensional images 
(Time Lapse, Z-Stack, Multichannel Fluorescence) at a speed that is only 
restricted by the technical limitations of the devices you are using (camera, 
light source, focusing unit) and the selected camera settings.  To achieve this 
speed, the Fast Acquisition module automatically uses a "streaming" 
technique, where  the raw camera data is written to a fast hard disk (or a 
suitable empty partition), which is only used for streaming. This can be 
defined in Tools ⇒ Options ⇒ Storage ⇒ Folder for Camera Streaming 
File. 

The result of acquisition is a streaming document (*.ziAR). 

After the data is collected,, the streaming document is converted into a 
regular ZVI image document. This is required for all further processing steps in 
AxioVision. 

The principle is illustrated in the following schematic (the actual harddisk 
configuration in your computer may be different): 
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This method of acquisition greatly depends on the PC equipment and 
configuration. Please adhere to the technical requirements for fast acquisition 
systems, which can be found in the "AxioVision Product Suite" installation 
manual. 

The Fast Acquisition menu entry contains three functions for calling up the 
Acquisition, Cutter and Information dialogs. 

Note: 
• You can also call up the Fast Acquisition entry from the Workarea. 

bñéÉêáãÉåí=éêçéÉêíó=é~ÖÉ=

Activating this function you will find the property page Experiment as well as 
property pages for the modules Multichannel Fluorescence, Z-Stack and 
Time Lapse. In many ways the operation of these functions is comparable to 
the respective modules of the Multidimensional Acquisition. 

On the Experiment property page you will find an overview of the available 
functions and also of a range of important control elements. From this 
property page you can load, save and execute a previously prepared 
experiment. Here you can also extract the relevant experiment data from a 
stored image and start a new experiment under identical conditions. 

Each dimension function has its own property page. 

� C = Channels 
� Z = Z-Stack 
� T = Time Lapse 

 
From the Experiment property page you can specify the dimension that you 
want included in your experiment. AxioVision requires information such as the 
definition of channels, z-planes and time series. This collection of information 
is referred to in AxioVision as an "experiment". 

You can save the experiment and execute it by clicking on the  
button. The result of this process is always a new, unsaved image. 
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Note: 
• Experiments defined for the Fast Acquisition are different from 

experiments of the Multidimensional Acquisition and are therefore not 
interchangeable. This is reflected by the document extension ZVXF. 

Options 

Each dimension function has a check box that allows you to specify whether 
you want to use the function in question. The status line to the right provides 
the most important information on the settings you have made on the 
corresponding property page. 

Experiment 

In the first line you will see the name of the current experiment. If a default 
experiment has been defined, this line is empty. You can load a previously 

saved experiment using the  button. Another dialog opens in 
which previously stored experiments present on the system are listed:  

Now select an experiment and click either on  to load the 

experiment or on  to close the dialog again. 

Note: 
• Please note that experiments can be recognized automatically by 

AxioVision in three different places on the system: 

• In a central location in the program directory (accessible to all users) 
(Windows XP/VISTA: C:\Program Files\Carl Zeiss 
Vision\AxioVision\Data\AcquisitionRecording\FastAcquisition). 

• In a central location for a work group (accessible to all members of 
that group) (Windows XP: C:\Documents and Settings\All 
Users\Shared Documents\Carl Zeiss\Data\AcquisitionRecording\ 
FastAcquisition; Windows VISTA: D:\User_Data\Public\Documents\Carl 
Zeiss\Data\AquisitionRecording\FastAquisition). 
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• In your personal work folder (for the user "Administrator" (Windows 
XP: e.g. C:\Documents and Settings\Administrator\My 
Documents\Carl Zeiss\Data\AcquisitionRecording\FastAcquisition) 
(accessible to you only); Windows VISTA: 
D:\User_Data\Administrator\Documents\Carl 
Zeiss\Data\AquisitionRecording\FastAquisition. 

A newly created or modified experiment can be saved by clicking on 

. Experiments are always saved with the extension "ZVXF" in your 
personal document folder (e.g. for the user "Administrator": C:\Documents 
and Settings\Administrator\My Documents\Carl 
Zeiss\Data\AcquisitionRecording\ FastAcquisition). 

You can also use  to save an experiment in a different 
location. This means, for example, that you can make a ZVXF experiment file 
available to several local Microsoft Windows users by saving it in the work-
group folder (C:\Documents and Settings\All Users\Documents\Carl Zeiss\Data\ 
AcquisitionRecording\FastAcquisition). 

Working with default experiments 

Instead of loading stored experiments it might be useful to store a standard 
experiment as the default experiment. This is useful when several users are 
working with the systems. For example, a standard experiment could contain 
all of the available possible channels on the imaging system for example. 
Starting with this default set up all channels not needed for the experiment 
can then simply be deactivated (right mouse click on the channel tab) 
temporarily. 

The experiment which should become the default first has to be configured as 
desired. Then, to make an experiment the default, the Save As Default 

option has to be selected from the Save dialog (accessed by clicking on ). 
From now on, every time, AxioVision is started, the default experiment will 
load automatically. Changes made to this experiment during an AxioVision 
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session are automatically discarded when the program is closed. This ensures 
that the standard experiment is always available to other users and not 
accidentally modified. 

Changes made to the default experiment during an AxioVision session can be 

discarded by choosing Load Default from the  button. 

In order to reset the experiment to the factory default, the Load Factory 

Default option can be selected from the  button. 

A newly acquired image is given the name Fast-Acquisition-Stream-, 
followed by a serial number. If you want to change the name of the image, 
you can do this in the Prefix input field. 

Camera 

From the drop-down list field you can select, which camera should be used for 
fast acquisition. This is important for systems which are set up with two 
identical cameras in a Dual Camera configuration. You can choose either the 
ActiveAcquisition camera, which is the camera currently active in the system 
or you can specifically specify one camera of your choice (e.g. AxioCamHS_2) 
which will then be automatically selected for acquisition. Finally, you can 
choose Dual Camera. In this case, two identical cameras can be used 
simultaneously. Please see the help for Dual Camera elsewhere for further 
details. 

Hardware-Settings for Experiment 

Here you can enter hardware component settings that you want to be 
executed at the start of the experiment before image acquisition starts, e.g. 
switching of light path to camera or desired camera resolution. 
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¾ Before experiment: Here you can select a suitable hardware setting 

from the drop-down list box. If you click on the  button, you can 
apply the selected hardware setting to the microscope to test the settings. 

¾ After experiment: You can use an additional hardware setting for the 

end of the experiment. If you click on the  button, you can apply the 
selected hardware setting to the microscope to test the settings. 

 

`=E`Ü~ååÉäëF=éêçéÉêíó=é~ÖÉ=

Here you can define up to 5 channels to be used for acquisition. Only one 
channel is displayed per page. To switch between channels, click on the 

corresponding button . The tabs show the channel number and 
are also displayed in the selected channel color to help you to find the channel 
you are looking for. 

You can temporarily disable a channel by right-mouse clicking on the channel 

tab. The channel will become inactive  and will not be used 
during the next acquisition. 

You can also change the order in which the channels are acquired by 

dragging a channel tab to another place . The channel 

number is reset after release of the mouse button . 

Settings 

¾ Dye: Here you can make a selection from a list of frequently used 
fluorescent dyes. If you make a selection from the drop-down list box, a 
suggested color is also inserted into the Color field. Values for excitation 
and/or emission maximums are also assigned to each fluorochrome. This 
information is important if you are using the 3D Deconvolution module, 
for example. 
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¾ In the  dialog you can also enter a new 
fluorochrome into the Dye text field. The appropriate wavelength 
information can be entered in the corresponding text fields (please also 
see Extended parameters). 

¾ Color: Here you can select a suitable channel color (often also known as 
pseudo color, in particular with black/white cameras in fluorescence 
microscopy). 

Click in the drop-down list box to select from a range of default colors.  

A new color can be selected via the Microsoft Windows color selection 

dialog by clicking on . Select a color field from the left-hand area or 
pick out a color from the color gradients on the right-hand side. Colors 
you define yourself appear as Custom colors in the bottom part of the 
list. 

¾ Name: Here you can assign a name of your choice to the channel. 
Default channel name is the dye name. 

 

bñíÉåÇÉÇ=é~ê~ãÉíÉêë=

In addition to the setting options offered on the C (Channels) property page, 
you can also make more advanced channel settings in an expert mode. The 
options available here are restricted to parameters that cannot reduce the 
speed of fast image acquisition. For this reason you will not find all the 
options here that are available in Multidimensional Acquisition. 

The  button opens the new dialog Extended Channel 
Parameters in the form of a floating window. 

This dialog displays all the channels of the current experiment next to each 
other in tabular form. Some functions are brought together as subgroups. 
Click on  to open the group and on  to close it again. 
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The channel table also contains all the control elements you need to be able 
to make the correct settings. The parameters are listed and explained 
individually below: 

Enable 

Here you can deactivate the use of a channel temporarily without having to 
remove the entire channel entry from an experiment. 

Name 

Give the channel a name of your choice (e.g. "DAPI-Automatic"). 

Channel Color 

This allows you to select a suitable channel color (often also known as pseudo 
color, in particular with black/white cameras in fluorescence microscopy). 

Click in the drop-down list box to select from a range of default colors. 

A new color can be selected via the Microsoft Windows color selection dialog 

by clicking on . Select a color rectangle from the left-hand area or pick out 
a color from the color gradients on the right-hand side. Colors you define 
yourself appear as "Custom" colors in the bottom part of the list. 

Exposure Time [ms] 

Here you can enter the exposure time being used for the channel into the 

value field, either directly or using the  buttons. To determine the 

exposure time interactively, click on . The dialog that opens contains a live
image, generated using the channel-specific hardware settings. In this live 

image the main control elements are 

 

available (  button) to 
allow you to determine the correct exposure time. After confirmation (clicking 

on ), the dialog is closed and the new exposure time is adopte
automatically. Please note that fast image acquisition only allows images to be 
acquired in rapid succession if suitably short exposure times are used. 

d 
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Exposure Mode 

In the drop-down list box, three modes are available: 

1. Camera settings: The value that has just been entered on the camera’s 
Adjust property page (called up e.g. via Acquisition menu ⇒ Select 
Camera) is used. Any value present in the channel table is ignored. 

2. Channel settings: The exposure time entered in the channel table is used. 
The value on the camera’s Adjust property page (called up e.g. via 
Acquisition menu ⇒ Select Camera) is ignored. 

3. Optimum Speed Value: The exposure time is chosen according to the 
readout time of the camera, which is determined by the used camera 
parameters (Binning, ROI). With this setting it is possible to maximize the 
acquisition speed in the case of 2D time lapse imaging. This setting does not 
make sense in all other cases involving other hardware such as wavelength 
switching devices or fast piezo focussing devices. 

Dye 

This information is essential if you have installed the ApoTome or 3D 
Deconvolution modules. Here you can make a selection from a list of 
frequently used fluorescent dyes in the drop-down list box. This suggested 
color is also entered into the Color field. The correct values for excitation 
and/or emission maximums have also already been assigned to each 
fluorochrome. This information is important if you are using the 3D 
Deconvolution module, for example. 

You can, however, also enter a fluorochrome into the text field yourself. The 
corresponding wavelength information can be entered into the following two 
fields. 

Excitation wavelength [nm] 

This information is crucial if images are to be used in the 3D Deconvolution 
module. If you have entered your own fluorochrome under Dye, here you can 
specify the excitation maximum for that fluorochrome. Please bear in mind 
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that the value that is relevant here may be dependent on the excitation filter 
you are using. 

Emission wavelength [nm] 

This information is crucial if images are to be used in the 3D Deconvolution 
module. If you have entered your own fluorochrome under Dye, here you can 
specify the emission maximum for that fluorochrome. Please bear in mind that 
the value that is relevant here is dependent on the emission filter you are 
using. If you are using a bandpass emission filter, for example, its maximum 
should be entered here. If you are using a longpass emission filter, you should 
enter the actual emission maximum of the fluorochrome. 

Display settings 

Here you can influence the way in which your images are displayed on the 
screen. These settings do not influence the data in your images. The settings 
guarantee that images are always correctly displayed on the screen, 
irrespective of the dynamic range you are using on the camera. Any settings 
you make here have exactly the same function as the editing of the display 
characteristic curve (Properties function on the View menu). In the drop-
down list box, six display modes are available: 

1. System default (from Live image): The values currently set for the 
display curve in the live image properties window are  copied to the acquired 
image. The display curve is normally set to linear by default. 

2. Gamma and automatic black/white value: The values entered in the 
table for Gamma, Auto black value and Auto white value are all used. 

3. Gamma only: Only the value entered in the table for gamma is used. 
Display settings for black and white values are carried over from the Live 
image property / Display window and not from the table values here. 

4. Automatic black/white value only: Only the values entered in the table 
for Auto black value and Auto white value are used. The Gamma value is 
carried over from the Live image property / Display window and not from 
the table value here. 
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5. Black/white value autom. to min/max: The black value for the display 
curve is automatically set to the darkest pixel (=min), the white value to the 
brightest pixel (=max) in the image. This corresponds to the Min/Max 
function in the image Properties/Display window. The gamma value is 
carried over from the Live image property / Display window and not from 
the table value here. 

6. Fixed black/white value and gamma: Sets the display curve to both 
Gamma and a fixed black and white value based on the available dynamic 
range of the camera. Values are taken from the table entries for Gamma, 
Fixed black value and Fixed white value. 

Gamma 

In this edit field you can enter a Gamma value which is used to emphasize 
certain intensity ranges within your image when it is displayed on the monitor. 
A value <1 emphasizes the medium pixel intensities (also called “mid tones”). 
A value >1 emphasizes pixel intensities of very dark and very bright pixels, and 
therefore increases the contrast. Recommended settings are 0.8 for 
fluorescence images, 1.2 for phase contrast or DIC and 0.45 for true color 
images. Please bear in mind that a "correct" setting of the gamma value is 
dependent on numerous parameters, such as the monitor setting, ambient 
brightness etc., and a universal value cannot be prescribed. This value is only 
used in the modes Gamma and automatic black/white value, Gamma 
only and Fixed black/white value. 

Auto black value [% dark pixels] 

Indicate here the percentage of dark pixels in the image that you want to be 
displayed as 100% black. This reduces the unspecific background of the 
display. For fluorescence images a value of 5% is a good starting point. This 
value is used in the modes Gamma and automatic black/white value and  
Automatic black/white value only. 
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Auto white value [% bright pixels] 

Indicate here the percentage of bright pixels in the image that you want to be 
displayed as 100% white. A value of 0.1% for fluorescence images, for 
example, emphasizes structures that are represented by a small number of 
very bright pixels and is therefore a good starting point. This value is used in 
the modes Gamma and automatic black/white value and  Automatic 
black/white value only. 

Fixed black value [% of camera range] 

Here you can define a fixed black value below which all pixels will be 
displayed as 100% black. This value is defined as percentage of the dynamic 
range of the camera used rather than the image content. This guarantees 
equal and comparable display settings for all images acquired with this 
experiment. This value is used only in the mode Fixed black/white value 
and gamma. The following table shows some percentage values and the 
corresponding gray value of a camera with a given gray value range: 

Camera bit depth 8 10 12 14 16 
Maximum gray value 256 1024 4096 1638

4 
65536 

Fixed black value Resulting black value [in gray values] 
1 % 3 10 41 164 655 
5 % 13 51 205 819 3277 
10 % 26 102 410 1638 6554 
20 % 51 205 819 3277 13107 

 
Fixed white value [% of camera range] 

Here you can define a fixed white value below which all pixels will be 
displayed as 100% white. This value is based upon the dynamic range of the 
camera used rather than the image content. This value is defined as 
percentage of the dynamic range of the camera used rather than the image 
content. This value is used only in the mode Fixed black/white value and 
gamma. The following table shows some percentage values and the 
corresponding gray value of a camera with a given gray value range: 
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Camera bit depth 8 10 12 14 16 

Maximum gray value 256 1024 4096 16384 65536 
Fixed white value Resulting white value [in gray values] 

80 % 205 819 3277 13107 52429 

90 % 230 922 3686 14746 58982 

95 % 243 973 3891 15565 62259 

99 % 253 1014 4055 16220 64881 

 
Channel display weight [%] 

In the case of a multichannel image you can enter a bias for the contribution 
of individual channels in the mixed-color display (pseudo color). This function 
can also be found on the Colors property page (Properties function on the 
View menu). 

bñéçëìêÉ=

Here you can set the main acquisition parameters. 

¾ Time: Here enter the exposure time being used for the channel into the 

value field, either directly or using the  buttons. 

¾ Measure: To determine the exposure time interactively, click on the 

 button. The dialog that opens contains a live image, 
generated using the channel-specific hardware settings. The exposure 
time is automatically measured when the dialog is opened. After you click 

on , the dialog is closed and the new exposure time is 
adopted automatically. 
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Mode 

¾ Fixed: The time (in ms) entered in the Time field is used. The value on 
the camera’s Adjust property page is ignored. 

¾ Camera: The time (in ms) entered on the camera’s Adjust property page 
is used. 

Settings during Acquisition 

This field shows icons of those hardware components, which are switched 
before the selected channel is acquired.  

Settings after Acquisition 

This field shows icons of those hardware components, which are switched 
after the selected channel has been acquired.  

Edit Hardware Settings … 

Clicking on  opens the Fast Acquisition Setting 
Editor. 

c~ëí=^Åèìáëáíáçå=pÉííáåÖ=bÇáíçê=

In Fast Acquisition, fast hardware devices as well as a few selected slow 
components can be controlled during an experiment. Fast hardware devices 
include fast switchable light sources such as Colibri, Sutter DG4 or Uniblitz 
shutters. Relevant slow components include the motorized reflector turret or 
internal shutters in a microscope. 

This dialog contains all the channels configured for Fast Acquisition and allows 
a quick configuration of all the hardware relevant for setting up the channels. 
The channel name of the currently selected channel is also shown in the title 
of the Settings window. The dialog is subdivided in two horizontal areas. The 
upper area refers to settings which are activated before the acquisition while 
the lower area refers to settings activated after acquisition of the selected 
channel. 
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Both areas show a list of available components, dependent on the available 
hardware components set up in the Microscope Configuration. As a rule, 
slow components are controlled through serial commands (via RS232 or USB) 
while fast devices are controlled directly through electrical signals (“TTL”) 
which are connected to the system using the Analog/Digital Input/Output card 
installed in the computer. 

The listed items show an Enable checkbox which enables or disables a 
hardware component for Fast Acquisition. By selecting an entry in the list, the 
corresponding control elements are displayed on the right side where the 
appropriate settings can be made. An entry can be selected (meaning the 
components line in the list is selected by mouse click) but still be disabled 
(Enable checkbox is off). In this case the control elements are shown in a 
grayed out manner. 

The Status shows, if a component belongs to the class of fast or slow devices. 
After the Component name a fourth column Value summarizes the status 
the device will assume during acquisition of the selected channel. This text is 
also shown on the Fast Acqusition C (Channel) page. 

Both areas can be further configured for the experiment using a set of control 
elements situated at the bottom of each list. The order in which the devices 
are activated during an experiment can be changed by moving an entry 
upward to the top of the list. This can be done using the up or down arrow 

buttons . Slow components should be activated first so that faster 
components are only switched after the slow components have reached their 
final position. This prevents unnecessary damage to the sample. By clicking on 

the  icon all settings are applied to the hardware items. This allows you to 

test, if the settings would work during acquisition. Clicking on the  button 
on the other hand puts a selected hardware item in a mode so that changes 
are immediately applied to the hardware. This helps especially when adjusting 
laser power for the laser module. 

The complete list can be reset to its default by clicking on . 

9-150 M 60-3-0024 e / printed 06.2010 



Modules  - Fast Acquisition 

Settings for Dual Camera 

If two identical cameras are available and properly configured in the system, 
the acquisition speed in Fast Acquisition can be considerably increased by 
using the optional Dual Camera module. If the Dual Camera option is 
selected on the Experiment page (Camera) the system uses both cameras at 
the same time. 

¾ Please observe the information about dual camera installation in the Dual 
Camera chapter of this document. 

The synchronous mode of operation for both cameras further depends on 
how the Fast Hardware Settings in the Fast Acquisition Setting Editor are 
set up. Channel #1 may have a hardware settings configured before but not 
after acquisition while for channel #2 only settings after acquisition may be 
configured. Checking the Synchronize Dual Camera checkbox will gray out 
the appropriate before/after acquisition section in the channel Settings fields. 
This guarantees synchronous operation of both cameras. The checkbox is 
enabled by default as soon as Dual Camera is selected on the Experiment 
page (Æ Camera). 

If the checkbox is unchecked and settings are configured contrary to these 
instructions, acquisition will commence anyway but both cameras will be 
operated sequentially, i.e, without synchronicity. This can still make sense for 
certain applications, if the primary goal for Dual Camera is the fact that both 
cameras can be optically configured to see different spectral signals but there 
will be a time delay between the two channels. 

Adjusting the laser intensity and assignment of wavelengths 

In contrast to all other hardware items available for Fast Acquisition 
adjustments to the AOTF module can only be done on the first channel page. 
Transmission settings for the three possible AOTF channels have to be done 
on the set up page for the first channel but are used correctly in the following 
channels as long as the proper AOTF channel has been activated  and 

turned on . 
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¾ Using the  button you can add a channel from the 
Channel pool to the experiment, and then remove it from the 

experiment again using .  is used to 
add a copy of the currently selected channel to the experiment. If you 
want to permanently store a channel setting you have made so that it can 
be used again in other experiments, you can transfer channels to the 

Channel pool (  button). 

w=éêçéÉêíó=é~ÖÉ=EwJëí~ÅâF=

Settings 

Note: 
• Please note that a fast piezo focusing unit must be available and correctly 

connected to allow the fast acquisition of z-stacks. This will be used 
automatically during acquisition. The option of direct control of the piezo 
focusing unit by the user is not available, in order to prevent operating 
errors. Please use the microscope’s internal focus drive to focus on the 
sample. 

¾ The desired number of slices can either be entered directly into the # 

Slices value field or via the arrow buttons . The distance between the 
individual z-planes (in µm) can also be specified in this way in the Slice 
distance input field. 

¾ If you click on the  button, the correct z-interval is 
calculated automatically in accordance with the Nyquist theory (2x 
oversampling in axial direction). This is a prerequisite for successful use of 
the Deconvolution module. 

¾ Under Mode you can select whether you want to specify a z-stack from a 
central z-position (Center) or interactively specify an upper/lower z-
position limit (Start/Stop). The input field for Center and the 
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corresponding button  or the input fields for Start and 

Stop and the corresponding buttons  and  
will become active in accordance with your selection. If you click on the 
buttons, the current z-position is adopted into the value field. 

¾ The total thickness of the stack is indicated in the Z-Stack height value 
field. If a z-stack height is achieved that exceeds the maximum travel 
range of the fast piezo focusing unit, a warning message is displayed 

(  Piezo out of range). 

 
Within the context of Fast Acquisition, the All channels per slice mode is 
used automatically, as channel switching can generally be performed faster 
than focusing. In contrast to Multidimensional Acquisition, it is not 
therefore possible to deactivate this mode here. 

Z-Stack navigation 

This field allows you to use the focus drive with the z-stack acquisition 

parameters. Using the  and  buttons, you can move the focus drive in 

defined increments. If you click on , the z-drive moves to the center of the 

stack.  and  move it to the lower/upper limit. 

The slider  allows you to move directly to a certain position. The height 
of the z-stack is represented by a blue bar. If you go beyond the lower/upper 

limit using the  or  button, this bar gets smaller and smaller. 
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The time lapse dimension function allows you to acquire time lapse images 
and create films of moving processes in living cells or tissue and even of 
certain material applications. A time lapse image can be defined by entering 
the maximum speed, interval, maximum duration, number of images required 
or total duration of the experiment. The entries in the fields influence each 
other. AxioVision can calculate an approximate duration as a function of the 
time and the number of cycles, or the number of cycles as a function of the 
total duration and intervals. 

Interval Settings 

You can choose between Maximal Speed and a defined Interval. The 
desired time interval can either be specified directly in the Interval input field 

or via the arrow buttons . The unit can be selected from a drop-down list 
box (hours, minutes, seconds, milliseconds). 

Duration Settings 

You can choose between Maximal Duration, a defined number of cycles or 
a defined duration. The desired number of cycles can either be entered 

directly in the # Cycles input field or via the arrow buttons . 
The total duration can either be entered directly in the Duration input field or 

via the arrow buttons . The desired unit can be selected from a drop-down 
list box (hours, minutes, seconds, milliseconds). 
If you have changed either of the input values by entering a value directly into 

the field, click on the  button to automatically calculate the other 
value, i.e. the possible number of cycles (if you have defined the duration) or 
the time required (if you have defined the number of cycles). The input field 
for which the value is to be calculated is inactive. Please note that the values 
calculated in this way are only approximations. If you want the possible 

minimum interval times to be calculated precisely, please use the  
button. 
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Current Size 

Once the time settings have been made for your experiment, the memory 
required for the raw data and the resulting image series appears in this field. 
Please note that streaming data files should not be stored on the same 
physical hard disk as the ZVI image data generated from them during 
conversion. Only in this way can maximum speed be achieved during 
acquisition and conversion. 

Limits 

If you have selected Maximal Speed or Maximal Duration, you can click on 

the  button to have the absolute time limit that is possible with 
the current microscope setting calculated for your experiment. A limited 
number of images are acquired for this purpose. The limits resulting from this 
are displayed as the minimum possible interval. 

If any of the dimensions you have selected are not possible with the current 
settings due to insufficient hard-disk capacity, a warning message appears. In 
addition, details on the storage medium currently being used are displayed. 

Starting an experiment 

To acquire an experiment, open the Fast Acquisition dialog window by 

clicking on . 
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¾ Start (F5): Click on this button to start acquisition of the image 
sequence. This procedure can be repeated several times without the need 
to exit the Fast Acquisition dialog. The acquired image sequences are 
stored as raw data on the defined streaming partition. 

¾ Stop (F8): Click on this button to stop acquisition before the end point 
defined in the parameters has been reached. Once you have stopped the 
process, a new image sequence can be initiated using the Start (F5) 
button, although this will then be saved in a separate file. 

¾ Pause (F6): Click on this button to pause the acquisition procedure. 

¾ Continue (F7): Click on this button to continue acquisition in the same 
image file. 

• A progress indicator shows 
the elapsed time for the 
selected experiment. 

• Indicators for the available 
main memory and disk 
space for the raw data 
provide important 
information on the status 
of the overall system. It is 
also possible to see for 
how long it will be 
possible to acquire image 
data. 

• In case the harddisk performance for the Streaming partition being too 
low some images may not be saved during acquisition. These images are 
instead stored temporarily in RAM. The number of affected images is 
shown here. 
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¾ To give you an impression of the current acquisition process, the acquired 
images are shown in a Preview. Here you can select a channel 

( ) and influence its display settings 

( ), e.g. to improve the display of 
dark images with a low dynamic range. Due to the special acquisition 
technique, here you do not have access to all the intervention options 
that would be available to you when using the multidimensional image 
acquisition, where a ZVI image is generated immediately. 

Further processing of the image 

¾ The Start Cutter button closes the acquisition dialog and opens the Fast 
Acquisition Document Cutter dialog. 

c~ëí=^Åèìáëáíáçå=açÅìãÉåí=`ìííÉê=

¾  Describes the name of the input 
document. 

¾ The  button opens a gallery from which you can also load a document 
other than the one that was last active. To do this, click on the thumbnail 
of the desired streaming document. 

¾ : With these buttons you can select a channel to 
affect its display settings. 

¾ : The buttons on this 
toolbar can be used to adjust the display (brightness, contrast, zoom etc.) 
of the images. 
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¾ Using the  button on the toolbar, it is possible to define a region of 
interest in the image that you want to be taken into account during the 
conversion to ZVI. This also allows you to reduce the data volume to the 
relevant parts of the image. 

¾ Experiment Overview: In the bottom area you will see an overview of 
the entire experiment along a timeline: 

 

¾ Each acquisition event is signified by a yellow line allowing easier frame 
selection 

 

¾ It is possible to define the areas of the streaming document that you want 
to be converted to ZVI. When this dialog is called up for the first time, no 
time points are selected by default. Selection can be done by clicking with 
the left mouse button and dragging whilst keeping the mouse key 
depressed. Selection is symbolized by a magenta selection bar. The 
selection that is currently active is marked in magenta, whilst inactive 
selections are shown in gray 

¾ Segments within the experiment where the acquisition had been paused 
are signified through a lighter color. Such paused areas are automatically 
excluded from conversion.: 
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¾ The time point currently displayed is indicated using the following 
marking line: 

 

If you grab the upside-down triangle with your mouse, you can select the 
time point of your choice. In the area at the lower half you can use the 
left-hand mouse button to define an area to be converted: hold down 
mouse button, drag, release Æ defined area is marked in violet. You can 
mark as many areas as you wish. 

¾ It is possible for selected areas to be moved (left-hand mouse button). 

¾  Adjusts the zoom factor of the histogram in such a way that the 
entire experiment is displayed. 

¾  Allows you to display a part of the experiment in the histogram with 
a higher zoom factor (Zoom in). 

¾  Reduces the zoom factor for the displayed histogram area (Zoom 
out). 

¾  Moves the displayed histogram area (only active with Zoom in). 

¾ In the bottom area of the dialog you will find a table containing the 
selected areas with an indication of the exact start and end time points, 
the resulting duration and the start-image position and end-image 
position for the marked segments. 
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¾ It may be beneficial, especially if you need to select a time point precisely,, 

to position the time point marking line  and set it as the start point 

for a new area selection. This is done using the  button. 

As soon as a start point has been defined, the  button for 
defining an end point becomes active. 

¾ You can use the two arrow buttons  to browse through 
the streaming file frame by frame. This allows a more precise frame 
selection.  

¾ To select the entire time series for conversion, click on the  
button. 

¾ To delete selected area markings, you can use the  button 
(or alternatively the Delete key). 

Conversion Information 

¾ Here you will find a display of the file size of the newly generated ZVI 
image, the number of individual images it contains and the available 
memory on the target drive. 

Executing editing 

 converts the currently shown frame into a ZVI image and 
leaves the dialog open 
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 selects the complete streaming file, starts conversion 
immediately and closes the dialog. This button is selected as default which 
means that you can confirm this action immediately by hitting Enter on your 
keyboard. 

 Carries out the conversion to a ZVI image according to the 
individual selections, after which the dialog is closed automatically.  

 Carries out the conversion to a ZVI image, but the dialog 
remains open. This allows you to generate several ZVIs of different areas and 
regions conveniently one after another, without having to call up the dialog 
again each time. 

 Closes the dialog. No ZVI image is generated. 

The result of the conversion is a new, unsaved ZVI image. The ZVI images 
generated in this way can now be subjected to further, more precise analysis 
in a second step. 

fåÑçêã~íáçå=Ñçê=c~ëí=^Åèìáëáíáçå=

This function opens a dialog window, where you can find in tabular form 
important information in connection with the experiment. The information it 
contains refer always on the current experiment and will be updated 
automatically upon changing the experiment. 

Show 

In the drop-down list you can select, whether only an overview or all available 
information are shown. 

To get more explanations to the existing information, you can select an item. 
In the bottom area of the dialog you will find more explanation. 
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Many intra- and intercellular processes are accompanied by rapid changes in 
the local concentration of various ions, such as calcium (Ca++) or magnesium 
(Mg++). For example, the penetration of an egg cell by a sperm cells sets in 
motion an intracellular signal cascade that results, within a few seconds, in 
the egg-cell membrane becoming impermeable for other sperm. The signal 
transmission between cells, such as neurons, is another example. In these 
cases the transmission of the signal is also accompanied by the release of 
calcium ions. It is therefore possible to visualize these processes by measuring 
the Ca++ concentration via imaging. 

The AxioVision Physiology module supports all the common methods of 
calcium measurements as well as many other ion measurements such as pH. 

Method 1: excitation at one wavelength, detection at another 
wavelength. 
What is measured here is the increase in the intensity of a calcium-sensitive 
dye as a function of the Ca++ concentration. Examples of such dyes are 
Calcium-Green-1, Fluo-3, Fluo-4 or the BAPTA-based Oregon-Green dyes. The 
fact that only rapid sequential acquisition in one channel is necessary for this 
method means that it is ideal for measuring relative calcium changes, even 
with extremely rapid processes. However, it is difficult to perform quantitative 
measurements using this method. One method by which this can be 
attempted is to calculate the ratio of F/F0 by which a baseline time point is 
selected as F0. 

Method 2: excitation in two wavelengths, detection of the changes in 
fluorescence intensity in one wavelength, generation of a ratiometric 
output image. (“Excitation ratioing”) 
This method is based on the fact that certain calcium-sensitive dyes change 
their excitation spectrum as soon as calcium is bound. The most popular dye 
from this class is Fura-2. This is particularly well suited to imaging techniques, 
as it is easy to change the excitation wavelength with the help of fast 
wavelength changers (e.g. Sutter Lambda DG4). In addition, the ratiometric 
measurement principle means that the quantification is concentration-
independent. One disadvantage of Fura-2 is the need to perform excitation in 
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the UV range. Measurement of pH values can be performed using the dye 
BCECF, which changes its excitation maximum upon binding to protons (H+ 
ions). 

This method can also be used to perform calibrated calcium or pH 
measurements to determine absolute calcium concentrations or pH values. 
There are two methods for calibration: One involves creating one calibration 
valid for the whole image, the other method involves measuring minimum 
and maximum responses on a cell per cell base and using these values to 
deduce calcium values for each measured ROI. Physiology supports the second 
calibration method, also known as “in situ” calibration... 

Method 3: Excitation in one wavelength, detection of the changes in 
fluorescence intensity in two wavelengths (“Emission ratioing”) 
This third method uses dyes with which the calcium binding produces a 
change in the emission spectrum. This is also a ratiometric method. This 
requires the simultaneous detection of the signal in two wavelengths, which 
requires the use of the two camera module Dual Camera. With this module 
two cameras, which have been appropriately configured using a dual camera 
adapter to each see a different wavelength, can be operated simultaneously 
producing a two channel image in the same instant. A popular dye used for 
emission ratioing is Indo-1. Also Calcium sensitive FRET sensors such as the 
yellow cameleon fluorescent proteins follow a similar acquisition principle. 

For an overview of this issue, we recommend that you refer to Takahashi, A., 
et al., Measurement of Intracellular Calcium. Physiological Reviews 70, No. 4, 
pp1089 ff, 1999. Another good review appeared in Methods in Cell Biology, 
Vol. 72, pp 369-387 (“Ratio Imaging: Measuring Intracellular Ca++ and pH in 
Living Cells” by Randi B. Silver, 1998). For further information on the reagents 
and techniques used, see also http://www.invitrogen.com/probes. 

^Åèìáëáíáçå=éêáåÅáéäÉë=

The Physiology module enables you to acquire time lapse images at a speed 
that is only limited by the technical limitations of the devices you are using 
(camera, light source) and the selected camera settings. To achieve such 
speeds, the Physiology module automatically uses a "streaming" technique, 
which involves the raw camera data being written directly to their own fast 
streaming hard disk (or a suitable empty partition). 
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The results of the acquisition process are therefore a streaming document 
(*.ziAR). 

At the same time, enough memory is reserved so that the measurement data 
can also be managed, which are necessary for online display of the charts. 
Physiology calculates the maximum possible number of individual images 
that can be acquired from the number of measurement regions drawn in and 
the memory available on the streaming hard disk. As this value is dependent 
on numerous factors (binning, ROI, number of measurement regions drawn 
in, demands made on available free memory by other applications etc.), the 
entire hard-disk space that is theoretically available cannot always be used. 

In a second step, which is separate from the acquisition process, the 
streaming document is converted into a regular ZVI image document. This is 
required for all further processing steps in AxioVision. 

The principle is illustrated in the following schematic (the actual hard disk 
configuration in your computer may be different): 

 

This acquisition technique depends to a great extent on ensuring that you 
have the correct PC equipment and the correct configuration. Please observe 
the minimum technical requirements, which can be found in the "AxioVision 
Product Suite" installation manual. 
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The procedure for calcium measurements with the Physiology module can be 
divided into four steps: 

� Preparation of the experiment, setting of the camera and drawing in of 
measurement regions Æ Setup. 

� Acquisition of the time lapse image, including measurement of the 
changes in concentration during the acquisition process itself, with 
options for interaction to control the experiment Æ Image Acquisition. 

� Conversion of the acquired raw data into ZVI and downstream analysis Æ 
Cutter 

� Measurement of the acquired data with options to select measurement 
methods, specify the type of background correction or even select custom 
calculation formulas Æ Physiology Measurements. 

These steps are explained below following the individual control elements as 
they appear in the software. 

^Åèìáëáíáçå=

If you select this function on the Acquisition menu ⇒ Physiology 
Acquisition ⇒ Acquisition, the Physiology Acquisition dialog opens. This 
dialog can be resized to accommodate the text presented in the Parameters 
field. 

¾ Parameters: An overview of the most important acquisition parameters 
of the experiment currently active is displayed in list form: acquisition 
mode, number of ROIs (measurement regions), number of possible 
acquisition cycles, time interval currently set and maximum possible 
streaming file size. Please note that these values depend on the settings 
you entered in the Setup dialog. 

¾ : Opens the Physiology Setup dialog. 
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Template 

All settings relating to an image acquisition procedure with the Physiology 
module are managed as an Experiment. 

¾ Name: Name of the experiment. If the default experiment is loaded, the 
name field remains empty ( * ). 

¾ A newly created or modified Physiology experiment can be saved by 

clicking on . Experiments are always saved with the 
extension "ziAR" in your personal document folder (e.g. for the user 
"Administrator": C:\Documents and Settings\Administrator\My 
Documents\Carl Zeiss\Data\AcquisitionRecording\PhysiologyAcquisition). 

¾ You can also save an experiment under a new name using Save As (click 

on  at the side of the  button). 

¾ It is also possible to define a Physiology experiment as a default 
experiment, instead of constantly reloading experiments. 

¾ To do this, the Physiology experiment must first be configured in the 
desired way. To make this experiment a default experiment, you then 

need to select the Save As Default option (click on  at the side of the 

 button). This Physiology experiment will now be loaded 
as a default experiment every time you start AxioVision. Any changes that 
are made to this experiment while AxioVision is running will be rejected 
automatically when the program is closed. This ensures that the next user 
will always find the familiar default experiment. 

¾ If, after making changes, you want to restore the default experiment 
while AxioVision is running, you can do this using the Load Default 

option (click on  at the side of the  button). 

¾ To load a saved experiment, click on . 
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¾ To reset the Physiology Experiment to the factory default state, the 

Load Factory Default option is available (click on  at the side of the 

 button). 

¾ Prefix: Here you can enter the basic name for all images acquired using 
the Physiology module. 

Camera 

From the drop-down list field you can select, which camera should be used for 
fast acquisition. This is important for systems which are set up with two 
identical cameras in a Dual Camera configuration. You can choose either the 
ActiveAcquisition camera, which is the camera currently active in the system 
or you can specifically select one camera of your choice (e.g. AxioCamHS_2) 
which will then be automatically selected for acquisition irrespective of which 
camera is the currently active camera. Finally, you can choose DualCamera. In 
this case, two identical cameras can be used simultaneously. Please see the 
help for Dual Camera elsewhere for further details. 

Hardware-Settings for Experiment 

In this field you can enter hardware settings that prepare the hardware for 
fast Physiology Acquisition, e.g. switching the light path to the camera or 
preparing the light sources for fast acquisition. 

� Before experiment …: Here you can select a suitable hardware setting 

from the drop-down list box. If you click on the  button, you can 
apply the selected hardware setting to the microscope to test the settings. 

� After experiment …: You can use an additional hardware setting for 

the end of the experiment. If you click on the  button, you can apply 
the selected hardware setting to the microscope to test the settings. 
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Here you can enter settings for the experiment on the Regions, C (Channel) 
and Markers property pages. 

As soon as more than one channel has been configured, channel 1 is 
ratiometrically processed with channel 2 (method 2 or 3). If only one channel 
has been configured, the method Ratio Single Channel should be used and 
the analysis performed with the help of an F0 image. It is also possible to 
configure more than 2 channels (e.g. for a brightfield image). However, it is 
always only channels 1 and 2 that are analyzed. For method 3 (emission 
ratioing) Dual Camera has to be selected. Here camera #1 is always assigned 
to channel #1, camera #2 to channel #2. 

The Physiology Setup dialog is opened by clicking on . 

oÉÖáçåë=éêçéÉêíó=é~ÖÉ=

On this property page you can prepare the Physiology Experiment by 
defining the method for calculation, acquiring test images, drawing in 
regions, setting the camera exposure time and specifying how the ratio image 
should be calculated. 

Setup Measurement Regions of Interest (ROI) 

This page is divided into 6 areas, containing an image display and the 
corresponding chart display. First of all, you should acquire a test image. In 
order to do this, the channels must have been correctly set (on the 
C (Channel) property page of the Physiology Setup dialog). The 
explanations given here relate to method 2 with the acquisition of 2 channels. 
For other type of experiments (e.g. for the FRET calculations) additional 
control elements will appear. 
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¾ To perform acquisition, click on the  button. Three images 
are acquired for each channel using the currently active camera settings 
and a mean-gray-value image is calculated to suppress background noise. 
You will now see channel 1, channel 2 and the calculated ratio image, 
including a rainbow color table ("Rainbow LUT"). 

¾ At the lower edge of the dialog you will find a toolbar. A description of 
the first 11 tools can be found under Display Panel. 

¾ Using the other tools it is possible to draw in up to 100 regions, which 
will be used during the acquisition procedure itself for the online analysis. 
When you draw in several regions, the next color from the color list is 
automatically assigned to each new region. 

: Allows you to click on and select measurement regions that have a
been drawn in to move them, enlarge them, delete them or change their 
color. 

lready 

: Used to draw in a rectangular measurement region. If the  button is 
not selected, the tool remains active and it is possible to draw in several 
measurement regions one after the other. 

: Used to draw in a measurement region with a free form of your choice 

(spline). If the  button is not selected, the tool remains active and it is 
possible to draw in several measurement regions one after the other. 

: Used to draw in an ellipse as a measurement region. If the  button 
is not selected, the tool remains active and it is possible to draw in several 
measurement regions one after the other. If the Shift key is depressed while 
drawing in the ellipse, a circular form is enforced. 
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 Draws a circle. Starting point and end point of the drawing defines the 
diameter making it easy to e.g. define a circle encompassing a complete cell. 

If the  button is not selected, the tool remains active and it is possible to 
draw in several measurement regions one after the other. 

 When clicked, the last shape used for drawing a ROI is “remembered” 
and drawn into the overlay by simple clicking. This allows the cloning of a 
shape with ease. It works with all ROI tools except the free form spline tool. 

This function can be disabled by selecting . 

: Deletes all selected measurement regions. 

: Selects all available measurement regions. 

: Allows you to change the color for a measurement region. 

: Via Custom... it is possible to add further colors to the list 
from a color selection dialog. 

: Defines a selected measurement region as a background region. The 
mean gray value from this region can, if desired, be automatically subtracted 
from the measurement values from other regions. Selecting this option will 
also include subtraction of the background for the calculation of the ratio 
image. 
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Settings Channel 1 

Here it is possible to enter the desired exposure time for channel 1. 

¾ Time: enter the exposure time to be used for the channel into the value 

field, either directly or using the arrow buttons . 

¾ Measure: To determine the exposure time interactively, click on the 

 button. The dialog that opens contains a live image, 
generated using the channel-specific hardware settings. The exposure 
time is automatically measured when the dialog is opened. After you click 

on , the dialog is closed and the new exposure time is 
adopted automatically. 

Note: 
• Please note that, in order to achieve high acquisition speeds, the exposure 

time should not be set too high. Maximum exposure time allowed in 
Physiology experiments is 800 msec. If resulting images are displayed too 
dark, adjust the display settings accordingly. Also, consider using camera 
binning and define a region of interest for the camera to further increase 
the acquisition speed. 

Settings Channel 2 

Here it is possible to enter the desired exposure time for channel 2. 

¾ Time: Here enter the exposure time being used for the channel into the 

value field, either directly or using the  buttons. 
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¾ Measure: To determine the exposure time interactively, click on the 

 button. The dialog that opens contains a live image, 
generated using the channel-specific hardware settings. The exposure 
time is automatically measured when the dialog is opened. After you click 

on , the dialog is closed and the new exposure time is 
adopted automatically. 

Sync 

In order to ensure identical exposure times for all channels click on the Sync 
button. Running experiments with the same exposure times is highly 
recommended for most FRET measurements. 

Note: 
• Settings for channel 2 are only available if more than one channel is set 

up. Also, for single channel ratioing (method 1), the image area for 
channel 2 is used to display the so-called F0 reference image instead. An 
exposure time for channel 2 can be defined nevertheless. 

Ratio Image Definition 

¾ Method: From the drop down list box you can select which calculation 
method you want to use for your experiment. 7 Methods are available for 
analysis during acquisition (“online”): 

• Ratio Dual Channel: Classical dual channel ratio imaging using either 
method 2 (excitation ratioing, e.g. Fura-2) or 3 (emission ratio 
imaging, e.g. Indo-1). Ratio is always calculated dividing channel #1 by 
channel #2. Only available with setups containing two or more 
channels. 

• Ratio Single Channel: Single Channel ratio imaging such as Fluo-4; 
can be done with single or multiple channel setups, online processing 
always done with channel #1. 

• Fret Youvan: Sensitized emission FRET measurements using three 
images. Channel #1 = Donor, Channel #2 = Acceptor, channel #3 = 
FRET. Only available with setups containing three or more channels. 
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• Fret Gordon: Derivative of FRET Youvan. Only available with setups 
containing three or more channels. 

• Fret Xia: Derivative of FRET Youvan. Only available with setups 
containing three or more channels. 

• Fret Siegel BL: Acceptor bleaching method, requires two channel 
setup (channel #1 = donor, channel #2 = bleached acceptor). 
Measurement done on channel #1 only. 

• Fret Dual Channel: Ratiometric FRET method with 2 channels only 
disregarding the acceptor channel from the FRET calculation. This 
method can be used for fast FRET measurements using two cameras 
simultaneously in a Dual Camera configuration 

Note:  
• All the following explanations are based upon the Ratio Dual Channel 

method. A detailed explanation of the available FRET methods please see 
Physiology Measurements. 

To calculate the ratio image, the gray values from channel 1 are divided by the 
gray values from channel 2 pixel by pixel. As the resulting ratio values are 
usually very small, the results are multiplied by an arbitrary factor. This makes 
it possible to display the ratio values as an image. To enable you to distinguish 
ratio differences more easily, these values are displayed in color using a 
rainbow colored look up table. 

¾ The ratio image is calculated as outlined in the formula shown here: 

 

- r (x,y) = ratio image 
- Multiplier = factor by which the result of the division is multiplied 
- channel 1 (x,y): image from channel 1 
- channel 2 (x,y): image from channel 2 
- Offset = factor that influences the general brightness of the ratio image. 

AxioVision User's Guide, Release 4.8.2 9-173 



Modules  - Physiology 

¾ In order to make it easier to match ratio image display and ratio charts the 
display can be influenced directly by changing lower (Minimum) and 
upper (Maximum) boundaries of the actual Ratio values. Use the sliders 
for Minimum or Maximum or by enter the values directly in the edit 
fields: 

 

The corresponding multiplier and offset factors are updated in the 
displayed formula. 

¾ By increasing the lower limit one can reduce the background of small 
ratios, by raising the upper limit, also larger ratios can be displayed 
properly. A minimum of 0 and a maximum of 3 cover the range of ratios 
commonly occurring in biology. 

¾ In the case of a single channel (method 1), a reference image is used as a 
denominator for the calculation. This so-called F0 image can be acquired 

using the  button. Please note, that once an acquired F0 
image is available it will remain active as long AxioVision is running. As 
soon as the conditions of the experiment change, a new F0 image has to 
be acquired. 

¾ If a ROI has been selected for background correction the ratio image is 
calculated after background subtraction. This can lead to very small gray 
values producing very large ratios which are then visible as white noise in 
the ratio image. This happens e.g. around the edges of cells. This negative 
effect can later be dealt with during offline measurement by including the 
Confidence Mapping function. 
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The basic functions available on this property page are identical to those on 
the C (Channels) property page for Fast Acquisition. 

In Physiology, up to 5 channels can be configured for acquisition. However, 
only the first (for single channel experiments, method 1) or the first and 
second channel (methods 2&3) will be taken into account for the online 
analysis. The other channels will nevertheless be acquired and used during the 
conversion into a ZVI document and will therefore be available for further 
processing. 

j~êâÉêë=éêçéÉêíó=é~ÖÉ=

Marker 

One of the most important functions for ion measurements is the ability to 
change the conditions of the experiment during acquisition and to log 
changes in the experiment. Physiology makes two types of markers available 
for this purpose. 

� Speed Marker: These markers can be used to change the interval 
between the individual time points for image acquisition at the touch of a 
button. 

� Event Marker: These markers enable you to enter previously defined 
events, such as a change of media, into the current experiment at the 
touch of a button. It is also possible to apply hardware settings using 
Event Markers. 

Both types of marker are incorporated into the log when they are used. They 
subsequently enable you to navigate more easily within the acquired data and 
can also be inserted into the image as annotations. 

AxioVision User's Guide, Release 4.8.2 9-175 



Modules  - Physiology 

Speed Marker 

¾ You can define as many markers as you wish. To create a new marker, 

click on the  button and enter the desired 
settings. 

¾ Marker Settings control area: Here you can give the Speed Marker a 
Name, enter a Tool tip text that will appear as a yellow text box if the 
mouse is moved over the button, allocate a Color to the marker from the 

 drop-down list box and define a Shortcut that enables you to 
operate the marker rapidly without having to click with the mouse. 

¾ Interval settings control area: Here you can define the acquisition 
frequency of a Speed marker. You can choose between 6 options: 

• As fast as possible: Acquisition will happen as fast as the camera 
allows 

• Interval: The desired time interval can either be specified directly in 

the Interval input field or via the arrow buttons . The unit can be 
selected from a drop-down list box (hours, minutes, seconds, 
milliseconds). 

• Start for: Instead of starting the experiment for an undefined period 
of time this marker setting allows you to specify a time duration for 
the whole experiment. You have to start the experiment with this 
marker for the timing constraint to take effect and not the regular 
Start (F5) button. 

Note:  
The remaining time of the experiment when using the Start for 
function is determined by calculating the number of remaining 
frames given the currently active interval setting when clicking the 
Start for Speed marker. This means, that when changing the interval 
during acquisition after having clicked on a Start for speed marker 
the timing of the experiment will not be as anticipated as the nr. of 
remaining frames will not be modified. 
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• Pause: Pauses the experiment 

• Continue: Continues a paused experiment 

• Stop: Stops the experiment 

¾ Trigger Mode control area: Here you can set up a marker to activate 
itself automatically upon an incoming trigger. Triggers can be either a 
predefined timer starting with the experiment or an electrical TTL signal 
coming in through the Digital I/O Device/SVB-1. 

¾ Off: Turns off automatic triggering 

• After: The desired timing for a software trigger event can either be 

specified directly in the After input field or via the arrow buttons . 
The unit can be selected from a drop-down list box (hours, minutes, 
seconds, milliseconds). The marker will be set once after starting the 
experiment when the specified time has elapsed. This feature allows 
setting up heterogeneous physiology experiments for unattended 
operation. This is done simply by defining several speed markers with 
different time intervals and trigger timings according to the following 
example: 
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The experiment gets started with an interval setting of 1 frame/s by 
clicking on the Start (F5) button. At the same time the counter for 
the software trigger events is started. After 2 min. the frequency is 
increased to 2 frames/s, after 4 minutes to as fast as possible, after 5 
minutes the original acquisition frequency of 1 fps is restored and the 
experiment stopped after 10 minutes. 

• TTL Input: Alternatively one can also use hardware trigger signals to 
activate a speed marker. Two TTL input lines are available through the 
Digital I/O Device together with the SVB-1 (TTL In 7 or TTL In 8). 
Both can be configured to react upon a change from low to high 
voltage (“High”) or from high to low (“Low”) depending on the type 
of external TTL source. 

¾ To delete a marker, click on the drop-down list box next to each button 

and select the Delete option . 

Event Marker 

¾ Here you can define as many event markers as you wish. To create a new 

marker, click on the  button and enter the 
desired settings. 

¾ Marker Settings control area: Here you can give the Event Marker a 
Name, enter a Tool tip text that will appear as a yellow text box if the 
mouse is moved over the button, allocate a Color to the marker from the 

 drop-down list box and define a Shortcut that enables you to 
operate the marker rapidly without having to click with the mouse. 

¾ Hardware Settings control area: Here it is possible to select an existing 
hardware setting that you want to be executed if the marker is selected 
during acquisition. Please note that you should only make changes to 
devices which make sense to change during fast image acquisition. You 
should not make any adjustments to, in particular, the camera resolution 
or the light source, to prevent the sequence of the experiment being 
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disrupted. Please check the Enabled check box in order to activate the 
execution of the hardware setting. 

¾ Trigger Mode control area: Here you can set up an event marker to 
activate itself automatically upon an incoming trigger. Triggers can be 
either a predefined timer (counting starts with the start of the experiment) 
or an electrical TTL signal coming in through the Digital I/O Device. Since 
Event marker can also be linked with hardware settings it is possible to set 
up flexible experiment protocols where specific hardware components are 
switched during the experiment automatically. 

• Off: Turns off automatic triggering 

• After: The desired software trigger timing can either be specified 

directly in the After input field or via the arrow buttons . The unit 
can be selected from a drop-down list box (hours, minutes, seconds, 
milliseconds). Markers triggered that way will be executed once 
during the experiment after the specified time has elapsed. 

• TTL Input: Alternatively one can also use hardware trigger signals to 
activate an event marker. Two TTL input lines are available through 
the Digital I/O Device together with the SVB-1 (TTL In 7 or TTL In 
8). Both can be configured to react upon a change from low to high 
voltage ("High") or from high to low ("Low") depending on the type 
of external TTL source. 

¾ To delete a marker, click on the drop-down list box next to each button 

and select the Delete option . 
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The dialog for image acquisition is opened using the  button. This 
dialog is divided into four areas: 

� Area for setting markers. 
� Area containing buttons for starting and stopping acquisition as well as 

the most important status information. 
� Area containing charts and the acquired images. 
� Overview chart for the entire experiment. 

Speed Marker 

Here you can activate a speed marker, either by mouseclick, by using a 
keyboard shortcut (if configured) or by a trigger signal. The acquisition speed 
then changes accordingly. Each marker if clicked is entered in the marker list 
for the experiment. It is also possible to use special speed marker settings to 
automatically change the acquisition speed, start the experiment for only a 
predefined period of time, pause, continue or stop the experiment. 

It is also possible to create new markers or modify existing ones during 
acquisition. To do this, click on the Edit option in the drop-down list box for 

the marker.  In the dialog that opens you can 
then make the desired changes. 

Event Marker 

Here you can activate an event marker, either by mouseclick, by using a 
keyboard shortcut (if configured) or by a trigger signal.  The corresponding 
coment is then entered in the marker list for the experiment. If an event 
marker is linked to a hardware setting, the corresponding hardware setting is 
executed. 

It is also possible to create new markers or modify existing ones during 
acquisition. To do this, click on the Edit option in the drop-down list box for 
the marker. 
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In the dialog that opens you can then make the desired changes. The Enable 
Hardware Settings option activates or deactivates the link to the Event 
Marker. 

Acquisition area 

¾ Start (F5): Clicking on this button (or keyboard shortcut F5) starts 
acquisition for the experiment. It is possible to repeat this procedure 
multiple times once acquisition has been completed without leaving the 
Physiology Acquisition dialog. The acquired image sequences are 
stored as raw data on the defined streaming partition. 

¾ Stop (F8): Clicking on this button (or keyboard shortcut F8) stops 
acquisition. Once you have stopped the process, a new image sequence 
can be initiated immediately using the Start (F5) button, although this 
will then be saved in a new streaming file. 

¾ Pause (F6): Clicking on this button (or keyboard shortcut F6) pauses the 
acquisition procedure. 

¾ Focussing (F9): Clicking this button (or using the keyboard shortcut F9) 
changes the acquisition speed to As fast as possible in order to allow 
focusing the sample. During this time the system continues delivering 
images but they will not be saved. This function is therefore equivalent to 
pausing the experiment while still updating the images. This helps avoid 
gathering unnecessary data. Clicking on Continue (F7) will commence 
acquisition with image storage with the last selected acquisition speed. 
The focusing time in the final image will be indicated by a focusing 
marker as well as a Pause segment. 

¾ Continue (F7): Clicking on this button (or keyboard shortcut F7) allows 
you to continue acquisition in the same image file. 
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• A progress indicator shows 
the elapsed time for the 
selected experiment. 

• Indicators for the available 
main memory and disk 
space for the raw data 
provide important 
information on the status 
of the overall system. It is 
also possible to see for 
how long it will be 
possible to acquire image 
data. 

• In case the hard disk performance for the Streaming partition being 
too low some images may not be saved during acquisition. These 
images are instead stored temporarily in RAM. The number of 
unsaved images is indicated here as well as the usage of RAM 
memory (bar on the left). 

Charts and image display 

¾ Markers: Shows all entries for the current experiment in list form. Every 
event is entered as a comment and transferred to the ZVI image during 
subsequent conversion. 

¾ : These buttons allow you to 
adjust the display (brightness, contrast, zoom etc.) for the images during 
acquisition as well as show a display histogram. 

¾ The drop-down list box next to the  icon opens a dialog in which the 
sliders for influencing the ratio image are available. These allow you to 
change the ratio display during acquisition.  
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¾ For method 2 (excitation ratioing in two channels) or method 3 
(emission ratioing), channel 1, channel 2 and the ratio image are 
displayed. To the left of these are the corresponding measurement value 
charts. 

¾ For method 1 (single-channel experiments), only channel 1 and the 
acquired reference image F0, as well as the ratio image, are displayed. 

¾ For FRET imaging you will see Donor, Acceptor and the processed FRET 
image. 

¾ If you double-click into the Ratio image it will magnify and hide the other 
image displays. Also only the Ratio chart will be displayed. This will allow 
easier observation of the experiment. Double-clicking once more restores 
the standard layout. 

¾ The charts can display 6 different measurement values for all drawn-in 
measurement regions (this setting can be entered via a shortcut menu 
Displayed value …, which is opened by right-clicking): 

• Mean gray value channel 1  
• Mean gray value channel 1 minus background 
• Mean gray value channel 2 
• Mean gray value channel 2 minus background 
• Ratio value 
• Ratio value minus background 

¾ Chart settings: The three charts next to channel 1, 2 and ratio image can 
be configured by right-clicking on a chart and selecting Chart Settings 
upon which a Chart Settings dialog is opened: 
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The dialog is divided into three tabs which allow the configuration of the 
chart parameters such as changing the default title, specifying a specific 
value range for X- or Y-axis, displaying or hiding legend and title or 
specifying tick marks. A Reset button on the X Axis and Y Axis page 
resets the chart configuration to its default setting. 

¾ Experiment overview chart: At the bottom edge of the window you 
will see an overview of the entire experiment. Here you see the Ratio 
values displayed as measurement traces, all event markers are shown by 
name and with a cross marking the time point and a navigation tool with 
a line marking the current time point. 
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Each camera acquisition (“snap”) is marked on the x-axis by a yellow line 

allowing precise frame selection . 

Here too it is possible to select which values you want the chart to display 
(right-hand mouse button, Chart settings). During the experiment, the 
new images and measurement values of the time lapse image are added 
continuously. The X-axis of the overview chart is updated once every 10 
minutes during an experiment. The broken red line of the navigation tool 
moves with each acquired image which is always displayed automatically. 

However, you can also stop the marking line by deactivating the 

 button. 

You have the option of using the marking line like a slider to move to an 
earlier time point and revisit the acquired data. The red, broken marking 
line has two red, solid peripheral lines. The area within these two lines 
corresponds to the area that is displayed in the charts next to the images. 
If you grab the squares at the top edge of the area boundaries, it is 
possible to change the range shown in the charts. 
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¾ ROI and line selection: During the experiment, especially one with many 
measurement ROI’s drawn in, it may be desirable to e.g. see which cell is 
especially active. You can therefore click on either an interesting looking 
measurement line in any of the charts, select a ROI in one of the displayed 
image displays or select it in the ROI legend at the bottom of each chart 

. 

Either selection will automatically select the corresponding shapes in the 
other areas. Selected lines show up more brightly on the screen, 
unselected lines become subdued in appearance. 

 

¾  If a ROI or measurement line is selected, moving the mouse cursor along 
the line with no buttons depressed shows a gray line and a pop up text 
showing the relevant intensity or ratio values. 
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¾ To move the marking line step by step, you can use the  and  
buttons. 

¾ After stopping the experiment (Stop or F8), you can directly load the new 
file in the Cutter to allow conversion into ZVI by clicking on the 

 button. 

¾ Clicking on the  button will exit the dialog. 

Note: 
• No other setting options are accessible in AxioVision while the 

Physiology Acquisition dialog is open. This is designed on purpose to 
prevent operating errors. 

¾ Once the dialog is closed, all acquired image data are loaded in 
AxioVision in streaming format, but have not yet been saved. They exist 
on hard disk but not in a format which AxioVision can read. 

¾ The streaming data can be saved as a *.ziStream document. Streaming 
files per se cannot be reopened in AxioVision. Upon saving each 
*.ziStream file will be accompanied by a *.ziAR file containing all relevant 
meta-information about the experiment and the data, which you will see, 
when reopening a streaming file. Both files are necessary to open an 
experiment again. 

¾ Please also note, that streaming files must not remain on the streaming 
disk in order to prevent disk fragmentation and the resulting loss in hard 
disk performance. Upon closing AxioVision, you will be therefore asked if 
you want to save or discard unsaved streaming files. 
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To generate a ZVI image from a saved or unsaved *.ziAR streaming 
document, you will require the Cutter. Open the Cutter via the 
corresponding entry in the work area or the Acquisition menu ⇒ 
Physiology Acquisition ⇒ Cutter. 

The principal task of the Cutter is to reduce the time-consuming conversion 
of the raw data into a ZVI image to a sensible level. This makes it possible to 
reduce the data volume and speed up the further processing of the data. 

Note: 
• The Cutter can only be opened if a suitable streaming file has also been 

loaded in AxioVision (otherwise the following error message appears: “No 
streaming document available to edit. Please first open a streaming 
document (*.ziAR)”). 

`ìííÉê=mÜóëáçäçÖó=

The Cutter Physiology dialog is structured in a similar way to the 
Physiology Acquisition dialog. 

¾  Describes the name of the input 
document. 

¾ The  button opens a gallery from which you can also load a document 
other than the one that was last active. To do this, click on the thumbnail 
of the desired streaming document. 

¾ : The buttons on this 
toolbar can be used to adjust the display (brightness, contrast, zoom etc.) 
of the images. 
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¾ Using the  button on the toolbar, it is possible to define a region of 
interest in the image that you want to be taken into account during the 
conversion to ZVI. This will dramatically reduce the data volume to the 
relevant parts of the image. 

¾ The drop-down list box next to the  icon opens a dialog in which the 
sliders for influencing the ratio image are available.  

¾ Marker: Shows all entries for the current experiment in list form to the 
right of the dialog. Every marker is transferred as a comment to the ZVI 
image during conversion and can later be inserted into the generated ZVI 
image as an annotation via Annotations ⇒ Frequent Annotations ⇒ 
Event marker / Speed marker. 

¾ The time format for the marker list can be changed by right-mouse click 
in the header row of the list and selecting the Properties Dialog:  

 

Please select the desired time format (Seconds, Minutes, Hour or the 
generic format hh:mm:ss:msec which is the default setting) from the 
drop down list. You can also select the frame number. 

¾ For methods 2 or 3 (excitation or emission ratioing in two channels), 
channel 1, channel 2 and the ratio image are displayed. To the right of 
these are the corresponding charts displaying the measurement values . 

¾ For method 1, only channel 1 and the acquired reference image F0, as 
well as the ratio image, are displayed. 
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¾ The charts can display 6 different measurement values for all drawn-in 
measurement regions (this setting can be entered via the menu 
Displayed value …, which is opened by right-clicking): 

• Mean gray value channel 1  
• Mean gray value channel 1 minus background 
• Mean gray value channel 2 
• Mean gray value channel 2 minus background 
• Ratio value 
• Ratio value minus backgroundccc 

¾ Chart settings: The charts can be configured by right-clicking on a chart 
and selecting Properties upon which a Chart Settings dialog is opened: 
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The dialog is divided into three tabs which allow the configuration of the 
chart parameters such as changing the default title, specifying a specific 
value range for X- or Y-axis, displaying or hiding legend and title or 
specifying tick marks. A Reset button resets the chart configuration to its 
default setting. 

¾ Experiment Overview: In the bottom area you will see an overview of 
the entire experiment displaying markers and measurement curves: 

 

¾ Each acquisition event is signified by a yellow line allowing easier frame 
selection 

 

¾ In this control element it is possible to define the areas of the streaming 
document that you want to be converted to ZVI. When this dialog is 
called up for the first time, nothing is selected. Selection can be done by 
clicking with the left mouse button and dragging whilst keeping the 
mouse key depressed. Selection is symbolized by a magenta selection bar. 
Segments within the experiment where the acquisition had been paused 
are signified through a lighter color. Such paused areas are automatically 
excluded from conversion. 
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¾ The time point currently displayed is indicated using the following 
marking line: 

 

If you grab the upside-down triangle with your mouse, you can select the 
time point of your choice. In the area at the lower half you can use the 
left-hand mouse button to define an area to be converted: hold down 
mouse button, drag, release Æ defined area is marked in magenta. You 
can mark as many areas as you wish. 

¾ The area that is currently active is marked in magenta, whilst inactive 
selections are shown in gray 

 

¾ It is possible for marked areas to be moved (left-hand mouse button). 

 Adjusts the zoom factor of the chart in such a way that the entire 
experiment is displayed. 

 Allows you to display a part of the experiment in the chart with a higher 
zoom factor (Zoom in). 

 Reduces the zoom factor for the displayed chart area (Zoom out). 

 Moves the displayed chart area (only active with Zoom in). 
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¾ In the bottom area of the dialog you will find a table containing the 
selected areas with an indication of the exact start and end time points, 
the resulting duration and the start-image position and end-image 
position for the marked segments. 

¾ It may be beneficial, especially if you need to select a time point precisely, 

to position the time point marking line  and set it as the start point 

for a new area selection. This is done using the  button. 

As soon as a start point has been defined, the  button for 
defining an end point becomes active. 

¾ You can use the two arrow buttons  to browse through 
the streaming file frame by frame. This allows an even more precise frame 
selection.  

¾ To select the entire time series for conversion, click on the  
button. 

¾ To delete selected area markings, you can use the  button 
(or alternatively the Delete key). 

Conversion Information 

¾ Here you will find a display of the file size of the newly generated ZVI 
image, the number of individual images it contains and the available 
memory on the target drive. 
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Executing editing 

 converts the currently shown frame into a ZVI image and 
leaves the dialog open 

 selects the complete streaming file, starts conversion 
immediately and closes the dialog. This button is selected as default which 
means that you can confirm this action immediately by hitting Enter on your 
keyboard. 

 Carries out the conversion to a ZVI image according to the 
individual selections, after which the dialog is closed automatically.  

 Carries out the conversion to a ZVI image, but the dialog 
remains open. This allows you to generate several ZVIs of different areas and 
regions conveniently one after another, without having to call up the dialog 
again each time. 

 Closes the dialog. No ZVI image is generated. 

The result of the conversion is a new, unsaved ZVI image. Images generated in 
this way can now be subjected to post acquisition analysis using the 
Measurements function 

9-194 M 60-3-0024 e / printed 06.2010 



Modules  - Physiology 

mÜóëáçäçÖó=jÉ~ëìêÉãÉåíë=

During acquisition preliminary measurements are performed based on the 
drawn in measurement regions. These online measurements mainly feed the 
charts with data for online display. Measurement regions can also be moved 
to compensate for moving cells during the experiment. This option as well as 
other vagaries during the experiment can lead to measurement values 
inconsistent with the experimental goals. Therefore a detailed analysis of the 
acquired data must be done after the acquisition. This can be done using the 
Measurements function in the Physiology module. 

Measurements can read any ZVI time series, also if the series has not been 
acquired using Physiology. ZVI time series can have one or more channels, 
which can be selected flexibly for measurement. The strict channel order 
which is required for online measurement does not apply for offline 
measurement. Streaming files (*.ziAR) must be converted into ZVI first using 
the Cutter. 

¾ You can open the Physiology Measurements dialog by clicking on 
Measurements in the Acquisition menu ⇒ Physiology Acquisition ⇒ 
Measurements. 

¾ Always the active ZVI image is loaded into the Measurement dialog. By 

using the  button another ZVI image can be selected from the 
Gallery. 

¾ The left side of the dialog features three tabs for setting up which 
channels should be measured (Channel Setup), for configuring the 
measurement parameters (Measurement) as well as parameters for 
generation of the ratio image (Ratio Image). 

Channel Setup 

¾ Method: From the drop down list box you can select a calculation 
method. Default method is Ratio Dual Channel. There are 8 predefined 
methods but you can also use your own custom formula. The parameters 
which can be changed depend on the method selected. For the various 
FRET methods the different formulas used are displayed as well: 
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• Ratio Dual Channel: Classical dual channel ratio imaging using either 
method 2 (excitation ratioing, e.g. Fura-2) or 3 (emission ratio 
imaging, e.g. Indo-1), only with two channel setups. Ratio is always 
calculated dividing channel #1 by channel #2. 

• Ratio Single Channel: Single Channel ratio imaging such as Fluo-4; 
can be done with single or multiple channel setups, online processing 
always done with channel #1. 

• Fret Youvan: Sensitized emission FRET measurements using three 
images. Channel #1 = donor, channel #2 = acceptor, channel #3 = 
FRET. 

• Fret Donor Ratio: channel #1 = donor, channel #2 = acceptor, 
channel #3 = FRET. 

• Fret Acceptor Ratio: channel #1 = donor, channel #2 = acceptor, 
channel #3 = FRET. 

• Fret Gordon: Derivative of FRET Youvan. 

• Fret Xia: Derivative of FRET Youvan. 

• Fret Siegel BL: Acceptor bleaching method, requires two channel 
setup. 

• Custom formula: Using regular algebra terms a customized formula 
can be edited and applied to the data.  
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Examples for FRET calculations using the Custom Formula 
function 

Youvan 
Fc = (GWfr - BGfr) - CFdon * (GWdon - BGdon) - CFacc * (GWacc - BGacc) 
 (ch3 - 1.275 * bg3) - 0.19 * (ch1 - 1.275 * bg1) - 0.09 * (ch2 - 1.275 
  * bg2) 
 (ch3 - 1.3 * bg3) - 0.19 * (ch1 - 1.3 * bg1) - 0.09 * (ch2 - 1.3 * bg2) 
 (ch3 - bg3) - 0.19 * (ch1 - bg1) - 0.09 * (ch2 - bg2) 
 (ch3) - 0.19 * (ch1) - 0.09 * (ch2) 
 
Gordon 
Fn = Fc / ((GWdon - 1.275 * BGdon) * (GWacc - 1.275 * BGacc)) 
 ((ch3 - 1.275 * bg3) - 0.19 * (ch1 - 1.275 * bg1) - 0.09 * (ch2 – 

1.275 * bg2)) / ((ch1 - 1.275 * bg1) * (ch2 - 1.275 * bg2)) 
 ((ch3 - 1.3 * bg3) - 0.19 * (ch1 - 1.3 * bg1) - 0.09 * (ch2 - 1.3 * 

bg2)) / ((ch1 - 1.3 * bg1) * (ch2 - 1.3 * bg2)) 
 ((ch3 - bg3) - 0.19 * (ch1 - bg1) - 0.09 * (ch2 - bg2)) / ((ch1 - bg1) * 

(ch2 - bg2)) 
 ((ch3) - 0.19 * (ch1) - 0.09 * (ch2)) / ((ch1) * (ch2)) 
 
Xia 
NF = Fc / SQRT((GWdon - 1.275 * BGdon) * (GWacc - 1.275 * BGacc)) 
 ((ch3 - 1.275 * bg3) - 0.19 * (ch1 - 1.275 * bg1) - 0.09 * (ch2 – 

1.275 * bg2)) / sqrt((ch1 - 1.275 * bg1) * (ch2 - 1.275 * bg2)) 
 ((ch3 - 1.3 * bg3) - 0.19 * (ch1 - 1.3 * bg1) - 0.09 * (ch2 - 1.3 * 

bg2)) / sqrt((ch1 - 1.3 * bg1) * (ch2 - 1.3 * bg2)) 
 ((ch3 - bg3) - 0.19 * (ch1 - bg1) - 0.09 * (ch2 - bg2)) / sqrt((ch1 –  

bg1) * (ch2 - bg2)) 
 ((ch3) - 0.19 * (ch1) - 0.09 * (ch2)) / sqrt((ch1) * (ch2)) 
 
Acceptor Ratio 
AcR = Fc / (GWacc - 1.275 * BGacc) 
 ((ch3 - 1.275 * bg3) - 0.19 * (ch1 - 1.275 * bg1) - 0.09 * (ch2 – 

1.275 * bg2)) / (ch2 - 1.275 * bg2) 
 ((ch3 - 1.3 * bg3) - 0.19 * (ch1 - 1.3 * bg1) - 0.09 * (ch2 - 1.3 * 

bg2)) / (ch2 - 1.3 * bg2) 
 ((ch3 - bg3) - 0.19 * (ch1 - bg1) - 0.09 * (ch2 - bg2)) / (ch2 - bg2) 
 ((ch3) - 0.19 * (ch1) - 0.09 * (ch2)) / (ch2) 
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Siegel (Acceptor Bleaching) 
BL = 100 * (1 - (GWdonbef - BGdonbef) / (GWdonaft - BGdonaft)) 
 100 * (1 - (f0 - 1.275 * bgf0) / (ch1 - 1.275 * bg1)) 
 100 * (1 - (f0 - 1.3 * bgf0) / (ch1 - 1.3 * bg1)) 
 100 * (1 - (f0 - bgf0) / (ch1 - bg1)) 
 100 * (1 - (f0) / (ch1)) 
 
Calculation of correction factors: 
 
Donor correction factor 
CFdon = 100 * (GWfr - BGfr) / (GWdon - BGdon) 
 100 * (ch3 - 1.275 * bg3) / (ch1 - 1.275 * bg1) 
 100 * (ch3 - 1.3 * bg3) / (ch1 - 1.3 * bg1) 
 100 * (ch3 - bg3) / (ch1 - bg1) 
 100 * (ch3) / (ch1) 
 
Acceptor correction factor 
CFacc = 100 * (GWfr - BGfr) / (GWacc - BGacc) 
 100 * (ch3 - 1.275 * bg3) / (ch2 - 1.275 * bg2) 
 100 * (ch3 - 1.3 * bg3) / (ch2 - 1.3 * bg2) 
 100 * (ch3 - bg3) / (ch2 - bg2) 
 100 * (ch3) / ch2) 
 
Neue Formeln: 
 
Donor Ratio 1 
DoR = Fc / (GWdon - 1.275 * BGdon) 
 ((ch3 - 1.275 * bg3) - 0.19 * (ch1 - 1.275 * bg1) - 0.09 * (ch2 – 

1.275 * bg2)) / (ch1 - 1.275 * bg1) 
 ((ch3 - 1.3 * bg3) - 0.19 * (ch1 - 1.3 * bg1) - 0.09 * (ch2 - 1.3 * 

bg2)) / (ch1 - 1.3 * bg1) 
 ((ch3 - bg3) - 0.19 * (ch1 - bg1) - 0.09 * (ch2 - bg2)) / (ch1 - bg1) 
 ((ch3) - 0.19 * (ch1) - 0.09 * (ch2)) / (ch1) 
 
New formulas for customer formula (examples): 
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2-channel methods: 
 
Donor Ratio 2 (Gordon) 
FR01 = (GWfr - BGfr) / (GWdon - BGdon) 
 (ch3 - 1.275 * bg3) / (ch1 - 1.275 * bg1) 
 (ch3 - 1.3 * bg3) / (ch1 - 1.3 * bg1) 
 (ch3 - bg3) / (ch1 - bg1) 
 (ch3) / (ch1) 
 
Donor Ratio 3 (Gordon) 
FR02 = (GWacc - BGacc) / (GWdon - BGdon) 
 (ch2 - 1.275 * bg2) / (ch1 - 1.275 * bg1) 
 (ch2 - 1.3 * bg2) / (ch1 - 1.3 * bg1) 
 (ch2 - bg2) / (ch1 - bg1) 
 (ch2) / (ch1) 
 
Donor Ratio 4 
FR03 = ((GWfr - BGfr) - CFdon * (GWdon - BGdon)) / (GWdon - BGdon) 
 ((ch3 - 1.275 * bg3) - 0.19 * (ch1 - 1.275 * bg1))/(ch1 - 1.275*bg1) 
 ((ch3 - 1.3 * bg3) - 0.19 * (ch1 - 1.3 * bg1)) / (ch1 - 1.3 * bg1) 
 ((ch3 - bg3) - 0.19 * (ch1 - bg1)) / (ch1 - bg1) 
 ((ch3) - 0.19 * (ch1)) / (ch1) 
 
3-channel methods: 
 
Zal 
Eapp = ((GWfr - BGfr) - CFdon * (GWdon - BGdon) - CFacc * (GWacc – 

BGacc)) / ((GWfr - BGfr) - CFdon * (GWdon - BGdon) + G * (GWdon- 
BGdon)) 

 ((ch3 - 1.275 * bg3) - 0.19 * (ch1 - 1.275 * bg1) - 0.09 * (ch2 – 
1.275 * bg2)) / ((ch3 - 1.275 * bg3) - 0.19 * (ch1 - 1.275 * bg1) + 
2.0 * (ch1 - 1.275 * bg1)) 

 ((ch3 - 1.3 * bg3) - 0.19 * (ch1 - 1.3 * bg1) - 0.09 * (ch2 - 1.3 * 
bg2)) / ((ch3 - 1.3 * bg3) - 0.19 * (ch1 - 1.3 * bg1) + 2.0 * (ch1 –  
1.3 * bg1)) 

 ((ch3 - bg3) - 0.19 * (ch1 - bg1) - 0.09 * (ch2 - bg2)) / ((ch3 - bg3)–  
0.19 * (ch1 - bg1) + 2.0 * (ch1 - bg1)) 

 ((ch3) - 0.19 * (ch1) - 0.09 * (ch2)) / ((ch3) - 0.19 * (ch1) + 2.0 * 
(ch1)) 
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Note:  
• All the following explanations refer prominently to the Ratio Dual 

Channel method.  

¾ Channel Selection: The ratiometric measurement can be set up here by 
selecting numerator and denominator channel used in the ratio 
formula. Select the desired channel (channel name as specified in the 
experiment) from the appropriate drop down list. 

¾ Ratio Image Definition: In both methods ratio values are displayed by 
applying a color look up table (LUT) to aid the visual distinction of small 
ratio changes. The ratio image is calculated as outlined in the formula 
shown here: 

 

- r (x,y) = ratio image 
- Multiplier = factor by which the result of the division is multiplied 
- channel 1 (x,y): image from channel 1 
- channel 2 (x,y): image from channel 2 
- Offset = factor that influences the general brightness of the ratio image. 

¾ The lower and upper limit of the displayed ratio can be entered using the 
sliders for Minimum or Maximum or by entering the values directly in 
the edit fields. These values are also put in the output ratio image as 
image tags and are used by the LUT Scale annotation. By raising the lower 
limit one can reduce the background of small ratios, by raising the upper 
limit, also larger ratios can be displayed properly. A minimum of 0 and a 
maximum of 3 cover the range of ratios commonly occurring in biology. 

¾ Look-up Table (LUT): Clicking on  opens the Open Table dialog 
which allows selection of a desired look up table. Depending on the 
application or the personal preference various LUTs serve different 
purposes. For Ratio imaging a rainbow look up table is frequently used 
(RAINBOW.COL). 
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¾ In case of the Ratio Single Channel method the Reference Image (F0) 
section becomes active which allows definition of time points for 
calculation of an averaged F0 reference image. 

¾ In order to generate an appropriate reference image for a single channel 
measurement a suitable range of time points can be defined from within 
the same channel. This, e.g., could be a resting phase, where cells do not 
show any ion fluctuations as well as do not move. You can either enter 
the desired time points directly in the From and To edit fields or take over 
the current time point as selected with the time player by clicking on the 

 buttons. 

¾ From this series of individual time points an averaged reference image is 

calculated after click on . 

¾ After the reference has been created, the charts become active and 
measurements can be performed. 

Measurement 

This tab contains functions for background correction as well as for in situ 
calibration should absolute concentrations be determined. Background 
correction is applied both to the measurement results for each measurement 
ROI and the corresponding measurement charts as well as to the ratio image. 

¾ : If selected, the uncorrected raw gray values 
are used to calculate the ratio values 

¾ : If selected, a fixed background value is 
subtracted from all time points. This value is channel specific and can be 
entered in the edit fields next to the appropriate channel number. In case 
of single channel images for which an F0 reference image has been 
defined, the F0 reference is considered as a pseudo channel #2.  
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¾ : If a measurement region (ROI) has been selected 
in the image, this option becomes active. Here a background value for 
each channel and time point is measured and subtracted from the gray 
values of the other measurement regions used to calculate the ratio. If 
either of the two other options is selected, the selected background ROI is 
converted into a standard measurement region. To again use a 

background region use the  button from the toolbar to convert a ROI 
into a background ROI. 

¾ In Situ Calibration: If enabled, the check box enables a dialog to 
perform in situ calibration for calibrated Calcium and pH measurements. 
As a prerequisite for in situ calibration you need to treat your cells with 
agents who allow you to determine the minimum (R(min) and the 
maximum R(max) response of the loaded dye. In the case of Calcium 
measurements using Fura-2, e.g., this is frequently done using 
Ionomycine, a drug, which permeabilizes the cell membrane followed by 
treatment with low and high calcium buffer.  

• Move the cursor of the navigator tool to the part in the chart, which 
shows minimum ratio: 

 

• click on  to use the current cursor position as the time 
point used for determining the minimum ratio of each ROI. 

• Repeat the same for R(max). 
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• Clicking on  opens a floating dialog Calibration editor 
showing the calibration charts. 

• Here you can select between Calcium Calibration or pH Calibration. 
In the case of Calcium calibration the formula according to 
Grynkiewicz et al. (Journal of Biological Chemistry, Volume 260: 
3440, 1985) is used. Here you can also modify the kD, which has 
been calculated to be 224 nM at 1 mM Mg++  and 37ºC. 

• A viscosity correction factor typically between 0.7 and 0.85 has been 
suggested to be used by M. Poenie (Cell Calcium Volume 11, 2-3, pp 
85-91, 1990), which can be entered here as well. Setting the value to 
1 disables correction. 

• In the case of pH calibration a simple linear interpolation is performed 
using R(min) and R(max). 

• OK closes the dialog and activates calibration. 

All measurements are done online, i.e., when the dialog first opens, all 
calculations are done once. The system then tries to update the 
measurements on the fly upon changes to ROIs etc. For large time series with 
many time points and/or many measurement regions, calculation of all values 
for all time points can take several seconds. To prevent the system from 
responding slowly, the calculation update is interrupted after a few seconds 
so that not all values may be present. In this case the charts may be 

incomplete which will be signified by a yellow signal . Clicking on the 

 button forces the complete calculation which is symbolized 

by changing the signal color to . 
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Options 

You can choose between two methods of calculating the ratio image: 
Standard and Confidence Mapping. Standard is active if the check box is 
unchecked. 

The second algorithm is called Confidence mapping. This method has been 
suggested by Tsien and Harootunian (Tsien, R.Y., and Harootunian, A.T. 1990. 
Practical design criteria for a dynamic ratio imaging system. Cell Calcium 11: 
93-109.) to prevent noise from influencing the ratio display negatively.  

When dividing two small gray values by each other, fluctuations in the gray 
value introduced by noise can result in quite large ratio values. With this 
method each ratio pixel value is put in proportion to the brightness of its 
original input pixels. This effectively introduces a bias for the display of 
brighter and therefore more relevant pixels. Consequently dark pixels become 
underrepresented in the result image reducing the displayed noise in the 
image. 

¾ The calculation is done in two steps: 

• Calculation of the Ratio 

 

• Calculation of the confidence: 

 

while ImageMaxValue is the brightest pixel present in the image. 
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• The display can be explained by setting the Hue = LUT (Ratio) and 
the Luminance = Confidence or as follows: 

 

¾ For confidence mapping it is not possible to directly enter a Ratio value as 
annotation in the resulting ratio output image due to the dual 
functionality required to calculate the ratio pixel appearance. 

¾ In order to influence the displayed value range both Multiplier (range 
between 0 and 10) and Offset values (value range of -1 to 1) can be 
changed on the Channel Selection tab using the sliders or by directly 
entering the values in the edit fields. 

Information Color Ratio Image 

The size and number of cycles of the resulting ratio image are displayed here. 

Tool bar 

: The buttons on this toolbar 
can be used to adjust the display (brightness, contrast, zoom etc.) of the 
images or analyze individual pixels using the picker tool. 

Using the other tools it is possible to draw in up to 20 regions, which will be 
used for measurement. When you draw in several regions, the next color from 
the color list is automatically assigned to each new region. 

 Allows you to click on and select measurement regions that have already 
been drawn in to move them, enlarge them, delete them or change their 
color. 
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 Used to draw in a rectangular measurement region. If the  button is 
not selected, the tool remains active and it is possible to draw in several 
measurement regions one after the other. 

 Used to draw in a measurement region with a free form of your choice 

(spline). If the  button is not selected, the tool remains active and it is 
possible to draw in several measurement regions one after the other. 

 Used to draw in an ellipse as a measurement region. If the  button is 
not selected, the tool remains active and it is possible to draw in several 
measurement regions one after the other. If the Shift key is depressed while 
drawing in the ellipse, a circular form is enforced. 

 Draws a circle. Starting point and end point of the drawing defines the 
diameter making it easy to e.g. define a circle encompassing a complete cell. 

 When clicked, the last shape used for drawing a ROI is “remembered” 
and drawn into the overlay by simple clicking. This allows the cloning of a 
shape with ease. It works with all ROI tools except the free form spline tool. 

This function can be disabled by selecting . 

: Displays the measurement values instead of the charts. You can click on 
an entry upon which the corresponding time point is selected in the time 
series. These values can also be exported as a data list later. The data table is 
set up as shown here, the “Channel 1” etc. is replaced by the actual channel 
name as specified in the experiment. Also, the set up shown here is only valid 
for the Ratio Dual Channel case. Especially in FRET experiments, the Ratio 
column will contain the calculated FRET values. 
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Index Row index 

TimeStamp relative time 

Markers Marker 

R1_Channel1 mean density of region 1, channel 1 

R1_Channel2 mean density of region 1, channel 2 

R1_Ratio ratio value region 1, channel 1 / channel 2 

R1_Channel1(-BG) background corrected mean density of region 1, channel 1 

R1_Channel2(-BG) background corrected mean density of region 1, channel 2 

R1_Ratio(-BG) background corrected ratio value region 1 channel 1 / channel 2 

R2_Channel1 mean density of region 2, channel 1 

R2_Channel2 mean density of region 2, channel 2 

R2_Ratio ratio value region 2, channel 1 / channel 2 

R2_Channel1(-BG) background corrected mean density of region 2, channel 1 

R2_Channel2(-BG) background corrected mean density of region 2, channel 2 

R2_Ratio(-BG) background corrected ratio value region 2, channel 1 / channel 2 

etc… etc… 
 
If no background correction is done, the background corrected value column 
is omitted from the table. In the case of calibrated measurements additional 
value columns will be present. 

Clicking again on  hides the table and displays the measurement charts 
again 

 Deletes all selected measurement regions. 

 Selects all available measurement regions. 

 Allows you to change the color for a measurement region. 
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: Via Custom... it is possible to add further colors to the list from 
a color selection dialog. 

 Defines a selected measurement region as a background region. The 
mean gray value from this region can, if desired, be automatically subtracted 
from the measurement values of all other regions. 

Markers 

Shows every event which has been transferred as a comment to the ZVI image 
during conversion. Clicking on an event moves the time marker tool to the 
corresponding time point. 

¾ The time format for the marker list can be changed by right-mouse click 
in the header row of the list and selecting Properties: 

 

Please select the desired time format (Seconds, Minutes, Hours or the 
generic format hh:mm:ss:msec which is the default setting) from the 
drop down list. You can also select the frame number. 
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Charts 

The charts can display 6 different measurement values for all drawn-in 
measurement regions (this setting can be entered via a shortcut menu, which 
is opened by right-clicking): 

� Mean gray value channel 1  
� Mean gray value channel 1 minus background 
� Mean gray value channel 2 
� Mean gray value channel 2 minus background 
� Ratio value 
� Ratio value minus background 

¾ Chart settings: The three charts next to channel 1, 2 and ratio image 
(two in the case of single channel experiments) can be configured by 
right-clicking on a chart and selecting Properties upon which a Chart 
Settings dialog is opened: 
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The dialog is divided into three tabs which allow the configuration of the 
chart parameters such as changing the default title, specifying a specific 
value range for X- or Y-axis, displaying or hiding legend and title or 
specifying tick marks. A Reset button resets the chart configuration to its 
default setting. 

Creation of output documents 

When all settings are made, clicking on OK will prompt the opening of the 
following dialog 

 

¾ Check all documents you want to be created as result of the 
measurement. In most cases at least the Color Ratio Image as well as 
the Ratio Table containing all measurement data will make sense to 
keep. 

¾ The data can be saved in the generic CSV file format or in an XML format, 
which can be opened directly with Microsoft Excel (2003 edition 
necessary). AxioVision has basic charting features for all data tables which 
can be accessed via the Chart View button at the bottom of the table. 

¾ The ratio image is a 24 Bit color image including all ROIs as annotation. 
Several annotations are available to help create informative movies for 
presentation. The Ratio range can be displayed using the LUT Scale 
annotation, both speed and event markers can be added as well.  
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All annotations can be found in the Annotation menu ⇒ Frequent 

annotations. The Show values picker tool  additionally shows the 
ratio value of each pixel for ratio images aiding the data evaluation: 

 

¾ The resulting charts may be useful to quickly put together a presentation 
of the data. They can be saved as EMF (enhanced meta file) or WMF 
(Windows meta file) data. Both formats are vector based so that they can 
be inserted in programs like Microsoft PowerPoint and rescaled without 
loss of quality. 

Clicking on OK closes the measurement dialog, the output documents are 
created and displayed as unsaved documents in AxioVision. 

fåÑçêã~íáçå=Ñçê=mÜóëáçäçÖó=

This function opens a dialog window, where you can find in tabular form 
important information in connection with the physiology experiment. The 
information it contains bear always on the current experiment and will be 
updated during each sequence of the experiment. 

Show 

In the drop-down list you can select, whether only an overview or all available 
information are shown. To get more explanations to the existing information, 
you can select an item. In the bottom area of the dialog you will find more 
explanation. 
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fåÑçêã~íáçå=

In the Information Current Physiology Experiment dialog, various items of 
information about the currently active Physiology experiment are shown, i.e. 
expected image size, available hard disk space etc. These values do not relate 
to open image documents or streaming files. 

Show 

Using the drop-down list box it is possible to select whether you want an 
overview only (Reduced information) or all information (All information) to 
be displayed. All parameters relating to the current experiment are presented 
in list form. For further explanations on the meaning of the entries, click on an 
entry. You will then see an explanation in the text box at the bottom edge of 
the dialog. 
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VKNN cobq=^å~äóëáë=áå=íÜÉ=mÜóëáçäçÖó=jçÇìäÉ=

jÉíÜçÇ=

The FRET technique allows you to quantify the distance between two 
molecules conjugated to different fluorochromes. 

By combining FRET (Fluorescence Resonance Energy Transfer) with optical 
microscopy, it is possible to obtain quantitative temporal and spatial 
information about the binding and interaction of proteins, lipids, enzymes, 
DNA and RNA in vivo. Usually, these processes lie below the resolution of an 
ordinary microscope. Thanks to the recent development of numerous variants 
of green fluorescent proteins (mutant GFPs), it is possible to use FRET to 
measure the interaction of intracellular molecular groups in intact living cells 
where the donor and acceptor fluorescent dyes are actually part of the 
molecules themselves. 

However, FRET microscopy measurements currently suffer from many 
different sources of distortion, which need to be corrected. These include 
direct excitation of the acceptor at the donor excitation wavelength and the 
dependence of FRET on the concentration of the acceptor. 

pçÑíï~êÉ=é~Åâ~ÖÉ=

The Carl Zeiss AxioVision FRET software is part of the Physiology module and 
offers you a choice between several of the methods described in the literature 
for determining FRET (see section 9.10 Physiology Measurements "Examples 
of FRET formulae"). Each method includes the acquisition of time lapse image 
series with the option of determining the FRET amount inside selected 
regions. These regions are defined using circles with variable sizes or are 
drawn in freehand. The results of time lapse series can be displayed as time-
dependent curves for each individual region. In addition, color-coded images 
are created for each time point. 

Depending on the method selected, these color-coded images are calculated 
for each pixel individually and either show an intensity value for FRET (Fc – 
Youvan), a FRET ratio image in relation to donor * acceptor (Fn – Gordon), a 
FRET ratio image in relation to the square root of donor * acceptor (NF – Xia), 
or in relation to the acceptor (Acc) or donor (Don) alone.  
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As an alternative method, FRET can be measured after bleaching of the 
acceptor by calculating the increase in the donor emission (BL – Siegel). It is 
also possible to enter your own methods using the formula generator. 

Either a motorized Axio Imager or an Axio Observer microscope can be used – 
these will serve as an outstanding input unit. The method for direct FRET 
measurement uses a combination of three filter sets: the donor, FRET and 
acceptor filter set. These filters have been specially developed to isolate and 
maximize three signals: the donor fluorescence, the acceptor fluorescence 
dependent on FRET and the directly excited acceptor fluorescence. The Fast 
Acquisition and Dual Camera modules are available for rapid image 
acquisition. 

cobq=ÇÉíÉêãáå~íáçå=ìëáåÖ=ÅçêêÉÅíáçå=ãÉíÜçÇë=

As donors such as CFP generally show a long-wavelength tail in their emission 
spectrum, there is significant fluorescence at YFP emission wavelengths from 
CFP alone. It is therefore difficult to determine FRET accurately using 
conventional measurement methods without making use of mathematical 
corrections. 

In the AxioVision Physiology module it is possible to choose between five 
different methods for direct FRET measurement. Youvan’s method (Fc) 
measures the intensity of the FRET image and performs a correction by means 
of the proportion of donor and acceptor direct excitation. Two additional 
samples are necessary to determine these correction factors. In the first 
sample the cells must be labeled with the donor fluorescent dye only, and in 
the second with just the acceptor fluorescent dye. For these samples the 
correction factors for crosstalk can be determined very accurately (see 9.10 
Physiology Measurements containing user formulae for the "donor correction 
factor" and "acceptor correction factor"). 

Youvan’s method forms the basis for all 3-channel correction measurement 
techniques in AxioVision FRET. It results in an intensity value being 
determined. The directly measured FRET intensity from the FRET filter set is 
corrected by the crosstalk from the donor alone and from the acceptor alone. 
Firstly, however, the intensity from each individual filter set is corrected by the 
relevant background value.  
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The following formula is used for the calculation: 

Fc = (fretgv–bgfret) – cfdon*(dongv–bgdon) – cfacc*(accgv–bgacc) 

Fc = FRET concentration according to Youvan et al. (1997) 
 gv = intensity as gray value 
 bg = background intensity 
 cf = correction factor 
 fret = FRET image 
 don = donor image 
 acc = acceptor image 
 
With Gordon’s method (Fn) this result is normalized to the direct donor and 
acceptor signal. The result is a ratio value. FRET is determined according to 
Youvan’s method, as described above, and the result is divided by the product 
of the donor and acceptor intensity. 

Fn = Fc / [(dongv–bgdon) * (accgv–bgacc)] 

Fn = FRET concentration according to Gordon et al. (1998) 
 Fc = FRET concentration according to Youvan et al. (1997) 
 gv = intensity as gray value 
 bg = background intensity 
 don = donor image 
 acc = acceptor image 
 
Due to the multiplication of donor and acceptor, however, this method 
actually calculates the ratio twice, with the effect that, in many regions, 
relatively low intensities lead to extremely high FRET values. 

The third method according to Xia (NF) is similar to Gordon’s method, but 
uses an adapted formula. Here, FRET according to Youvan is divided by the 
square root of the product of donor and acceptor. In this way the ratio is 
calculated only once, and FRET is determined independently of the relevant 
donor and acceptor concentration. 
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NF = Fc / sqrt [(dongv–bgdon) * (accgv–bgacc)] 

 Fn = FRET concentration according to Xia et al. (2001) 
 Fc = FRET concentration according to Youvan et al. (1997) 
 sqrt = square root 
 gv = intensity as gray value 
 bg = background intensity 
 don = donor image 
 acc = acceptor image 
 
The fourth method calculates the FRET ratio in relation to the acceptor alone 
(Acc). Here, the FRET value according to Youvan is divided by the acceptor 
intensity only. 

Acc = Fc / (accgv–bgacc) 

 Acc = FRET concentration as acceptor ratio according to  
  Malkusch (2004) 
 Fc = FRET concentration according to Youvan et al. (1997) 
 gv = intensity as gray value 
 bg = background intensity 
 acc = acceptor image 
 
As with Xia’s method, here too the ratio is only calculated once, but the FRET 
amount is dependent on the acceptor concentration. This results in relatively 
low FRET values with high acceptor intensities and high FRET values with low 
acceptor concentrations, due to the division. 

The fifth method calculates the FRET ratio in relation to the donor alone 
(Don). Here, the FRET value according to Youvan is divided by the donor 
intensity only. 

Don = Fc / (dongv–bgacc) 

 Don = FRET concentration as donor ratio according to 
  Vanderklish et al. (2000) 
 Fc = FRET concentration according to Youvan et al. (1997) 
 gv = intensity as gray value 
 bg = background intensity 
 don = donor image 
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As with Xia’s method, here too the ratio is only calculated once, but the FRET 
amount is dependent on the donor concentration. This results in relatively low 
FRET values with high donor intensities and high FRET values with low donor 
concentrations, due to the division. 

cobq=ÇÉíÉêãáå~íáçå=ìëáåÖ=~ÅÅÉéíçê=ÄäÉ~ÅÜáåÖ=ãÉíÜçÇ=

As an alternative and relatively simple way to determine the absolute 
efficiency of FRET between the donor (CFP) and the acceptor (YFP), it is 
possible to measure the donor emission before and after selective bleaching 
of the acceptor. The increase, or dequenching, of donor emission can be used 
as a direct measure of the FRET efficiency. 

BL = [1 - (dongvbef - bgdon-bef) / (dongvaft – bgdon-aft)] * 100 

 BL = FRET concentration by acceptor bleaching 
  according to Siegel et al. (2000) 
 don = donor image 
 gv = intensity as gray value 
 bg = background intensity 
 bef = before bleaching 
 aft = after bleaching 
 
This method uses each cell or each subregion as its own internal standard 
and, according to the authors, is therefore far more accurate than comparing 
cells with unknown FRET with separate cells with very strong FRET or even no 
FRET at all. Using this method, values of just a few percent can be quantified 
with reasonable confidence. 

The result is a percentage for the donor concentration, as only the donor is 
directly determined. The authors claim that this is the only genuinely 
quantitative method. However, it has decisive disadvantages when used in 
living cells, due to extremely small movements of the cells themselves or of 
the cell organelles inside the cells. 
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cobq=ÇÉíÉêãáå~íáçå=ìëáåÖ=Ñçêãìä~=ÖÉåÉê~íçê=

With the help of the formula generator it is possible to make use of new or 
your own techniques for determining FRET. FRET determination according to 
Zal is used here as an example: 

Eapp = Fc / [(fretgv – bgfret) – cfdon * (dongv – bgdon) + 2.0 * (dongv–bgdon)] 

 Eapp = FRET concentration according to Zal et al. (2004) 
 Fc = FRET concentration according to Youvan et al. (1997) 
 gv = intensity as gray value 
 bg = background intensity 
 don = donor image 
 fret = FRET image 
 
The channel images are entered into the formula by means of the channel 
numbers used (ch1, ch2, ch3) and the associated background values are 
entered accordingly as bg1, bg2, bg3. If the various time points are related to 
an identical reference image (as with the acceptor bleaching method), this 
calculated reference image can be entered into the formula as f0. The 
associated background value is available under bgf0. 

You would therefore integrate the FRET analysis according to Zal into the 
formula generator as follows: 

 ((ch3–bg3) – 0.19*(ch1-bg1) – 0.09*(ch2-bg2)) /  
 ((ch3–bg3) – 0.19*(ch1-bg1) + 2.0 * (ch1-bg1)) 
 
The formula generator can also be used to calculate the correction values for 
the donor and acceptor crosstalk: 

 Donor (cfdon):  (ch3-bg3) / (ch1-bg1) 
 Acceptor (cfacc):  (ch3-bg3) / (ch2-bg2) 
 
Giving the results as a percentage the numbers have to be multiplied by 100. 
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bñ~ãéäÉë=çÑ=cobq=Ñçêãìä~É=Ñçê=íÜÉ=Ñçêãìä~=ÖÉåÉê~íçê=

FRET according to Youvan DC et al. (Biotechnology 3, 1997) 
 (ch3-bg3) – 0.19*(ch1-bg1) – 0.09*(ch2-bg2) 
 
FRET donor ratio method (PNAS 97, 2000) 
 ((ch3-bg3) – 0.19*(ch1-bg1) – 0.09*(ch2-bg2)) / (ch1-bg1) 
 
FRET acceptor ratio method (Bioscience Technology 01, 2004)) 
 ((ch3-bg3) – 0.19*(ch1-bg1) – 0.09*(ch2-bg2)) / (ch2-bg2) 
 
FRET according to Gordon GW et al. (Biophysical Journal 74, 1998) 
 ((ch3-bg3) – 0.19*(ch1-bg1) – 0.09*(ch2-bg2)) / ((ch1-bg1) * (ch2-bg2)) 
 
FRET according to Xia Z et al. (Biophysical Journal 81, 2001) 
 ((ch3-bg3) – 0.19*(ch1-bg1) – 0.09*(ch2-bg2)) / sqrt((ch1-bg1) *  
 (ch2-bg2)) 
 
FRET via acceptor bleaching (%) according to Siegel RM et al. (Science’s stke, 
2000) 
 100 * (1 – (f0-bgf0) / (ch1-bg1)) 
 
FRET according to Zal T et al. (Biophysical Journal 86, 2004) 
 ((ch3–bg3) – 0.19*(ch1-bg1) – 0.09*(ch2-bg2)) /  
 ((ch3–bg3) – 0.19*(ch1-bg1) + 2.0 * (ch1-bg1)) 
 
Donor crosstalk calculation 
 (ch3-bg3) / (ch1-bg1) 
 
Acceptor crosstalk calculation 
 (ch3-bg3) / (ch2-bg2) 
 
FRET (2-channel donor ratio via FRET and donor) according to Gordon 
(without correction factor) 
 (ch3-bg3) / (ch1-bg1) 
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FRET (2-channel donor ratio via acceptor and donor) according to Gordon 
(without correction factor) 
 (ch2-bg2) / (ch1-bg1) 
 
FRET (2-channel donor ratio via FRET and donor with correction factor) 
 ((ch3-bg3) – 0.19*(ch1-bg1)) / (ch1-bg1) 
 
p~ãéäÉë=

With AxioVision FRET it is possible to use both fixed and living cells for 
determining FRET. Fixed cells are suitable for analyses on an upright as well as 
on an inverse microscope. For analyses involving living cells, an inverse 
microscope is usually the most suitable option, as living cells are generally 
examined in Petri dishes. 

All applications for the correction methods require, for each new experiment 
(each new preparation series), at least one sample labeled with the donor only 
and one labeled with the acceptor only – in addition to the actual FRET 
specimens. These are used to determine the correction factors in order to 
compensate for crosstalk. The precise method for measuring the correction 
factors is described under the formula generator. 

_~ëáÅ=ëÉííáåÖë=Ñçê=áã~ÖÉ=~Åèìáëáíáçå=

Multichannel time lapse images are always required for FRET analyses. The 
settings for image acquisition are defined in the Multichannel Setup function. 
For precise instructions, please refer to the description there. 

The correction methods always require 3-channel images (donor, acceptor 
and FRET image), or two image groups (donor and acceptor before and after 
bleaching) for the acceptor bleaching method. There is also a range of 
methods that perform FRET determination with just 2 channels (FRET – Donor, 
FRET – Acceptor, Donor – Acceptor; see 9.10 Physiology Measurements: 
"Example formulae of FRET calculations"). Longer time lapse images are 
needed if histograms or time lapse movies are desired. 

9-220 M 60-3-0024 e / printed 06.2010 



Modules  - FRET Analysis in the Physiology 

fã~ÖÉ=~Åèìáëáíáçå=Ñçê=^ñáçsáëáçå=cobq=~å~äóëÉë=

The settings for the multidimensional 
image series for offline FRET analyses 
are made using the Multidimensional 
Acquisition function. Detailed 
explanations can be found in the 
"Multidimensional Acquisition" section.

 

¾ All the settings for each channel 
are made on the C (Channel) 
property page. 

¾ When you select the fluorochrome 
under Dye, the color and channel 
name are determined 
automatically. You can change 
these default settings. 

¾ If you click on the measure button 
in the Exposure field, a window 
for determining the appropriate 
exposure time is opened 
automatically. All predefined 
hardware settings are set at the 
same time. 

¾ All the specific settings for all 
channels can be checked and 
adjusted in the overview under 
Extended Parameters. 
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¾ For Physiology FRET measurements, 
time lapse images are required. The 
intervals for the acquisition of the 
multichannel images can be 
entered on the T (Time Lapse) 
property page. 

¾ The Time Lapse check box must 
be selected for these to be used in 
the experiment. The intervals can 
be defined as required, in any unit 
of time. It is possible to predefine 
the length of the experiment by 
specifying the number of cycles or 
the duration. 

 

¾ On the Experiment property page, 
under an experiment name, you 
can save all settings from all 
property pages, together with the 
hardware settings before and after 
the experiment, so that you can 
use them again. 

¾ The options that you have selected 
for the experiment are also shown 
here, to allow you to check them. 

¾ Using the ReUse button you can 
read out the settings of a saved 
image and reuse them as an 
experiment, provided that the 
settings were saved with the 
image. 

¾ Start image acquisition by clicking 
on the Start button. 
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cobq=ãÉ~ëìêÉãÉåí=áå=íÜÉ=^ñáçsáëáçå=mÜóëáçäçÖó=
ãçÇìäÉ=

¾ Before you start the FRET 
measurement, you need to open a 
multichannel time lapse image that 
is suitable for the FRET 
measurement in the AxioVision 
image window. 

¾ Clicking on the Physiology 
Measurements function in the 
Physiology module gives you 
access to the ratio and FRET 
measurements. 

 

The Physiology Measurements window is opened with the last settings that 
were used. 

The meanings of the various windows on the property pages differ according 
to the method selected. 
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¾ Select the desired method using 

the Method drop-down list box. 

¾ The FRET functions are initially 
explained below using the example 
of the correction method according 
to Youvan. For the methods that 
follow this one, reference is only 
made to any differences that apply. 
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The Physiology Measurements dialog window displays the property pages 
containing the corresponding settings, the two raw images for the donor and 
acceptor channel and also the color-coded  FRET ratio image. Next to each 
image is a corresponding chart window in which the results display for the 
signals is shown. The overview chart presents the results for the entire 
experiment. All functions for working with the images and charts are 
arranged on a toolbar. 
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¾ The Fret Parameters window on 
the Channel Setup property page 
first shows the formula used for the 
selected method of performing FRET 
measurements (Ch = channel, BG = 
background, cf = correction factor, 
fret = FRET signal, don = donor 
signal, acc = acceptor signal). 

 

¾ In the Donor, Acceptor and Fret 
drop-down list boxes you can select 
the filter sets used in each case. 
Using cf you can define the 
correction factor for the crosstalk in 
percent (%). 

 

¾ In the Ratio Image Definition field 
you set the range for the FRET color 
coding. For Youvan the value ranges 
depend on the bit depth of the 
camera used. In the example an 
AxioCam MRm with 12 bits was 
used. Initially, half of the bit depth 
can be entered as a maximum 
starting value. 

 

¾ Various lookup tables are available 
for the color coding. The Rainbow 
LUT is usually used for the FRET color 
coding. 
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� The Reference Image (“F0”) has no 
significance for the FRET correction 
methods. It is always used if the ratio 
calculation is related to a starting 
image. For FRET measurements this 
is the case with the acceptor 
bleaching method. 

 

Donor image 

Using the function keys it is possible to 
define regions for the measurement in 
each image. Function key 23 allows you 
to redefine a region as the region for 
measuring the background. 

 

Acceptor image 

The regions are generated in parallel in 
all three image windows. To allow more 
precise positioning, it is also possible to 
increase the zoom factor of the images 
in parallel (function keys 2 - 5) and adjust 
their contrast (function keys 7 - 11). 

 

FRET color-coded image 

The color coding is carried out in 
accordance with the LUT selected using 
the range set under Ratio Image 
Definition. 
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Part of the Donor signal curves. The part in question is defined in the 
overview image: 

 

Part of the Acceptor signal curves. To change the colors of the curves, it is 
possible to select the corresponding regions using the left-hand mouse 
button. The color can then be changed using the color selection function key 
(22): 

 

For the FRET calculation according to Youvan the ratio values represent gray 
values. The scale range of the Y-axis therefore depends on the bit depth of 
the input image (8, 12, 14 or 16 bits). 
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Overview image of the entire duration of the FRET experiment. The size of 
the window defining the part of the curves displayed can be changed by using 
the cursor to adjust the corner points. Its position can be moved using the two 
arrow keys or the left/right keys on the keyboard. 

 

cìåÅíáçå=âÉóë=Ñçê=cobq=ãÉ~ëìêÉãÉåí=

 

 
1 Opens the pan mode with the cursor 

 
2 Displays the images with no zoom factor 

 
3 Displays the image so that it fills the image windows 

 
4 Increases the zoom factor (F7) 

 
5 Decreases the zoom factor (F8) 

 
6 Shows/hides the measurement regions 

 
7 Shows/hides the gray value histogram in the donor and acceptor 
image 

 
8 Best fit distribution of the gray value images between Min and 
Max, minus tolerances 

 
9 Min/Max distribution of the gray value images 

 
10 Linear distribution of the gray values over the entire range 
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11 Gamma setting of gray value curve to 0.45 

 
12 Display of pixel values at cursor position 

 
13 Object selection mode (Alt F1) 

 
14 Draws a rectangle at the position defined using the cursor and 
with the properties set (Alt F2) 

 
15 Draws a rounded external contour 

 
16 Draws an ellipse at the position defined using the cursor and 
with the properties set 

 
17 Draws a circle at the position defined using the cursor and with 
the properties set 

 
18 Copies a region with the same size and shape 

 
19 Shows the measurement value table 

 
20 Deletes all regions (Del) 

 21 Activates all regions (Ctrl+A) 

 
22 Assigns a color to a region and line in a chart 

 
23 Defines the selected region for the background measurement 

 
Buttons 

 transfers the color ratio image to AxioVision as a ZVI image 
and leaves the Physiology window open. 

 transfers all images, charts and tables selected during the 
confirmation stage to AxioVision in separate windows and closes the 
Physiology window Physiology Measurements. 
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 closes the Physiology window and takes you back to 
AxioVision. 

¾ The color-coded FRET image 
transferred to AxioVision displays 
all regions for the FRET 
measurements and the 
background. If you click on Create 
Single, only the color image with 
the regions is transferred. If you 
carry out the transfer using the OK 
button, a color scale with value 
indications is added to the left of 
the image. You can use the cursor 
to activate this, change its size and 
move it to the desired position. 

 

¾ Click on the OK button. All the 
required tables, charts or images 
can then be selected in a selection 
window. 
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¾ After changes are made to the 
settings of the Min/Max values under 
Ratio Image Definition, to the 
correction factors or to the channel 
selection, the calculation must be 
performed again in order to update 
the FRET values in the table. This is 
done on the Measurement property 
page by clicking on the Update 
Data button. 

¾ Once the new calculation has been 
performed successfully, the color of 
the status circle changes to green. 

¾ Such an update is always required if 
the color of the circle is yellow and 
the results are to be transferred to 
AxioVision. 

¾ Some FRET calculations may result in very high FRET values, particularly in 
the area of the background. These can become visible in the form of 
white noise against the dark background. You can suppress this effect by 
activating the Confidence Mapping option on the Options property 
page (according to Tsien RY, 1990). 
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¾ The extent of the background elimination can be influenced by moving 
the Strength slider. 

The Confidence value is calculated 
according to the following formula: 

   channel1 * channel2    
 2 * intensity maximum 

This confidence value is multiplied by 
each red, green and blue value for the 
color display.  

¾ By showing the gray value 
histogram (function key 7) in the 
donor or acceptor image you can 
also modify the gray value 
distribution manually by using your 
mouse to adjust the five points. 

¾ The middle point influences the 
brightness, the outer points the 
contrast and the two intermediate 
points the gamma setting. 

 

In the data table (function key 19) the donor, acceptor and ratio values are 
listed without and with background correction (-BG) for all time points and 
for each region. 
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In the charts the curves are initially displayed without background correction. 

 

You can call up the display with background correction in each window via 
the right-hand mouse button. 
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The appearance of the charts can be 
adapted via the Chart Settings, which 
can be called up for each chart using 
the right-hand mouse button. 

¾ In the Time Range field you can 
determine the range automatically 
or manually. 

¾ In the Show field on the General 
property page you can show and 
hide the display of the markers, 
image-acquisition time points, 
chart title and legend. 

 

¾ In the General field on the X Axis 
property page you can enter the 
Label for the X-axis. This entry can 
be made in text form via the 
keyboard. The Reset button resets 
the label to the original text. 

¾ In the Tick Marks field you can 
also define the time periods for the 
marks manually. These marks can 
also be hidden here. 
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¾ On the Y Axis property page, 
again in the General field, you can 
enter a Label for the Y-axis in text 
form via the keyboard. It is also 
possible to choose between Linear 
and Logarithmisch. 

¾ The value range can be determined 
automatically or manually in the 
Value Range field. 

¾ In the Tick Marks field you can 
determine the periods for the 
marks automatically or manually 
and/or show or hide them. 

 

¾ When you select a region in object 
selection mode (function key 13), 
you can use the color selection 
function (function key 22) to assign 
a predefined color from a color list 
to the region and the 
corresponding curve, or you can 
select a color freely from the color 
circle in the Color window. 
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Selection from the Method drop-down list box. The formula used is displayed 
in the Fret Parameters field: 

  

The measurement regions (R1 – R4) are defined in the image windows via the 
mouse, using function keys 14 - 18. A region can be defined as the region for 
measuring the background value (BG1) using function key 23: 
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Results of the Donor Ratio FRET measurement. Genuine FRET values are 
usually between 0.0 and 1.0: 

 

 
¾ Color-coded FRET ratio image for 

the Donor Ratio calculation. In 
regions where donor values are 
very low, the division can result in 
extremely high FRET values, which 
appear as white points of noise in 
the color-coded image. 

¾ If each pixel is converted using 
Confidence Mapping (according 
to Tsien RY, 1990), these points are 
displayed as very dark in the 
resulting image. The color coding is 
confined to the regions with a 
genuine FRET portion. 
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Selection from the Method drop-down list box. The formula used is displayed 
in the Fret Parameters field: 

  

 
¾ The measurement regions (R1 – R4) 

are defined in the image windows 
via the mouse, using function keys 
14 - 18. A region can be defined as 
the region for measuring the 
background value (BG1) using 
function key 23. 

 

Results of the Acceptor Ratio FRET measurement. Genuine FRET values are 
usually between 0.0 and 1.0: 
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¾ Color-coded FRET ratio image for 
the Acceptor Ratio calculation. In 
regions where acceptor values are 
very low, the division can result in 
extremely high FRET values, which 
appear as white points of noise in 
the color-coded image. 

¾ If each pixel is converted using 

 

ing is 

Confidence Mapping (according 
to Tsien RY, 1990), these points are
displayed as very dark in the 
resulting image. The color cod
confined to the regions with a 
genuine FRET portion. 

dçêÇçå=

Selection from the Method drop-down d 

 

list box. The formula used is displaye
in the Fret Parameters field: 
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¾ The measurement regions (R1 – R4) 

 

are defined in the image windows 
via the mouse, using function keys 
14 - 18. A region can be defined as 
the region for measuring the 
background value (BG1) using
function key 23. 

 

Results of the Gordon FRET measurement. In this case genuine FRET values are 

age, 
extremely low and depend on the bit depth of the acquired image. The 
Gordon values are therefore always multiplied by 10,000. For a 12-bit im
genuine FRET values are usually between 0.0 and 10.0: 

 

 
 Color-coded FRET ratio image for 

, 

h 

¾
the Gordon Ratio calculation. In 
regions where values are very low
the double division can result in 
extremely high FRET values, whic
appear as white points of noise in 
the color-coded image. 
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¾ If each pixel is converted using 
Confidence Mapping (according 
to Tsien RY, 1990), these points are 
displayed as very dark in the 
resulting image. The color coding is 
confined to the regions with a 
genuine FRET portion. 

uá~=

Selection from the Method drop-down list box. The formula used is displayed 
in the Fret Parameters field: 

  

 
¾ The measurement regions (R1 – R4) 

are defined in the image windows 
via the mouse, using function keys 
14 - 18. A region can be defined as 
the region for measuring the 
background value (BG1) using 
function key 23. 
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Results of the Xia Ratio FRET measurement. Genuine FRET values are usually 
between 0.0 and 1.0: 

 

 
¾ Color-coded FRET ratio image for 

the Xia Ratio calculation. In regions 
where values are very low, the 
division can result in extremely high 
FRET values, which appear as white 
points of noise in the color-coded 
image. 

 

¾ If each pixel is converted using 
Confidence Mapping (according 
to Tsien RY, 1990), these points are 
displayed as very dark in the 
resulting image. The color coding is 
confined to the regions with a 
genuine FRET portion. 
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Selection from the Method drop-down list box. The formula used is displayed 
in the Fret Parameters field. 

The FRET calculation is performed via the donor channel only. The acceptor 
channel is only acquired too so that the bleaching process can be checked. 
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¾ The measurement regions (R1 – R3) 
are defined in the image windows 
via the mouse, using function keys 
14 - 18. A region can be defined as 
the region for measuring the 
background value (BG1) using 
function key 23. 

 

Results of the FRET measurement in percent. Genuine FRET values are 
therefore between 0.0 and 100.0: 

 

 
¾ Color-coded FRET efficiency 

image of the calculation according 
to Siegel. In regions where values 
are very low, the division can result 
in very high FRET values, which 
appear as white points of noise in 
the color-coded image. 
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¾ If each pixel is converted using 
Confidence Mapping (according to 
Tsien RY, 1990), these points are 
displayed as very dark in the 
resulting image. The color coding is 
confined to the regions with a 
genuine FRET portion. 

^å~äóëáë=çÑ=äçåÖ=íáãÉ=ä~éëÉ=áã~ÖÉë=

Example of an offline FRET analysis of a time lapse image (donor, acceptor, 
FRET) over 60 hours. The calculation was performed using the method 
according to Youvan: 
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User-defined FRET analyses are possible with the help of the formula 
generator. This option is selected on the Channel Setup property page using 
the Custom Formula function. 

In the Custom calculation formula field the corresponding channels (ch1, 
ch2, ch3) of the open image are selected from the drop-down list boxes. It is 
possible to define 2-channel, 3-channel or f0 analyses here. 

The formula is entered into the formula field using the keyboard. 
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¾ The variables and operators for the 
formulae can be entered freely via 
the keyboard. Alternatively, they can 
be selected from the Terms list and 
inserted into the formula by double-
clicking. The Terms list is called up 

using the  button. 

¾ Examples of user formulae with 
different correction methods are 
provided in 9.10 Physiology 
Measurements "Examples of FRET 
formulae " and can be copied into 
the input field via the online help. 

¾ As with the pre-programmed 
methods, the measurement regions 
(R1 – R4) are defined in the image 
windows via the mouse, using 
function keys 14 - 18. A region can 
be defined as the region for 
measuring the background value 
(BG1) using function key 23. 

The range of the FRET values depends on the formulae used. In the example 
FRET was calculated by means of FRET / Donor with background correction: 
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¾ Color-coded FRET ratio image for 
the Donor Ratio calculation. 
 
(fehlerhaft) 
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User-defined FRET analyses according to the acceptor bleaching method with 
constant correction to minimize the background. This option is selected on 
the Channel Setup property page using the Custom Formula function. 

The formula is entered into the formula field using the keyboard (it can also 
be copied from the collection of formulae in 9.10 Physiology Measurements 
"Examples of FRET formulae for the formula generator"): 
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¾ The variables and operators for the 

formulae can be entered freely via 
the keyboard. Alternatively, they can 
be selected from the Terms list and 
inserted into the formula by double-
clicking. The Terms list is called up 

using the  button. 

¾ With this method FRET is calculated 
in relation to the starting image (see 
section "Siegel FRET calculation via 
acceptor bleaching" on the acceptor 
bleaching method). The reference 
(f0) image can be calculated from 
the first 3 images of the time 
sequence using the Create 
Reference Image button on the 
Channel Setup property page. 

¾ As with the pre-programmed 
methods, the measurement regions 
(R1 – R3) are defined in the image 
windows via the mouse, using 
function keys 14 - 18. A region can 
be defined as the region for 
measuring the background value 
(BG1) using function key 23. 

The range of the FRET values depends on the formulae used. In the example 
FRET was calculated as a percentage of the reference image f0: 
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¾ Color-coded FRET ratio image for 

the Acceptor Bleaching calculation. 

 

 
cobq=çåäáåÉ=ãÉ~ëìêÉãÉåíë=

In the AxioVision Physiology module, FRET online measurements are 
accessed in the work area via Physiology and Physiology Acquisition. 
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Other options for fast acquisition and fast online FRET analysis are described 
under the Fast Acquisition and Dual Camera modules. 

¾ The Physiology Acquisition page 
that now opens displays all 
important system information under 
the parameters. 

¾ The settings for acquisition are 
defined using the Setup button. 

¾ In the Template field you can load 
existing settings (Load) and save 
new ones (Save). The prefix defines 
the basic name for the 
multidimensional images to be 
acquired.  

¾ In the Camera drop-down list box 
you can select the camera type from 
the installed cameras. 
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¾ Under Physiology Setup you 
define the channel properties 
according to the multichannel 
settings. 

¾ In the Dye drop-down list box you 
select the fluorochrome.  

¾ The channel name can be entered 
freely via the keyboard in the Name 
input field. The suggested channel 
color can also be changed, if 
required. 

¾ Using the measure button you can 
determine the exposure time for the 
channel automatically or 
interactively. 

¾ If you click on the Edit Hardware 
Settings button, the dialog window 
opens for changing the Settings 
during Acquisition and Settings 
after Acquisition parameters. 

¾ A separate property page is created 
for each channel. 

 

AxioVision User's Guide, Release 4.8.2 9-253 



Modules  - FRET Analysis in the Physiology 

¾ Clicking on the Edit Hardware 
Settings button opens the Fast 
Acquisition Setting Editor dialog 
window. Here, for each channel, 
you can enter the settings during 
and after acquisition separately for 
all components concerned. 

¾ All parameter settings are 
summarized in the Extended 
Channel Parameters dialog 
window. 

¾ These settings can be called up 
using the Extended Parameters 
button in the Channel Definition 
field. 
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¾ Once all settings have been made, 
you can save the experiment with a 
Name in the Template field (Save 
as via the  key). This means that 
the settings will be available again 
for later use. 

¾ Image acquisition is started by 
clicking on the Start button. 

 

¾ The window for Physiology acquisition (Acquisition Physiology) is 
opened by clicking on the Start button. 

¾ Before acquisition begins you can define additional speed markers and 
event markers.  

¾ The acquisition sequence is started by clicking on the Start button. 
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During the acquisition sequence the current gray value images of the donor 
and acceptor channel and the calculated ratio FRET color image containing 
the defined measurement regions are permanently displayed in the image 
windows. 

In the overview window the progression of the measurement results over 
time is displayed, whilst the chart windows contain the results in the region 
window selected in the overview. 

In the event of interventions during the experiment, the corresponding 
markers can be adopted into the chart at any time with a click of the mouse. 
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After the experiment has ended the results can be reopened for further 
editing from the work area using the Cutter function. 

Detailed descriptions of all the functions relating to Physiology Acquisition 
and the Cutter can be found in the description of the Physiology module. 
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Dual Camera is a module which allows the simultaneous viewing and 
acquisition of images from two identical AxioCam cameras. Major advantages 
of using two cameras simultaneously are: 

� Acquisition is performed simultaneously, i.e., objects with dual color 
labeling which move very fast can be acquired without delay between 
channel 1 and channel 2 

� Speed of acquisition is increased  

� Observation of two spectrally variant signals such as infrared transmitted 
light techniques and fluorescence at the same time, useful for 
neurobiology and electrophysiology 

� Ability to independently adjust exposure times for each camera 

The module primarily enhances the acquisition functionality of the modules 
Fast Acquisition and Physiology. But Dual Camera also has its own dialog 
which produces two dual camera live images for simultaneous observation as 
well as auxiliary images which facilitate easy alignment of both cameras using 
a suitable calibration sample. 

A suitable calibration slide is the so called Home slide (order number 453583), 
which features suitable markings, For a finer calibration beads stained with 
two fluorescent colors can be used, which are sold through 
Invitrogen/Molecular Probes e.g. 

aì~ä=`~ãÉê~=ëÉíìé=Üáåíë=

Dual Camera looks for two identical cameras and, if finding such cameras, 
controls them simultaneously. The order in which both cameras are 
recognized in the system is determined by the cameras serial number. 

Unfortunately it is not possible to easily derive this information by looking up 
the serial number at the label on the camera due to the way, the operating 
system interprets this number. Please follow the suggested steps in order to 
install two cameras for proper use with the Dual Camera module before 
configuring the cameras in the MTP2004 configuration program. 
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¾ Connect both cameras to separate Fire Wire channels on the computer 
(the current Zeiss workstations are equipped with the appropriate dual 
channel fire wire card) and start AxioVision. Select the first camera via 
Acquisition ⇒ Select Camera as the active camera. This should be the 
camera without a numeral in its name. 

¾ Open the live image. The camera which is now active can be recognized 
by the red blinking LED. Label this camera as camera #1 and the other 
one as camera #2. 

¾ If your computer is equipped with the Digital I/O Board as well as the 
signal distribution box SVB-1 both cameras must be connected to it. 
Connect the camera trigger cable with the appropriate port on the SVB-
1. Please see the Peripheral Devices Reference Guide which came with the 
installation for further details. 

¾ Close AxioVision and open the configuration program MTB2004. Select 
the camera port to which the dual camera adapter has been attached and 
configure the correct magnification camera adapter (e.g. 1x Camera 
Adapter). 

¾ From the list of possible cameras on the right select the camera without 
numbering in its name, e.g. AxioCam MR R3 and add it to the camera 
adapter. 

¾ As soon as a camera name is selected in the configuration on the left, a 
text field Camera Name becomes active on the right. In the case of an 
AxioCam the default name here is the same as in the list of possible 
cameras. You can now change the name in any way you like, e.g. in order 
to add the proper emission filter and the port orientation (e.g. CFP-
Camera-top). This name will be shown in several of the camera related 
dialogs in AxioVision, e.g. in the Live image window and also stored 
together with the image. Repeat this for the second camera. 

¾ In order to use both cameras as dual camera select the check box Use 
Dual Camera option (with 2 identical cameras only).  

¾ In the second drop-down list box which should now be active you can 
now assign a camera to a channel in Fast Acquisition. The camera 
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selected for channel #1 will be used for channels #3 and #5, camera 
assigned to channel #2 will also be used for channel #4. 

¾ Please remember, that this assignment determines, in which channel 
order the information from both cameras is being acquired. This is 
important in applications such as dual channel ratio imaging with the 
Physiology module, where during online measurement the ratio is always 
determined as channel #1 over channel #2. (See Fast Acquisition ⇒ C 
(Channels) property page.) 

The following AxioCam models are supported: 

� AxioCam HSm/c 
� AxioCam MRm/c rev. 3 (FireWire version) 
� AxioCam HRm/c rev. 3, (FireWire version) 
� PVCam Roper QuantEM (FireWire version only) 

Other cameras such as the AxioCam MRc5, the AxioCam ICc models or other 
third party cameras are not supported currently. 

Open Dual Camera Live from the Acquisition menu (see the following 
description). 

Layout 

Dual Camera Live is divided into 6 areas. Live images for Camera #1 and 
Camera #2 are shown next to each other, while a color merge image and a 
subtract image are shown beneath the live images. Both can be turned off 
and are mostly useful for alignment purposes. To the left of the dialog two 
property pages are available to adjust both cameras. Finally at the bottom 
edge of the dialog a toolbar contains the most important tools for adjusting 
exposure and display curves and a status bar shows the performance of both 
cameras. 

Live images 

By right mouse click you can access a context menu which allows turning all 
live images on or off. This way, you can configure the Dual Camera Live dialog 
in any way you want. 
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Color Merge Image 

The Live images of both cameras are pseudocolored and shown as a merged 
overlay. The image of camera #1 is shown in red and the one from camera #2 
in cyan to enhance visual differentiation. The colors are fixed and cannot be 
changed.  

Subtract Image 

The subtract image mainly serves the purpose of aligning both cameras. The 
goal is to achieve an image as homogenously gray and with as little contrast 
as possible. Even smallest differences will be displayed in an enhanced 
fashion. 

The calculation occurs as follows: Images from both cameras are converted 
into 8 bits, then normalized to each other and then subtracted from each 
other. A fixed value of 128 is added to the resulting image which will then 
have intensities somewhere between 0 and 255. Those data are then spread 
out to fill the full 8 bit range. A perfectly aligned image should be of a 
homogeneous gray. 

aì~ä=`~ãÉê~=éêçéÉêíó=é~ÖÉë=

You can access the property pages either via the context menu (right mouse 

click) or via the toolbar button . In the Dual Camera Live dialog 
you can only adjust the most important parameters such as exposure time and 
camera resolution. All other adjustments such as shading correction or camera 
image orientation etc. must be done using the standard camera property 
pages and will subsequently be used by Dual Camera Live. 

Adjust property page 

¾ Camera #1: Exposure: Here you can adjust the exposure time for the 
first camera. Normally it is recommended to define fixed exposure times 
for fast acquisition with dual camera. If the Dual Camera Live dialog is 
used for observation only it is also possible to use Auto Live for 
automatic adjustment of the exposure time. You can also define, which 
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percentage of the dynamic range of your cameras sensor should be filled 
by the exposure measurement algorithm. For fluorescence images this 
value can be as low as 20 percent without compromising image quality. 

¾ Camera #2 Exposure: identical to Camera #1 

¾ Dual Camera Frame Shift: Here it is possible to correct small shifts 
between both cameras. The upper slider controls lateral shift while the 
lower slider controls vertical shifts. Maximum shift range is -128 to 128 
pixels. This is done by shifting the region of interest on the camera sensor. 
When using binning, the minimum step size which can be influenced 
using these sliders will become coarser with increases binning steps and 
may not give the best results. 

¾ Automatic: This button tries to determine the optimal shift between the 
two cameras. It works best in cases, where structures are clearly seen as 
identical by both cameras. Automatic only corrects lateral and vertical 
shifts but not rotational shifts 

Frame property page 

¾ Here you can adjust the binning as well as select a ROI to be used for 
acquisition. Please see help for the camera you are using for more details. 

Toolbar 

A Toolbar is available with the following functions: 

: Opens and closes the live images. 

: Creates a new, unsaved 2-channel ZVI image. 
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: Performs an exposure measurement for both cameras at the same 
time. 

: In the case of color cameras performs an automatic White 
Balance. 

: Adjusts the display line with the Best Fit function for a stronger 
contrast with 0.1% value settings (see help for Best Fit). 

: Performs a Min/Max adjustment of the display line. 

: Makes a linear adjustment of the display line. 

: Creates a gamma value of 0.45. 

: Opens the property pages on the left side of the dialog. 

Status bar 

The status bar displays the performance of each camera in frames per second 
(fps): 
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NM fã~ÖÉ=mêçÅÉëëáåÖ=jçÇìäÉë=

NMKN fã~ÖáåÖ=mäìë=

dÉåÉê~ä=

As already described in chapter 5 "Image Processing", image processing 
functions have a range of different tasks. Besides the "traditional" areas of 
application of correction and optimization, which have already been 
mentioned, there is also a third area: data extraction. Here, for example, 
structures are highlighted in relation to the image background to make them 
more visible, or objects are purposefully detected so that they can be 
measured later.  

The Imaging Plus module expands the image processing functions of the basic 
program with the following functions and functional groups. 

fã~ÖÉ=ÉåÜ~åÅÉãÉåí=

Additional functions to enhance contrast, brightness and color, plus filters for 
smoothing, sharpening and edge detection with user-definable filter 
operators. 

  

 Edge detection with Sobel filter 
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dê~ó=ãçêéÜçäçÖó=

The gray morphology functions enable you to reconstruct the boundaries of 
connected objects. 

  

Through the reconstruction of grain boundaries images are prepared for 
automatic measurement. 

fã~ÖÉ=~êáíÜãÉíáÅë=

AxioVision enables you to combine and compare images, as well as extract 
information, by means of the image arithmetics functions in Imaging Plus. 
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Fourier transformation allows you to restore images by purposefully filtering 
out defined frequencies. 

  

With Fourier transformation it is possible to purposefully remove (right) 
sinusoidal super positioning (left), for example. 

`çäçê=ëé~ÅÉ=íê~åëÑçêã~íáçå=

Color discrimination enables you to separate object and image background 
more effectively on the basis of color. This makes it possible e.g. to distinguish 
better between individual classes of object. 

Bright field image of a composite 
material, contrasted with PtOx 

Heterochromatic super positioning of 
two different phases 
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tçêâáåÖ=ïáíÜ=áã~ÖÉ=éêçÅÉëëáåÖ=ÑìåÅíáçåë=

The principal working method for the functions of the Imaging Plus module is 
described in chapter 5 "Image Processing". 

The chapter also contains background information on the image processing 
functions and storage, etc. We recommend that you work through this 
chapter as a basis for applying the functions of the Imaging Plus module. A 
description of the individual functions and their parameters can be found in 
the online help. 

The individual steps in the following examples can also be practiced using the 
original images that were employed. The sample images can be found in the 
folder Demo Images and Scripts\AxioVision Images of the Product DVD. 

oÉÇìÅáåÖ=çê=Éåä~êÖáåÖ=áã~ÖÉë=çê=áã~ÖÉ=êÉÖáçåë=

The Resample function can be used to reduce or enlarge an entire image or a 
freely selectable region of an image. The reduction or enlargement is defined 
using a zoom factor (Scale). If only a region is being reduced or enlarged, the 
center of the region (Shift) must be indicated. 

The size of the resulting image can be adapted (ForceSizes = On), depending 
on the scaling factors (Scale).  You can, however, also generate the resulting 
image in the size of the original image (ForceSizes = Off). 

It is also possible to take the influence of the scaled neighboring pixels into 
account (Interpolation). 

Note: 
• If you simply want the entire image to be displayed in reduced or 

enlarged form without a new image being generated, this is also possible 
using the + Zoom and - Zoom functions from the image window’s 
shortcut menu. 

10-4 M 60-3-0024 e / printed 06.2010 



Modules - Imaging Plus 

The following example explains step by step how to reduce an image or 
enlarge a region of an image.  

 Load the image "Bone-
fluorescence_3.zvi" via the 
function File ⇒ Open Image, 
or acquire an image with the 
camera. 

 The image is displayed in 
AxioVision’s image window. 

 

In the first example, the loaded image is to be reduced by the factor 0.5. In 
the second example it is to be enlarged by the factor 2. 
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Now select from the Processing menu the Utilities functional group and 
then the Resample function. 

 You will now see the dialog 
window of the Resample 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear. 

 Set CreateNew to Off so that 
you can select the images 
freely. 

 Set the following values by 
clicking on the arrow keys or 
by entering the values directly: 
ForceSizes=On, ShiftX=0, 
ShiftY=0, ScaleX=0.5, 
ScaleY=0.5, ScaleZ=1, 
Interpolation= 
NearestNeighbour. 

 Click on OK to close the 
dialog. 
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 The resulting image shows all 
the structures of the original 
image, but has been reduced 
by the factor 0.5. 

 The image size has been 
adjusted accordingly, as 
ForceSizes was set to On. 

 

 Position the cursor over the 
resulting image, press the 
right-hand mouse button and 
select Normal View (1:1) 
shortcut menu.  

 Move the scroll bar to adjust 
the desired area. 

 Do the same with the original 
image. 

 Compare the two images. In 
the normal view of the image 
the difference can be clearly 
seen. 

Original image 

 

 

 

Resulting image
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For the second example, again select from the Processing menu the 
Utilities functional group and then the Resample function. 

 You will now see the dialog 
window of the Resample 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input image appears. 

 Under Input select the original 
image again and allocate a 
new image name under 
Output. 

 Set the following values by 
clicking on the arrow keys or 
by entering the values directly: 
ForceSizes=On, ShiftX=650, 
ShiftY=515, ScaleX=2, 
ScaleY=2, ScaleZ=1, 
Interpolation= 
NearestNeighbour. 

 Click on Apply to view the 
resulting image in the preview. 

 Click on OK to close the 
dialog. 
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The resulting image shows only the top left quarter of the structures in the 
original image. This region was defined by ShiftX and ShiftY. 

 The region is now larger than 
the original image by the factor 
2. 

 The image size has been 
retained, as ForceSizes was set 
to Off. 
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 Position the cursor over the 
resulting image, press the 
right-hand mouse button and 
select Normal View (1:1) from 
the shortcut menu. Do the 
same with the original image. 

 Compare the two images. In 
the normal view of the image 
the difference can be clearly 
seen. 

 

 

 

Note: 
• Adjust the display characteristic 

curve in the resulting image if 
necessary. 
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Often you will only want to further process a particular region (ROI) of an 
image, or generate a composite image from various images or from regions of 
various images.  

Using the Copy Region function, you can copy a freely selectable region from 
the original image into a new image. The starting coordinates in the original 
and the resulting image (SourceStart, DestinationStart) and the size of the 
region to be copied (Size) must be specified. If you are copying one region 
only, the size of the resulting image can be adapted to the region (ForceSizes 
= Set region size). You can, however, also generate an image in the size of 
the original (ForceSizes = Keep input image size). 

To create a composite image from several images or image regions, you need 
to define the overall image size (Size, ForceSizes = KeepMaxSize). The 
individual images can then be copied into this image step by step. During the 
copying of an individual image, the area outside the region to be copied can 
be retained (ClearOutside = Off) or deleted (ClearOutside = On) in the 
resulting image. 

Note: 
• If you simply want a region of an image to be copied, and a new image 

to be generated from it, this process can also be performed using the 
Select ROI/Copy ROI and Paste functions on the Edit menu. 
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The following example explains step by step how to copy various regions from 
one image into a new image. 

 Load the image that you want 
Load the image "Tupaia_head_ 
section_overview.zvi" via File ⇒ 
Open Image, or acquire an 
image with the camera. 

 The image is displayed in 
AxioVision’s image window. 

 

The image contains two histological sections through embryo heads. In the 
first example, only one embryo head is to be copied into a new image. In the 
second example, both embryo heads will be copied into a new image, with as 
little background as possible. 

Select from the Processing menu the Utilities functional group, and then the 
Copy Region function. 
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 You will now see the dialog window 
of the Copy Region function. 

 If the Automatic Preview check box 
is activated, the reduced input image 
appears. 

 Set CreateNew to Off, so that you 
can select the images freely. 

 Set the following values by clicking on 
the arrow keys, or by entering the 
values directly: ForceSizes=Set region 
size,  
SourceStartX =100, 
SourceStartY=120, 
DestinationStartX=0, 
DestinationStartY=0, SizeX=850, 
SizeY=780, ClearOutside=Off. 

 Click on OK to close the dialog.  

 

 In this example, only one region 
(ROI) has been copied into a 
new image. The resulting image 
therefore shows the first 
embryo head only. 

 The image size has been 
adapted to the specified size of 
850 x 780 pixels, as ForceSizes 
was set to On.  
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For the second example, again select from the Processing menu the Utilities 
functional group, and then the Copy Region function. 

 You will now see the dialog 
window of the Copy Region 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input image appears.  

 Select the original image again 
under Input. 

 Set the following values by 
clicking on the arrow keys, or 
by entering the values directly: 
ForceSizes=Keep input image 
size,  
SourceStartX =100, 
SourceStartY=120, 
DestinationStartX=0, 
DestinationStartY=0, 
SizeX=1000, SizeY=800, 
ClearOutside=Off. 

 Click on OK to close the dialog. 

 

 The resulting image then shows 
the first embryo head in the top 
left-hand corner. 

 As ForceSizes was set to Off, 
the image size corresponds to 
that of the original. The rest of 
the image is black. 
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Again select from the Processing menu the Utilities functional group, and 
then the Copy Region function. 

 You will now see the dialog 
window of the Copy Region 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input image appears. 

 Select the original image again 
under Input. 

 Set the following values by 
clicking on the arrow keys, or 
by entering the values directly: 
ForceSizes=Keep omput image 
size, SourceStartX =1300, 
SourceStartY=130, 
DestinationStartX=900, 
DestinationStartY=0, 
SizeX=900, SizeY=1000, 
ClearOutside=Off. 

 Click on OK to close the dialog. 

 

 Both embryo heads are now 
visible in the resulting image.  

 As the image size has been 
retained, the image is not 
completely filled, and contains 
some black regions. The next 
step therefore involves cutting 
out both embryo heads again in 
full.  
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Again select from the Processing menu the Utilities functional group, and 
then the Copy Region function. 

 You will now see the dialog 
window of the Copy Region 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input image appears. 

 Under Input select the resulting 
image that has been generated, 
and allocate a new image name 
under Output. 

 Set the following values by 
clicking on the arrow keys, or 
by entering the values directly: 
ForceSizes=On, SourceStartX 
=0, SourceStartY=0, 
SourceStartZ=0, 
DestinationStartX=0, 
DestinationStartY=0, 
DestinationStartZ=0, 
SizeX=1750, SizeY=800, 
SizeZ=1, ClearOutside=Off. 

 Click on OK to close the dialog 
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 The resulting image now shows 
both embryo heads on an area 
smaller than that of the original 
image. 

 The image size has been 
adapted in accordance with the 
values for SizeX and SizeY, as 
ForceSizes was set to Set 
region size. 

 

 

Note: 
• Adjust the display characteristic 

curve in the resulting image if 
necessary. 
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Color images consist of the three superimposed black/white images of the 
individual color channels red, green and blue. In many cases you will only 
want to use an image processing function for a specific color channel. This 
means that you have to split the image up into its individual channels. These 
individual color channels appear as black/white images, and allow you to carry 
out image processing procedures for the channels independently of each 
other. A color image is created again by merging the individual channels that 
have been processed. 

Note: 
• The HLS color space (Hue, Lightness, Saturation) is more suitable for many 

image processing requirements. In the HLS model, the image can also be 
split up into its individual channels. To do this, you must first perform a 
conversion into the HLS color space using the Color Model function. Once 
you have split the image up into its individual channels using the Split 
RGB Extractions function, each channel can be processed separately. The 
individual channels are merged again using the Combine RGB 
Extractions function. The combined image must then be converted back 
into the RGB color space using the Color Model function. 

The following example explains step by step how to split up a color image into 
its individual color channels, and merge it again after processing a channel. 

 Load the image "Bone-
overview.zvi" via the function 
File ⇒ Open Image, or acquire 
an image with the camera. 

 The image is displayed in 
AxioVision’s image window. 
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Select from the Processing menu the Utilities functional group, and then the 
Split RGB Extractions function. 

 You will now see the dialog 
window of the Split RGB 
Extractions function. 

 If the Automatic Preview 
check box is activated, you will 
see the reduced input image. 

 Set CreateNew to Off, so that 
you will be able to select the 
input image (Input) freely later. 

 Under PixelFormat select 
"8bit". 

 Click on OK to close the dialog. 
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 The Split RGB Extractions 
function splits up the color 
image into the individual color 
channels red, green and blue. 
The result is a black/white 
image for each channel. 

 

 

 

10-20 M 60-3-0024 e / printed 06.2010 



Modules - Imaging Plus 

 

Select from the Processing menu the Adjust functional group, and then the 
Brightness/Contrast/Gamma function. 

 You will now see the dialog 
window of the 
Brightness/Contrast function. 

 If the Automatic Preview 
check box is activated, you will 
see the reduced input image. 

 If you click on the  button in 
the Input field, the image 
gallery appears. Select the 
black/white image of the blue 
channel by clicking on it. 

 Set the value -0.5 for 
Brightness, the value 1 for 
Contrast and the value 0.5 for 
Gamma by clicking on the 
arrow keys, or by entering the 
values directly. 

 Click on OK to close the dialog. 

 

 This increases the brightness in 
the blue channel image. 
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Select from the Processing menu the Utilities functional group, and then the 
Combine RGB Extractions function. 

 You will now see the dialog 
window of the Combine RGB 
Extractions function. 

 If the Automatic Preview 
check box is activated, you will 
see the reduced input image. 

 If you click on the  button in 
the Input field, the image 
gallery appears. Here select the 
image in question by clicking on 
it. For InputR select the 
black/white image of the red 
channel, for InputG the 
black/white image of the green 
channel, and for InputB the 
enhanced image of the blue 
channel. 

 Under PixelFormat select 
"24bit". 

 Click on OK to close the dialog. 
 

 In the resulting image the 
brightness has been greatly 
enhanced. 

Note: 
• Adjust the display characteristic 

curve in the resulting image if 
necessary. 
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Note: 
• More information about image format and bit depth can be found In 

chapter 5 "Imae Processing"- 5.1 "General". 

If images are acquired using a digital camera, they will take the form, 
depending on the camera, of 10 bit images (or 3x10 = 30 bit color images), 
12 bit images (or 3x12 = 36 bit color images) or 14 bit images (or 3x14 = 42 
bit color images). An analog camera, on the other hand, only produces 
images with 8 bits (or 3x8 = 24 bit color images). 

The gray value distribution of the image is displayed in the display 
characteristic curve (View menu ⇒ Properties function ⇒ Display property 
page). The number of bits that an image has can be seen from the maximum 
gray value. 

Bits Maximum gray value 

8 256 

10 1024 

12 4096 

14 16384 

16 65536 
 
As many programs work with 8 bit images only, or only distinguish between 8 
and 16 bits, it is useful to be able to convert images into other bit formats. 
The Convert Pixel Format function therefore also only distinguishes between 
8 and 16 bit black/white and 24 or 48 bit color images. 

As they have three color channels, color images always require three times as 
much storage space as black/white images. A 16 bit image requires greater 
storage space due to the increased gray value information it contains. Often 
the color information is not required, or 8 bit gray value information is 
sufficient. For this reason the Convert Pixel Format function is suitable for 
converting a color image into a black/white image, or a 16 bit image into an 8 
bit image. 
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If you want the same image to be converted into various pixel formats, we 
recommend that you work with the setting CreateNew = Off. This allows 
you not only to select the input image, but also to overwrite or enter a new 
name for the resulting image. Conversely, with CreateNew = On, a new 
resulting image is always created automatically, starting from the input image. 

The following example explains step by step how to convert an image into a 
different pixel format whilst continuing to use the same input image. 

 Load the image "Cut-
Cerebellum(1300).zvi" via the 
function File ⇒ Open Image, 
or acquire an image with the 
camera. 

 The image is displayed in 
AxioVision’s image window. 

 

 Position the cursor over the 
image, press the right-hand 
mouse button, and select the 
Properties function from the 
shortcut menu. 
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 Click on the Display tab sheet, 
where the image’s display 
characteristic curve is shown. 
This shows a gray value 
distribution of 3 x 14 bits for 
the red, green and blue color 
channels. 
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Now select from the Processing menu the Utilities functional group, and 
then the Convert Pixel Format function. 

 You will now see the dialog 
window of the Convert Pixel 
Format function. 

 If the Automatic Preview 
check box is activated, the 
reduced input image appears. 

 Set CreateNew to Off, so that 
a different conversion can be 
executed using the same image 
later. 

 Under PixelFormat select 
16bit.  

 Click on OK to close the dialog. 
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 The original image has been 
converted into a 16 bit 
black/white image. The display 
characteristic curve shows the 
distribution of the gray values. 
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Again select from the Processing menu the Utilities functional group, and 
then the Convert Pixel Format function. 

 You will again see the dialog 
window of the Convert Pixel 
Format function. 

 If you click on the  button in 
the Input field, the image 
gallery appears. Select the 
original image by clicking on it. 

 

 Under PixelFormat select 
"8bit". 

 The name of the resulting 
image remains unchanged. The 
image is overwritten. 

 Click on OK to close the dialog. 
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 The resulting image is an 8 bit 
black/white image. 

 

 The display characteristic curve 
of the resulting image now 
shows the gray value 
distribution of an 8 bit 
black/white image. 
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Again select from the Processing menu the Utilities functional group, and 
then the Convert Pixel Format function. 

 Select the original image again 
in the Input field. 

 For Output, allocate a new 
name, so that a new resulting 
image is generated. 

 If you click on the  button in 
the Input field, the image 
gallery appears. Select the 
original image by clicking on it. 

  

 Under PixelFormat select 
"24bit".  

 Click on OK to close the dialog. 
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 The resulting image is a 24 
(3x8) bit color image. 

 

 The display characteristic curve 
of the resulting image shows 
the gray value distribution of 
the individual color channels.  
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NMKO fåëáÇÉQa=EPa=sáÉïF=L=Pa=jÉ~ëìêÉ=

With Inside4D you can display the Z-stack fluorescence images you have 
generated using AxioVision in three dimensions. The Z-stack images have to 
be black & white (acquired with a monochrome camera), can consist of up to 
32 channels and can also be a time lapse series. 

To display the third dimension on a two-dimensional medium such as a 
monitor, the data are projected into a virtual space. The impression of three 
dimensions can be created either by setting reference points (e.g. a shadow) 
or by animating the view. A three-dimensional display can be particularly 
effective for image stacks that have been processed using the Deconvolution 
module, acquired using the ApoTome module or acquired using a Confocal 
Laser Scanning Microscope (LSM). 

It is also possible to include time (from time lapse images) in each display as a 
fourth dimension (simultaneous animation of 3D projection and playback of 
time sequence). 

3D Measure allows you to perform automatic measurements in Z-stack 
images. 

Note: 
• Switching between 2D and 3D View is best done using the buttons 

 and  at the lower edge of the image. 

Additional buttons 

 activates the Shadow rendering mode. 

 activates the Transparency rendering mode. 

 activates the Surface rendering mode. 

 activates the Maximum rendering mode. 
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 activates the Mixed rendering mode. 

 activates the Measure 3D mode. This button is only 
available when the 3D Measure module is activated. 

 creates a binary mask image of the displayed channel 
based on the current threshold settings. You can create a binary mask image 
of all channels whne you press the Ctrl key while clicking the Create Lable 
Image button. This mask image can e.g. be processed by the 3D Binary 
Image Editor function. This button is only available when the 3D Measure 
module is activated. 

  displays the 3D objects that are selected interactively in 
the Measure 3D mode. This check box is only available when the 3D 
Measure module is activated. 

 Clicking on the  button opens the Inside4D Settings dialog. 
Here detailed settings for the selected rendering modes can be specified. 
Also creation of a rendered animation series is started from here (see 
Series property page). 

 The  button creates a new unsaved 2D image of the 
currently displayed rendering.  

 Using the  slider, you can reduce the complexity of the 
image data used for the calculation. The speed of the calculation 
increases as the complexity of the data decreases. This applies to all 
display modes, although the slider has different effects (number of pixels, 
textures, triangles etc.) depending on the mode in question. Even more 
flexible settings can be made on the View property page. 
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 A progress bar appears during the rendering procedure. If the calculation 
is taking too long, you can interrupt the procedure by clicking on the 

 button. 

 Clipping buttons: : With these buttons one can 
introduce three so called Clipping planes into the volume. Clipping 
planes can cut the volume open to unveil structures inside the volume. 
The labeling of the buttons indicates the clipping planes default 
orientation. 

 if the orientation of a clipping plane has been changed (see detailed 
description of the clipping plane options in the Clipping tab of the 
Settings dialog) the default orientation can be regained by using the 

 button 

  if checked this option hides the volume data. This 
feature enhances the effect of displaying textures mapped onto Clipping 
planes. 

 : This button is active in Surface mode only (method 
Variable detail (graphics card) and can be used for multichannel z-
stacks to display the rendering of individual channels as well as the merge 
of all channels. All manipulation options for the volume are available as in 
normal 3D view. 

Control elements in the window 

The standard view when you first switch into 3D view is a front view in the 
Transparency mode (graphics card accelerated mode). 
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 You can use the wheels  to zoom in and out of the view 

 and/or to rotate the view around the x , y  and z axes 

. 

 The mouse function for direct interaction with the image volume can be 
configured using the five buttons at the center of the left-hand image 
edge 

• The  button allows the selection of measurement tools present in 
the volume. As long as the mouse cursor is not in the vicinity of an 

endpoint of a measurement tool the cursor symbol  is shown. If 
the cursor moves into the vicinity of an endpoint the cursor shape 

changes into . The now selected endpoint is displayed in yellow 
and can be moved by keeping the left mouse button clicked down 
and moving the mouse to a new position within the volume. This 
action also updates the measurement values. If in this mode it is 

possible to temporarily switch into the default mode  by keeping 
the Ctrl+Shift keys depressed. This permits the quick reorientation of 
the volume during interactive measurements. If released the cursor 
resumes the selection shape. 

• If the 
 

 button is selected, you can rotate the image volume freely 
by depressing the left mouse button 

• The  button allows you, with the left mouse button depressed, 
to zoom into the image by moving the mouse in an upward direction, 
or to zoom out of the image by moving the mouse in a downward 
direction 
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• If the  button is depressed, you can move the image volume 
laterally, e.g. to make certain structures visible when in zoom mode. 
You can also activate this function temporarily by pressing the Ctrl 
key followed by the left mouse button 

• With the  button selected changes the function of the left mouse 
button into a fly mode. By depressing the left mouse button you can 
fly into and through the sample. Moving the mouse at the same time 
changes the flight path. Alternatively the fly mode can also be 
invoked by pressing the mouse wheel key. 

Note: 

• The  and  button and the associated functionality is only 
available for graphics card accelerated rendering modes. 

There are six additional buttons at the lower edge of the image 

 You can use the  button at the lower edge of the image to apply a 
frame to your image stack,  

 ... the  button to show the x, y and z axes  (x=red, y=blue, z=green) 
 
or … 

 … in the case of scaled data, the  button to add a scale. These 
functions help you to get oriented inside the virtual space. If you move 
the mouse pointer above one of these buttons, a tool tip will be displayed 
explaining the function. 

 The  button hides measurement shapes drawn into the volume (Only 
available in graphics card accelerated rendering modes) 
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 The  button returns you to the default front view at any time from 
within the selected viewing mode. This resets all positions including Shift, 
Zoom or Flight so that the complete image content is visible in the image 
frame. 

 The  button allows you to touch the object using your mouse and set 
it into continuous motion ("animation'). This significantly improves the 
impression of three dimensions. 

Note: 
• In animation mode a view is re-rendered for each projection. In the case of 

large image stacks (more than 20 MB) a powerful computer with a good 
graphics card is required to guarantee smooth animation. 

If you have loaded a time lapse image the player bar appears at the bottom 
edge of the window. You can then play back the time lapse sequence. 
However, the player does not wait for the rendering of the scene to be 
completed before moving on to the next instant. That's why you should select 

a slower time setting for rendering using the  button. This opens the 
Player interval dialog window: 

 

In the Delay field enter the desired time in milliseconds and click 

. 
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qÜÉ=îáÉïáåÖ=ãçÇÉë=pÜ~ÇçïI=qê~åëé~êÉåÅóI=pìêÑ~ÅÉI=
jáñÉÇ=~åÇ=j~ñáãìã=

: In the Shadow mode the structures in the image are 
illuminated by a virtual light source. The volume is viewed as if looking 
through the eyepieces of the microscope and the light source projects a 
shadow onto a background plane. This gives the data a reference in space, 
making visualization much easier. The rendering effect itself consists of a 
combination of light reflection and opacity (degree of transparency). The 
display in this mode is only calculated by the main processor (CPU) of the 
computer (Voxel mode). 

: In the Transparency mode a three-dimensional image 
with a transparent effect is calculated. At least two two-dimensional texture 
stacks (computed from two different angles) are used depending on the 
volume orientation (only for the graphics card accelerated rendering mode). In 
contrast to the Shadow mode the scene here is illuminated by diffuse white 
light from the rear. By changing the available parameters one can mix 
different channels and reveal relationships between information in those 
channels. This view is particularly useful for visualizing the three-dimensional 
relationships between structures within the volume. This mode can be 
displayed both in CPU based Voxel mode and also (with the help of a suitable 
graphics card) with accelerated calculations in so-called OpenGL mode. 

: In the Surface mode grey values in the image are 
computed as solid surfaces (also known as Isosurfaces) instead of soft 
transparent shades. This display mode is useful to focus the attention on 
certain structures (e.g plant cell walls, nucleoli, intracellular vesicles) while 
potentially hiding additional structures deeper within. In this mode you also 
can select between Voxel- (CPU) and OpenGL- (graphics card) display. 

: Clicking on this button switches to Maximum projection 
mode, which calculates a three-dimensional view of the data by only showing 
pixels of the highest intensity along the projection axis. This view is particularly 
useful for displaying three-dimensional images in two dimensions, e.g. in 
publications, and guarantees a maximum possible degree of transparency. The 

10-38 M 60-3-0024 e / printed 06.2010 



Modules  - Inside4D (3D View) / 3D Measure 

display in this mode can be calculated by the main processor (CPU) of the 
computer (Voxel mode) or the graphics card in OpenGL mode. 

: In Mixed mode both transparency and surface modes can 
be mixed in one volume display. Using this mode one can render small 
structures within cells such as vesicles or speckles (e.g. FISH signals) as surfaces 
in one channel of a multichannel image while rendering the surrounding 
cytoplasm from another channel in transparency mode. This way one can also 
visualize more complex relationships convincingly.  

jÉ~ëìêÉ=Pa=jçÇÉ=

To measure 3D objects the surface of the objects has to be determined first. 
You can specify this surface on the Data tab in the Inside4D Settings dialog. 
Here you can modify the Threshold value to specify the gray value which 
define the objects to be measured. 

In Measure 3D mode the spcified 3D objects are measured and displayedin 
individual colors. Activate the To select an object activate the standard cursor 

mode by clicking the  button. When the mouse cursor has detected a 3D 

object the shape changes from  to . No click the detected object. 
The color of the object and the circumscribing cuboid are now displayed in a 
higher brightness. Keep the Ctrl key pressed to select more objects. Use the 

wheels  to rotate the view around the various axes in order 
to select hidden 3D objects. 

The measurement data for all measured objects are displayed on the 3D 
Measurement tab of the Properties window. 

The Measure 3D mode can not be combined with the following modes: 
 Shadow 
 Transparency - Rendering mode Voxel (computer) 
 Surface - Rendering mode Voxel (computer) and Maximum detail 

(graphics card) 
 Maximum - Rendering mode Voxel (computer) 
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pÉííáåÖë=Ñçê=íÜÉ=îáÉïáåÖ=ãçÇÉë=

In the Inside4D Settings dialog you can adjust settings, which influence the 
3D view, on the property pages Data, Illumination, Series, View, Info, 
Clipping, Measure, Stereo and Special. You can also create animations as 
image series (required for movie export) as well as perform simple interactive 
measurements. 

Settings you have made and want to keep can be saved independent of the 
image and applied to other image stacks. On the Data property page click on 

 button in the Settings field. Now you can name the settings 
file, to which a *.zv3 ending will be attached. In this setting file all settings 
you can change in Inside4D will be included. This function is particularly 
important if you want to observe images of samples under identical 
conditions, to allow comparison. 

Depending on the chosen Rendering method the settings you can change will 
be different for the Data, Illumination and View property pages. In the 
following chapters each property page will be explained separately for each 
rendering mode. 

a~í~=éêçéÉêíó=é~ÖÉ=

On the Data property page, select the threshold starting at which individual 
pixels will be used for the calculation. All pixel values that are not being used 
are hidden and interpreted as background. Once you have specified the pixels 
to be used, define the surface composition of the objects. Different 
parameters are available for this purpose in the individual modes. 

Settings 

These functions are identical for all render modes. 

The  button loads a previously saved *.zv3 settings and applies 
it to the z stacks. 
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 saves the settings you made, independently from the image, so 
they can be used for other z-stacks. Now you can name the settings file, to 
which a *.zv3 ending will be attached. All parameters are included in the 
setting file. This function is particularly important if you want to observe 
images of samples under identical conditions, to allow comparison. 

The  button saves the current setting as default setting, which 
will be used by all followed images. 

The  button restores the default state. 

Note: 
• You can create a new image from any current view by clicking on the 

 button on the right side of your image. 

pÜ~Ççï=ãçÇÉ=

Data 

 Channels: The settings are entered separately for each channel using 
sliders or by entering a numerical value in the corresponding input field. 
To select a channel click on the corresponding button (labeled with the 

channel color, e.g. ). 

 Threshold specifies a lower threshold as a percentage of the gray values 
displayed. This decides which data enter the rendered image. If one 
fluorescence channel contains a homogeneous fluorescence signal with 
high signal strength, one would set the threshold higher in order to 
"protect" signals from weaker channels from being quenched. 

 Ramp controls the degree of the transition from completely transparent 
to completely opaque. 

 Maximum influences the degree of opacity. 
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 The settings are combined into a histogram . The x axis corresponds 
to the gray values and the y axis to the degree of opacity. You can also 
use the mouse to interact with the histogram curve. 

 Roughness: You can also influence the roughness used to display the 
surface of the image structures. This changes the plasticity of the display 
(relative scale between 0 and 1). This setting quickly can produce artifacts 
if pixels reach saturation. The degree of roughness should be reduced 
accordingly. 

qê~åëé~êÉåÅó=ãçÇÉ=

Data 

 Channels: The settings are entered separately for each channel using 
sliders or by entering a numerical value in the corresponding input field. 
To select a channel click on the corresponding button (labeled with the 

channel color, e.g. ). 

 Threshold specifies a lower threshold as a percentage of the gray values 
displayed (relative scale between 0 and 1). This decides which data enter 
the rendered image. 

 Ramp controls the degree of the transition from completely transparent 
to completely opaque (relative scale between 0 and 1). 

 Maximum influences the degree of opacity (relative scale between 0 and 
1). 

 The parameters are schematically illustrated in a histogram . The x 
axis represents the gray values and the y axis the transparency. You can 
also use the mouse to interact with the histogram curve. 

 Gamma: With this slider the transparency effect can be further enhanced 
in a channel specific manner (relative scale between 0 and 1). This 
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parameter influences all pixel gray values in the same way in contrast to 
the Ramp and Maximum settings. 

Global 

 Opacity: If you select the Texture (graphics card) method in the 
Special property page, you can change the degree of opacity in the scene 
anywhere between 0.00 and 1.00. Use the slider or enter the value into 
the input field. A value of 0.00 will make all objects fully transparent. 

 Angle: If you select the Texture (graphics card) method in the Special 
property page, you can change the projection angle used to view the 
scene anywhere between 0.1° and 89.9°. Use the slider or enter the 
Angle into the input field. The effect of this on the display perspective is 
similar as if you were viewing the 3D image through a telephoto or wide-
angle lens. 

 If the Voxel (computer) method is selected in the Special property 
page, this adjustment cannot be done. 

pìêÑ~ÅÉ=ãçÇÉ=

Data 

 Channels: The settings are entered separately for each channel using 
sliders or by entering a numerical value in the corresponding input field. 
To select a channel click on the corresponding button (labeled with the 

channel color, e.g. ). 

 Threshold: Sets the gray value threshold on a relative scale between 0 
and 1 at which a pixel will belong to the object. 

 Ambient: describes a diffuse, non-directed light source, which lets both 
bright and dark structures appear darker or brighter in an equal fashion 
(values on a scale between 0 and 1). 
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 Specular: sets a directional brightness (values on a scale between 0 and 
1). Influences the differences between dark and bright structures, which 
are strongest at a value of 0. 

 Shininess changes the surface gloss (on a scale between 0 and 1). 

Global 

 Angle: If you select the Texture (graphics card) method in the Special 
property page, you can change the projection angle used to view the 
scene anywhere between 10° and 80°. Use the slider or enter the Angle 
into the input field. The effect of this on the display perspective is similar 
as if you were viewing the 3D image through a telephoto or wide-angle 
lens. 

 If the Voxel (computer) method is selected in the Special property 
page, this adjustment cannot be done. 

Note: 
• If the render method Maximum detail (graphics card) is selected on the 

View property page AND on the Special property page the option 
Transparent surfaces is selected, the Data property page shows the slider 
Transparency. Using this slider one can assign an additional transparency 
effect to the surfaces of a channel. 

j~ñáãìã=ãçÇÉ=

Data 

 Channels: The settings are entered separately for each channel using 
sliders or by entering a numerical value in the corresponding input field. 
To select a channel click on the corresponding button (labeled with the 

channel color, e.g. ). 

 Threshold: In the Threshold area, you can use the slider or value field to 
set an upper and a lower threshold. Values smaller than the lower 
threshold value, or greater than the upper threshold value, are not 
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considered in the rendered stack. This setting option is particularly useful 
for the rendering of multichannel image stacks. 

Note: 
• Please note, that the setting for upper threshold is only available for the 

CPU method Voxel (computer) (View property page  Mode Maximum 
 Method Voxel). 

Global 

 Opacity: If you select the Texture (graphics card) method in the 
Special property page, you can change the degree of opacity in the scene 
anywhere between 0.00 and 1.00. Use the slider or enter the value into 
the input field. Please note that visibility of opacity adjustments in 
maximum mode depends on background color and/or presence of 
colored clipping planes in the image. 

 Angle: If you select the Texture (graphics card) method in the Special 
property page, you can change the projection angle used to view the 
scene anywhere between 10° and 80°. Use the slider or enter the Angle 
into the input field. The effect of this on the display perspective is similar 
as if you were viewing the 3D image through a telephoto or wide-angle 
lens. 

 If the Voxel (computer) method is selected in the Special property 
page, this adjustment cannot be done. 

jáñÉÇ=ãçÇÉ=

Data 

In the Mixed mode a volume can be displayed both in surface and 
transparency mode. For this is it necessary to define settings for both methods 
separately for each channel. To accommodate this the Data page has been 
subdivided in two halves. 

 Channels: The settings are entered separately for each channel using 
sliders or by entering a numerical value in the corresponding input field. 
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To select a channel click on the corresponding button (labeled with the 

channel color, e.g. ). All changes you make are only applied to the 
selected channel. 

 Transparency: if checked, the selected channel is shown in 
Transparency mode. 

• Threshold specifies a lower threshold as a percentage of the gray 
values displayed (relative scale between 0 and 1). This decides which 
data enter the rendered image. 

• Ramp controls the degree of the transition from completely 
transparent to completely opaque (relative scale between 0 and 1). 

• Maximum influences the degree of opacity (relative scale between 0 
and 1). 

• The parameters are schematically illustrated in a histogram . The 
x axis represents the gray values and the y axis the transparency. You 
can also use the mouse to interact with the histogram curve. 

• Gamma: With this slider the transparency effect can be further 
enhanced in a channel specific manner (relative scale between 0 and 
1). This parameter influences all pixel gray values in the same way in 
contrast to the Ramp and Maximum settings. 

 Surface: if checked, the selected channel is shown in Surface mode. 

• Threshold: Sets the gray value threshold on a relative scale between 
0 and 1 at which a pixel will belong to the object. 

• Ambient: describes a diffuse, non-directed light source, which lets 
both bright and dark structures appear darker or brighter in an equal 
fashion (values on a scale between 0 and 1). 
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• Specular: sets a directional brightness (values on a scale between 0 
and 1). Influences the differences between dark and bright structures, 
which are strongest at a value of 0. 

• Shininess changes the surface gloss (on a scale between 0 and 1). 

Global 

 Opacity: If you select the Texture (graphics card) method in the 
Special property page, you can change the degree of opacity of all 
transparent objects in the scene anywhere between 0.00 and 1.00. Use 
the slider or enter the value into the input field. A value of 0.00 will make 
all transparent rendered parts in the scene become fully transparent. 
Please note that opacity adjustments will not influence the rendering of 
surface portions in the scene. 

 Angle: If you select the Texture (graphics card) method in the Special 
property page, you can change the projection angle used to view the 
scene anywhere between 10° and 80°. Use the slider or enter the Angle 
into the input field. The effect of this on the display perspective is similar 
as if you were viewing the 3D image through a telephoto or wide-angle 
lens. 

Note: 
• The Mixed Mode is only available as a graphics card accelerated mode 

and not as CPU only mode. 

fääìãáå~íáçå=éêçéÉêíó=é~ÖÉ=

With the settings made on this property page you influence the light sources, 
that illuminate the volume as well as the background color. The settings 
available on Illumination are different for each render mode and are 
therefore explained separately. In contrast to the settings on Data property 
page all illumination settings act on all channels at the same time. 
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Settings 

These functions are identical for all render modes. 

The  button loads a previously saved *.zv3 settings and applies 
it to the z stacks. 

 saves the settings you made, independently from the image, so 
they can be used for other z-stacks. Now you can name the settings file, to 
which a *.zv3 ending will be attached. All setting options, with the exception 

of the lateral position ( ), are taken into consideration. This function is 
particularly important if you want to observe images of samples under 
identical conditions, to allow comparison. 

The  button saves the current setting as default setting, which 
will be used by all followed images. 

The  button restores the default state. 

Background 

Functions for changing the background color are available in the same fashion 
for all render modes. 

 Clicking on the  button opens a window that allows 
you to select the background color. 

• You can either select the background color from 8 standard colors or 
create your own colors. In the drop down list field click on the 

 option and select colors from the palette 
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• You can also enter color values manually in the value fields. Clicking 

on the  button adds the newly 
selected color to the selected field for user-defined colors. 

• To use a user-defined color click on the corresponding color field 
("Basic Colors" or "Custom Colors") and confirm by clicking 

. 

pÜ~Ççï=ãçÇÉ=

 Brightness can be controlled via input field or slider bar (value range 0.2 
– 4). Fluorescence data usually profit from brightness values > 1.6 when 

viewed in pseudo color mode (  button in the Player panel). 

 Azimuth describes the angle of the light source above the virtual horizon 
and can be set by entering values directly or by slider (value range 0°-90°) 

 Elongation describes the horizontal direction of lighting and can be set 
by entering values directly or by slider (value range -180° to +180°) 

 You can change the settings also by moving the small circle with the 

mouse . The position of the light source is represented by the 
small circle inside the large circle. 

qê~åëé~êÉåÅó=ãçÇÉ=

 Brightness can be controlled via input field or slider bar (value range 0.2 
to 4). Fluorescence data usually profit from brightness values > 1.6 when 

viewed in pseudo color mode (  button in the Player Panel). 
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pìêÑ~ÅÉ=ãçÇÉ=

 Distance (value range 0.1 – 9-5) determines the distance between light 
source and volume. At a value of 0.1 the light source is close by, shadow 
effects etc. are minimal. The further away the light source, the more 
prominent the shadow effects become (“evening shadows are longer”). 

 Azimuth describes the angle of the light source above the virtual horizon 
and can be set by entering values directly or by slider (value range 0°-90°) 

 Elongation describes the horizontal direction of lighting and can be set 
by entering values directly or by slider (value range -180° to +180°) 

 You can change the settings also by moving the small circle with the 

mouse . The position of the light source is represented by the 
small circle inside the large circle. 

j~ñáãìã=ãçÇÉ=

 Brightness: Control the brightness of the display using the slider or input 
field (value range 0.1 to 4). With multichannel images, screen saturation 
quickly occurs in mixed color mode. If this happens, reduce the overall 
brightness. 

jáñÉÇ=ãçÇÉ=

 Brightness can be controlled via input field or slider bar (value range 0.2 
to 4). Fluorescence data usually profit from brightness values > 1.6 when 

viewed in pseudo color mode (  button in the Player Panel). 

 Distance (value range 0.1 – 9-5) determines the distance between light 
source and volume. At a value of 0.1 the light source is close by, shadow 
effects etc. are minimal. The further away the light source, the more 
prominent the shadow effects become (“evening shadows are longer”). 
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 Azimuth describes the angle of the light source above the virtual horizon 
and can be set by entering values directly or by slider (value range 0°-90°) 

 Elongation describes the horizontal direction of lighting and can be set 
by entering values directly or by slider (value range -180° to +180°) 

 You can change the settings also by moving the small circle with the 

mouse . The position of the light source is represented by the 
small circle inside the large circle. 

pÉêáÉë=éêçéÉêíó=é~ÖÉ=

Once you have decided on a viewing mode and entered your settings, you can 
have your view calculated as a series of individual images. 

Note: 
• This property page is always identical for the Shadow, Transparency, 

Surface, Maximum and Mixed modes. 

Whereas the  button (see Control elements in the window) produces 
a live animation, which requires each image to be re-calculated for display, 
here you can have a series of individual images calculated to represent the 
animation you would like. 

Depending on the image size, the display of an image series like this can be 
much faster and smoother than a "live" animation, as the views no longer 
have to be re-rendered. This type of image series can also be exported as a 
film in Video for Windows (AVI) or QuickTime -format (MOV) with excellent 
results. However, you can also export an image series into other file formats 
as a series of individual images. 

The settings you make here define the parameters to be used to perform the 
animation. A minimum required entry is the definition of a start angle as well 
as an end angle. 
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Series 

 Series: In this drop-down list box you have the choice between five 
different options: X-Axis, Y-Axis, Z-Axis. With these first three options 
you can create the series using a fixed axis (x,y,z), around which the 
animation turns. If you select one of these options, three sliders appear. 

 Views: This slider specifies the number of images you want to be 
included in the animation. The greater the number of images you enter, 
the smoother the display will be. However, the resulting image will also 
increase in size accordingly. The value range of the slider extends from 1-
1000 images. However, you may also enter a higher value in the value 
field (up to 9999). 

 Start Angle / End Angle: These two sliders can be used to specify the 
start angle and end angle. Here you can make a selection between -360° 
and +360°. Frequently entering a small range such as -35° to +35° will 
already give impressive results, smooth "tumbling" without the need for 
large number of views. 

 Alternatively, you can also save any views of the object in the space as 
positions in a position list and generate an animation with changing 
rotation axes and/or zoom factors. To do this, select in the drop-down list 
box Series the Position List option. This opens another drop-down list 
box. 

• Clicking on the  button adds the current position with 
the values for x, y, z and d (for zoom factor). A position also 
incorporates a lateral shift as well as the position of the time player 
(when rendering time series), both parameters are not shown in the 

list though. The  button is also available on the right 
hand side directly next to the rendering window. 

• Now change the orientation of the object in the image window as 
required and save the new position.  
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• You can delete one or more positions by clicking  or 

delete all positions by clicking on . A double click on a 
position entry will invoke this setting on the image. 

 If you have created a time lapse image, you can generate a time lapse 
series of the 3D view you have just selected by choosing the Time Series 
option from the drop down list. Please be aware, that it might be better 
in many cases to use the position list option instead in order to combine 
both spatial and temporal changes in the render series. This will enhance 
the 3D effect on 4D movies. 

 If you want to generate a series using the settings you have made on the 
Data and Illumination property pages, select the Use Settings or 
Without Settings function from the drop-down list box at the bottom 
edge of the position list. Using this feature you can make one channel 
disappear by setting the threshold to 100%. Using this technique you can 
demonstrate structures otherwise hidden behind dominant signals from 
other channels. 

 You always generate the series by clicking on . The 
result is a new image that corresponds to a time lapse image in terms of 
its operation (player bar). Additionally, you may start and stop a preview 

of your render series by clicking on the  buttons on the right 
hand side directly next to the rendering window. This preview uses the 
number of views that are adjusted by the views slider but excludes some 
options and details of the final render series (e.g. clipping planes) to 
enable a fast preview.  

The new image series document can be saved as a ZVI-image or exported in 
another format, such as Video for Windows (AVI). 

Notes: 
• It can take up to several minutes to calculate complex image series with 

large numbers of images and/or positions. 
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• In uncompressed form, complex series can become extremely large. This 
can make it difficult to import them into e.g. Microsoft PowerPoint™ for a 
presentation. It is therefore recommended that you compress the AVI or 
QuickTime files during export (for help on this subject, see the Export help 
topic). 

Settings 

The  button loads a previously saved *.zv3 settings including 
stored position lists and applies it to the z stacks. 

 saves the settings including positions you made independent 
from the image, so they can be used for other z-stacks. Now you can name 
the settings file, to which an *.zv3 extension will be attached. All setting 
options are applied. This function is particularly important if you want to 
observe images of samples under identical conditions, to allow comparison. 

The  button saves the current setting as default setting, which 
will be used by all followed images. 

The  button restores the default state. 

sáÉï=éêçéÉêíó=é~ÖÉ=

On this page, you can choose amongst the following viewing parameters: 
geometric parameters, volume resolution as well as settings influencing the 
rendering method. 

pÜ~Ççï=ãçÇÉ=

Geometry 

 Angles (x,y,z): shows the current orientation of the volume in degrees (-
180 to 180) with respect to the main axis (x, y, z). You can also define an 
angle by entering a desired value in the edit fields.  
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 Center (x,y,z): describes the relative position of the rotation center to the 
center of the 3D stack. This translates into a lateral shift of the volume 

and is best defined by the  tool. The values are given in units of 
volume diagonals (x, y, z): the diagonal is set to 1. For the home position 
all values equal 0 

 Zoom: defines the magnification factor (value range 0-1000). 

Note: 
• Stretch Z is not active in Shadow mode. 

Resolution 
 Reduction XY / Reduction Z: In this field, for shadow mode you can 

reduce the number of pixels used for the volume rendering step by step in 
both the lateral (x,y) and axial (z) direction (subsampling). In some cases 
this can significantly reduce the time for the calculation. 

• To do this, move the corresponding slider, or enter the desired value 
in the edit field. A reduction value of 2 (x,y) combines 2 pixels in the x 
and y directions, reducing the data volume by a factor of four. A 
value of 2 for z combines two z-planes in one single plane, reducing 
the data volume by half. 

• The more you reduce the data, however, the smaller the benefits in 
terms of speed. As a rule, a reduction of 2-3 is sufficient for a smooth 
display. 

• To get the optimum effect you can also adjust these settings on the 
Info property page. There the performance measurements give a 
direct feedback on the speed improvement. 

Rendering Mode 

 Here you can also switch between the different modes (using the drop-
down list box). In the OpenGL accelerated modes, here you can also 
change the rendering method being used (using the drop-down list box).  
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 Method: As in shadow mode only the computer’s processor (“CPU 
method”) is used, the Method drop-down list box remains inactive. 

 : hides the shadow if unchecked 

 Distance: regulates the distance between shadow and volume using the 
slider or entering the desired value in the edit field (value range 0.5 to 3) 

 Use Depth Coding: activates a depth coding in the z-dimension that 
ranges from blue over green, orange and yellow to red. Depth Coding 
effects only the rendering modes Maximum, Transparency and 
transparent parts of the Mixed mode. 

 Draw Depth Coding Scale: draws a color coded scaling below the 
rendered image. This option is only available for the Transparency 
rendering mode of the CPU method Voxel (computer) 

Note: 
• Stretch Z is not active in Shadow mode. 

Measure 

 : You can specify whether the 
measured 3D objects shall be displayed. 

 : With this option you specify whether 
the surface of the measured objects shall be displayed. 

 : This option specifies whether the 
circumscribing cuboid shall be displayed. 

 : Check this option to combine the 
color-coded display of the measured objects with the display of their 
surface. 
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Geometry 

 Angles (x,y,z): shows the current orientation of the volume in degrees (-
180 to 180) with respect to the main axis (x, y, z). You can also define an 
angle by entering a desired value in the edit fields.  

 Center (x,y,z): describes the relative position of the rotation center to the 
center of the 3D stack. This translates into a lateral shift of the volume 

and is best defined by the  tool. The values are given in units of 
volume diagonals (x, y, z): the diagonal is set to 1. For the home position 
all values equal 0. 

 Zoom: defines the magnification factor (value range 0-1000). 

 Stretch Z stretches the volume display in axial (z) direction. Entering 
values >1 (value range 0-20) increased the height of flat structures. 

Note: 
• Stretch Z is only active for the graphic card method. 

Resolution 

 Reduction (xy) / Reduction (z): For Transparency mode you can reduce 
the number of pixels used for the calculation step by step in both the 
lateral (x,y) and axial (z) directions (subsampling). In some cases this can 
significantly reduce the duration of the calculation. 

• To do this, move the corresponding slider, or enter the desired value 
in the input field. A reduction value of 2 for x,y, for example, 
combines 2 pixels in the x and y directions, reducing the data volume 
by a factor of 4. A value of 2 for z combines two z-planes in one 
single plane, reducing the data volume by half. 
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• The more you reduce the data, however, the smaller the benefits in 
terms of speed. As a rule, a reduction of 2-3 is sufficient for a smooth 
display. 

• You can also adjust the resolution on the Info property page where 
you can see the performance values of the rendering directly. 

• The ability of the graphics card to hold all texture planes in its 
memory is a key factor in determining whether the image stack can 
be rendered smoothly (animation mode!) with the Texture (graphics 
card) method. You should therefore set the sliders in such a way that 
in the info field on the Info property page, the value "Nr. 
Texture planes = all" is displayed. 

Rendering Mode 

 Here you can also switch between the different modes (using the drop-
down list box). In the OpenGL accelerated modes, here you can also 
change the rendering method being used (using the drop-down list box). 

 Method: In the Transparency mode, the two options Voxel (computer) 
and Texture (graphics card) are available. 

• With the Voxel (computer) method, rendering is performed using 
the main processor only, without OpenGL support; the model that 
forms the basis for the calculation is also less complex. As a result, 
this method is usually faster on slow computers with small graphics 
cards. The results, however, are also of reduced quality. 

• The more complex method Texture (graphics card) gives the 3D 
images surface structures, so-called textures, which are in turn 
constructed from individual elements (texels). The fewer elements 
required, the faster the rendering speed (images/s). 

 Use Depth Coding: activates a depth coding in the z-dimension that 
ranges from blue over green, orange and yellow to red. Depth Coding 
effects only the rendering modes Maximum, Transparency and 
transparent parts of the Mixed mode. 
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 Draw Depth Coding Scale: draws a color coded scaling below the 
rendered image. This option is only available for the Transparency 
rendering mode of the CPU method Voxel (computer) 

Measure 

 : You can specify whether the 
measured 3D objects shall be displayed. 

 : With this option you specify whether 
the surface of the measured objects shall be displayed. 

 : This option specifies whether the 
circumscribing cuboid shall be displayed. 

 : Check this option to combine the 
color-coded display of the measured objects with the display of their 
surface. 

pìêÑ~ÅÉ=ãçÇÉ=

Geometry 

 Angles (x,y,z): shows the current orientation of the volume in degrees (-
180 to 180) with respect to the main axis (x, y, z). You can also define an 
angle by entering a desired value in the edit fields.  

 Center (x,y,z): describes the relative position of the rotation center to the 
center of the 3D stack. This translates into a lateral shift of the volume 

and is best defined by the  tool. The values are given in units of 
volume diagonals (x, y, z): the diagonal is set to 1. For the home position 
all values equal 0 

 Zoom: defines the magnification factor (value range 0-1000). 

 Stretch Z stretches the volume display in axial (z) direction. Entering 
values >1 (value range 0-20) increased the height of flat structures. 
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Note: 
• Stretch Z is only active for the graphic card method. 

Resolution 

 Reduction (xy) / Reduction (z): For Surface mode you can reduce the 
number of pixels used for the calculation step by step in both the lateral 
(x,y) and axial (z) directions (subsampling). In some cases this can 
significantly reduce the duration of the calculation. 

• To do this, move the corresponding slider, or enter the desired value 
in the input field. A reduction value of 2 for x,y, for example, 
combines 2 pixels in the x and y directions, reducing the data volume 
by a factor of 4. A value of 2 for z combines two z-planes in one 
single plane, reducing the data volume by half. 

• The more you reduce the data, however, the smaller the benefits in 
terms of speed. As a rule, a reduction of 2-3 is sufficient for a smooth 
display. 

• You can also adjust the resolution on the Info property page where 
you can see the performance values of the rendering directly. 

• In Surface mode, here you can also determine the maximum number 
of triangles used for calculation. The fewer triangles used by the 
model, the higher the rendering speed. At the same time, this also 
reduces the level of detail. 

• The more you reduce the data, however, the smaller the benefits in 
terms of speed. As a rule, a reduction of 2-3 in the x,y and z 
directions is sufficient for a smooth display. The number of triangles 
should not be less than 5000, as otherwise the quality of the 
resolution is insufficient. To achieve the same quality in the Variable 
detail (graphics card) mode as in the Maximum detail (graphics 
card) mode, the maximum number of triangles must be set, 
depending on the image data, to several million (entry of figures in 
the value field). 
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Rendering Mode 

 Using the drop-down list box you can switch between the modes. In the 
Open GL accelerated modes you can in addition change the render 
method used (drop down list box). 

 Method: Three methods are available, which you can select in the drop-
down list box: The method Voxel (computer), the graphics-card-
accelerated method Variable detail (graphics card) and the method 
Maximum detail (graphics card). 

• With the Voxel (computer) method, rendering is performed using 
the main processor only, without OpenGL support; the model that 
forms the basis for the calculation is also less complex. As a result, 
this method is faster on slow computers with small graphics cards. 
The results, however, are also of reduced quality. 

• Depending on the size of the data, the method Variable detail 
(graphics card) can be accelerated by the OpenGL-compatible 
graphics card. 

• The Maximum detail (graphics card) method calculates the surface 
model layer by layer. Here the available channels are added to the 
model one after the other. This process takes significantly longer than 
with the Variable detail (graphics card) method, which attempts to 
keep all image data in the graphics card’s memory. On the other 
hand, this method usually produces the best results. 

 Use Depth Coding: activates a depth coding in the z-dimension that 
ranges from blue over green, orange and yellow to red. Depth Coding 
effects only the rendering modes Maximum, Transparency and 
transparent parts of the Mixed mode. 

 Draw Depth Coding Scale: draws a color coded scaling below the 
rendered image. This option is only available for the Transparency 
rendering mode of the CPU method Voxel (computer) 
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Measure 

 : You can specify whether the 
measured 3D objects shall be displayed. 

 : With this option you specify whether 
the surface of the measured objects shall be displayed. 

 : This option specifies whether the 
circumscribing cuboid shall be displayed. 

 : Check this option to combine the 
color-coded display of the measured objects with the display of their 
surface. 

j~ñáãìã=ãçÇÉ=

Geometry 

 Angles (x,y,z): shows the current orientation of the volume in degrees (-
180 to 180) with respect to the main axis (x, y, z). You can also define an 
angle by entering a desired value in the edit fields.  

 Center (x,y,z): describes the relative position of the rotation center to the 
center of the 3D stack. This translates into a lateral shift of the volume 

and is best defined by the  tool. The values are given in units of 
volume diagonals (x, y, z): the diagonal is set to 1. For the home position 
all values equal 0 

 Zoom: defines the magnification factor (value range 0-1000). 

 Stretch Z stretches the volume display in axial (z) direction. Entering 
values >1 (value range 0-20) increased the height of flat structures. 

Note: 
• Stretch Z is only active for the graphic card method 
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Resolution 

 Reduction (xy) / Reduction (z): For Maximum mode you can reduce the 
number of pixels used for the calculation step by step in both the lateral 
(x,y) and axial (z) directions (subsampling). In some cases this can 
significantly reduce the duration of the calculation. 

• To do this, move the corresponding slider, or enter the desired value 
in the input field. A reduction value of 2 for x,y, for example, 
combines 2 pixels in the x and y directions, reducing the data volume 
by a factor of 4. A value of 2 for z combines two z-planes in one 
single plane, reducing the data volume by half. 

• The more you reduce the data, however, the smaller the benefits in 
terms of speed. As a rule, a reduction of 2-3 is sufficient for a smooth 
display. 

• You can also adjust the resolution on the Info property page where 
you can see the performance values of the rendering directly. 

• In contrast to the Transparency and Surface modes Maximum 
rendering is based upon a much simpler calculation model. As a result 
the rendering speed increase by data reduction is not as pronounced 
as with the other modes. It is for this reason, that the Maximum 
mode is very suitable for the rendering of large volume stacks. 

• To get the optimum effect you can also adjust these settings on the 
Info tab. There the performance measurements give a direct 
feedback on the speed improvement. 

Rendering Mode 

 Here you can also switch between the different modes (using the drop-
down list box). In the OpenGL accelerated modes, here you can also 
change the rendering method being used (using the drop-down list box). 

 Method: In the Transparency mode, the two options Voxel (computer) 
and Maximum (graphics card) are available. 
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• With the Voxel (computer) method, rendering is performed using 
the main processor only, without OpenGL support; the model that 
forms the basis for the calculation is also less complex. As a result, 
this method is usually faster on slow computers with small graphics 
cards. The results, however, are also of reduced quality. 

• The more complex method Maximum (graphics card) performs the 
maximum projection calculation on the graphics card and produces 
faster and better rendering results. 

 Use Depth Coding: activates a depth coding in the z-dimension that 
ranges from blue over green, orange and yellow to red. Depth Coding 
effects only the rendering modes Maximum, Transparency and 
transparent parts of the Mixed mode. 

 Draw Depth Coding Scale: draws a color coded scaling below the 
rendered image. This option is only available for the Transparency 
rendering mode of the CPU method Voxel (computer) 

Measure 

 : You can specify whether the 
measured 3D objects shall be displayed. 

 : With this option you specify whether 
the surface of the measured objects shall be displayed. 

 : This option specifies whether the 
circumscribing cuboid shall be displayed. 

 : Check this option to combine the 
color-coded display of the measured objects with the display of their 
surface. 
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Geometry 

 Angles (x,y,z): shows the current orientation of the volume in degrees (-
180 to 180) with respect to the main axis (x, y, z). You can also define an 
angle by entering a desired value in the edit fields.  

 Center (x,y,z): describes the relative position of the rotation center to the 
center of the 3D stack. This translates into a lateral shift of the volume 

and is best defined by the  tool. The values are given in units of 
volume diagonals (x, y, z): the diagonal is set to 1. For the home position 
all values equal 0. 

 Zoom: defines the magnification factor (value range 0-1000). 

 Stretch Z stretches the volume display in axial (z) direction. Entering 
values >1 (value range 0-20) increased the height of flat structures. 

Resolution 

 Reduction (xy) / Reduction (z): For Transparency mode you can reduce 
the number of pixels used for the calculation step by step in both the 
lateral (x,y) and axial (z) directions (subsampling). In some cases this can 
significantly reduce the duration of the calculation. 

• To do this, move the corresponding slider, or enter the desired value 
in the input field. A reduction value of 2 for x,y, for example, 
combines 2 pixels in the x and y directions, reducing the data volume 
by a factor of 4. A value of 2 for z combines two z-planes in one 
single plane, reducing the data volume by half. 

• The more you reduce the data, however, the smaller the benefits in 
terms of speed. As a rule, a reduction of 2-3 is sufficient for a smooth 
display. 

AxioVision User's Guide, Release 4.8.2 10-65 



Modules  - Inside4D (3D View) / 3D Measure 

• You can also adjust the resolution on the Info property page where 
you can see the performance values of the rendering directly. 

• The parameter Triangles as available for Surface mode is not 
available for Mixed mode. 

Rendering Mode 

 Here you can also switch between the different modes (using the drop-
down list box). For Mixed mode only the OpenGL accelerated method 
calculated with the graphics card is available. 

 Use Depth Coding: activates a depth coding in the z-dimension that 
ranges from blue over green, orange and yellow to red. Depth Coding 
effects only the rendering modes Maximum, Transparency and 
transparent parts of the Mixed mode. 

 Draw Depth Coding Scale: draws a color coded scaling below the 
rendered image. This option is only available for the Transparency 
rendering mode of the CPU method Voxel (computer) 

Measure 

 : You can specify whether the 
measured 3D objects shall be displayed. 

 : With this option you specify whether 
the surface of the measured objects shall be displayed. 

 : This option specifies whether the 
circumscribing cuboid shall be displayed. 

 : Check this option to combine the 
color-coded display of the measured objects with the display of their 
surface. 
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This property page shows performance values for the different render modes. 
With the settings in the Resolution field, you can accelerate the rendering 
speed significantly for large volumes. 

Info 

The Info field on this property page shows performance values that are 
designed to help you achieve a realistic estimate of the rendering speed you 
can expect. Partially different parameters will be displayed for the different 
render modes. 

For all render modes: 

 Performance: You are given a time value (in msec) for each image 
calculated resulting in a Frames/second value.  

 Angles: You can also still see the angle positions that are currently set. 
This can prove useful for the precise orientation of image stacks in space. 
The angle positions can be changed with the control elements of the 
image or on the View property page. 

 Center: You can change the center of the image with the control 
elements of the image or on the View property page. 

 Zoom: The current zoom factor of the display. You can change the zoom 
factor with the control elements of the image or on the View property 
page. 

 Additional parameters for Transparency: 

• Number of calculated Texture elements per second 

• Number of calculated pixels per second 
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• Number of loaded texture planes: Maximum rendering speed is only 
obtainable, if all texture planes can be loaded in the graphic card’s 
memory (Nr. Texture planes = all) 

• Number of rendered textures as well as texels, bytes and pixels (all in 
millions) 

• Nr. of loaded … shows number and size of textures during the 
process of loading them into the memory of the graphics card  

 Additional parameters for Surface 

• Number of calculated triangles / second 

• Number of calculated vertices (= points where the line segments of 
two triangles meet each other) 

• Total number of triangles 

• Total number of vertices 

Resolution 

 Reduction XY / Reduction Z: In this field you can reduce the number of 
pixels used for the calculation in both the lateral (x,y) and axial (z) 
directions (subsampling). In some cases this can significantly reduce the 
duration of the calculation. 

• To do this, move the corresponding slider, or enter the desired value 
in the input field. A reduction value of 2 (x,y) combines 2 pixels in the 
x and y directions, reducing the data volume by a factor of 4. A value 
of 2 for z combines two z-planes in one single plane, reducing the 
data volume by half. 

• The more you reduce the data, however, the smaller the benefits in 
terms of speed. As a rule, a reduction of 2-3 is sufficient for a smooth 
display. 
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 Triangles: In Surface mode, here you can also determine the maximum 
number of triangles used. The fewer triangles used by the model, the 
higher the rendering speed. At the same time, this also reduces the level 
of detail. 

• The number of triangles should not be less than 5000, as otherwise 
the quality of the resolution is insufficient. 

• To achieve the same quality in the Variable detail (graphics card) 
mode as in the Maximum detail (graphics card) mode, the 
maximum number of triangles must be set, depending on the image 
data, to several million (entry of figures in the value field). 

`äáééáåÖ=éêçéÉêíó=é~ÖÉ=

Inside4D features up to three so called Clipping planes. These planes can be 
used to cut the volume open in order to visualize structures which are within 
the volume. Clipping planes make most sense when used in the Surface 
mode but can also be used with limited functionality with the rendering 
modes Maximum and Transparency. 

In Surface mode clipping planes can also be used in a channel specific 
manner. This means, that in a multichannel image one can selectively cut 
away portions of the volume in one channel in order to unveil other structures 
from other channels. This technique also works in Mixed mode. 

A further possibility is, to use clipping planes in order to display only the gray 
values of the volume which touch the clipping plane.  

All these functions can be used for creating a render series in order to make 
spectacular movies for presentation. 

There are three clipping planes, which are named according to their default 
orientation with respect to the volume axis: XY, YZ, XZ.  All the parameters 
influencing a clipping plane can be found on the corresponding tab: 

. 
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When set, each plane is placed into the center of the volume and oriented in 
orthogonal fashion according to its name (XY, XZ, YZ). 

Clipping 

 Clip mode: Here you can select between 4 clipping modes: 

• None: Plane has no clipping function. 

• Back: Plane cuts away the background. 

• Front: Plane cuts away the foreground. 

• Both: Plane cuts away both fore- and background. This mode is 
similar to the check box Hide Volume on the right side bar of the 
render window. 

 : Here you can choose which channel should be clipped. 
Simply disable the channel you do not want to clip by clicking on the 

appropriate channel button:   channel 1 and 3 will be 
clipped, channel 2 not. This function is only available for the modes 
Surface and Mixed. 

 : This check box is available for the modes 
Surface, Maximum and Mixed. This option clips all transparently rendered 
channels in a global fashion. For technical reasons it is not possible to 
correctly clip transparent volumes in a channel specific manner. 

Plane Parameters 

 Draw Mode: From this drop down box one of 6 options can be selected, 
which influence the way, the clipping plane is drawn: 

• None: plane is transparent 
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• Colored: clipping plane is colored in a semitransparent fashion with a 
green hue 

• Binary: Gray levels above the defined threshold, which are touched 
by the plane are displayed binary white, black pixels are opaque 

• Transparent (linear): Data, which are touched by the plane, are 
displayed as in the render mode Transparent but in a two-
dimensional projection. The ramp for the transparency in this case is 
always linear. Black pixels are transparent. 

• Transparent (with settings): Data, which are touched by the plane, 
are displayed as in the render mode Transparent but in a two-
dimensional projection. The ramp for the transparency is as defined 
on the Data property page. Black pixels are transparent. 

• Opaque: as with Transparent (with settings) but in this case black 
Pixels are non-transparent, rendered volume data in the background 
do not shine through.  

 : draws a green frame outlining the plane. Especially 
useful, it plane is in draw mode None. 

 : With this button the plane can be 
reset to its default orientation 

 Horizontal: allows the rotation of the clipping plane along the horizontal 
volume axis (oblique orientation) 

 Axial: allows defining an oblique orientation of the plane along the z-axis 
of the volume. 

 Position: shifts the plan along the planes perpendicular. 
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Sometimes the display of three-dimensional structures on a two dimensional 
display can be difficult. In this case it can be helpful to display volumes as 
Anaglyphs. The volume is separated into two separate views which are 
calculated as if viewed through two different cameras. Both cameras are 
positioned in a defined distance from each other. Each view is colored 
differently (red and green) so that when viewed through red-green glasses, a 
3 dimensional impression is created for the observer. 

The Stereo view can be invoked for all graphic card accelerated rendering 
modes (Transparency, Surface, Maximum and Mixed). 

Stereo 

 Stereo Mode: enables (Anaglyph Stereo) or disables (None) the stereo 
mode. 

 Channel: The drop down box contains the options Both, Left and Right. 
Only in Both is the analglyph stereo effect visible. The other modes each 
turn off the other channel. 

 Camera: Defines the distance of both cameras from each other (Units in 
meters). 

 Parallax Shift: Determines the degree of shift which is necessary to 
correlate both camera views. The slider should be adjusted to maximize 
the stereo effect. Please note, that this setting will be different for each 
observer. 

péÉÅá~ä=éêçéÉêíó=é~ÖÉ=

 : If checked, illuminates the inside of a surface 
rendered volume. If unchecked, the inside is dark. If one views the inside 
of a volume by flying or zooming into it, the inside illumination is helpful. 
This option is only available for the Surface mode. 
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 : with activated Inner surface lighting, 
this checkbox colors the inside lighting with a bluish hue. This makes 
distinguishing inside from outside easier. This option is only available for 
the Surface mode. 

 : This option specifies to render plain 
surfaces. If this option is not activated these surfaces look like „windows“ 
you can look through into the rendered volume. 

 : This option allows transparency to 
be assigned to surface rendered volumes in a channel specific manner. If 
checked, the slider Transparency will be available on the Data property 
page. This option is only available for the Surface mode if the method 
Maximum Detail is chosen on the View property page. Please be aware, 
that with multichannel volumens the transparency effect depends on the 
order in which the channels are rendered. This technical limitation does 
not always lead to satisfactory results. 

  If checked, this option displays the merge 
image including all channels of a multichannel volume in 3D-Gallery 
View. This option is only available for the Surface mode. 

 Texture-Switch: This parameter influences the volume angle, upon 
which the next set of 2D-Textures will be loaded into the graphics card 
(value range 1-100 degree). Depending on the object orientation, the 
number of z-slices and the chosen render settings this loading process can 
be visible and may be disturbing especially when rendering a series for 
movie export. Changing this angle can postpone or even avoid this switch 
during a series rendering. This Option is only available for Transparency 
and Maximum modes.  

 : Influences the fly speed (value range 0.0001 – 0.9999) when 
flying through a volume. 

 Mouse Sensit.: Influences the mouse sensitivity (value range 1-720). 
Small values make the mouse actions precise but slow, large values less 
precise but faster. 
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 VRML Export: This button opens a standard Microsoft Windows dialog 
to save a surface mode in the VRML file format. VRML (Virtual Reality 
Markup Language) is a standard file format for representing 3D graphics. 
It has been designed particularly with the world wide web (WWW) in 
mind. VRML files are commonly called “worlds” and have the *.wrl file 
extension. To open and view these files a suitable Web Browser with a 
VRML PlugIn is required. 
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NMKP aÉÅçåîçäìíáçå=

A prerequisite for 2D deconvolution is a 2-dimensional image with 8-16 bit 
gray levels. All functions that are not necessary for 2D deconvolution are 
inactive. 

A prerequisite for 3D deconvolution is an 8-16 bit gray level image in the form 
of a z-stack. To acquire a z-stack using AxioVision, the optional Z-stack 
module is required. If you wish to acquire z-stacks in several fluorescence 
channels, you will also require the Multichannel Fluorescence module. 

The following processing methods can be used for the relevant image types in 
deconvolution: 

Frame rate 2D Deconvolution 3D Deconvolution 

NN  NN x 
RIF x RIF x 
FIT x FIT x 

2D Fluorescence 

CIT x CIT x 
   

NN  NN x 
RIF x RIF x 
FIT x FIT x 

Z-Stack Fluores-
cence 

CIT x CIT x 
   

NN  NN  
RIF  RIF x 
FIT  FIT  

3D ApoTome SIM 

CIT  CIT  
 
NN: Nearest Neighbor 
RIF: Regularized Inverse Filter 
FIT: Fast Iterativ 
CIT: Constrained Iterativ 
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 Load a suitable image. On the Product DVD, you will find the image 
"FluoCells_DCV-Teststack.zvi" in the folder Demo Images and 
Scripts\AxioVision Images. This is a 3-channel z-stack image, and is a good 
image to use here. 

 In the work area, switch to the Deconvolution entry. 

  

 This opens the Deconvolution property page. First of all, deactivate the 
CreateNew function. This setting ensures that only one resulting image is 
generated, and that the input image remains selected. This allows you to 
change parameters as often as you like, without a new resulting image 
being generated each time. 

  

 If the desired image was in the foreground when Deconvolution was 
selected, it is now loaded as the input image. Otherwise load it by clicking 

on the  button and selecting the image in the gallery: 
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 The name of the resulting image can be changed. We recommend that 
you include in this an indication of the method used: 

. 

 The Regularized Inverse Filter method is already selected. 

 In the Channel specific settings section, you can enter settings that may 
differ from channel to channel, e.g. the desired reconstruction strength. 
For the second channel (green), select a manual strength setting: 

  

 Leave the other channels on the automatic strength setting. 

 Leave the AutoLinear setting for normalization. 

 Define a sub-region using the Select ROI menu command: 
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 In the image, define a small region to which you want deconvolution to 
be applied: 

  

 Start the procedure by clicking on . Follow the display in the job 
list: 
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The resulting image should now look like this: 

  

The first channel is displayed, and you can see the effect of the inverse 
filter applied to the ROI. 

 Adjust the slider for Z until you arrive more or less at the center of the z-

stack . You should now see an image 
that looks something like this: 
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The bright regions in the acting structure of the fluocell sample appear 
over-saturated. This is the effect of automatic normalization. To compensate 

for this, open the Properties window using the  button in the image 
window’s display field (or Alt+Enter). 

In the image histogram, you can now see that the setting of the display 
characteristic curve is still the same as it was for the original image: 

  

As the 16-bit dynamic range (= 65536 gray levels) is now being used in full, 
the display characteristic curve needs to be adapted to the new data range. 

 To do this, click on the  button. The value in the input field 

underneath this button should then be one per thousand: . 
The display characteristic curve is now set in such a way that 0.1% of the 
brightest pixels in the image are shown as completely white, and 0.1% of 
the dark pixels in the image as completely black. These settings only 
influence the display on the monitor, not the pixel values in your image. 
The histogram should now look something like this: 
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 The contrast setting of the image is now more or less correct. This means 
that you are able to properly assess the image components that have 
been enhanced using deconvolution: 

  

 Repeat these steps for channels 2 and 3 until a good, high-contrast image 

is also visible in superimposed color mode (  button). 

 The orthogonal slice view is particularly useful for assessing the result. 
Switch to the slice view by clicking on the Cut View tab 

. Position the slice lines in the 
deconvoluted region (for example): 
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 You can now clearly see the effect of the contrast enhancement. In 
particular, the separation of the green channel (which represents the cell 
nuclei of the intestinal cells in the fluocell sample) from the red actin 
elements is only clearly visible after deconvolution. 

You can now experiment with the various parameters and deconvolution 
methods. Provided you do not make any changes to the name of the resulting 
image, the resulting images are overwritten every time you click on the 

 button. This procedure also enables you to display various 
deconvolution methods simultaneously, in a single resulting image, by moving 
the ROI (region of interest) in the input image after selecting a different 
method. 
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Save the desired resulting image. These images are ideal for use with the 3D 
rendering module Inside4D. 
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NMKQ táÇÉÑáÉäÇ=jìäíáÅÜ~ååÉä=råãáñáåÖ=

_~ÅâÖêçìåÇ=

Widefield Multichannel Unmixing is a new function for the removal of 
crosstalk between fluorescent dyes in multichannel images with up to eight 
fluorescence channels using a traditional epifluorescence microscope. 
Crosstalk is a phenomenon which occurs, whenever dyes are excited by 
excitation light of more than one filter combination. This problem occurs for 
example, when dyes with broadly overlapping excitation spectra are used 
concurrently in one sample. Good examples are the spectral variants of 
fluorescent proteins, e.g. BFP, CFP, GFP and YFP. With traditional reflector 
filter sets it has been often difficult to achieve 100% signal separation for 
such dyes. 

In essence this means, that a certain proportion of a signal in one channel is 
actually derived from another dye spilling over into the channel. 

A parameter based separation is now available with the Widefield 
Multichannel Unmixing module. The procedure is separated into three 
steps: 

 Measurement of the amount of crosstalk in 2 alternative procedures: 

With appropriate reference samples 
by automatic component extraction (ACE) from the sample to be unmixed 

 Creation of the unmixing matrix file. 

 Unmixing of the image to be corrected by means of using the unmixing 
matrix file generated in step 2. 
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Note: 
• Non-fluorescent channels such as DIC or Phase contrast are automatically 

detected and disregarded by all unmixing functions. Such channels are 
automatically copied into the unmixed result images to facilitate merged 
views with fluorescent channels. 

• The module Widefield Multichannel Unmixing is designed to work with 
images created using the AxioVision Multichannel Fluorescence module. 
For the creation of correct reference images the use of the AxioVision 
Multichannel module is required. 

• The images used in these examples you will find on the Product DVD in 
the folder Demo Images and Scripts\AxioVision Images. 

qÜÉ=mêáåÅáéäÉ=çÑ=ìåãáñáåÖ=

The following example tries to demonstrate the problem of cross talk as well 
as show the potential of unmixing such images. In this case, determination of 
cross talk is done using reference samples and not ACE. 

Reference sample A (CFP-Reference1.zvi): HeLa cells containing a virus 
proteins coupled to cyan fluorescent protein (CFP). This protein accumulates 
especially in the nucleolar regions of the cell nucleus. 

Reference sample B (GFP-Reference1.zvi): HeLa cells containing a virus 
proteins coupled to green fluorescent protein (GFP). This protein accumulates 
in the nucleolar regions of the cell nucleus too. 

Sample C: (RevCFP-H2-GFP_3.zvi): HeLa cells containing two proteins with 
different fluorescence: coupled to CFP is the same viral protein as in reference 
sample A (nucleoli); coupled to GFP is a histone protein, which stains the 
chromosomes and thus the entire nucleus a lesser degree of staining of the 
nucleoli. 
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Sample Channel 1(CFP) Channel 2 (GFP) 

A. Reference sample 
CFP only: 

A small degree of 
crosstalk is visible in 
channel 2 coming from 
channel 1. 

Image histogram: 

x-axis: pixel gray values. 
y-axis: relative number 
of pixels in logarithmic 
scale; identical settings 
of the display curve. 

 

B. Reference sample 
GFP only: 

A moderate degree of 
cross talk from channel 
2 is visible in channel 1. 

Image histogram: 

x-axis: pixel gray values. 
y-axis: relative number 
of pixels in logarithmic 
scale; identical settings 
of the display curve. 

10-86 M 60-3-0024 e / printed 06.2010 



Modules  - Widefield Multichannel Unmixing 

AxioVision User's Guide, Release 4.8.2 10-87 

Sample Channel 1(CFP) Channel 2 (GFP) 

C. 2-channel 
fluorescence sample 
(CFP and GFP): 

Before Unmixing: 

How much signal from 
channel 2 is visible in 
channel 1 (cross talk) 
and vice versa? 

Image histogram: 

x-axis: pixel gray values. 
y-axis: relative number 
of pixels in logarithmic 
scale; identical settings 
of the display curve. 

 

 

D. 2-channel 
fluorescence sample 
(CFP and GFP): 

After Unmixing: 

A net percentage of 
pixel intensity  values 
from channel 2 are 
added to the signal in 
channel 1. 

Image histogram: 

x-axis: pixel gray values. 
y-axis: relative number 
of pixels in logarithmic 
scale; identical settings 
of the display curve. 
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 CFP&GFP-sample 
original 
pseudocolor mode 

CFP&GFP-sample 
unmixed 
pseudocolor mode 

E. 2-channel 
fluorescence sample 
(CFP and GFP): 

Comparison 
"before" and 
"after" unmixing: 
shows a markedly 
improved signal 
separation (shown 
at identical display 
settings. 
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qÜÉ=táÇÉÑáÉäÇ=jìäíáÅÜ~ååÉä=råãáñáåÖ=ÑìåÅíáçå=

The Widefield Multichannel Unmixing function is the central function for 
unmixing samples: 

  

Using the function dialog, you can select whether the unmixing should take 
place via “automatic component extraction” (left-hand image) or using a 
reference matrix (right-hand image). If you choose unmixing using a reference 
matrix, you will need a reference matrix file containing the corresponding 
information for the unmixing. 
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If such a file does not yet exist, you can start a wizard via the 

 button, which will lead you through 
the process of generating a reference matrix file. 

 
tçêâáåÖ=ïáíÜ=íÜÉ=Ä~ëáÅ=ÑìåÅíáçåë=

The basic functions in the menu Processing ⇒ Widefield Multichannel 
Unmixing are the functions for unmixing that will already be familiar to you 
from the previous version of AxioVision. These functions are still available, for 
compatibility reasons and for use in Commander scripts. The following two 
examples describe how you can use these functions for unmixing. 

råãáñáåÖ=ïáíÜ=êÉÑÉêÉåÅÉ=ë~ãéäÉë=

This example shows you how to measure cross talk using reference samples 
and use this information to unmix a 2 channel fluorescence image. 

The same images are used as in example 1. 

 Open the first reference image 
"CFP-Reference1.zvi". 
It is a 3 channel image. The 
first channel contains 
transmitted light information 
(DIC). 
The CFP signal is visible 
strongest in channel 2 (Zeiss 
filter set #47). Change into 

b/w mode ( ) and 

channel . 
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 Open the properties dialog 
(menu View ⇒ Properties) 
and adjust the display line in a 
way to enhance the gray value 
visibility (e.g. Best Fit: Gamma 
value ~ 0.25).  
Now it is easier to distinguish 
true image background from 
signal derived from the 
fluorescent dye. 

 

 In the workarea select Image 
Processing/Widefield 
Multichannel Unmixing and 
then Reference 
measurement. 

 

 The image "CFP-
Reference1.zvi" is selected 
automatically as Input image 
because it the active image in 
the foreground.  

 

 If it is not selected, select the image from the pop up gallery. 
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 In the edit field 

 click 

on the  button. 

 Select a suitable region in the 
image for background 
correction (ideally without any 
signal coming from the dye). 
The pixel coordinates (x/y) as 
well as the gray value of the 
selected pixel are shown. If a 
scaling is available, the stage 
coordinates are shown. 

 Click at an suitable position 
once in the image. The x and y 
coordinates are shown in the 
input field. 

 Click the  button in the 
input field 

. 

 Search for a suitable region in 
the image for measurement. 
Ideally search for a region with 
an intensity as high as 
possible. 
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 Click the   button to 
carry out measurement. 

 The regions taken for 
measurement are shown in the 
image. Save the image, 
because it’s used later for 
generation of the unmixing 
matrix. 

 

 

 Open the second reference 
image GFP-Reference1.zvi. 
The third channel contains the 
GFP fluorescence (fluorescence 
filter set # 44). 

 Repeat the corresponding 
steps also for this image. 

 

 In the workarea select the 
function Create Unmixing 
Matrix from the function 
group Image 
Processing/Widefield 
Multichannel Unmixing.  
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 10. Select the input images 
accordingly: CFP-Reference1 as 
ReferenceImage1, GFP-
Reference1.zvi as 
ReferenceImage2. Please 
take care to enter channels 
and reference images in the 
same order. If you use images 
with more than two channels, 
the function is extended 
accordingly. 

 To define a name for the 
unmixing matrix file, click the 

 button in the input field 

. In the following 
dialog you can enter a name 
for the matrix file. 

 Click the  button 
to accept the filename.  

 Click the  button to 
generate the unmixing matrix 
file. The file is saved – like 
other AxioVision files – in the 
user folder. 

 In the workarea select the 
function Unmix Multichannel 
Image from the Image 
Processing/Widefield 
Multichannel Unmixing 
function group. 
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 Open the image to unmix and 
select it as Input image. In this 
example, the image "RevCFP-
H2-GFP_3.zvi" is used.   

 Switch to the black and white 

view ( ) and activate 

channel 2 ( ). 

 Right click in the image and 
select Properties. Set the 
display characteristic line in 
such a way, that the gray 
values are displayed extremely 
amplified. So you can easily 
detect, where the background 
is not caused by the sample 
fluorescence. 

 Switch to channel 3  and 
repeat the setting of the 
display characteristic line like in 
previous step. 
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 Switch back to the color view 
and switch off channel 1 

. 

 Now you can separate the two 
fluorescence colors clearly 
from the background signal. 

 Click the  button in the 
input field 

. In 
the image search for a suitable 
region for the background 
measurement (preferably 
without a signal caused by the 
fluorescence dye).  

 The pixel coordinates (x/y) as 
well as the gray value of the 
selected pixel and stage 
positions are shown. Click at a 
suitable position once in the 
image. The x and y coordinates 
are shown in the input field. 

 Enter a name for the Output 
image. 
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 Click the  button in the 

input field  to select 
the unmixing matrix file. Click 

the  button to 
load the file. The dialog is 
closed. 

 

 Click the  button to 
start the unmixing. The result 
image shows a clear separation 
of the fluorescence channels 2 
(CFP) and 3 (GFP). Channel 1 
without fluorescence (DIC) is 
copied to the output images 
unchanged.  

 

 To optimize the display, you 
should set the display 
characteristic line for channel 2 
and 3 accordingly: 
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 Save the output image. 

 
råãáñáåÖ=çÑ=~=ãìäíáÅÜ~ååÉä=áã~ÖÉ=ìëáåÖ=^`b=

This example shows you how to measure cross talk directly an image for 
unmixing with Automatic Component Extraction (ACE) and how to use it for 
unmixing of samples. 

The same images are used as in example 1. 

 Open the image to unmix. In 
this example the image 
"RevCFP-H2-GFP_3.zvi" is 
used. 
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 Switch to the black and white 

view ( ) and activate 

channel 2 ( ). Right click in 
the image and select 
Properties. Set the display 
characteristic line in such a 
way, that the gray values are 
displayed extremely amplified. 
So you can easily detect, 
where the background is not 
caused by the sample. 

 

 Switch to channel 3  and 
repeat the setting of the 
display characteristic line like in 
previous step. 

 

 Switch back to the color view 
and switch off channel 1 

. 

 Now you can separate the two 
fluorescence colors clearly 
from the background signal. 
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 In the workarea select the 
function Automatic 
Component Extraction from 
the Image Processing/Widefield 
Multichannel Unmixing 
function group.  

 The reference image "RevCFP-
H2-GFP_3.zvi" is selected 
automatically as Input image 
because it the active image in 
the foreground. 

 If it is not selected, select the image from the pop up gallery. 

 Click the  button in the 
input field 

. In 
the image search for a suitable 
region for the background 
measurement (preferably 
without a signal caused by the 
fluorescence dye). The pixel 
coordinates (x/y) as well as the 
gray value and the stage 
position of the selected pixel 
are shown. 

 Click at an suitable position once in the image. The x coordinate is 
shown in the input field. 

 The predefined threshold in the input field Threshold can be used 

unchanged . For further information 
about this parameter, please read in the online help. 
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 To define a name for the 
unmixing matrix file, click the 

 button in the input field 

. In the following 
dialog you can enter a name 
for the matrix file. Click the 

 button to accept 
the filename.  

 Click the  button to 
generate the unmixing matrix 
file. The file is saved – like 
other AxioVision files – in the 
user folder. 

 The measurement regions 
defined by ACE are drawn to 
the image using the channel 
color.  

 Switch to the black and white 

view ( ) and activate 
the accordant channel. 

Channel 2:  

Channel 3:  

 In the workarea select the 
function Unmix Multichannel 
Image from the Image 
Processing/Widefield 
Multichannel Unmixing 
function group.  
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 Open the image to unmix and 
select it as Input image. In this 
example, the image "RevCFP-
H2-GFP_3.zvi" is used. 

 Now repeat the background 
measurement: 

 Click the  button in the 
input field 

 and 
then click in a background 
region. 

 Enter a name for the Output 
image. 

 Click the  button in the 

input field  to select 
the unmixing matrix file. 

Click the  button 
to load the file. The dialog is 
closed. 
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 Click the  button to 
start the unmixing. The result 
image shows a clear separation 
of the fluorescence channels 2 
(CFP) and 3 (GFP). Channel 1 
without fluorescence (DIC) is 
copied to the output images 
unchanged. 

 

 To optimize the display, you 
should set the display 
characteristic line for channel 2 
and 3 accordingly: 

 

 Save the output image.  
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_~ÅâÖêçìåÇ=

The acquisition of fluorescence images in several channels makes it possible to 
visualize the relationship between biological structures. Displaying two 
channels together in color merge mode makes it easier to establish whether 
the components are "colocalized", i.e. are occupying the same position in 
space. 

The classic display is the color-coded overlaying of two fluorescence channels. 
The most common form is red/green overlaying. Regions in which both 
fluorescent dyes occupy the same position in space are therefore shown as 
yellow. However, it is not possible to use this display as a basis for quantitative 
statements about the extent of colocalization. At best, a qualitative statement 
can be made on whether or not two dyes are colocalizing. The 
Colocalization module can fill this gap and provides you with a tool that 
enables you to determine colocalization quantitatively. 

Principle: 
• The colocalization of two channels is always analyzed. For images with 

more than 2 channels, the user is required to make a selection. 
Colocalization results from the pixel-by-pixel comparison of intensities per 
channel. 

`çåíêçä=ÉäÉãÉåíë=

The colocalization display consists of three elements: the scatter plot, the 
image (2 channels are shown) and the table of measurement values. On the 
right-hand side of the display is a control field for the colocalization settings. 
The colocalization display can be activated in the View ⇒ Views ⇒ 
Colocalization menu or by clicking on the Colocalization button at the 
bottom edge of the image. 
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oÉÖáçåå=pÉäÉÅí=

: Using these buttons you can select 
up to 32 regions in the input image or the scatter plot. Five different forms 
can be used by clicking on the buttons: contour, circle, ellipse, rectangle, 
contour (spline). If you hold the button down, the form of the mouse pointer 
changes to the drawing symbol. Once you have finished drawing, the mouse 
pointer changes back to the original arrow symbol and the button is no longer 
shown as depressed. 

Once a region has been drawn, it is automatically treated as an active region. 
The scatter plot shows the pixel-value frequencies of these regions. The 
colocalization table shows the data for the entire image and for the selected 
region. If you wish to select several regions, you can do so by holding down 
the Shift key and clicking on the regions in question. You can also deselect 
them in the same way. 

Note: 
• The regions are only visible in the Colocalization view and are not 

adopted if you switch to a different type of display. 

`Ü~ååÉä=pÉäÉÅí=

: Here you can select the two 
channels that you want to view. 

In the drop-down list boxes on the right you can set a gray value range for 
each channel. This allows you to make optimum use of the available gray 
value range. You can have the range set automatically, choose between 
predefined fixed values or enter a value of your choice interactively. The 
scaling of the scatter plot is adapted according to the selection you make. 
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: In these list boxes you can set the 
threshold value for both channels in accordance with the graphic below. 

 

 : This button becomes active as soon as a region is inserted into 
the scatter plot. It remains active as long as regions are being selected or 
moved there. By activating and deactivating this button, you can switch 
between the selection of threshold values using the mouse and the 
selection/shifting of selected regions in the scatter plot image. If regions 
have been defined in the scatter plot, the corresponding data appear in 
the table, in addition to the entire image. 

10-106 M 60-3-0024 e / printed 06.2010 



Modules  - Colocalization 

j~ëâ=

: Using these buttons you can mask 
the four quadrants described in the Threshold section and assign user-
defined colors to the channels of the original image (Ch1 and Ch2). The same 
process can also be carried out for the colocalized pixels (Coloc) and the 
background (BG). The color selection menu is opened by right-clicking with 
the mouse. 

 : This button becomes active as soon as a quadrant has been 
masked. If you press the button by clicking on it with the mouse, a new 
image containing exclusively the masked pixels is created. 

: Using these buttons you can select 
the scatter plot and/or the value table for the image currently being displayed 
and edited for saving in a separate file. This enables you, for example, to edit 
the data in another program (e.g. Microsoft Excel). 

 
dê~éÜáÅ~ä=aáëéä~ó=

The Scatter Plot is a graphical display of the pixel-value frequencies of 
channels 1 and 2. These frequencies are shown using a rainbow lookup table 
(units between 0 and 255). Channel 1 is distributed along the x-axis and 
channel 2 along the y-axis. The threshold value can be changed directly in the 
graphic by left-clicking with the mouse. It is also possible to move the 
threshold value lines interactively using the mouse. 
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The Colocalization table contains 17 columns. These are used to present the 
following details and calculations: 

1. Image Region: When a region has been selected, it is assigned a 
number. This number appears in the image and the table. Data from the 
scatter plot can either relate to the entire plot or to the selected region. 
For this reason no numbering for the selected region appears here in the 
data table.  

2. Scatter Quadrant: As described under the Threshold field, the scatter 
plot display is divided into four quadrants, which are numbered 1,2,3 and 
4. These numbers correspond to channel 1, channel 2, colocalization and 
background. All data can be obtained individually for these four 
quadrants. In addition, the threshold value set in the scatter plot is 
displayed for each channel. 

3. Number of Pixels: Shows the total number of pixels in each quadrant. 
The sum of all the pixels in this column for all 4 quadrants corresponds to 
the product of the height and width of the original image. 

4. Area (µm²):  
Area = number of pixels x X-scale x Y-scale 
If no scaling is available for the original image, the following applies: 
1 pixel = 1 µm. 

5. Relative Area (%):  
Relative area = area of quadrant x / total area 
x = 1, 2, 3, 4; total area = area of quadrant 1 + area of quadrant 2 + area 
of quadrant 3 + area of quadrant 4. 

6. Mean Intensity Channel 1: The sum of all the gray values of channel 1 
divided by the total number of pixels in this channel. 

1lAreaChanne
1ChannelGrayValues∑
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7. Mean Intensity Channel 2: 

2lAreaChanne
2ChannelGrayValue∑

 

8. Standard Deviation Channel 1: 

11lAreaChanne
)1ityChannelMeanIntens1ChannelGrayValues( 2

−

−∑
 

9. Standard Deviation Channel 2: 

12lAreaChanne
)2ityChannelMeanIntens2hannelGrayValueC( 2

−

−∑
 

10. Colocalization Coefficient Channel 1: This coefficient indicates the 
relative number of colocalized pixels in channel 1 or 2 in relation to the 
total number of pixels above the threshold value: 

∑
∑

total,

dcolocalize,

1ChannelPixels
1ChannelPixels

 

The values vary between 0 and 1, where 0 indicates no colocalization and 
1 complete colocalization. 
Numerator = number of pixels in quadrant 3 
Denominator = number of pixels in quadrant 3 + number of pixels in 
quadrant 1 
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11. Colocalization Coefficient Channel 2: 

∑
∑

total,

dcolocalize,

2ChannelPixels
2ChannelPixels

 

Numerator = number of pixels in quadrant 3 
Denominator = number of pixels in quadrant 3 + number of pixels in 
quadrant 2 

12. Weighted Colocalization Coefficient Channel 1 (Pearson): 
Provides information on the intensity distribution within the colocalization 
region. 
Value range: -1 to 1. 

1: All pixels lie in a straight line in the scatter plot (if you have used the 
same channel twice for colocalization, you will obtain the value 1 in this 
column). 
0: The pixels in the scatter plot are distributed in the form of a cloud with 
no preferred direction. 

∑∑
∑

−×−

−×−
22 )2MVC2GVC()1MVC1CGV(

))2MVC2GVC()1MVC1GVC((
 

GV: gray value; MV: mean value; C: channel 

13. Overlap Colocalization Coefficient (Manders): 
Insensitive to differences in signal intensity between the two channels and 
to bleaching. 
Value range: 0 to 1 

∑∑
∑

×

×
22 2GrayValueC1GrayValueC

2GrayValueC1GrayValueC
 

C: channel 
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14. Index Z: Indicates the z-index for z-stack images. 

15. Index T: Indicates the time index for time lapse images. 

16. Acquisition Time: Indicates the time of acquisition for all dimensions of a 
multidimensional image. 

17. Focus Position: Indicates the focus position at which an image was 
acquired. 
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The Interactive Measurement module builds on the standard image analysis 
functions in the basic program. It offers the following two additional features: 

 A clearly extended list of measurement parameters: besides the standard 
parameters there are, among other things, several tools for distance 
measurement and multiple distance measurement, two additional options 
for cyclometry (including clicking on contour points), and much more 
besides. 

 The possibility for generating measurement programs for interactive 
measurements. 

Notes: 
• For general background information and basic details on how to operate 

the measurement function, please read through chapter 6 "Image 
Analysis" first. 

• A complete list, plus a description, of all measurement parameters can be 
found in the online help. 

tçêâáåÖ=ïáíÜ=áåíÉê~ÅíáîÉ=jÉ~ëìêÉãÉåí=mêçÖê~ãë==

Measurement programs allow you to put together parameters of your choice, 
which the user must then run through in the defined sequence. This creates a 
kind of electronic work instruction that ensures that a measurement sequence 
is run through properly and completely. The programs can be saved so that 
they can be used in routine operation. 

Working with interactive measurement programs usually involves two steps: 
1. loading and 2. executing a measurement program. However, before a 
measurement program can be used for routine measurements, it must first be 
configured. 
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Note: 
• Further explanations on all the functions described can be found in the 

online help. 

dÉåÉê~íáåÖ=ãÉ~ëìêÉãÉåí=éêçÖê~ãë=

Using the Measure ⇒ Interactive Measurement Programs ⇒ Define 
function, you can load and modify existing measurement programs or 
generate new ones. 

 

Generating measurement programs: selecting measurement tools and 
parameters 

The Interactive Measurement Programs⇒ Define function is also suitable 
for loading measurement programs, as the relevant program is also visible 
here. There is an independent function for loading a program. This is 
particularly useful for automatic execution within a Commander script. 
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In order to execute an existing measurement program, it must first be 
"loaded". This means that one program is selected from a list of existing 
measurement programs.  This program then becomes active. When the 
execution function is started, the program that is currently active is always the 
one that is used. 

To load a measurement program, please select the Measure ⇒ Interactive 
Measurement Programs ⇒ Load function: 

 

Loading a measurement program 
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The desired program can be selected from a list of existing programs. You can 
also use the Measure ⇒ Interactive Measurement Programs ⇒ Define 
function to load a measurement program. The advantage of this is that a 
loaded program is also displayed in this function. However, if a measurement 
program is to be automatically loaded and executed within the context of a 
Commander script, the function for generating programs is not suitable. 

When the measurement program has been loaded, you can start it via the 
Measure ⇒ Interactive Measurement Programs ⇒ Run function: 

 

Executing a measurement program 
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The process of measuring interesting objects in an image automatically is 
closely linked to the rapid development of the hardware sector. Without this 
development it would take a huge amount of time to perform these 
measurements (which can involve several hundred images in some cases). 

Thanks to the performance of modern PCs, it is now possible to use 
increasingly complex functions for image analysis, and to perform an 
automatic evaluation. 

The term automatic measurement is understood to mean, in particular, the 
automatic recognition of interesting objects. In contrast to interactive 
measurement, it is no longer necessary to use the mouse to outline the 
objects to be measured in the image. The objects can be recognized 
automatically on the basis of their brightness and/or color and other 
descriptive parameters (shape, size etc.). 

An automatic measurement usually consists of the six steps briefly listed 
below. These steps represent the general sequence of an image analysis 
procedure. They are in no way specific to AxioVision, and should always be 
carried out in this or a similar form. 

1. Image acquisition 

Image acquisition is – besides segmentation – the most important step within 
image analysis. It is only during image acquisition that you have all the original 
data available. Image information that is poor or, worst of all, incorrect 
prevents you from achieving accurate measurement results. This can even lead 
to a situation in which a sample that should be simple to measure from an 
image analysis perspective is no longer analyzable, as the system can no 
longer recognize the objects to be measured. In such cases you have to revert 
to interactive measurement. 
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Information that is not acquired during image acquisition is very difficult to 
reconstruct during image enhancement. In many cases this is not possible at 
all. You must therefore take advantage of all of the technical possibilities 
offered by your microscope and camera during the preparation of the sample. 

Often there is room for improvement with regard to sample preparation. You 
need to be self-critical, and check whether the quality of your samples could 
be improved. 

2. Image enhancement 

In general terms, it is possible to distinguish between two different application 
situations: 

The optical enhancement of an image helps the user to correctly interpret 
the accuracy of the solution suggested by the measurement system. This 
includes enhancement of the brightness and contrast, and also gamma 
correction. Enhancing the quality of the image from an optical perspective, 
however, has no influence on the quality of the recognition results. 

Functions to enhance recognition performance (segmentation) allow you 
under certain circumstances, that images can be measured automatically even 
when the image quality would lead you to assume otherwise. These functions 
include, for example, the elimination of illumination errors (shading 
correction). 

3. Segmentation 

Segmentation is the key to a correctly functioning automatic measurement. 
This process involves having the interesting objects determined automatically 
by the measurement system, and separated from the regions that are not to 
be measured (the image background). Initially this takes place on the basis of 
brightness or color information. Reference objects are outlined or highlighted 
in the image using the mouse. AxioVision then recognizes all other objects 
independently. It is also possible to directly select the thresholds for the 
brightness or color ranges that represent the objects using the distribution of 
the brightness or color information (histograms). However, this requires a 
certain amount of experience. 
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The result of segmentation is a "measurement mask", which is represented 
internally by a so-called binary image. This mask conceals the background 
regions using black pixels, and shows the objects to be measured as white. 
You will only come into contact with this measurement mask indirectly. 
AxioVision shows it as a color image superimposed over the original image. 

4. Processing the measurement mask 

A measurement cannot be performed until the objects to be measured, and 
only those objects, have been correctly recognized. Sometimes, however, this 
is not possible. Artifacts that you do not want to measure may also be 
acquired, or objects may be touching and may not therefore be recognized as 
individual objects by the system. These must then be separated before 
proceeding. 

Typical processing steps therefore involve the deletion of artifacts, the filling 
of gaps in objects and the automatic separation of objects. In difficult cases, 
subsequent interactive processing (deletion, separation, additional drawing in 
of objects etc.) may also be required.  

5. Measurement 

During the measurement, the selected parameters are determined by 
AxioVision and saved in a results file. Two types of file are distinguished: files 
for so-called region specific and field specific image data. 

 Region specific image data are measurement parameters that are 
determined for every individual object (an image region). These are, for 
example, the area, circumference and shape of the object in question, or 
even its densitometric values, such as the average gray value. The 
measurement results are written within the results file in the form of one 
line per region or object. 

 Field specific data are measurement parameters that are determined for 
the entire image field. These are, for example, the number of objects, or 
the percentage of the entire image area represented by all the objects 
present, etc. Field-specific measurement results lead to one line per 
image in the results file. 

AxioVision User's Guide, Release 4.8.2 11-7 



Modules  - AutoMeasure 

6. Evaluation 

Before you can actually make a statement about the image using the data for 
the images or objects in which you are interested, this data needs to be 
evaluated. As a wide range of special evaluation programs, such as Microsoft 
Excel, are now available, AxioVision itself does not feature any evaluation 
functions. The data are made available in Excel format, and can therefore be 
evaluated in the environment you are familiar with. 

In addition to the pure measurement data, image documentation should also 
always be used to make clear which objects were used to determine the 
measurement results. AxioVision gives you the option of displaying the 
objects, e.g. by outlining their contours, and the measurement results directly 
in the image. 

qÜÉ=ÅçåÅÉéí=çÑ=íÜÉ=^ìíçjÉ~ëìêÉ=ãçÇìäÉ=

The concept of the AutoMeasure module is based on Carl Zeiss’ many years of 
experience in the field of automated image analysis. It has become clear that 
in most cases only a small proportion of the range of available functions are 
actually required and employed. The aim was to arrange these functions in a 
way that was simple to operate and would also allow less experienced users 
to perform fast and accurate measurements. 

As with automated analyses you are usually not just measuring an individual 
image, but in some cases are analyzing a very large number of images, the 
interactive execution of individual steps via menu functions or a workflow is 
often not a realistic option. Nevertheless, with the AutoMeasure module you 
have the option of measuring “just” one image quickly and efficiently (further 
information on this will be provided later). 

The two points touched upon – "Complex technology, simply packaged" and 
"Analysis of large numbers of images" – are reflected by the structure of the 
AutoMeasure module. 
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The module therefore consists of two parts: 

 The Automatic Measurement Program Wizard allows you to generate 
automatic measurement programs quickly and simply. 

 The function for the Run Automatic Measurement Program allows 
you to execute a program you have generated for any number of images. 
It makes no difference whether these images are acquired via a camera or 
are already present as files. 

Notes: 
• At this point, we should emphasize that the AutoMeasure module is not 

suitable for resolving every conceivable measurement task. It is intended 
more as a tool to simplify your everyday tasks. 

• More complex applications are possible using the AutoMeasure Plus 
module. In this module the full range of image analysis functions are 
available via the AxioVision menus, and can be freely combined. You can 
therefore even realize exotic applications, although this requires the 
person generating the program (not the actual user of the program) to 
have some knowledge of the background to digital image analysis. 

qÜÉ=ïáò~êÇ=Ñçê=ÖÉåÉê~íáåÖ=ãÉ~ëìêÉãÉåí=éêçÖê~ãë=

The Automatic Measurement Program Wizard leads you step by step through 
the individual stages of digital image analysis (please also read the "General" 
section earlier in this chapter). 

 From the Product DVD (folder AxioVision Images\AutoMeasure) load the 
image "round.zvi". 

 Start the wizard in the menu Measure ⇒ Automatic Measurement 
Programs ⇒ Program Wizard. 

Further information on the individual steps, and the functions and functional 
parameters used, can be found in the online help by pressing the F1 key. 
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Program management gives you an overview of the measurement programs 
available, and a brief description on them individually: 

 

Program overview with brief description on the selected program 

Click on the New button and enter a name for your measurement program. It 
will be saved in the folder My Documents\Carl Zeiss\Data\Automatic 
Measurement Projects.  

Note: 
• The measurement programs are saved by default in the folder "My 

Documents\Carl Zeiss\Data\Automatic Measurement Projects". 
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For optical image enhancement, functions are available for brightness 
adjustment, contrast enhancement and gamma correction. 

 

Enhancement of brightness, contrast and gamma value 

To improve detection, images can be smoothed (Sigma filter), illumination 
errors corrected (Shading correction), and object edges sharpened 
(Delineation). 
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Segmentation is the most important function of the AutoMeasure module. 

 

Dialog for image segmentation 

Here you can separate the objects to be measured from the background 
simply by clicking on or outlining reference objects. Select whether you want 
individual objects only, or the entire image, to be segmented. 

With multidimensional images, you also have the option of performing 
segmentation separately for each channel of a multichannel fluorescence 
image. If two-dimensional gray level or color images are used, up to 32 
different phases can be defined (in place of channels). 
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To separate connected objects automatically, you can use the functions 
Erosion/Dilatation (for round objects) or Wasserscheiden (for objects with 
no distinct shape). The extent of the separation is set via the tolerance. 
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In most cases, the measurement mask generated during segmentation has to 
be processed subsequently to ensure that only the objects you actually want 
to measure are highlighted. With the interactive correction of the 
measurement mask you can draw-in separating lines, delete and add objects). 

 

Step for interactive correction of the measurement mask 

The functions for the automatic separation of touching objects 
(Erosion/Dilation, Watersheds) and for the subsequent interactive processing 
of the mask start with a function for eliminating artifacts and for filling gaps 
("cleaning" of the measurement mask). 
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The actual measurement procedure consists of several steps. These are used 
to define how the measurement should be carried out in detail. 

 
Definition of a measurement condition ("object filter”) 
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The individual steps 

 Determination of region-specific (individual objects) and field-specific 
(entire image) measurement parameters. 

 Definition of the way in which the measured objects should be 
highlighted in the resulting image at the end of the measurement 
(contour, measurement parameters etc.). 

 Generation of a measurement condition. This defines the conditions that 
an object must satisfy in order to be measured. This is a kind of "object 
filter", which can be used, for example, to specify that only objects within 
a certain size category should be counted. 

 Definition of a measurement frame, which is used to specify how objects 
that are cut off by the image edge, and are therefore likely to distort the 
measurement result, should be handled. 

11-16 M 60-3-0024 e / printed 06.2010 



Modules  - AutoMeasure 

bî~äì~íáçå=

In the final step, AxioVision shows you the image with the objects selected for 
measurement again. Here you can make any final changes, e.g. deleting 
individual objects by clicking on them. 

 

The measurement data are saved at the end of the measurement in so-called 
CSV format (Comma Separated Values). 

This is a pure text format that separates the individual values from one 
another using special text symbols. The specific country settings that have 
been set in the Microsoft Windows control panel apply. 

Files in CSV format offer two advantages: on the one hand, they are a special 
Microsoft Excel format, and can be opened and processed directly by that 
program. On the other hand, as the files contain pure text data, you can 
import the data into practically any other program. 
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Once measurement programs have been generated, they can be applied to 
any number of images for series analyses. To do this, start from the menu 
Measure ⇒ Automatic Measurement Programs the function Run 
Program. Further information can be found in the online help by pressing the 
F1 key. 

  

As the tables of measurement results are available at the end of the 
measurement wizard, the wizard can also be used to measure an individual 
image. A useful feature is that rather than a new measurement program 
being generated each time for this purpose, an "auxiliary program", which 
always has the same name (e.g. "individual image measurement"), is used. 
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While the AutoMeasure module has been designed primarily with ease of 
operation in mind (which naturally means that concessions have to be made 
in terms of flexibility), the AutoMeasure Plus module aims to offer unlimited 
possibilities for use. 

A certain amount of knowledge of the procedure used for image analysis 
measurements is required in order to use these functions. You should 
therefore make sure that you also read the "General" section under 12.2 
"AutoMeasure (Automatic Measurement)" as an introduction, before you 
start working with the individual functions of the AutoMeasure Plus module. 
There you will find important background information on the principal 
procedure used for measurements. 

qÜÉ=ÅçåÅÉéí=çÑ=íÜÉ=^ìíçjÉ~ëìêÉ=mäìë=ãçÇìäÉ=

To offer you as much flexibility as possible, all of the functions available within 
the context of measurements can be accessed individually via the Processing 
and Measure menus. By way of comparison, the respective functions in the 
AutoMeasure module can only be activated via the wizard. 

In general, there are two ways in which you can automate measurement 
procedures: 

The first step involves specifying the operations that you want to be 
performed during the actual measurement. This means that you need to 
define the measurement properties (see also the section “Working with the 
functions for automatic measurement”). In this step you need to answer 
questions including: 
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 Which parameters do I want to be measured? 
 How do I want objects that are no longer fully visible in the image to be 

handled? 
 Do I only want objects that satisfy special conditions to be measured (e.g. 

objects with an area between 50 and 100 µm²)? 

During the definition of these settings you are supported by a wizard. Once 
you have defined properties, it is then possible to save them for routine 
measurement and simply reload them as required. This also takes place via the 
wizard. A separate function allows you to test the measurement properties 
before performing the measurement. 

The second step simply involves performing the measurement on the basis of 
the properties you have defined. 

 In general, there are three ways in which you can automate measurement 
procedures: 

 Call up the individual functions via workflows or toolbars (see also section 
9.4 "Adapting the User Interface"). 

 Create scripts with the Commander modul (please read also Chapter 13.1 
"Commander"). 

 Generate applications via the VBA module (see also section 13.2 "VBA"). 

tçêâáåÖ=ïáíÜ=íÜÉ=ëÉÖãÉåí~íáçå=ÑìåÅíáçåë=

The individual steps in the following examples can also be practiced using the 
original images that were employed. The sample images can be found in the 
folder Demo Images and Scripts\AxioVision Images on the Product DVD. 
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Dynamic segmentation is particularly useful for detecting fine structures 
against a varying background in cases where an optimum result cannot be 
achieved using threshold value segmentation. 

It is, however, also suitable for images with inhomogeneous illumination. The 
Dynamic function employs a smoothing filter internally. This is used to 
balance out uneven brightness, or gray value fluctuations, in the background. 

The following example explains step by step how to perform dynamic 
segmentation. 

 From the Product-DVD load the 
image " sand.tif" from the 
folder Demo Images and 
Scripts\AxioVision Images via 
the function File ⇒ Open 
Image. 

 The image is displayed in 
AxioVision’s image window. 
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Select from the Processing menu the Segment functional group, and then 
the Dynamic function. 

 You will now see the dialog 
window of the Dynamic 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear. 

 Set the value 63 for Size and 
the value 0 for Offset by 
clicking on the arrow keys, or 
by entering the values directly. 
Set Binary to Yes. 

 Click on OK to close the dialog. 

 

 The resulting image provides a 
satisfactory segmentation result.

 Although the original image 
exhibited inhomogeneous 
illumination, no shading 
correction was performed in 
advance. 

 The uneven brightness in the 
image is compensated for by 
the dynamic segmentation. 
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 You are now able to process the binary image further. Now select from 
the Processing menu the Binary functional group, and then the Open 
function. 

 You will now see the dialog 
window of the Open function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear. 

 Set "Octagon" for Structuring 
Element and the value "1"  for 
Count. 

 Click on OK to close the dialog. 
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In the resulting image, the detected objects have been smoothed, and small 
particles removed. 
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If you want to detect structures in a multichannel z-stack image, functions are 
available that take the entire z-stack into account, or all of the channels in full 
or on a selective basis. 

As the individual channels clearly differ in terms of colors and structures, here 
it is possible to make settings on a channel-by-channel basis. The specific 
settings for the z-stack do not have to be entered separately for each 
individual image. A setting made for an individual image is applied to all the 
images in the stack, and therefore provides a very fast detection result. 

The automatic segmentation of an image is based on the automatic detection 
of local minimums in the image’s gray value distribution. The Automatic 
function uses these minimums as thresholds in order to separate the 
structures to be measured from the background. This means that entering 
thresholds manually, as in the Threshold function, is not necessary here. 

Often only certain structures, present in just one fluorescence channel, are of 
interest (e.g. cell nuclei). In a multichannel z-stack image, each channel’s z-
stack always has the same number of sections. In some cases the structure to 
be measured may not extend over the entire stack. 

Setting the Subset therefore allows you, in the case of a multichannel z-stack, 
to choose selectively between individual channels or sections. 

The following example explains step by step how to segment selected sections 
of a fluorescence channel in a multichannel z-stack. 
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 From the Product-DVD load the 
image 
"Hela_DsRed_RevGFP.zvi" from 
the folder Demo Images and 
Scripts\AxioVision Images via 
the function File ⇒ Open 
Image. 

 The image is displayed in 
AxioVision’s image window. 

 

 Now select from the Processing menu the Segment functional group, 
and then the Automatic function. 

 You will now see the dialog 
window of the Automatic 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear.  

 Click on Subset to enter the 
specific settings in the Select 
Subset window. 
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 Activate only the channel that 
you want to be segmented 
(channel 2 in the example).  

 The first 5 sections contain 
hardly any structures, and 
should not be taken into 
account during segmentation. 
Deactivate these sections by 
clicking on them. 

 

 Activate the Copy selected items only check box, so that only the 
selected channels and sections are segmented. 

 Click on OK. 

 In the Automatic dialog window, click on OK to close the dialog.  

The resulting image is a binary image that contains only the selected sections 
of channel 2. This image can be used as a mask for automatic measurement. 
Use the arrow keys in the Player Field 

to display the segmentation in single steps. 
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In many images there is no clear distinction between the objects and the 
background. The objects lie very close together, and are separated from each 
other by brighter or darker contours. In such cases, threshold value 
segmentation does not usually produce a satisfactory result, as the contours 
exhibit significant gray value fluctuations. For these kinds of images, edge 
detection offers a possible solution. 

Imagine an image as a gray value mountain range, where the valleys are 
formed by dark gray values, and the peaks by bright gray values. In the 
following example, the Valleys function is used. This detects dark edges (gray 
value valleys) between bright regions. 

Before the edges are detected, smoothing is performed. This is determined by 
the Sigma parameter. A high value for Sigma means that strong smoothing 
is performed. 
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As a rule, the edges are not uniformly dark, and brighter edges (weakly 
pronounced valleys) and darker edges (strongly pronounced valleys) are 
present. The detection of the edges can be controlled using the Threshold 
parameter. A low value for Threshold excludes bright edges. The higher the 
value for Threshold, the lower the number of edges detected. The value is 
normally set at a low level, to ensure that any artifacts that are also detected 
are removed. 

Note: 
• Please note that the setting of the value for Threshold depends on the 

image’s pixel type. A value of 0.00001 for Threshold corresponds to a 
gray value in a 16 bit image (1/65536). In the case of an 8 bit image, a 
gray value corresponds to a value of 0.03 (1/255). This means that with 
16 bit images, very low values are sufficient, whilst with 8 bit images, the 
value has to be set correspondingly higher. 

If you have images in which dark objects are separated from each other by 
bright contours (edges), we recommend that you invert the image before 
using the Valleys function. To do this, use either the Invert function from the 
Adjust functional group, or the Not function from the Binary functional 
group. 

If a color image is used as an input image, you should split the image up into 
its individual color channels before or after executing the Valleys function 
(Utilities functional group, Split RGB Extractions function), process these 
channels separately, and combine them as an individual binary image again, 
before the measurement (Binary functional group, Or function) is performed. 

The following example explains step by step how to detect these contours 
(edges) in an image that contains bright structures separated by dark 
contours. 
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 From the Product-DVD load the 
image "Steel-banding.zvi" from 
the folder Demo Images and 
Scripts\AxioVision Images via 
the function File ⇒ Open 
Image. 

 The image is displayed in 
AxioVision’s image window. 

 

 Select from the Processing menu the Segmentation functional group, 
and then the Valleys function. 

 You will now see the dialog 
window of the Valleys 
function. 

 If the Automatic Preview 
check box is activated, you will 
see the reduced input and 
output images. 

 Set the value 1.5 for the 
parameter Sigma by clicking on 
the arrow keys, or by entering 
the value directly. 

 Set the value 0.03 for 
Threshold by entering the 
value directly. 

 Click on OK to close the dialog. 
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The resulting image shows the detected edges, but also numerous small 
structures (artifacts) that have also been detected. 
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 Select from the Processing menu the Binary functional group, and then 

the Bin Scrap function. 

 You will now see the dialog 
window of the Scrap function. 

 If the Automatic Preview 
check box is activated, you will 
see the reduced input and 
output images.  

 Set the value 1 for the 
parameter MinArea and the 
value 50 for MaxArea by 
clicking on the arrow keys, or 
by entering the values directly. 

 Click on OK to close the dialog. 
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In the resulting image, the artifacts have now disappeared. A comparison with 
the original image, however, shows that some of the detected edges contain 
gaps. 
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In order to measure the image correctly, the edges of the objects (regions) to 
be measured must be closed. Using the watersheds function, it is possible to 
reconstruct them, so that they form complete contours (see chapter 
"Separation and/or reconstruction of structures using watersheds"). 
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If you want an image to be measured automatically, you must first perform 
segmentation. This produces a so-called mask (binary image). Frequently the 
binary image is not perfect, and can only be used for measurement following 
further processing. During segmentation, incomplete or superfluous structures 
(gaps, peripheral regions or other structures) are often detected. Special 
functions are available for processing such structures. 

The following example explains step by step how to process a segmented 
image morphologically, and thereby optimize it. 

 From the Product-DVD load the 
image "Cat-
Cerebellum(1300).zvi" from the 
folder Demo Images and 
Scripts\AxioVision Images via 
the function File ⇒ Open 
Image. 

 The image is displayed in 
AxioVision’s image window. 
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 Now select from the Processing menu the Smooth functional group, and 

then the Gauss binomial function. 

 You will now see the dialog 
window of the Gauss binomial 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear.  

 In places the image contains 
inhomogeneous structures, 
which make segmentation more 
difficult. For this reason the 
image is smoothed in advance 
using a Gauss filter. 

 Set the value 5 for the 
parameter KernelSize by 
clicking on the arrow keys, or 
by entering the value directly.  

 Click on OK to close the dialog. 
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 Now select from the Processing menu the Segment functional group, 

and then the Threshold interactive function. 

 You will now see the dialog 
window of the Threshold 
interactive function. 

 Set New image to Off. Under 
Input select GaussImage. 

 Click on OK. 
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 You will now see the dialog window with the segmentation function. 
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 Click on OK. The resulting image is displayed in the image window. 
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Often the image structures that you want to measure are present in the form 
of agglomerates, or are positioned very close together, which means that 
separation is required following segmentation. If only the object contours 
have been detected, these are frequently incomplete, and need to be 
reconstructed to form complete contours. 

If conventional separating functions (combination of Bin Erode and Bin 
Dilate or Exoskeleton) fail to produce a usable result, the watersheds 
function can be employed. 
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In the segmented image it is necessary, first of all, to perform smoothing 
(using Lowpass, Gauss or Median), in order to eliminate excess structures 
and structures that are too small. Smoothing can, however, also take place 
prior to segmentation. 

Distance transformation (Bin Euclidean Distance) is then used to generate a 
distance map from the smoothed binary image. The distances of the white 
regions from the black background are coded as gray values in the resulting 
image. Bright gray values in the distance map indicate a large distance from 
the object. 

An image can be regarded as a gray-value landscape, with valleys (dark gray 
values) and hills (bright gray values). In the distance-transformed image, the 
regions have to be the valleys, in order for the watersheds algorithm to 
function. The Watersheds function floods the valleys, and marks the places 
where the water masses flow together. These are then identifiable as 
separating lines or reconstruction lines. 

The following example explains step by step how to generate separating lines 
using watersheds. 

 Use the resulting image from 
the Edge detection example in 
the previous section, or 
generate a similar image.  
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 Select from the Processing menu the Smooth functional group, and then 
the Lowpass function. 

 You will now see the dialog 
window of the Lowpass 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear.  

 Set New image to Off, so that 
you can select the images 
freely.  

 If you click on the  button in 
the Input field, the image 
gallery appears. Select the 
original image by clicking on it. 

 Set the value 5 for 
KernelSizeX, KernelSizeY and 
Count by clicking on the arrow 
keys, or by entering the value 
directly. 

 Click on OK to close the dialog. 
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 Select from the Processing menu the Binary functional group, and then 

the Distance Transformation function. 

 You will now see the dialog 
window of the Distance 
Transformation function. 

 If the Automatic Preview 
check box is activated, the 
reduced inputand output 
images appear. 

 Click on OK to close the dialog. 
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 Now select from the Processing menu the Morphology functional 

group, and then the Watersheds function. 

 You will now see the dialog 
window of the Watersheds 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear. 

 Select under Basins the Off 
setting. 

 Click on OK to close the dialog. 
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The resulting image now shows the reconstructed separating lines. 

  

Incomplete separating lines have been completed, and superfluous structures 
removed. If the resulting image is to be used as a mask for measuring, it must 
first be inverted using the Not function (menu Processing ⇒ Binary). 
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Images often contain structures with varying brightnesses or colors, which are 
detected over several segmentation steps. In some cases, the binary images 
produced have to be combined in order to join together or mask structures. 
Boolean operations are available for this purpose. The And function can be 
used to mask structures, whilst the Or and Xor functions are better suited to 
combining structures. Frequently an inverted image is required, which can be 
generated using the Not function.  

The following example explains step by step how to mask or combine 
structures from various binary images. The example uses a metaphase image, 
from which the DAPI channel, the FITC channel and the Rhodamine channel 
have been detected in three separate steps. 

 Use the segmentation functions to generate three binary images in which 
various structures have been detected. 

 Or: from the Product DVD load the images "FISH_DAPI_BIN.zvi", 
"FISH_FITC_BIN.zvi" und ""FISH_RHO_BIN.zvi" from the folder Demo 
Images and Scripts\AxioVision Images. 
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 FISH_DAPI_BIN.zvi 

  

 "FISH_FITC_BIN.zvi 

  

 FISH_RHO_BIN.zvi 
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 Now select from the Processing menu the Binary functional group, and 
then the And function. 

 You will now see the dialog 
window of the And function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear. 

 Set CreateNew to Off so that 
you will be able to select the 
images freely later. 

 If you click on the  button in 
the Input field, the image 
gallery appears. Here select the 
image in question by clicking on 
it. Select different binary images 
for Input1 and Input2. 

 Click on OK to close the dialog. 
 

 The And function only masks 
structures that are present in 
both images.  

 As, in the sample image, the 
FITC structures lie directly on 
top of the DAPI structures, the 
resulting image is identical to 
the FITC binary image. 
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 Now select from the Processing menu the Binary functional group, and 
then he Or function. 

 You will now see the dialog 
window of the Or function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear. 

 If you click on the  button in 
the Input field, the image 
gallery appears. Here select the 
image in question by clicking on 
it. Select different binary images 
for Input1 and Input2. 

 Click on OK to close the dialog. 

 

 

11-48 M 60-3-0024 e / printed 06.2010 



Modules  - AutoMeasure Plus 

The Or function masks structures that are present in either one image or the 
other.In the sample image, the FITC structures and the Rhodamine structures 
are in different positions. Both types of structure appear in the resulting 
image. 
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 Now select from the Processing menu the Binary functional group, and 

then the Xor function. 

 You will now see the dialog 
window of the Xor function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear. 

 If you click on the  button in 
the Input field, the image 
gallery appears. Here select the 
image in question by clicking on 
it. For Input2 select the 
resulting image of the Or 
function, and for Input1 
another binary image. 

 Click on OK to close the dialog. 

 

The Xor function masks as black any structures present in both images. Any 
white structures that do not overlap also appear as white in the resulting 
image. 

11-50 M 60-3-0024 e / printed 06.2010 



Modules  - AutoMeasure Plus 

In the sample image, the FITC and Rhodamine structures lie directly on top of 
the DAPI structures. Structures in the resulting image therefore appear as gaps 
in the DAPI image. 
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 Now select from the Processing menu the Binary functional group, and 

then the Not function. 

 You will now see the dialog 
window of the Not function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear.  

 If you click on the  button in 
the Input field, the image 
gallery appears. Here select the 
image in question by clicking on 
it. For Input1, select any binary 
image. 

 Click on OK to close the dialog. 
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The resulting image now shows all white structures as black, and vice versa. 
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 From the Product-DVD load the 
image "round.zvi" from the folder 
Demo Images and Scripts\AxioVision 
Images via the function File ⇒ Open 
Image. 

 The image is displayed in AxioVision’s 
image window. 
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 Now select from the Processing menu the Segmentation functional 
group, and then the Automatic function. 

 You will now see the dialog 
window of the Automatic 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear.  

 If you click on the  button in 
the Input field, the image 
gallery appears. Here select the 
image in question by clicking on 
it. For Invert reult, select Yes. 

 Click on OK to close the dialog. 
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 Now select from the Processing menu the Segmentation functional 

group, and then the Separatrion function. 

 You will now see the dialog 
window of the Separatrion 
function. 

 If the Automatic Preview 
check box is activated, the 
reduced input and output 
images appear.  

 Set the value 3 for Count by 
clicking on the arrow keys, or 
by entering the value directly. 

 For the parameter Mode select 
Watersheds. 

 Click on OK to close the dialog. 
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 Now select from the menu Measure ⇒ Automatic Measurement the 

function Set Measurement Properties. 

 You will now see the dialog 
window of the Set 
Measurement Properties 
function. 

 From the image gallery  for 
the parameter DensImage the 
image "round.zvi" and for 
parameter MaskImage select 
"SeparatedImage". 

 Click on OK to close the dialog. 
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Set the selected measurement features, draw features as well as the 
measurement frame and activate the check bos Maximiz frame. Save the 
settings and click OK to close the dialog window. 
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 Now select from the menu Measure ⇒ Automatic Measurement the 

function Start Measurement. 

 You will now see the dialog 
window of the Start 
Measurement function. 

 Select the parameters as shown 
in the screenshot of the dialog 
window. 

 Click on OK to close the dialog. 

 

In the AxioVision's image window the result image DrawImage and the 
result table RegionTable will be displayed. 

11-58 M 60-3-0024 e / printed 06.2010 



Modules  - AutoMeasure Plus 

   

The results will be displayed in the graphics plane of the resulting image. With 
the function Set Mesurement Properties you can define the way in which the 
Region Features, Draw Features resp. Field Features Draw Features will be 
displayed. 
The measurement values are displayed in region specific resp. field specific 
tables. 

The measurement data are saved at the end of the measurement in so-called 
CSV format (Comma Separated Values). 

This is a pure text format that separates the individual values from one 
another using special text symbols. The specific country settings that have 
been set in the Microsoft Windows control panel apply. 

Files in CSV format offer two advantages: on the one hand, they are a special 
Microsoft Excel format, and can be opened and processed directly by that 
program. On the other hand, as the files contain pure text data, you can 
import the data into practically any other program. 
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The Particle Analyzer Projects module forms the basis for the Particle 
Analyzer system on the software side. The Particle Analyzer from Carl Zeiss is 
a complete system for analyzing particles and is currently based on two 
microscope platforms: 

 platform 1: Upright light microscope Axio Imager 
 platform 2: SteREO Discovery.V12 stereo microscope 

For either platform, manual and partially or fully motorized system versions 
are available. See the system overviews below: 

 

 Particle Analyzer with Axio Imager.M1m or Axio Imager.Z1m 

11-60 M 60-3-0024 e / printed 06.2010 



Modules  - Particle Analyzer Projects 

 

 Particle Analyzer with SteREO Discovery.V8 or SteREO Discovery.V12 

In addition to the microscopes, the following components are essential for a 
complete Particle Analyzer system: 

 Digital camera (integrated into AxioVision, e.g. AxioCam family). 
 PC with monitor. 
 AxioVision basic package and the Particle Analyzer Projects module. 

Depending on the microscopy platform used and the requirements of your 
application, you may need the following components in addition: 

 For scanning large areas: a motorized stage and the AxioVision MosaiX 
module. For automatic focusing during image acquisition, the AxioVision 
Autofocus module will be helpful. 

 For the individual modification of analysis scripts: the Commander 
module. 

For details on setting up and using the hardware components, such as the 
microscope, motorized stage and camera, please refer to the manuals 
supplied with the corresponding devices. 
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Note: 
• Before using the Particle Analyzer, familiarize yourself with the basic 

functions of the AxioVision software. You should be familiar with the 
operation of the camera and microscope components in particular. 

^ÅÅÉëëçêáÉë=Ñçê=é~êíáÅäÉ=~å~äóëáë=

Specimen holder for round particle filters 

 

The specimen holder for round particle filters is used to hold round filters up 
to 50 mm in diameter. It can be used for the following tasks/has the following 
features: 

 Reproducible positioning of filters on a mechanical stage or scanning 
stage. 

 Plane-parallel glass plate with retaining ring for flat insertion of a filter. 
This means that autofocusing is no longer necessary. Automatic focusing 
would make the acquisition process many times longer. 

 Suitable for objectives up to Epiplan 10x. 
 Marking to ensure correct positioning of filters with a 25 mm diameter. 

Depending on the type of stage used (mechanical or scanning stage), special 
specimen holders or inserts may also be required in addition to the specimen 
holder for particle filters to ensure that the latter is correctly positioned on the 
stage in question. 

11-62 M 60-3-0024 e / printed 06.2010 



Modules  - Particle Analyzer Projects 

Particle analysis calibration standard 

 

Using the calibration standard, you can check whether measurements made 
using the Particle Analyzer lead to reproducible results. The calibration 
standard has the following features: 

 Depiction of size classes of guideline VDA volume 19 and ISO 16232 
 10 size classes: 10, 20, 35, 75, 125, 175, 300, 500, 800, 1200 µm 
 Total number of particles: 6960 
 Three different shapes: circles, rectangles, ellipses 
 Diameter: 47 mm 
 Diameter containing particles: 44 mm 
 Anti-reflective on both sides 

Note:  
• The calibration standard is also available in a certified version. 
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The following table provides an overview of the particle distribution for the 
calibration standard: 

VDA 19, ISO 16232 Calibration standard 

Class 
Class boundaries 

(µm) 
Particle size 

(µm) 
Number of 

particles 

B 5 ≤ x < 15 10 1920 

C 15 ≤ x < 25 20 1920 

D 25 ≤ x < 50 35 960 

E 50 ≤ x < 100 75 960 

F 100 ≤ x < 150 125 480 

G 150 ≤ x < 200 175 240 

H 200 ≤ x < 400 300 120 

I 400 ≤ x < 600 500 120 

J 600 ≤ x < 1000 800 120 

K 1000 ≤ x 1200 120 

Total number of particles 6960 
 
Cleaning of sample holder and calibration standard  

You will need to differentiate between dust particles (e.g. glass particles from 
slides, skin particles from the microscope user, fluff from textiles, etc.) and 
other kinds of dirt (e.g. cleaning residues, finger prints and grease). Dust 
particles may lie loosely on optical surfaces or become more or less stuck to 
them. Other dirt is either water-soluble or only completely removable using 
organic solvents. 

Depending on the type of soiling, different methods can be used to clean the 
sample holder or the calibration standard. You will find further information in 
the brochure "The clean microscope" by Carl Zeiss. This brochure can be 
found on the Internet at www.zeiss.de. 
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The operating concept of the Particle Analyzer is designed to make it possible 
to achieve a reproducible result with as little interaction as possible. The 
performance of a measurement can be automated to such an extent that only 
the project data need to be entered and the entire analysis process can run 
automatically.  

To automate a measurement completely, you need extensive knowledge of 
systems engineering and the respective application. Carelessly made 
alterations of a setting can promptly lead to faulty measurement results. It is 
important, therefore, to prevent users not having such knowledge from 
changing the basic settings. This is achieved by dividing up the tasks involved 
into the definition of a measurement and the performance of a measurement. 

The performance of a measurement is always based on what is called test 
specifications. All important settings are saved in a test specification. A test 
specification cannot be created or edited by a user. This is reserved to Power 
Users resp. Administrators. Access to the respective functions is governed by 
the access rights of the operating system: 
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Dialog for starting a particle 
measurement (for standard 
users and administrators) 

Dialog for editing a test specification 
(only for administrators, not available to 
standard users) 

Under Microsoft Windows Vista the administrator must actively run AxioVision 
as an administrator. To do this, after the administrator has right-clicked on the 

AxioVision  start icon, the Run as administrator option must 
be activated. 
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Note: 
• Under Microsoft Windows Vista you can also set this option permanently. 

Please read the following chapter. 

 Right-mouse click on the AxioVision icon  and select the 
Properties function. 
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 The AxioVision Properties dialog window will be displayed. In the 
Privilege Level field activate the option Run this program as an 
administrator.  

 * 

From now on the program will be executed with administrator rights when 
starting AxioVision.  
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The configuration data of a measurement are saved to so-called test 
specifications. A test specification contains all the information on the 
performance of a particle measurement in detail: from the configuration of 
the device and the type of image acquisition through to the determination of 
the size of the original data to be saved and how the results should be 
displayed at the end of a measurement.  

The test specifications are saved to the archive, together with the 
measurement projects, but they are not visible in the archive window. They 
can only be modified via the Manage Test Specifications function. 

Data are saved and managed in a project-based archive. All the data 
generated (images, data tables, reports etc.) are arranged by project and 
saved centrally: 

 

Archive view of the Particle Analyzer software 
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General 

The functionality of the Particle Analyzer Projects module is based on the basic 
functionality of AxioVision. Before you can work with the Particle Analyzer, 
you must, therefore, configure the basic settings for AxioVision. You will find 
further information you require in Section 8 "Configuration" of this manual. 

Microscope configuration 

To be able to use your microscope together with AxioVision, you need to 
define once your individual system configuration via the separate MTB2004 
Configuration program. Should you be retrofitting the Particle Analyzer to 
your existing microscope system, you may have to do this configuration via 
the Microscope Configuration program. 

The configuration programs have their own icons and buttons on your 
Microsoft Windows Desktop: 

   

Note: 
• For detailed information, see Chapter 4 "Microscope Control". 
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The Particle Analyzer Setup toolbar 

The Particle Analyzer Setup toolbar is specially intended for setting and 
configuring the Particle Analyzer: 

 

 

In the following it is assumed that the toolbar is open. If the toolbar is not 
displayed on your monitor, select Toolbars in the View menu: 

Hereinafter it is assumed that the toolbar is open. If it should not be displayed 
on your system, open it via the menu View ⇒ Toolbars: 
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Please make sure that the following settings have been made: 

Alignment of camera and motorized stage 

If you wish to acquire images of large areas using the MosaiX module, you 
must ensure that the camera and stage are exactly aligned with the camera 
horizontal.  

To check this, in the live image move a clearly recognizable object point as 
close as possible to the upper image edge. When the stage is moved in the X 
direction, this point in the image must remain at exactly the same distance 
from the upper image edge. If this is not the case, the camera must be 
rotated until the direction of movement and the image edge are completely 
parallel. Otherwise the individual component images will not be put together 
properly. The aligning and setting process may take quite some time with 
conventional camera adapters; therefore use of the adjustable Carl Zeiss 
camera adapter is recommended: 

  

Note: 
• For detailed information, see Chapter 9.7 "MosaiX" – "Setting up the 

camera and scanning stage"). 
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Scaling 

Measurement in real units (e.g., µm) is only possible if there exist scaling files. 
Although AxioVision has a capability to compute a theoretical scaling on the 
basis of the current system configuration, it is urgently recommended to 
create, for measurement tasks, an individual scaling file by means of a stage 
micrometer. 

Note: 
• For detailed information, see Chapter 8.4 "Scalings". 

Autofocus calibration 

To be able to use the autofocus feature, you need to calibrate it for the 
magnifications used. The autofocus feature can then be used for defining 
interpolation nodes for the focal plane, and for acquiring mosaic images. 

Notes: 
• For detailed information, see Chapter 9.2 "Autofocus". 

User settings 

Select the User tab in the Tools ⇒ Options menu. Enter the information 
about the respective user and select your corporate logo. This information is 
administrated separately for each user. It is saved to the archive for each 
project or each measurement and, by way of default, used for the reports.  

Note: 
• For detailed information, see Chapter 8.6 "General settings". 

Configuration of the user interface 

AxioVision offers an extremely wide range of options with regard to user-
specific configuration. In particular, the fact that the interface is structured as 
simply as possible means that even inexperienced users are able to use the 
system to achieve accurate results both quickly and easily. 

AxioVision User's Guide, Release 4.8.2 11-73 



Modules  - Particle Analyzer Projects 

It is recommendable to hide all controls not used for the purpose. For routine 
measurements, you usually need only the Particle Analysis workflow and, 
perhaps, the Particle Analyzer toolbar. The Particle Analyzer Setup toolbar 
is not required for routine measurements. All toolbars, as well as the main 
menu, can be displayed and hidden via the View ⇒ Toolbars menu. 

Notes: 
• To show the main menu again, click the right mouse button on the title 

bar of the AxioVision window, or on a toolbar. This opens a context menu 
in which you can display everything again. 

• For detailed information, see Chapter 8.5 "Adapting the user interface". 

péÉÅá~ä=ëÉííáåÖë=Ñçê=é~êíáÅäÉ=~å~äóëáë=

Creating an archive 

The database of the Particle Analyzer constitutes an archive. All data (images, 
measurement data tables, reports, etc.) are saved to this archive in a project-
related order. To be able to work with the Particle Analyzer Projects module, 
therefore, an archive must exists and be opened in AxioVision. 

In the Particle Analyzer Setup toolbar, click on the New button. On the 
Archive tab, select the Particle Analysis template: 

 

11-74 M 60-3-0024 e / printed 06.2010 



Modules  - Particle Analyzer Projects 

Opening the particle analysis archive when starting 
AxioVision 

To start AxioVision always with the desired archive, you should establish a 
shortcut to the archive on the Microsoft Windows desktop: 

 Click the right mouse button on a free area on the desktop, and select 
New ⇒ Shortcut 

  

 This opens the dialog Create Shortcut. Click on Browse… and select 
the Particle Analysis Archive (file extension *.zva): 

  

 Click on Next and, in the next step, enter a name for the link. 

 To create the link, click on Finish. 
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Note: 
• Via the properties of the shortcut you can also adapt the icon. Suitable 

icons can be found in the "ZiResrc.dll" file in the "C:\Program 
Files\Common Files\Carl Zeiss Vision\System\Resource" folder. 

Administrating several users 

The user management of AxioVision is directly based on that of the operating 
system. Each user with access rights works under a different AxioVision 
configuration. This means that, e.g., the configuration of the user interface, 
the entry of user data, etc., are managed separately for each user. 

Notes: 
• For detailed information on user and data management, see Chapter 8.3 

"User and data administration". 

• If you use a common account for all users but wish to use different 
configurations nevertheless, proceed as described in the following 
section.  

Separation of Particle Analysis and standard AxioVision 

It is a strong point of the Particle Analyzer that the system is completely based 
on the standard AxioVision software. Therefore, it can also be used for simple 
documentation jobs or other applications such as, e.g., analysis of non 
metallic inclusions in steel. To start AxioVision always with a special, 
application-specific configuration (e.g., specific toolbars, workflows, etc.), you 
can establish any number of links with separate icons on the Microsoft 
Windows Desktop. 

Note: 
• For detailed information on the creation of configurations, see Chapter 

8.8 "Creating various AxioVision configurations for a user". 
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In test specifications, all settings and files for performing a particle 
measurement are saved. All subsequent particle measurements always are 
based on a test specification. When you start a measurement you are 
prompted to select the desired test specification first before you can actually 
start the measurement. 

The test specifications are managed via the Edit Test specifications dialog:  

 

In the Edit Test specifications dialog you can edit, create and delete test 
specifications. Further, you can import and export test specifications. 
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To make the preparation and setup for Particle Analysis as easy as possible, 
you can simply import existing test specifications for special applications and 
use them right away. 

This is especially helpful if measurements are to be made in different places 
but with exactly the same specifications. Test specifications once created 
centrally can then be imported on any number of systems installed. 

Clicking the Import/Export… button starts the wizard that guides you 
through all the necessary steps: 

 

Note: 
• Test specifications available at Carl Zeiss can be downloaded from the 

Particle Analyzer Internet website www.zeiss.de/particle and then 
imported. Test specifications are available, e.g., for data analysis 
conforming to ISO 16232, and for measuring the Carl Zeiss particle 
standard. 
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Test specifications are created via the Change Test Specification function. 

  

Here again you can, for each single item required for creating a test 
specification, load settings already existing in another template. For the 
management of template files, use the buttons on the right of the respective 

creation items: . 

Thus, you can directly copy device settings, settings of the image source, input 
forms, etc. from existing templates into the current test specification you are 
creating. Further, you can save your own settings to a new template in order 
to use them in further test specifications. 

And finally, you can set every step separately. To open the respective dialog, 

click on the Edit… button:  

The following chapters describe the procedure step by step. 
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If you want to test whether the settings of a test specification really produce 
the desired results, you can click on the Execute… button to run a complete 
measurement without having to create a project in the archive. It is important 
that you perform this step with a real sample, because all settings made in the 
functional dialogs during the test run are adopted by the test specification. 

Settings that are particularly important in this context are, e.g., those 
concerning the segmentation thresholds for particle detection, or the size and 
position of the measurement frame. 

e~êÇï~êÉ=ëÉííáåÖë=

The settings of microscope and camera are decisive for the reproducibility of 
measurements. Measurements will yield the same results only if they are 
always made with the same parameters. With the hardware settings you can 
ensure that you are always using the same hardware configuration before you 
start a Particle Analysis. This is conditional on the use of motorized 
microscopes or microscope components, and digital cameras. These can be 
completely controlled via the software. 

In case of manual microscopes you need to do the correct settings manually. 
So-called coded components require a mixed approach. Their current statuses 
can be checked by the software, but the correct setting has to be done 
manually as required. If you are using coded components, the system will 
warn you if a setting is faulty and prompt you to establish the correct 
configuration. 

The most important settings include, e.g., the objective to be used, the 
brightness adjustment, the used contrasting method, camera resolution, 
exposure time, camera mode, etc. 

Example: Setting the camera mode (color, gray levels) 

The camera setting has a decisive influence on the size of your files. Given the 
memory capacity of modern computers, the use of color images is considered 
a standard feature. However, color images require three times as much 
memory space as gray scale images. In most cases, though, color information 
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is not required for particle detection; therefore, images should be acquired as 
gray scale images. This setting can be made in the camera control dialog, and 
it can be changed there by every user: 

 

By including the camera mode in the hardware settings you can ensure that 
you are always acquiring gray level images for a measurement, irrespective of 
the actual settings of the camera: 

 

fã~ÖÉ=pçìêÅÉ=

The image source defines the way images are acquired. When large areas are 
acquired by the mosaic technique, the size and position of the acquired area 
are defined in addition via the Setup function of the MosaiX module. Then it 
is important, in routine work, that the samples are actually located in the 
places previously defined. This can be ensured through the use of holders for 
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different slide types. A special holder is available for measuring round particle 
filters: 

  

For details, see Chapter "Accessories for particle analysis". 

To ensure unmistakable repositioning in the acquisition of MosaiX images, the 
z focus and the x and y settings of the motorized stage are calibrated after 
every restart of AxioVision.  

fåéìí=Ñçêã=

During a measurement, the user enters the required project data into input 
forms. You can freely define which data to enter. The input fields required 
and their linking to the archive are defined in what is called the Layout mode. 
The Layout mode is active immediately when you start editing. 

 

Standard input form for project data 
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Note: 
• For detailed information on editing form templates, see Chapter 7.4 

"Templates for forms and reports". 

bî~äì~íáçå=ëÅêáéíë=

General 

The analysis script determines the way in which the particle analysis is to be 
carried out. Consequently, this script is the key to the entire analysis. Besides 
the sequence of the commands, here you can also define the functions that 
you want to be executed interactively, i.e. which functions should be opened 
during the performance of a measurement to allow the user to enter 
parameter settings. 

Notes: 
• In order to display and modify the analysis script, you will need the 

Commander module. The Commander module however is NOT required 
for executing a particle measurement. 

• Since modification of the analysis script has dramatic consequences with 
regard to the quality of the analysis, this should only be performed by 
experienced users. It is essential that you read the "Commander" section 
and the information in the online help before making any modifications. 

• The analysis scripts are not managed in the usual standard AxioVision 
folders. The New and Rename buttons are therefore inactive. The Save 
button only becomes active once you have made changes to the script. 
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 Analysis script in the Commander script editor 
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Adapting the evaluation script 

As long as you do not insert or delete any commands, you can modify the 
behavior of the script simply by switching the commands on the Commands 
tab on and off. 
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You can any functions, available in AxioVision, incorporate into the script. 
After doing so, however, you must ensure that the input and output 
documents are correctly linked. 
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The three command lines at the end of the script must not be deleted under 
any circumstances. These commands calculate the actual classification and 
generate the results document. 

 

jçÇáÑóáåÖ=êÉéçêí=íÉãéä~íÉë=

In order to print the results of a measurement clearly, it is possible to structure 
the appearance of the results report individually. A report template may only 
be modified during the creation/editing of a test specification and is, 
therefore, not accessible for standard users. The predefined template is always 
used when you perform a measurement. 

Note: 
• For detailed information, see Chapter 6.4 "Creating data reports". 
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General 

With optional settings you define essentially the following items: 

 Selection of the data to be saved (above all, image data). 
 Behavior during image acquisition. 
 Presentation of result data after the measurement. 

It is imperative that you consult the Online Help function for information on 
details of the parameters that can be set. 

Memory space required 

The quantity of data obtained in particle analyses is sometimes enormous, 
especially when you acquire large images using the MosaiX module. The table 
below shows the memory requirements for different conditions: 

Image size in MB* 
Pixel scaling 

used Gray scale 
image Color image 

1.0 µm / pixel 1450 4350 

2.5 µm / pixel 232 696 

5.0 µm / pixel 58 174 

10.0 µm / pixel 15 44 

* Area approx. 1500mm², 8 bit gray levels 

You should carefully consider which original data should actually be saved. 
Among others, the two factors outlined below may be a basis for decision: 

 If you want to ensure that a measurement can be reproduced at any time, 
you need to save the original data as they are. It is not permissible in this 
case to scale down the original image or to save it in a compressed 
format. 
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 If you want to save the original image for documentation purposes, you 
should consider whether a scaled down version could be saved in a 
compressed format (e.g., ZVI or JPG). This will considerably reduce the 
amount of image data, but they will not be suitable for subsequent 
measurements. 

Number of gray levels or color values of the images acquired 

Another important consideration is the bit depth, i.e. the number of gray 
levels or color values used for image acquisition. In the past, the entire 
brightness or color range was captured 256 different gray levels (8 bit). Most 
modern digital cameras have more than 256 gray levels. But here, too, this 
means that the resulting image data files are exceedingly large; the great 
number of gray levels (possibly more than 65,000) is not needed for a 
measurement. It is possible, therefore, to enforce reduction to 256 gray levels: 

 

Conversion of acquired images to 8 bit 
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A measurement is performed via the Start Particle Analysis function in the 
Particle Analysis workflow: 

  

 Dialog for starting a particle measurement 

A particle measurement is always based on a previously defined test 
specification. This must have been created beforehand by a qualified user. It is 
not possible to perform a measurement if no test specification has been 
created. 

During the course of the measurement, the function dialog for which the 
Interactive mode has been selected in the analysis script will be displayed. All 
other functions run automatically in the background. 

The program will stop at each function for which Interactive has been 
selected and the corresponding dialog will open. The predefined parameters 
can then be modified and optimally adapted to the image in question. 
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The functions that are carried out interactively feature the additional 
parameter Always interactive during the execution of the program. This 
allows the user to decide whether or not the dialog should be opened again 
for the next image. This is particularly useful if you have set segmentation 
thresholds, for example, and do not need to modify them again for 
subsequent images. The thresholds can therefore be set using one or more 
images and then applied automatically. 

This option is useful if you are measuring several images immediately after 
each other. Otherwise, this setting does not have any impact on the running 
of the program. 

Once the measurement is complete, the results window will be displayed or, 
alternatively, the report can be displayed immediately: 

 

Results document 

Note: 
• Whether it is the results document or report that is displayed depends on 

the settings for the test specification. 
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Note: 
• For detailed information on the individual functions and commands, 

please refer to the online help (F1 key). 

qÜÉ=ëóëíÉã=î~êá~åíë=

The NMI module is the software for the NMI system. The NMI (non-metallic 
inclusions) system from Carl Zeiss is a complete system for analyzing the purity 
of steels in accordance with current standards. This system is currently based 
on three fully motorized microscopy platforms: 

 Platform 1: upright light microscope Axio Imager.Z2m for multiple sample 
analysis 

 Platform 2: inverse microscope Axio Observer.M2m individual sample 
analysis 

 Platform 3: inverse microscope Axio Observer.Z1m 

In addition to the microscopes, the following components are essential for a 
complete NMI system: 

 Digital camera AxioCam MRc 
 High-performance PC with monitor 
 AxioVision basic package and the NMI and MosaiX modules 

Depending on the microscopy platform used and the application-related 
requirements, the following components may also be necessary: 

 A multiple sample holder for up to six round samples up to 40 mm in 
diameter 

 For the individual modification of evaluation scripts: Commander module 

For details on setting up and using the hardware components, such as the 
microscope, scanning stage and camera, please refer to the manuals supplied 
with the corresponding devices. 

11-92 M 60-3-0024 e / printed 06.2010 



Modules - NMI 

An overview of the system: 

 

Note: 
• Before using NMI, familiarize yourself with the basic functions of the 

AxioVision software. You should be familiar with the operation of the 
camera and microscope components in particular. 
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The operating concept of NMI is designed to make it possible to achieve a 
reproducible result with as little interaction as possible. The performance of a 
measurement can be automated to such an extent that only the project data 
need to be entered and the entire analysis process can run automatically.  

To automate a measurement completely, you need extensive knowledge of 
systems engineering and the respective application. Carelessly made 
alterations of a setting can promptly lead to faulty measurement results. It is 
important, therefore, to prevent users not having such knowledge from 
changing the basic settings. This is achieved by dividing up the tasks involved 
into the definition of a measurement and the performance of a measurement. 

The performance of a measurement is always based on what is called test 
specification. All important settings are saved in a test specification. A test 
specification cannot be created or edited by a user. This is reserved to Power 
Users or Administrators. Access to the respective functions is governed by the 
access rights of the operating system: 
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Dialog for starting an NMI Analysis Dialog for editing a test specification 
(not available to standard users) 
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The configuration data of a measurement are saved to so-called test 
specification. A test specification contains all the information on the 
performance of an NMI analysis in detail: from the configuration of the device 
and the type of image acquisition through to the determination of the size of 
the original data to be saved. 

The test specifications are saved to the archive, together with the 
measurement projects, but they are not visible in the archive window. They 
can only be modified via the Manage Test Specification function. 

Data are saved and managed in a project-based archive. All the data 
generated (images, data tables, reports etc.) are saved by project: 

 

 Archive View 
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General 

The functionality of the NMI module is based on the basic functionality of 
AxioVision. Before you can work with NMI, you must, therefore, configure the 
basic settings for AxioVision. You will find further information you require in 
Section 8 "Configuration" of this manual. 

Microscope configuration 

To be able to use your microscope together with AxioVision, you need to 
define once your individual system configuration via the separate MTB2004 
Configuration program. Should you be retrofitting NMI to your existing 
microscope system, you may have to do this configuration via the 
Microscope Configuration program. 

The configuration programs have their own icons and buttons on your 
Microsoft Windows Desktop: 

   

Note: 
• For detailed information, see Chapter 4 "Microscope Control". 
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Please make sure that the following settings have been made: 

Alignment of camera and motorized stage 

If you wish to acquire images of large areas using the MosaiX module, you 
must ensure that the camera and stage are aligned correctly with one another 
and that the stage’s direction of movement has been set correctly. Otherwise 
the individual component images will not be put together properly. The 
aligning and setting process may take quite some time with conventional 
camera adapters; therefore it is recommendable to use the adjustable Carl 
Zeiss camera adapter: 

  

Note: 
• For detailed information, see Chapter 9.7 "MosaiX" – "Setting up the 

camera and scanning stage"). 

 Scalings: Measurement in real units (e.g., µm) is only possible if there 
exist scaling files. Although AxioVision has a capability to compute a 
theoretical scaling on the basis of the current system configuration, it is 
urgently recommended to create, for measurement tasks, an individual 
scaling file by means of a stage micrometer. 

Note: 
• For detailed information, see Chapter 8.4 "Scalings". 
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User settings 

Select the User tab in the Tools ⇒ Options menu. Enter the information 
about the respective user and select your corporate logo. This information is 
administrated separately for each user. It is saved to the archive for each 
project or each measurement and, by way of default, used for the reports.  

Note: 
• For detailed information, see Chapter 8.6 "General settings". 

Configuration of the user interface 

AxioVision offers an extremely wide range of options with regard to user-
specific configuration. In particular, the fact that the interface is structured as 
simply as possible means that even inexperienced users are able to use the 
system to achieve accurate results both quickly and easily. 

It is recommendable to hide all controls not used for the purpose. For routine 
measurements, you usually need only the NMI workflow. 

Notes: 
• To show the main menu again, click the right mouse button on the title 

bar of the AxioVision window, or on a toolbar. This opens a context menu 
in which you can display everything again. 

• For detailed information, see Chapter 8.5 "Adapting the user interface". 

péÉÅá~ä=ëÉííáåÖë=Ñçê=kjf=

Creating an archive 

The database of NMI constitutes an archive. All data (images, measurement 
data tables, reports, etc.) are saved to this archive in a project-related order. 
To be able to work with the NMI module, therefore, an archive must exists 
and be opened in AxioVision. 
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Opening the NMI archive when starting AxioVision 

To start AxioVision always with the desired archive, you should establish a 
shortcut to the archive on the Microsoft Windows desktop: 

 Click the right mouse button on a free area on the desktop, and select 
New ⇒ Shortcut: 

 

 This opens the dialog Create Shortcut. Click on Browse… and select 
the NMI Archive (file extension *.zva): 
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 Click on Next and, in the next step, enter a name for the link. 

 To create the link, click on Finish. 

Administrating several users 

The user management of AxioVision is directly based on that of the operating 
system. Each user with access rights works under a different AxioVision 
configuration. This means that, e.g., the configuration of the user interface, 
the entry of user data, etc., are managed separately for each user. 

Notes: 
• For detailed information on user and data management, see Chapter 8.3 

"User and data administration". 

• If you use a common account for all users but wish to use different 
configurations nevertheless, proceed as described in the following 
section.  
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Separation of Particle Analysis and standard AxioVision 

It is a strong point of NMI that the system is completely based on the standard 
AxioVision software. Therefore, it can also be used for simple documentation 
jobs or other applications such as, e.g., particle analysis or analysis of non 
metallic inclusions in steel. To start AxioVision always with a special, 
application-specific configuration (e.g., specific toolbars, workflows, etc.), you 
can establish any number of links with separate icons on the Microsoft 
Windows Desktop. 

Note: 
• For detailed information on the creation of configurations, see Chapter 

8.8 "Creating various AxioVision configurations for a user". 

`êÉ~íáåÖ=íÉëí=ëéÉÅáÑáÅ~íáçåë=

dÉåÉê~ä=

In test specification, all settings and files for performing an NMI analysis are 
saved. All subsequent NMI analysis always are based on a test specification. 
When you start a measurement you are prompted to select the desired test 
specification first before you can actually start the measurement. 
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The test specifications are managed via the Manage Test Specification 
dialog: 

  

In the Manage Test Specifications dialog you can edit, create and delete 
test specifications. Further, you can import and export test specifications. 
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fãéçêíáåÖ=~åÇ=ÉñéçêíáåÖ=íÉëí=ëéÉÅáÑáÅ~íáçåë=

To make the preparation and setup for NMI Analysis as easy as possible, you 
can simply import existing test specifications for special applications and use 
them right away. 

This is especially helpful if measurements are to be made in different places 
but with exactly the same specifications. Test specifications once created 
centrally can then be imported on any number of systems installed. 

Clicking the Import/Export… button starts the wizard that guides you 
through all the necessary steps: 
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qÜÉ=`Ü~åÖÉ=qÉëí=péÉÅáÑáÅ~íáçå=Çá~äçÖ=

Test specifications are created via the Change Test Specification function. 
All the dialogs used to set up an NMI analysis are called up via this dialog: 

  

 Dialog for changing a test specification 

Each individual step can be modified entirely. The relevant dialog can be 

opened using the button . Here again you can, for each single item 
required for creating a test specification, load settings already existing in 
another template. For the management of template files, use the buttons on 

the right of the respective creation items: . 
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Thus, you can directly copy device settings, settings of the image source, input 
forms, etc. from existing test specifications into the current test specification 
you are creating. Further, you can save your own settings to a new test 
specification in order to use them in further test specification. 

The following chapters describe the procedure step by step. 

qÉëíáåÖ=íÉëí=ëéÉÅáÑáÅ~íáçåë=

If you want to test whether the settings of a test specification really produce 
the desired results, you can click on the Execute… button to run a complete 
measurement without having to create a project in the archive. It is important 
that you perform this step with a real sample, because all settings made in the 
functional dialogs during the test run are adopted by the test specification. 

Segmentation threshold settings for detecting inclusions, in particular the 
threshold values for sulfides, oxides and titanium nitrides, are especially 
important here, for example.  

e~êÇï~êÉ=ëÉííáåÖë=

The settings of microscope and camera are decisive for the reproducibility of 
measurements. Measurements will yield the same results only if they are 
always made with the same parameters. With the hardware settings you can 
ensure that you are always using the same hardware configuration before you 
start NMI Analysis. This is conditional on the use of motorized microscopes or 
microscope components, and digital cameras. These can be completely 
controlled via the software. 

The most important settings include, e.g., the objective to be used, the 
brightness adjustment, the used contrasting method, camera resolution, 
exposure time, camera mode, etc. 
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Example: Setting the camera mode (color, gray levels) 

The camera setting has a decisive influence on the size of your files. Given the 
memory capacity of modern computers, the use of color images is considered 
a standard feature. However, color images require three times as much 
memory space as gray scale images. In most cases, though, color information 
is not required for the detection of inclusions; therefore, images should be 
acquired as gray scale images. This setting can be made in the camera control 
dialog, and it can be changed there by every user: 

  

By including the camera mode in the hardware settings you can ensure that 
you are always acquiring gray level images for a measurement, irrespective of 
the actual settings of the camera: 

 

If hardware settings have been activated, these can be checked immediately 
before the measurement on the sample to be measured.  
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fã~ÖÉ=ëçìêÅÉ=

The image source defines where the image comes from. If you have already 
acquired images that you wish to analyze, select folder or gallery as the image 
source. In most cases, however, an image is acquired and analyzed 
immediately. When you are acquiring images of large surfaces using the 
mosaic technique, the size and position of the acquisition region are defined 
using the MosaiX module’s Setup function. To do so select the Acquisition 
option. 
To ensure unmistakable repositioning in the acquisition of MosaiX images, the 
z focus and the x and y settings of the motorized stage are calibrated after 
every restart of AxioVision.  

fåéìí=Ñçêãë=

Input forms allow the user to enter the necessary project and sample data 
during the measurement. You can freely define the data that you want to be 
entered. The necessary fields and their link to the archive are defined in layout 
mode. Layout mode is active as soon as editing is started.  
The module includes two input forms: the project-specific input form and the 
sample-specific input form. The project-specific input form is displayed 
immediately after the measurement. It is used for entering general project 
data. The sample-specific input form, on the other hand, is not displayed until 
the data are saved in the archive. The number of times that it is opened 
corresponds to the number of samples you have measured. In this form you 
enter data relating to the individual sample, e.g. sample name or material. 

  

 Standard input form for project data 
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 Standard input form for sample data 

Note: 
 For detailed information on editing form templates, see Chapter 7.4 

"Templates for forms and reports". 

bî~äì~íáçå=ëÅêáéí=

General 

An evaluation script defines which image-processing steps will be performed 
in which sequence. It is not normally necessary to change the evaluation 
script. You can choose which functions will be executed interactively, i.e. 
which functions will be opened while a measurement is being performed to 
allow the user to adjust parameters. 

Notes: 
• In order to display and modify the evaluation script, you will need the 

Commander module. The Commander module however is NOT required 
for executing NMI Analysis. 

• Since modification of the evaluation script has dramatic consequences 
with regard to the quality of the analysis, this should only be performed 
by experienced users. It is essential that you read the "Commander" 
section and the information in the online help before making any 
modifications. 
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• The evaluation scripts are not managed in the usual standard AxioVision 
folders. The New and Rename buttons are therefore inactive. The Save 
button only becomes active once you have made changes to the script. 

  

Adapting the evaluation script 

As long as you do not insert or delete any commands, you can modify the 
behavior of the script simply by switching the commands on the Commands 
tab on and off. 
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You can incorporate any functions available in AxioVision into the script. After 
doing so, however, you must ensure that the input and output documents are 
correctly linked. 

  

The multiphase segmentation and its settings should not, however, be deleted 
or changed under any circumstances.  
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jçÇáÑóáåÖ=êÉéçêí=íÉãéä~íÉë=

In order to print the results of a measurement clearly, it is possible to structure 
the appearance of the results report individually. A report template may only 
be modified during the creation/editing of each test specification and is, 
therefore, not accessible for standard users. The predefined template is always 
used when you perform a measurement. 

Note: 
• For detailed information, see Chapter 6.4 "Creating data reports". 

léíáçå~ä=ëÉííáåÖë=

General 

With optional settings you define essentially the following items: 

 Selection of the data to be saved (above all, image data) 
 Behavior during image acquisition 
 Presentation of result data after the measurement 

It is imperative that you consult the Online Help function for information on 
details of the parameters that can be set. 

Memory space required 

The quantity of data obtained in NMI is sometimes enormous, especially when 
you acquire large images using the MosaiX module. The table below shows 
the memory requirements for different conditions: 

Image size in MB* 
Pixel scaling used 

Gray scale image Color image 

1.0 µm / pixel 1450 4350 

2.5 µm / pixel 232 696 

5.0 µm / pixel 58 174 

10.0 µm / pixel 15 44 
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You should carefully consider which original data should actually be saved. 
Among others, the two factors outlined below may be a basis for decision: 

 If you want to ensure that a measurement can be reproduced at any time, 
you need to save the original data as they are. It is not permissible in this 
case to scale down the original image or to save it in a compressed 
format. 

 If you want to save the original image for documentation purposes, you 
should consider whether a scaled down version could be saved in a 
compressed format (e.g., ZVI or JPG). This will considerably reduce the 
amount of image data, but they will not be suitable for subsequent 
measurements. 

Number of gray levels or color values of the images acquired 

Another important consideration is the bit depth, i.e. the number of gray 
levels or color values used for image acquisition. In the past, the entire 
brightness or color range was captured 256 different gray levels (8 bit). Most 
modern digital cameras have more than 256 gray levels. But here, too, this 
means that the resulting image data files are exceedingly large; the great 
number of gray levels (possibly more than 65,000) is not needed for a 
measurement. It is possible, therefore, to enforce reduction to 256 gray levels: 

  

 Conversion of acquired images to 8 bit 

Note: 
• If only sulfides and/or oxides are analyzed, a gray scale image is normally 

perfectly sufficient. In order to distinguish between sulfides and titanium 
nitrides, however, color images are required. 
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mÉêÑçêãáåÖ=ãÉ~ëìêÉãÉåíë==

A measurement is performed via the Start NMI Analysis function in the NMI 
workflow: 

  

An NMI analysis is always based on a previously defined test specification. This 
must have been created by a qualified user. No measurement can be started 
until a test specification has been created. 

During the course of the measurement, the function dialog for which the 
Interactive mode has been selected in the evaluation script will be displayed. 
All other functions run automatically in the background. 
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The program will stop at each function for which Interactive has been 
selected and the corresponding dialog will open. The predefined parameters 
can then be modified and optimally adapted to the image in question. 

The functions that are carried out interactively feature the additional 
parameter Always interactive during the execution of the program. This 
allows the user to decide whether or not the dialog should be opened again 
for the next image. This is particularly useful if you have set segmentation 
thresholds, for example, and do not need to modify them again for 
subsequent images. The thresholds can therefore be set using one or more 
images and then applied automatically. 

This option is useful if you are measuring several images immediately after 
each other. Otherwise, this setting does not have any impact on the running 
of the program. 

qÜÉ=êÉëìäíë=ÇçÅìãÉåí=

At the end of the measurement the results window is displayed. This is divided 
into three areas: 

 Results view 
 Gallery of images of the largest inclusions 
 Gallery of unlikely inclusions 

In this document the measurement results for each sample and each standard 
are displayed separately. It is possible to view the results for a different 
standard or sample here. 

The results window is divided into different property pages. The Results, 
Data property page shows the numerical values with a classification table, 
statistical values and an overview chart. The Gallery of largest inclusions 
property page shows the gallery containing images of the largest inclusions 
and allows the repositioning of objects and artifacts to be deleted. The 
Gallery of unlikely inclusions property page shows objects with properties, 
which are unlikely for inclusions. 
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The results view 

 

Results document with results view 

The document is essentially divided into three areas: 

1. Chart 
2. Classification tables 
3. Statistics  
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The gallery of images of the largest inclusions 

This gallery shows the largest inclusions. It is possible to filter the gallery 
according to inclusion type (sulfides, oxides) or display it for all inclusion types. 
In addition, in all standards (except EN 10247) it is possible to display the 
worst field for each inclusion type.  

If the sample is still under the microscope and has not been changed, the 
inclusion can be repositioned. This means that, if you click on the Edit 
Inclusion button, the microscope stage is moved in such a way that you are 
able to view the currently highlighted inclusion directly in the live image or 
through the eyepiece. If you establish that this object is an artifact, you are 
also able to delete it.  

 

Results document with gallery of the largest inclusions 
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The gallery of unlikely inclusions 

This gallery shows objects that are "unusual". Scratches, for example, are 
filtered out on the basis of their angle. However, as it is also possible for 
inclusions to have unusual forms or angles, automatic filtering of artifacts is 
not sensible. Instead, all objects to which the parameters apply are collected in 
a gallery and presented to the user following the measurement. The user is 
then able to decide whether they are inclusions or artifacts. The parameters 
can be changed under Change Test Specification. 

 

Results document with gallery of unlikely inclusions 
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dÉåÉê~íáåÖ=êÉéçêíë=

Reports are generated separately for each standard. It is also possible to 
combine several samples in a single report on the basis of a particular 
standard. There are no restrictions with regard to either the number of reports 
or the combination options. This means that you can measure the samples of 
several customers or from several casts using a single measurement but 
nevertheless generate a separate report for each case. 
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eçï=Çç=f=ÅêÉ~íÉ=~å=kjf=~êÅÜáîÉ\=

The NMI Archive forms the basis for managing the data resulting from NMI 
analysis. All the data relating to the performance of a measurement are 
managed here. In order to perform a measurement, it is necessary for an 
archive to be opened in AxioVision. The creation and opening of an archive 
are therefore shown first. 

 Select the New function in the File menu. 

 On the Archives tab sheet, select the Material Analysis Archive and 
then click OK. 

  

 The SQL based Archive dialog window will appear. Enter a name for the 
archive in the Name input field and confirm by clicking on OK. 
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Notes: 
• An archive is created in the My Documents\My Pictures folder by default. 

If you wish to save the archive elsewhere, click on the  button. Select 
the location where you wish the archive to be saved in the Microsoft 
Windows standard dialog that then opens.  

• In the case of large data volumes in particular, we recommend that you 
save the archive to a local hard drive.  

• Only one archive can be opened at a time in AxioVision. 

The newly created archive is now displayed in AxioVision.  
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Opening an archive 

 Click on the Open icon in the menu bar and then on the Open Archive 
function: 

  

eçï=Çç=f=ÅêÉ~íÉ=~=íÉëí=ëéÉÅáÑáÅ~íáçå\=

The test specification contains all the settings required for performing a 
measurement.  

 From the workflows, select the NMI workflow.  

 Click on the Manage Test Specifications function. 
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This opens the Manage Test Specifications dialog. 

  

 Select the test specification that you wish to use as a basis for the new 
test specification. If you have not yet created a test specification, you can 
select one of the standard test specifications.  

Note: 
• In the Create New Test Specification mode, a copy is generated of the 

selected test specification, which you can then adapt. The original test 
specification that is used is not changed. If you only wish to make a 
modification to the test specification, change to the Modify Existing 
Test Specification mode. The standard templates of NMI analysis cannot 
be changed, but only used as the basis for a new test specification.  
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 Click on the Change Test Specification button. This opens the Change 
Test Specification dialog. 

  

 You can now save the hardware settings, select the image source, set 
options or edit the input form and report template. It is recommended, 
however, that you modify the report template after running the program, 
because measurement data are then available. The report editor is 
displayed automatically after running the program.  

Notes: 
• You will find more detailed information about the hardware settings in 

Chapter 4.5 "Settings Editor" of this manual. 

• You will find more detailed information on modifying form templates in 
Chapter 7.4 " Templates for forms and reports" of this manual. 

• You will find more detailed information on editing a report template in 
Chapter 6.4 " Creating Data Reports" of this manual. 
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 Once you have made all the necessary settings, click on the  
button. The individual steps of the evaluation script are now run through, 
followed by an NMI measurement. Here you can test When you have 
made all the necessary settings, leave the Change Test Specifications 

dialog by clicking on the  button. 

 Save the test specification by clicking on the  button. This 
opens the Save Test Specification dialog. You can enter a name and a 
description of the test specification here. A description helps the user 
when starting the measurement, as he is unable to open the Manage 
Test Specifications area and does not, therefore, see the settings that 
have been made there.  

eçï=Çç=f=ëÉí=ìé=áã~ÖÉ=~Åèìáëáíáçå=Ñçê=ëÉîÉê~ä=
ë~ãéäÉë\=

Create a test specification and open the Change Test Specification dialog.  

Select Image Acquisition as the image source. 

  

To set up image acquisition, now click on the  button.  

First of all, calibration is performed. This is required in order for exact 
repositioning to be guaranteed. During this process the z-focus and the 
scanning stage are each calibrated once in the x and y direction. This 
calibration is only performed if necessary (e.g. if the microscope is restarted). 
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The Definition Image Acquisition dialog opens. 

 

To add a sample, move to the top left-hand corner of your sample using the 
scanning stage and click on the Add New Position button. 
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The MosaiX Acquisition - Setup dialog is opened. This contains a MosaiX 
grid with 2x2 tiles. The top left-hand tile is the section of the image that was 
visible in the live image in the previous dialog. 

 

Note: 
• You can obtain detailed information on the individual functions of the 

dialog in the online help (F1 key). 
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Move to the bottom right-hand corner of the sample using the scanning stage 

and click on the  button. This extends the size of the MosaiX image to the 
selected position. 

 

Now define the focus correction points. To do this, first select the Correct 
Focus Position property page. In the case of samples that have been 
prepared using modern preparation machines, the following positions are 
recommended for the focus correction points: 

11-128 M 60-3-0024 e / printed 06.2010 



Modules - NMI 

 

Schematic image of the recommended focus position. The red bordered positions are 
the default positions which should be selected in any case. The other points should be 
selected if the default positions are not sufficient for focusing. 

Confirm the settings by clicking on OK. The Definition Imagr Acquisition 
dialog then becomes active again. 

In order to define another sample, move to the top left-hand corner of this 
sample. Clicking on the Add New Position button moves the MosaiX grid to 
the new position. The focus correction points are also moved relative to this. 
The current focus position is adopted as the z-position.  

Check the MosaiX definition by locating all corners of the MosaiX with the 
help of a double-click on the corner points. If the sample is the same size as 
the first one, you can adopt the settings using the OK button. If it is not the 
same size, you can adjust the MosaiX definition using the following buttons: 

, , ,  ,   and . You must then also adjust the focus 
correction points, if necessary. 
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Note: 
• In order to acquire MosaiX images of different sizes, the Allow different 

MosaiX size option must be activated. If this is not active, the image size 
of the last position will be adopted for all other positions. 

Once you have defined all the positions, exit the Definition Image 
Acquisition dialog by clicking on the OK button, close the Change Test 
Specification dialog, also by clicking OK, and save the test specification by 
clicking on the Save button. 
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NNKS dê~áåë=

In the Grains module, the grain size is determined in accordance with current 
international standards. Three methods are available for determining grain 
sizes: 

 Auto: automatic reconstruction of the grain boundaries 
 Chord: determination of the grain size using the intercept method 
 Compare: comparison of micrographs with comparative diagrams 

These methods differ in terms of their accuracy and in the level of interaction 
with the user. Starting from Compare, a purely interactive method, the 
accuracy increases with the semi-automatic Chord method and increases still 
further with the Auto method, but the duration of the analysis can increase 
too. The visibility of the grain boundaries also plays a role in the selection of 
the method. 

The Compare method 

The micrograph is compared with the comparative diagrams. This method is 
primarily suited to steels, as the comparative diagrams have been created on 
the basis of steels. This is a purely interactive method. The following 
comparative diagrams are available: 

 SEP151061: microscopical grain size analysis of steel samples with help of 
tables using different Grain sizes (1-8) and stretch factors (1,2,4). 

 ASTMIA: is for coarse grains, grain size 0-2.5. 

 ASTMIB: is for finer grains, grain sizes 3-10. 

 ASTMII: is used in cases when twin grains are seen in grains (flat etch), 
grain size 1-8. 

 ASTMIII: is the alternative to ASTMII (contrast etch versa flat etch), grain 
sizes 0.005-0.2 mm 

 ASTMIV: is used to evaluate austenitic grain structures in steel, grain sizes 
1-8. 

 BS4990: this image series is used for fine grain sizes (grain sizes 1 to 8). 
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The Chord method 

The micrograph is overlaid with a pattern. It is possible to choose between 
different patterns here. The size of the pattern and distance between the lines 
are then adjusted to the image. The intercept points with the grain 
boundaries are marked. Additional intercept points can be added or removed 
interactively. As the length of the pattern of lines is known, it is possible to 
determine the average grain size. This procedure, in particular the adjustment 
of the pattern of lines to the size of the image and the setting of the distance 
between the lines, corresponds to the requirements of the standard and the 
method is suitable for all sample types. 

The analysis takes place in accordance with the following standards: 

 ASTM E 112 
 ASTM E 1382 
 DIN EN ISO 643 

The Auto method 

The grain boundaries are reconstructed automatically and the individual grain 
sizes determined. Using this method the grain size distribution is also available 
in addition to the average grain size. This method is most suitable for samples 
with grain boundaries that are comparatively easy to detect. 

The analysis takes place in accordance with the following standards: 

 ASTM E 112 
 ASTM E 1382 
 DIN EN ISO 643 

Other, regional names are also available for DIN EN ISO 643. 

All data are saved and managed in one place – the archive – which has search 
and filter functions. This ensures that the data can be relocated easily. 

The operating concept of Grains is described below. This is followed by a 
practical section that provides step-by-step instructions in relation to the 
individual points. 
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Note: 
• For detailed information on the individual functions and commands, 

please refer to the online help (F1 key). 

qÜÉ=ÅçåÅÉéí=

The operating concept of Grains is designed to make it possible to achieve a 
reproducible result with as little interaction as possible. The performance of a 
measurement can be automated to such an extent that only the project data 
need to be entered and the entire analysis process can run automatically.  

To automate a measurement completely, you need extensive knowledge of 
systems engineering and the respective application. Carelessly made 
alterations of a setting can promptly lead to faulty measurement results. It is 
important, therefore, to prevent users not having such knowledge from 
changing the basic settings. This is achieved by dividing up the tasks involved 
into the definition of a measurement and the performance of a measurement. 
For this reason, the operation of Grains is essentially divided into two 
functional areas: 

 administrator mode (definition of a measurement) 
 user mode (performance of a measurement) 

Administrator mode 

A measurement is always based on a test specification, which is created in the 
administrator mode. All the key settings required for a grains analysis are 
saved here. This test specification may only be created or modified by principal 
users or administrators. Here, the administrator can also specify whether or 
not certain parameters may be changed by the user. A standard user has no 
access to the management of test specifications. Access to the corresponding 
functions is controlled by means of the access rights of the operating system. 

User mode 

In the user mode, measurements can be performed on the basis of a test 
specification. The administrator determines to what extent the user may 
change the measurement parameters.  

AxioVision User's Guide, Release 4.8.2 11-133 



Modules - Grains 

léÉê~íáçå=~åÇ=ÅçåÑáÖìê~íáçå=

mêÉé~êáåÖ=íÜÉ=ëóëíÉã=

General 

The functionality of the Grains module is based on the basic functionality of 
AxioVision. Before you can work with Grains, you must, therefore, configure 
the basic settings for AxioVision.  

Note: 
• You will find further information you require in Section 8 "Configuration" 

of this manual. 

Microscope configuration 

The microscope is controlled with the help of the separate MTB 2004 
Configuration program. In order to use your microscope together with 
AxioVision, your individual system configuration must first be defined via this 
separate program. If you upgrade a pre-existing system for grains analysis, the 
configuration may take place via the Microscope Configuration program. 

The configuration programs have their own icons and buttons on your 
Microsoft Windows Desktop: 

   

Note: 
• For detailed information, see Chapter 4 "Microscope Control". 
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Scalings 

Measurement in real units (e.g., µm) is only possible if there exist scaling files. 
Although AxioVision has a capability to compute a theoretical scaling on the 
basis of the current system configuration, it is urgently recommended to 
create, for measurement tasks, an individual scaling file by means of a stage 
micrometer. 

User settings 

Select the User tab in the Tools ⇒ Options menu. Enter the information 
about the respective user and select your corporate logo. This information is 
administrated separately for each user. It is saved to the archive for each 
project or each measurement and, by way of default, used for the reports.  

Note: 
• For detailed information, see Chapter 8.6 "General settings". 

Configuration of the user interface 

AxioVision offers an extremely wide range of options with regard to user-
specific configuration. In particular, the fact that the interface is structured as 
simply as possible means that even inexperienced users are able to use the 
system to achieve accurate results both quickly and easily. 

It is recommendable to hide all controls not used for the purpose. For routine 
measurements, you usually need only the Grains workflow. 

Notes: 
• To show the main menu again, click the right mouse button on the title 

bar of the AxioVision image window, or on a toolbar. This opens a 
context menu in which you can display everything again. 

• For detailed information, see Chapter 8.5 "Adapting the user interface". 
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Administrating several users 

The user management of AxioVision is directly based on that of the operating 
system. Each user with access rights works under a different AxioVision 
configuration. This means that, e.g., the configuration of the user interface, 
the entry of user data, etc., are managed separately for each user. 

Notes: 
• For detailed information on user and data management, see Chapter 8.3 

"User and data administration". 

• If you use a common account for all users but wish to use different 
configurations nevertheless, proceed as described in the following 
section.  

Grains and other AxioVision applications 

One of AxioVision’s particular strengths is its modular structure. Each module 
is added directly onto the basic system. This means that the system can also 
be used for simple documentation tasks or other applications such as particle 
analysis or multiphase analysis. To ensure that AxioVision always starts with a 
particular configuration specific to the application (e.g. specific toolbars, 
workflows, etc.), any number of configurations can be started via individual 
icons on the Microsoft Windows desktop. 

Note: 
• For detailed information on the creation of configurations, see Chapter 

8.8 "Creating various AxioVision configurations for a user". 

qÜÉ=j~íÉêá~ä=^å~äóëáë=~êÅÜáîÉ=

Data are saved and managed in an archive. There, all data (images, 
measurement data tables, reports, etc.) are saved by project.  

The test specifications are also saved in the archive together with the 
measurement projects. These are not visible in the archive window, and can 
only be modified using the Manage Test Specifications function. 
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There are several types of archive in AxioVision. Besides the folder and asset 
archive, there are also specific archives for certain modules. The Material 
Analysis archive is intended for Grains. The measurements of the AxioVision 
Multiphase, Graphite and/or Comparative Diagrams modules can also be 
stored in this archive.  

In order to work with the Grains module, an archive must therefore exist and 
be opened in AxioVision. 

Note: 
• The grains analysis can only be performed in the Material Analysis 

archive. No other types of archive are suitable for this!  

  

 Archive View 
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Opening the Material Analysis Archive when starting 
AxioVision 

To start AxioVision always with the desired archive, you should establish a 
shortcut to the archive on the Microsoft Windows desktop: 

 Click the right mouse button on a free area on the desktop, and select 
New ⇒ Shortcut: 

  

 In the Create Shortcut dialog that follows, select the Material Analysis 
archive (extension *.zva) by clicking on the Browse… button: 

  

 Click on Next and, in the next step, enter a name for the shortcut. 

 To create the shortcut, click on Finish. 
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All settings and configuration data are saved in test specifications. These 
therefore contain all the information required for performing a grains analysis: 
from the configuration of the hardware and the origin of the images through 
to the definition of the report. All measurements performed at a later date are 
based on a test specification. When starting a measurement, the user is 
prompted to select the desired test specification. Only then can the 
measurement be started.  

Via the Manage Test Specifications dialog, test specifications can be 
modified, created or deleted. It is also possible to import and export test 
specifications. This dialog is only available to users who are logged on to 
Microsoft Windows as principal users or administrators.  
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fãéçêíáåÖ=~åÇ=ÉñéçêíáåÖ=íÉëí=ëéÉÅáÑáÅ~íáçåë=

To make the preparation and setup for grains analysis as easy as possible, you 
can simply import existing test specifications for special applications and use 
them right away. 

This is especially helpful if measurements are to be made in different places 
but with exactly the same specifications. Test specifications once created 
centrally can then be imported on any number of systems installed. 

Clicking the Import/Export… button starts the wizard that guides you 
through all the necessary steps: 

 

11-140 M 60-3-0024 e / printed 06.2010 



Modules - Grains 

jçÇáÑó=qÉëí=péÉÅáÑáÅ~íáçåë=

Test specifications are created via the Change Test Specification function. 
All the dialogs used to set up a grains analysis are called up via this dialog: 

  

 Dialog for adapting and changing a test specification 

Each individual step can be modified. The relevant dialog can be opened using 

the button .  

Here again you can, for each single item required for creating a test 

specification, load  and save  settings already existing in another 
template. 

Thus, you can directly copy hardware settings, settings of the image source, 
input forms, etc. from existing templates into the current test specification 
you are creating. Further, you can save your own settings to a new template 
in order to use them in further test specification. 

The following chapters describe the procedure step by step. 
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e~êÇï~êÉ=ëÉííáåÖë=

The settings of microscope and camera are decisive for the reproducibility of 
measurements. Measurements will yield the same results only if they are 
always made with the same parameters. With the hardware settings you can 
ensure that you are always using the same hardware configuration before you 
start a measurement. This is conditional on the use of motorized microscopes 
or microscope components, and digital cameras. These can be completely 
controlled via the software. 

In case of manual microscopes you need to do the correct settings manually. 
So-called coded components require a mixed approach. Their current statuses 
can be checked by the software, but the correct setting has to be done 
manually as required. If you are using coded components, the system will 
warn you if a setting is faulty and prompt you to establish the correct 
configuration. 

The most important settings include, e.g., the objective to be used, the 
brightness adjustment, the used contrasting method, camera resolution, 
exposure time, camera mode, etc. 

Note: 
 For detailed information on hardware settings, see Chapter 4.5 "The 

Settings Editor". 

fã~ÖÉ=ëçìêÅÉ=

The image source defines where the image comes from. If you have already 
acquired images that you wish to analyze, select Folder or Gallery as the 
image source. In most cases, however, when an image is acquired and 
analyzed immediately, use the Camera setting as the image source.  
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fåéìí=Ñçêãë=

Input forms allow the user to enter the necessary project and sample data 
during the measurement. You can freely define or adapt the data that you 
want to be entered. The necessary fields and their link to the archive are 
defined in layout mode. Layout mode is active as soon as editing is started.  

  

 Standard input form for project data 

Note: 
 For detailed information on editing form templates, see Chapter 7.4 

"Templates for forms and reports". 
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jçÇáÑóáåÖ=êÉéçêí=íÉãéä~íÉë=

In order to print the results of a measurement clearly, it is possible to structure 
the appearance of the results report individually. A report template may only 
be modified during the creation/editing of each test specification and is, 
therefore, not accessible for standard users. The predefined template is always 
used when you perform a measurement. 

Note: 
• For detailed information, see Chapter 6.4 "Creating data reports". 

léíáçåë=Ó=^ìíç=

In the options, you specify the settings relating to the standard and the 
classification.  It is possible to specify a lower limit for the classification. A 
more refined classification in half steps is also possible. 

léíáçåë=Ó=`ÜçêÇ=

Here you mainly select the standard on which the measurement should be 
based. It is also possible to preselect the other parameters here.  However, 
these can still be adjusted during the measurement procedure.  

qÜÉ=ãÉ~ëìêÉãÉåí=éêçÅÉÇìêÉ=

You can specify the measurement procedure by clicking on the Run button. 
This opens a wizard that guides you through the individual steps. All possible 
steps relating to image preparation, segmentation and classification are 
displayed here.  
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A measurement is performed via the Start Grains Analysis function in the 
Grains workflow: 

   

A live image is then shown which you can use to help check the hardware 
settings.  

A grains analysis is always based on a previously defined test specification. 
This must have been created by a qualified user. No measurement can be 
started until a test specification has been created. 
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During the course of the measurement, the function dialog for which the 
Interactive mode has been selected in the evaluation script will be displayed. 
All other functions run automatically in the background, if the check box 
Execute is selected. 

The program will stop at each function for which Interactive has been 
selected and the corresponding dialog will open. The predefined parameters 
can then be modified and optimally adapted to the image in question. The 
functions that are carried out interactively feature the additional parameter 
Always interactive during the execution of the program. This allows the 
user to decide whether or not the dialog should be opened again for the next 
image. This is particularly useful if you have set segmentation thresholds, for 
example, and do not need to modify them again for subsequent images. The 
thresholds can therefore be set using one or more images and then applied 
automatically. 

This option is useful if you are measuring several images immediately after 
each other. Otherwise, this setting does not have any impact on the running 
of the program. 

qÜÉ=êÉëìäíë=ÇçÅìãÉåí=

At the end of the measurement the results window is displayed. Here, the 
results are displayed in the form of a table for all the images measured, as 
well as the image of the sample currently selected. Below the images are 
three tabs which you can use to switch between the input, output and 
processed image. If the image has been processed using image enhancement 
methods (e.g. sigma filter), you can therefore see the effect if you switch 
between the input and processed image.  
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dÉåÉê~íáåÖ=êÉéçêíë=

The data are not saved directly in a report, but are only displayed there. This 
avoids data being saved twice. As a result, the data must first be saved in the 
archive. Then you can generate the report, which, immediately upon being 
generated, is also saved automatically in the archive. Provided you do not 
delete any of the tables or images from the archive, the data are also 
displayed in the report. In order to display the report on other PCs too, you 
can export the report into PDF or RTF format (File menu ⇒ Save as PDF or 
Save as RTF). 
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Now that the theoretical principles have been explained above, below you will 
find step-by-step instructions for creating and performing a grains analysis. 

eçï=Çç=f=ÅêÉ~íÉ=~å=~êÅÜáîÉ\=

The Material Analysis Archive forms the basis for managing the data resulting 
from grains analysis. All the data relating to the performance of a 
measurement are managed here. In order to perform a measurement, it is 
necessary for an archive to be opened in AxioVision. The creation and opening 
of an archive are therefore shown first. 

 Select the New function in the File menu. 

 On the Archives tab sheet, select the Material Analysis Archive and 
then click OK. 

  

The SQL based Archive dialog window will appear. Enter a name for the 
archive in the Name input field and confirm by clicking on OK. 
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Notes: 
• An archive is created in the My Documents\My Pictures folder by default. 

If you wish to save the archive elsewhere, click on the  button. Select 
the location where you wish the archive to be saved in the Microsoft 
Windows standard dialog that then opens.  

• In the case of large data volumes in particular, we recommend that you 
save the archive to a local hard drive.  

• Only one archive can be opened at a time in AxioVision. 

The newly created archive is now displayed in AxioVision.  
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Opening an archive 

 Click on the Open icon in the menu bar and then on the Open Archive 
function: 

  

eçï=Çç=f=ÅêÉ~íÉ=~=íÉëí=ëéÉÅáÑáÅ~íáçå\=

The test specification contains all the settings required for performing a 
measurement.  

 From the workflows, select the Grains workflow.  

 Click on the Manage Test Specifications function. 
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This opens the Manage Test Specifications dialog. 

  

 Select the test specification that you wish to use as a basis for the new 
test specification. If you have not yet created a test specification, you can 
select one of the standard test specifications "Auto", "Chord" or 
"Compare", depending on which measurement method you require.  

Note: 
• In the Create New Test Specification mode, a copy is generated of the 

selected test specification, which you can then adapt. The original test 
specification that is used is not changed. If you only wish to make a 
modification to the test specification, change to the Modify Existing 
Test Specification mode. The standard templates of Grains cannot be 
changed, but only used as the basis for a new test specification.  
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 Click on the Change Test Specification button. This opens the Change 
Test Specification dialog. 

  

 You can now save the hardware settings, select the image source, set 
options or edit the input form and report template. It is recommended, 
however, that you modify the report template after running the program, 
because measurement data are then available. The report editor is 
displayed automatically after running the program.  

Notes: 
• You will find more detailed information about the hardware settings in 

Chapter 4.5 "Settings Editor" of this manual. 

• You will find more detailed information on modifying form templates in 
Chapter 7.4 " Templates for forms and reports" of this manual. 

• You will find more detailed information on editing a report template in 
Chapter 6.4 " Creating Data Reports" of this manual. 
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 Once you have made all the necessary settings, click on the  
button. This opens a wizard that guides you through the program. Using 
the Execute option, you can determine whether or not the processing 
step is carried out. If you activate the Interactive option, this step will 
also be displayed during the measurement. The user can also change the 
parameters here.  

 When you have made all the necessary settings, leave the Change Test 

Specifications dialog by clicking on the  button. 

 Save the test specification by clicking on the  button. This 
opens the Save Test Specification dialog. You can enter a name and a 
description of the test specification here. A description helps the user 
when starting the measurement, as he is unable to open the Manage 
Test Specifications area and does not, therefore, see the settings that 
have been made there.  

eçï=Çç=f=éÉêÑçêã=~=ãÉ~ëìêÉãÉåí\=

 From the workflows, select the Grains workflow.  

 First of all you will need an open archive. To open one, click on the Open 
Archive function.  
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 This opens the standard dialog for opening a file in Microsoft Windows. 
Select a Material Analysis Archive.  

 Then click on the Start Grains Analysis function in the workflow. 

This opens a wizard that guides you through the measurement. At the end of 
the measurement, you will be shown the Results View: 

 

 To generate a report, first click on the  button.  

 Then click on the  button that is now active and the 
report will be generated and displayed. It will already have been saved in 
the archive. 
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NNKT jìäíáéÜ~ëÉ=

In the Multiphase module, phases are determined based on both the size of 
the individual particles of a phase as well as the percentage of the area they 
represent.  It is possible to determine up to 32 phases.  

When classifying the particles of a phase, you can determine a measurement 
parameter and set the upper and lower limit for the classification. The range is 
then divided into ten classes. Both linear and logarithmic classification are 
available. The following parameters may be selected for the classification: 

 Area 
 Densitometric mean  
 Diameter  
 Feret Maximum  
 Ellipse major  
 Ellipse minor   
 Perimeter convex  
 Form circle 
 Volume Ellipsoid 
 Volume Sphere 

In addition, the number of particles and the percentage of the area they 
represent in relation to the image are displayed for each phase.  

All data are saved and managed in one place – the archive – which has search 
and filter functions. This ensures that the data can be relocated easily. 

The operating concept of Multiphase is described below. This is followed by a 
practical section that provides step-by-step instructions in relation to the 
individual points. 

Note: 
• For detailed information on the individual functions and commands, 

please refer to the online help (F1 key). 
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qÜÉ=ÅçåÅÉéí=

The operating concept of Multiphase is designed to make it possible to 
achieve a reproducible result with as little interaction as possible. The 
performance of a measurement can be automated to such an extent that only 
the project data need to be entered and the entire analysis process can run 
automatically.  

To automate a measurement completely, you need extensive knowledge of 
systems engineering and the respective application. Carelessly made 
alterations of a setting can promptly lead to faulty measurement results. It is 
important, therefore, to prevent users not having such knowledge from 
changing the basic settings. This is achieved by dividing up the tasks involved 
into the definition of a measurement and the performance of a measurement. 
For this reason, the operation of Multiphase is essentially divided into two 
functional areas:  

 administrator mode (definition of a measurement) 
 user mode (performance of a measurement) 

 
Administrator mode 

A measurement is always based on a test specification, which is created in the 
administrator mode. All the key settings required for a multiphase analysis are 
saved here. This test specification may only be created or modified by principal 
users or administrators. Here, the administrator can also specify whether or 
not certain parameters may be changed by the user. A standard user has no 
access to the management of test specifications. Access to the corresponding 
functions is controlled by means of the access rights of the operating system. 

User mode 

In the user mode, measurements can be performed on the basis of a test 
specification. The administrator determines to what extent the user may 
change the measurement parameters.  
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mêÉé~êáåÖ=íÜÉ=ëóëíÉã=

General 

The functionality of the Multiphase module is based on the basic functionality 
of AxioVision. Before you can work with Multiphase, you must, therefore, 
configure the basic settings for AxioVision.  

Note: 
• You will find further information you require in Section 8 "Configuration" 

of this manual. 

Microscope configuration 

The microscope is controlled with the help of the separate MTB 2004 
Configuration program. In order to use your microscope together with 
AxioVision, your individual system configuration must first be defined via this 
separate program. If you upgrade a pre-existing system for multiphase 
analysis, the configuration may take place via the Microscope Configuration 
program. 

The configuration programs have their own icons and buttons on your 
Microsoft Windows Desktop: 

   

Note: 
• For detailed information, see Chapter 4 "Microscope Control". 
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Scalings 

Measurement in real units (e.g., µm) is only possible if there exist scaling files. 
Although AxioVision has a capability to compute a theoretical scaling on the 
basis of the current system configuration, it is urgently recommended to 
create, for measurement tasks, an individual scaling file by means of a stage 
micrometer. 

Note: 
• For detailed information, see Chapter 8.4 "Scalings". 

User settings 

Select the User tab in the Tools ⇒ Options menu. Enter the information 
about the respective user and select your corporate logo. This information is 
administrated separately for each user. It is saved to the archive for each 
project or each measurement and, by way of default, used for the reports.  

Note: 
• For detailed information, see Chapter 8.6 "General settings". 

Configuration of the user interface 

AxioVision offers an extremely wide range of options with regard to user-
specific configuration. In particular, the fact that the interface is structured as 
simply as possible means that even inexperienced users are able to use the 
system to achieve accurate results both quickly and easily. 

It is recommendable to hide all controls not used for the purpose. For routine 
measurements, you usually need only the Multiphase workflow. 

Notes: 
• To show the main menu again, click the right mouse button on the title 

bar of the AxioVision image window, or on a toolbar. This opens a 
context menu in which you can display everything again. 

• For detailed information, see Chapter 8.5 "Adapting the user interface". 
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Administrating several users 

The user management of AxioVision is directly based on that of the operating 
system. Each user with access rights works under a different AxioVision 
configuration. This means that, e.g., the configuration of the user interface, 
the entry of user data, etc., are managed separately for each user. 

Notes: 
• For detailed information on user and data management, see Chapter 8.3 

"User and data administration". 

• If you use a common account for all users but wish to use different 
configurations nevertheless, proceed as described in the following 
section.  

Multiphase and other AxioVision applications 

One of AxioVision’s particular strengths is its modular structure. Each module 
is added directly onto the basic system. This means that the system can also 
be used for simple documentation tasks or other applications such as particle 
analysis or grain size analysis. To ensure that AxioVision always starts with a 
particular configuration specific to the application (e.g. specific toolbars, 
workflows, etc.), any number of configurations can be started via individual 
icons on the Microsoft Windows desktop. 

Note: 
• For detailed information on the creation of configurations, see Chapter 

8.8 "Creating various AxioVision configurations for a user". 

qÜÉ=j~íÉêá~ä=^å~äóëáë=~êÅÜáîÉ=

Data are saved and managed in an archive. There, all data (images, 
measurement data tables, reports, etc.) are stored/saved by project.  

The test specifications are also saved in the archive together with the 
measurement projects. These are not visible in the archive window, and can 
only be modified using the Manage Test Specifications function. 
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There are several types of archive in AxioVision. Besides the folder and asset 
archive, there are also specific archives for certain modules. The Material 
Analysis archive is intended for Multiphase. The measurements of the 
AxioVision Grains, Graphite and/or Comparative Diagrams modules can also 
be stored in this archive.  

In order to work with the Multiphase module, an archive must therefore exist 
and be opened in AxioVision. 

Note: 
• The multiphase analysis can only be performed in the Material Analysis 

archive. No other types of archive are suitable for this!  

  

 Archive View 
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Opening the Material Analysis Archive when starting 
AxioVision 

To start AxioVision always with the desired archive, you should establish a 
shortcut to the archive on the Microsoft Windows desktop: 

 Click the right mouse button on a free area on the desktop, and select 
New ⇒ Shortcut: 

  

 In the Create Shortcut dialog that follows, select the Material Analysis 
archive (extension *.zva) by clicking on the Browse… button: 

  

 Click on Next and, in the next step, enter a name for the shortcut. 

 To create the shortcut, click on Finish. 
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All settings and configuration data are saved in test specifications. These 
therefore contain all the information required for performing a multiphase 
analysis: from the configuration of the hardware and the origin of the images 
through to the definition of the report. All measurements performed at a later 
date are based on a test specification. When starting a measurement, the user 
is prompted to select the desired test specification. Only then can the 
measurement be started.  

Via the Manage Test Specifications dialog, test specifications can be 
modified, created or deleted. It is also possible to import and export test 
specifications. This dialog is only available to users who are logged on to 
Microsoft Windows as principal users or administrators.  
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To make the preparation and setup for Multiphase Analysis as easy as 
possible, you can simply import existing test specifications for special 
applications and use them right away. 

This is especially helpful if measurements are to be made in different places 
but with exactly the same specifications. Test specifications once created 
centrally can then be imported on any number of systems installed. 

Clicking the Import/Export… button starts the wizard that guides you 
through all the necessary steps: 
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Test specifications are created via the Change Test Specification function. 
All the dialogs used to set up an Multiphase Analysis are called up via this 
dialog: 

  

Dialog for adapting and changing a test specification 

Each individual step can be modified. The relevant dialog can be opened using 

the button .  

Here again you can, for each single item required for creating a test 

specification, load  and save  settings already existing in another 
template. 

Thus, you can directly copy hardware settings, settings of the image source, 
input forms, etc. from existing templates into the current test specification 
you are creating. Further, you can save your own settings to a new template 
in order to use them in further test specifications. 

The following chapters describe the procedure step by step. 
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e~êÇï~êÉ=ëÉííáåÖë=

The settings of microscope and camera are decisive for the reproducibility of 
measurements. Measurements will yield the same results only if they are 
always made with the same parameters. With the hardware settings you can 
ensure that you are always using the same hardware configuration before you 
start a measurement. This is conditional on the use of motorized microscopes 
or microscope components, and digital cameras. These can be completely 
controlled via the software. 

In case of manual microscopes you need to do the correct settings manually. 
So-called coded components require a mixed approach. Their current statuses 
can be checked by the software, but the correct setting has to be done 
manually as required. If you are using coded components, the system will 
warn you if a setting is faulty and prompt you to establish the correct 
configuration. 

The most important settings include, e.g., the objective to be used, the 
brightness adjustment, the used contrasting method, camera resolution, 
exposure time, camera mode, etc. 

Note: 
 For detailed information on hardware settings, see Chapter 4.5 "The 

Settings Editor". 

fã~ÖÉ=ëçìêÅÉ=

The image source defines where the image comes from. If you have already 
acquired images that you wish to analyze, select Folder or Gallery as the 
image source. In most cases, however, when an image is acquired and 
analyzed immediately, use the Camera setting as the image source.  
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fåéìí=Ñçêãë=

Input forms allow the user to enter the necessary project and sample data 
during the measurement. You can freely define or adapt the data that you 
want to be entered. The necessary fields and their link to the archive are 
defined in layout mode. Layout mode is active as soon as editing is started.  

  

 Standard input form for project data 

Note: 
 For detailed information on editing form templates, see Chapter 7.4 

"Templates for forms and reports". 

11-166 M 60-3-0024 e / printed 06.2010 



Modules - Multiphase 

jçÇáÑóáåÖ=êÉéçêí=íÉãéä~íÉë=

In order to print the results of a measurement clearly, it is possible to structure 
the appearance of the results report individually. A report template may only 
be modified during the creation/editing of each test specification and is, 
therefore, not accessible for standard users. The predefined template is always 
used when you perform a measurement. 

Note: 
• For detailed information, see Chapter 6.4 "Creating data reports". 

qÜÉ=ãÉ~ëìêÉãÉåí=éêçÅÉÇìêÉ=

You can specify the measurement procedure by clicking on the Run button. 
This opens a wizard that guides you through the individual steps. All possible 
steps relating to image preparation, segmentation and classification are 
displayed here.  

mÉêÑçêãáåÖ=ãÉ~ëìêÉãÉåíë=

A measurement is performed via the Start Multiphase Analysis function in 
the Multiphase workflow: 
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 Starting dialog for multiphase analysis 

A multiphase analysis is always based on a previously defined test 
specification. This must have been created by a qualified user. No 
measurement can be started until a test specification has been created. 

During the course of the measurement, the function dialog for which the 
Interactive mode has been selected in the evaluation script will be displayed. 
All other functions run automatically in the background, if the check box 
Execute is selected. 
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The program will stop at each function for which Interactive has been 
selected and the corresponding dialog will open. The predefined parameters 
can then be modified and optimally adapted to the image in question. The 
functions that are carried out interactively feature the additional parameter 
Always interactive during the execution of the program. This allows the 
user to decide whether or not the dialog should be opened again for the next 
image. This is particularly useful if you have set segmentation thresholds, for 
example, and do not need to modify them again for subsequent images. The 
thresholds can therefore be set using one or more images and then applied 
automatically. 

This option is useful if you are measuring several images immediately after 
each other. Otherwise, this setting does not have any impact on the running 
of the program. 

qÜÉ=êÉëìäíë=ÇçÅìãÉåí=

At the end of the measurement the results window is displayed. Here, the 
results are displayed in the form of a table for all the images measured, as 
well as the image of the sample currently selected. Below the images are 
three tabs which you can use to switch between the input, output and 
processed image. If the image has been processed using image enhancement 
methods (e.g. Sigma filter), you can therefore see the effect if you switch 
between the input and processed image.  
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dÉåÉê~íáåÖ=êÉéçêíë=

The data are not saved directly in a report, but are only displayed there. This 
avoids data being saved twice. As a result, the data must first be saved in the 
archive. Then you can generate the report, which, immediately upon being 
generated, is also saved automatically in the archive. Provided you do not 
delete any of the tables or images from the archive, the data are also 
displayed in the report. In order to display the report on other PCs too, you 
can export the report into PDF or RTF format (File menu ⇒ Save as PDF or 
Save as RTF). 
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`êÉ~íáåÖ=~åÇ=éÉêÑçêãáåÖ=~=ãìäíáéÜ~ëÉ=~å~äóëáë=

Now that the theoretical principles have been explained above, below you will 
find step-by-step instructions for creating and performing a multiphase 
analysis. 

eçï=Çç=f=ÅêÉ~íÉ=~å=~êÅÜáîÉ\=

The Material Analysis Archive forms the basis for managing the data resulting 
from multiphase analysis. All the data relating to the performance of a 
measurement are managed here. In order to perform a measurement, it is 
necessary for an archive to be opened in AxioVision. The creation and opening 
of an archive are therefore shown first. 

 Select the New function in the File menu. 

 On the Archives tab sheet, select the Material Analysis Archive and 
then click OK. 

  

The SQL based Archive dialog window will appear. Enter a name for the 
archive in the Name input field and confirm by clicking on OK. 
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Notes: 
• An archive is created in the My Documents\My Pictures folder by default. 

If you wish to save the archive elsewhere, click on the  button. Select 
the location where you wish the archive to be saved in the Microsoft 
Windows standard dialog that then opens.  

• In the case of large data volumes in particular, we recommend that you 
save the archive to a local hard drive.  

• Only one archive can be opened at a time in AxioVision. 

The newly created archive is now displayed in AxioVision.  
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Opening an archive 

 Click on the Open icon in the menu bar and then on the Open Archive 
function: 

  

eçï=Çç=f=ÅêÉ~íÉ=~=íÉëí=ëéÉÅáÑáÅ~íáçå\=

The test specification contains all the settings required for performing a 
measurement.  

 From the workflows, select the Multiphase workflow.  

 Click on the Manage Test Specification function. 
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 This opens the Manage Test Specifications dialog. 

  

 Select the test specification that you wish to use as a basis for the new 
test specification. If you have not yet created a test specification, select 
the standard "Multiphase" test specification. 

Note: 
• In the Create New Test Specification mode, a copy is generated of the 

selected test specification, which you can then adapt. The original test 
specification that is used is not changed. If you only wish to make a 
modification to the test specification, change to the Modify Existing 
Test Specification mode.  

• The standard Multiphase test specification cannot be changed, but only 
used as the basis for a new test specification.  
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 Click on the Change Test Specification button. 

 This opens the Change Test Specification dialog. 

  

 You can now save the hardware settings, select the image source or edit 
the input form and report template. It is recommended, however, that 
you modify the report template after running the programme, because 
measurement data are then available. The report editor is displayed 
automatically after running the programme.  

Notes: 
• You will find more detailed information about the hardware settings in 

Chapter 4.5 "Settings Editor" of this manual. 

• You will find more detailed information on modifying form templates in 
Chapter 7.4 " Templates for forms and reports" of this manual. 

• You will find more detailed information on editing a report template in 
Chapter 6.4 " Creating Data Reports" of this manual. 
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 Once you have made all the necessary settings, click on the  
button. This opens a wizard that guides you through the program. Using 
the Execute option, you can determine whether or not the processing 
step is carried out. If you activate the Interactive option, this step will 
also be displayed during the measurement. The user can also change the 
parameters here. 

 When you have made all the necessary settings, leave the Change Test 

Specifications dialog by clicking on the  button. 

 Save the test specification by clicking on the  button. This 
opens the Save Test Specification dialog. You can enter a name and a 
description of the test specification here. A description helps the user 
when starting the measurement, as he is unable to open the Manage 
Test Specifications area and does not, therefore, see the settings that 
have been made there.  

eçï=Çç=f=éÉêÑçêã=~=ãÉ~ëìêÉãÉåí\=

 From the workflows, select the Multiphase workflow.  

 First of all you will need an open archive. To open one, click on the Open 
Archive function.  
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 This opens the standard dialog for opening a file in Microsoft Windows. 
Select a Material Analysis Archive.  

 Then click on the Start Multiphase Analysis function in the workflow. 

 This opens a wizard that guides you through the measurement. At the 
end of the measurement, you will be shown the results view: 

  

 To generate a report, first click on the  button.  

 Then click on the  button that is now active and 
the report will be generated and displayed. It will already have been saved 
in the archive. 
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NNKU `çãé~ê~íáîÉ=aá~Öê~ãë=

The Comparative Diagrams module allows the comparision of a micrograph 
with comparative diagrams interactively. 

The result is a table containing the comparative diagram numbers relating to 
each image and a table containing statistical analyses. You can also have a 
micrograph displayed with an overlaid comparative diagram.  

The following standards are available: 

 ASTM E 112 
 ASTM E 1382 
 BS 4990 
 DIN 50602 
 EN 10247 
 EN ISO 643 
 SEP 151061 

 

All data are saved and managed in one place – the archive – which has search 
and filter functions. This ensures that the data can be relocated easily. 

The operating concept of Multiphase is described below. This is followed by a 
practical section that provides step-by-step instructions in relation to the 
individual points. 

Notes: 
• The license for the comparative diagrams taken from the standards does 

not form part of the AxioVision Comparative Diagrams module. Before 
you can install these, you must confirm that you have purchased the 
standard. For this reason, each standard must also be installed separately.  

• For detailed information on the individual functions and commands, 
please refer to the online help (F1 key). 
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qÜÉ=ÅçåÅÉéí=

To set up a comparative-diagram comparison, you need extensive knowledge 
of systems engineering and the respective application. Carelessly made 
alterations of a setting can promptly lead to faulty measurement results. It is 
important, therefore, to prevent users not having such knowledge from 
changing the basic settings. This is achieved by dividing up the tasks involved 
into the definition of a measurement and the performance of a measurement. 
For this reason, the operation of Comparative Diagrams is essentially divided 
into two functional areas: 

 Administrator mode (definition of a measurement) 
 User mode (performance of a measurement) 

Administrator mode 

A measurement is always based on a test specification, which is created in the 
administrator mode. All the key settings required for comparative-diagram 
comparisons are saved here. This test specification may only be created or 
modified by principal users or administrators.  

A standard user has no access to the management of test specifications. 
Access to the corresponding functions is controlled by means of the access 
rights of the operating system. 

User mode  

In the user mode, measurements can be performed on the basis of a test 
specification. The administrator determines to what extent the user may 
change the measurement parameters.  
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léÉê~íáçå=~åÇ=ÅçåÑáÖìê~íáçå=

mêÉé~êáåÖ=íÜÉ=ëóëíÉã 

General 

The functionality of the Comparative Diagrams module is based on the basic 
functionality of AxioVision. Before you can work with Comparative Diagrams, 
you must, therefore, configure the basic settings for AxioVision.  

Note: 
• You will find further information you require in Section 8 "Configuration" 

of this manual. 

Microscope configuration 

The microscope is controlled with the help of the separate MTB 2004 
Configuration program. In order to use your microscope together with 
AxioVision, your individual system configuration must first be defined via this 
separate program. If you upgrade a pre-existing system for comparative-
diagram comparisons, the configuration may take place via the Microscope 
Configuration program. 

The configuration programs have their own icons and buttons on your 
Microsoft Windows Desktop: 

   

Note: 
• For detailed information, see Chapter 4 "Microscope Control". 
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User settings 

Select the User tab in the Tools ⇒ Options menu. Enter the information 
about the respective user and select your corporate logo. This information is 
administrated separately for each user. It is saved to the archive for each 
project or each measurement and, by way of default, used for the reports.  

Note: 
• For detailed information, see Chapter 8.6 "General settings". 

Configuration of the user interface 

AxioVision offers an extremely wide range of options with regard to user-
specific configuration. In particular, the fact that the interface is structured as 
simply as possible means that even inexperienced users are able to use the 
system to achieve accurate results both quickly and easily. 

It is recommended that you hide all control elements that are not required, as 
far as possible. For a comparative-diagram comparison, you will usually only 
need the Comparative Diagrams workflow. 

• To show the main menu again, click the right mouse button on the title 
bar of the AxioVision image window, or on a toolbar. This opens a 
context menu in which you can display everything again. 

• For detailed information, see Chapter 8.5 "Adapting the user interface". 

Administrating several users 

The user management of AxioVision is directly based on that of the operating 
system. Each user with access rights works under a different AxioVision 
configuration. This means that, e.g., the configuration of the user interface, 
the entry of user data, etc., are managed separately for each user. 

Notes: 
• For detailed information on user and data management, see Chapter 8.3 

"User and data administration". 
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• If you use a common account for all users but wish to use different 
configurations nevertheless, proceed as described in the following 
section.  

Comparative Diagrams and other AxioVision applications 

One of AxioVision’s particular strengths is its modular structure. Each module 
is added directly onto the basic system. This means that the system can also 
be used for simple documentation tasks or other applications such as particle 
analysis or grain size analysis. To ensure that AxioVision always starts with a 
particular configuration specific to the application (e.g. specific toolbars, 
workflows, etc.), any number of configurations can be started via individual 
icons on the Microsoft Windows desktop. 

Note: 
• For detailed information on the creation of configurations, see Chapter 

8.8 "Creating various AxioVision configurations for a user". 

qÜÉ=j~íÉêá~ä=^å~äóëáë=~êÅÜáîÉ=

Data are saved and managed in an archive. There, all data (images, 
measurement data tables, reports, etc.) are saved by project.  

The test specifications are also saved in the archive together with the 
measurement projects. These are not visible in the archive window, and can 
only be modified using the Manage Test Specifications function. 

There are several types of archive in AxioVision. Besides the folder and asset 
archive, there are also specific archives for certain modules. The Material 
Analysis archive is intended for Comparative Diagrams. The measurements of 
the AxioVision Grains, Graphite and/or Multiphase modules can also be stored 
in this archive.  

In order to work with the Comparative Diagrams module, an archive must 
therefore exist and be opened in AxioVision. 

Note: 
• A comparative-diagram comparison can only be performed in the 

Material Analysis archive. No other types of archive are suitable for this!  
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 Archive View 

Opening the Material Analysis Archive when starting 
AxioVision 

To start AxioVision always with the desired archive, you should establish a 
shortcut to the archive on the Microsoft Windows desktop: 

 Click the right mouse button on a free area on the desktop, and select 
New ⇒ Shortcut: 
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 In the Create Shortcut dialog that follows, select the Material Analysis 
archive (extension *.zva) by clicking on the Browse… button: 

  

 Click on Next and, in the next step, enter a name for the shortcut. 

 To create the shortcut, click on Finish. 

mêçàÉÅíë=~åÇ=íÉëí=ëéÉÅáÑáÅ~íáçåë=

All settings and configuration data are saved in test specifications. These 
therefore contain all the information required for performing a comparative-
diagram comparison: from the configuration of the hardware and the origin 
of the images through to the definition of the report. All measurements 
performed at a later date are based on a test specification. When starting a 
measurement, the user is prompted to select the desired test specification. 
Only then can the measurement be started.  

Via the Manage Test Specifications dialog, test specifications can be 
modified, created or deleted. It is also possible to import and export test 
specifications. This dialog is only available to users who are logged on to 
Microsoft Windows as principal users or administrators.  
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fãéçêíáåÖ=~åÇ=ÉñéçêíáåÖ=íÉëí=ëéÉÅáÑáÅ~íáçåë 

To make the preparation and setup for Comparative Diagrams as easy as 
possible, you can simply import existing test specifications for special 
applications and use them right away. 

This is especially helpful if measurements are to be made in different places 
but with exactly the same specifications. Test specifications once created 
centrally can then be imported on any number of systems installed. 

Clicking the Import/Export… button starts the wizard that guides you 
through all the necessary steps: 
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qÜÉ=`Ü~åÖÉ=qÉëí=péÉÅáÑáÅ~íáçå=Çá~äçÖ 

Test specifications are created via the Change Test Specification function. 
All the dialogs used to set up Comparative Diagrams are called up via this 
dialog: 

  

 Dialog for adapting and changing a test specification 

Each individual step can be modified entirely. The relevant dialog can be 

opened using this   button.  
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Here again you can, for each single item required for creating a test 

specification, load  and save  settings already existing in another 
template. 

Thus, you can directly copy hardware settings, settings of the image source, 
input forms, etc. from existing templates into the current test specification 
you are creating. Further, you can save your own settings to a new template 
in order to use them in further test specification. 

The following chapters describe the procedure step by step. 

e~êÇï~êÉ=ëÉííáåÖë 

The settings of microscope and camera are decisive for the reproducibility of 
measurements. Measurements will yield the same results only if they are 
always made with the same parameters. With the hardware settings you can 
ensure that you are always using the same hardware configuration before you 
start a measurement. This is conditional on the use of motorized microscopes 
or microscope components, and digital cameras. These can be completely 
controlled via the software. 

In case of manual microscopes you need to do the correct settings manually. 
So-called coded components require a mixed approach. Their current statuses 
can be checked by the software, but the correct setting has to be done 
manually as required. If you are using coded components, the system will 
warn you if a setting is faulty and prompt you to establish the correct 
configuration. 

The most important settings include, e.g., the objective to be used, the 
brightness adjustment, the used contrasting method, camera resolution, 
exposure time, camera mode, etc. 

Note: 
 For detailed information on hardware settings, see Chapter 4.5 "The 

Settings Editor". 
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fã~ÖÉ=ëçìêÅÉ 

The image source defines where the image comes from. If you have already 
acquired images that you wish to analyze, select Folder or Gallery as the 
image source. In most cases, however, when an image is acquired and 
analyzed immediately, use the Camera setting as the image source.  

fåéìí=Ñçêãë 

Input forms allow the user to enter the necessary project and sample data 
during the measurement. You can freely define or adapt the data that you 
want to be entered. The necessary fields and their link to the archive are 
defined in layout mode. Layout mode is active as soon as editing is started.  

  
 Standard input form for project data 
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Note: 
 For detailed information on editing form templates, see Chapter 7.3 

"Templates for forms and reports". 

jçÇáÑóáåÖ=êÉéçêí=íÉãéä~íÉë 

In order to print the results of a measurement clearly, it is possible to structure 
the appearance of the results report individually. A report template may only 
be modified during the creation/editing of each test specification and is, 
therefore, not accessible for standard users. The predefined template is always 
used when you perform a measurement. 

Note: 
• For detailed information, see Chapter 6.4 "Creating data reports". 

mÉêÑçêãáåÖ=~=Åçãé~ê~íáîÉJÇá~Öê~ã=Åçãé~êáëçå=

The comparative-diagram comparison is performed via the Start 
Comparative Diagrams function in the Comparative Diagrams workflow.  

  

 Starting dialog for Comparative Diagrams 
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A comparative-diagram comparison is always based on a previously defined 
test specification. This must have been created by a qualified user. No 
comparison can be started until a test specification has been created. 

dÉåÉê~íáåÖ=êÉéçêíë=

The data are not saved directly in a report, but are only displayed there. This 
avoids data being saved twice. As a result, the data must first be saved in the 
archive. Then you can generate the report, which, immediately upon being 
generated, is also saved automatically in the archive. Provided you do not 
delete any of the tables or images from the archive, the data are also 
displayed in the report. In order to display the report on other PCs too, you 
can export the report into PDF or RTF format (Datei menu -> Speichern als 
PDF or Speichern als RTF). 

`êÉ~íáåÖ=~åÇ=éÉêÑçêãáåÖ=~=Åçãé~ê~íáîÉJÇá~Öê~ã=
Åçãé~êáëçå=

Now that the theoretical principles have been explained above, below you will 
find step-by-step instructions for creating and performing a comparative-
diagram comparison. 

eçï=Çç=f=ÅêÉ~íÉ=~å=~êÅÜáîÉ\=

The Material Analysis Archive forms the basis for managing the data resulting 
from the Comparative Diagrams module. All the data relating to the 
performance of a measurement are managed here. In order to perform a 
measurement, it is necessary for an archive to be opened in AxioVision. The 
creation and opening of an archive are therefore shown first. 

 Select the Neu function in the Datei menu. 
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 On the Archives tab sheet, select the Material Analysis Archive and 
then click OK. 

  

 The SQL based Archive dialog window will appear. Enter a name for the 
archive in the Name input field and confirm by clicking on OK. 

  

Notes: 
• An archive is created in the My Documents\My Pictures folder by default. 

If you wish to save the archive elsewhere, click on the  button. Select 
the location where you wish the archive to be saved in the Microsoft 
Windows standard dialog that then opens.  

• In the case of large data volumes in particular, we recommend that you 
save the archive to a local hard drive.  

• Only one archive can be opened at a time in AxioVision. 
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The newly created archive is now displayed in AxioVision.  

 

Opening an archive 

 Click on the Open icon in the menu bar and then on the Open Archive 
function: 
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eçï=Çç=f=ÅêÉ~íÉ=~=íÉëí=ëéÉÅáÑáÅ~íáçå\=

The test specification contains all the settings required for performing a 
measurement.  

 From the workflows, select the Comparative Diagrams workflow.  

 Click on the Manage Test Specification function. 

  
 This opens the Manage Test Specifications dialog. 
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 Select the test specification that you wish to use as a basis for the new 
test specification. If you have not yet created a test specification, select 
the standard "Comparative Diagrams" test specification. 

Note: 
• In the Create New Test Specification mode, a copy is generated of the 

selected test specification, which you can then adapt. The original test 
specification that is used is not changed. If you only wish to make a 
modification to the test specification, change to the Modify Existing 
Test Specification mode. The standard "Comparative Diagrams" test 
specification cannot be changed, but only used as the basis for a new test 
specification.  

 
 Click on the Change Test Specification button. 

 This opens the Change Test Specification dialog. 

  

 You can now save the hardware settings, select the image source or edit 
the input form and report template. It is recommended, however, that 
you modify the report template after running the program, because 
measurement data are then available. The report editor is displayed 
automatically after running the program.  
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Notes: 
• You will find more detailed information about the hardware settings in 

Chapter 4.5 "Settings Editor" of this manual. 

• You will find more detailed information on modifying form templates in 
Chapter 7.4 " Templates for forms and reports" of this manual. 

• You will find more detailed information on editing a report template in 
Chapter 6.4 " Creating Data Reports" of this manual. 

 When you have made all the necessary settings, leave the Change Test 

Specification dialog by clicking on the  button. 

 Save the test specification by clicking on the  button. This 
opens the Save Test Specification dialog. You can enter a name and a 
description of the test specification here. A description helps the user 
when starting the measurement, as he is unable to open the Manage 
Test Specifications area and does not, therefore, see the settings that 
have been made there.  

eçï=Çç=f=éÉêÑçêã=~=Åçãé~ê~íáîÉJÇá~Öê~ã=Åçãé~êáëçå\=

 From the workflows, select the Comparative Diagrams workflow.  

 First of all you will need an open archive. To open one, click on the Open 
Archive function.  
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 This opens the standard dialog for opening a file in Microsoft Windows. 
Select a Material Analysis Archive.  

 Then click on the Start Comparative Diagrams function in the 
workflow. 

 Once you have allocated a comparative diagram to every image, click on 
the Close and Generate Report button. 

 To generate a report, first click on the  button.  

 Then click on the  button that is now active and the 
report will be generated and displayed. It will already have been saved in 
the archive. 

Note: 
• For detailed information on the individual functions and commands, 

please refer to the online help (F1 key). 
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NNKV dê~éÜáíÉ=

In the Graphite module, the size of graphite particles in cast iron is 
determined in accordance with current international standards. Various 
methods are available for analyzing the graphite in cast iron: 

Shape and Size: for determining the shape and size distribution in 
accordance with 
EN ISO 945-1. 

SinterCast: for determining nodularity – analysis of vermicular and 
spheroidal graphite in accordance with SAE J 1887. 

Spherolite: for determining the size of spheroidal graphite 
in accordance with EN ISO 945:1994 (graphite size). 

Lamellar: for determining the size of lamellar graphite in accordance with 
EN ISO 945:1994 (graphite size).  

The Shape and Size method 

The spheroidal graphite particles are detected by means of a gray-value and 
shape-based segmentation. Then the particles are classified on the basis of 
their shape and size. In addition, the spheroid number is also calculated. This 
classification is based on the EN ISO 945-1 standard. 

The SinterCast method 

The analysis performed with the SinterCast method follows the SAE J 1887 
standard. This determines the “nodularity”, i.e. the proportion of spheroidal 
graphite to vermicular graphite.  

The Spherolyte method 

The spheroidal graphite particles are detected by means of a gray-value and 
form-based segmentation. The particles are then classified by size (i.e. 
diameter). This classification is based on the EN ISO 945:1994 standard. 
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The Lamellar method 

Using this measurement method, the size of individual lamellar graphite 
particles is measured in each image and the distribution of these particles is 
shown. In this case too the particles are detected by means of a gray-value 
and form-based segmentation. The classification follows the requirements of 
EN ISO 945:1994, which means that the length of the lamellar graphite 
particles is taken as a basis for the size.  

qÜÉ=`çåÅÉéí=

The operating concept of Graphite is designed to make it possible to achieve a 
reproducible result with as little interaction as possible. The performance of a 
measurement can be automated to such an extent that only the project data 
need to be entered and the entire analysis process can run automatically.  

To automate a measurement completely, you need extensive knowledge of 
systems engineering and the respective application. Carelessly made 
alterations of a setting can promptly lead to faulty measurement results. It is 
important, therefore, to prevent users not having such knowledge from 
changing the basic settings. This is achieved by dividing up the tasks involved 
into the definition of a measurement and the performance of a measurement. 
For this reason, the operation of Graphite is essentially divided into two 
functional areas: 

 Administrator mode (definition of a measurement) 
 User mode (performance of a measurement) 

Administrator mode 

A measurement is always based on a test specification, which is created in the 
administrator mode. All the key settings required for a graphite analysis are 
saved here. This test specification may only be created or modified by principal 
users or administrators. Here, the administrator can also specify whether or 
not certain parameters may be changed by the user. A standard user has no 
access to the management of test specifications. Access to the corresponding 
functions is controlled by means of the access rights of the operating system. 
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User mode 

In the user mode, measurements can be performed on the basis of a test 
specification. The administrator determines to what extent the user may 
change the measurement parameters.  

léÉê~íáçå=~åÇ=ÅçåÑáÖìê~íáçå=

mêÉé~êáåÖ=íÜÉ=ëóëíÉã=

General 

The functionality of the Graphite module is based on the basic functionality of 
AxioVision. Before you can work with Graphite, you must, therefore, 
configure the basic settings for AxioVision.  

Note: 
• You will find further information you require in Section 8 "Configuration" 

of this manual. 

Microscope configuration 

The microscope is controlled with the help of the separate MTB 2004 
Configuration program. In order to use your microscope together with 
AxioVision, your individual system configuration must first be defined via this 
separate program. If you upgrade a pre-existing system for graphite analysis, 
the configuration may take place via the Microscope Configuration 
program. 

The configuration programs have their own icons and buttons on your 
Microsoft Windows Desktop: 
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Note: 
• For detailed information, see Chapter 4 "Microscope Control". 

Scalings 

Measurement in real units (e.g., µm) is only possible if there exist scaling files. 
Although AxioVision has a capability to compute a theoretical scaling on the 
basis of the current system configuration, it is urgently recommended to 
create, for measurement tasks, an individual scaling file by means of a stage 
micrometer. 

Note: 
• For detailed information, see Chapter 8.4 "Scalings". 

User settings 

Select the User tab in the Tools ⇒ Options menu. Enter the information 
about the respective user and select your corporate logo. This information is 
administrated separately for each user. It is saved to the archive for each 
project or each measurement and, by way of default, used for the reports.  

Note: 
• For detailed information, see Chapter 8.6 "General settings". 

Configuration of the user interface 

AxioVision offers an extremely wide range of options with regard to user-
specific configuration. In particular, the fact that the interface is structured as 
simply as possible means that even inexperienced users are able to use the 
system to achieve accurate results both quickly and easily. It is 
recommendable to hide all controls not used for the purpose. For routine 
measurements, you usually need only the Graphite workflow. 

Notes: 
• To show the main menu again, click the right mouse button on the title 

bar of the AxioVision image window, or on a toolbar. This opens a 
context menu in which you can display everything again. 

• For detailed information, see Chapter 8.5 "Adapting the user interface". 
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Administrating several users 

The user management of AxioVision is directly based on that of the operating 
system. Each user with access rights works under a different AxioVision 
configuration. This means that, e.g., the configuration of the user interface, 
the entry of user data, etc., are managed separately for each user. 

Notes: 
• For detailed information on user and data management, see Chapter 8.3 

"User and data administration". 

• If you use a common account for all users but wish to use different 
configurations nevertheless, proceed as described in the following 
section.  

Graphite and other AxioVision applications 

One of AxioVision’s particular strengths is its modular structure. Each module 
is added directly onto the basic system. This means that the system can also 
be used for simple documentation tasks or other applications such as particle 
analysis or multiphase analysis. To ensure that AxioVision always starts with a 
particular configuration specific to the application (e.g. specific toolbars, 
workflows, etc.), any number of configurations can be started via individual 
icons on the Microsoft Windows desktop. 

Note: 
• For detailed information on the creation of configurations, see Chapter 

8.8 "Creating various AxioVision configurations for a user". 

qÜÉ=j~íÉêá~ä=^å~äóëáë=~êÅÜáîÉ=

Data are saved and managed in an archive. There, all data (images, 
measurement data tables, reports, etc.) are saved by project.  

The test specifications are also saved in the archive together with the 
measurement projects. These are not visible in the archive window, and can 
only be modified using the Manage Test Specifications function. 
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There are several types of archive in AxioVision. Besides the folder and asset 
archive, there are also specific archives for certain modules. The Material 
Analysis archive is intended for Graphite. The measurements of the AxioVision 
Multiphase, Grains and/or Comparative Diagrams modules can also be stored 
in this archive. 

In order to work with the Graphite module, an archive must therefore exist 
and be opened in AxioVision. 

Note: 
• The graphite analysis can only be performed in the Material Analysis 

archive. No other types of archive are suitable for this!  

  

 Archive View 
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Opening the Material Analysis Archive when starting 
AxioVision 

To start AxioVision always with the desired archive, you should establish a 
shortcut to the archive on the Microsoft Windows desktop: 

 Click the right mouse button on a free area on the desktop, and select 
New ⇒ Shortcut: 

  

 In the Create Shortcut dialog that follows, select the Material Analysis 
archive (extension *.zva) by clicking on the Browse… button: 

  

 Click on Next and, in the next step, enter a name for the shortcut. 

 To create the shortcut, click on Finish. 
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mêçàÉÅíë=~åÇ=íÉëí=ëéÉÅáÑáÅ~íáçåë=

All settings and configuration data are saved in test specifications. These 
therefore contain all the information required for performing a graphite 
analysis: from the configuration of the hardware and the origin of the images 
through to the definition of the report. All measurements performed at a later 
date are based on a test specification. When starting a measurement, the user 
is prompted to select the desired test specification. Only then can the 
measurement be started.  

Via the Manage Test Specifications dialog, test specifications can be 
modified, created or deleted. It is also possible to import and export test 
specifications. This dialog is only available to users who are logged on to 
Microsoft Windows as principal users or administrators.  
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fãéçêíáåÖ=~åÇ=ÉñéçêíáåÖ=íÉëí=ëéÉÅáÑáÅ~íáçåë=

To make the preparation and setup for graphite analysis as easy as possible, 
you can simply import existing test specifications for special applications and 
use them right away. This is especially helpful if measurements are to be made 
in different places but with exactly the same specifications. Test specifications 
once created centrally can then be imported on any number of systems 
installed. 

Clicking the Import/Export… button starts the wizard that guides you 
through all the necessary steps: 

  

jçÇáÑó=qÉëí=péÉÅáÑáÅ~íáçåë=

Test specifications are created via the Change Test Specification function. 
All the dialogs used to set up a graphite analysis are called up via this dialog: 

  

 Dialog for adapting and changing a test specification 

AxioVision User's Guide, Release 4.8.2 11-205 



Modules  - Graphite 

Each individual step can be modified. The relevant dialog can be opened using 

the button .  
Here again you can, for each single item required for creating a test 

specification, load  and save  settings already existing in another 
template. 

Thus, you can directly copy hardware settings, settings of the image source, 
input forms, etc. from existing templates into the current test specification 
you are creating. Further, you can save your own settings to a new template 
in order to use them in further test specification. 

The following chapters describe the procedure step by step. 

e~êÇï~êÉ=ëÉííáåÖë=

The settings of microscope and camera are decisive for the reproducibility of 
measurements. Measurements will yield the same results only if they are 
always made with the same parameters. With the hardware settings you can 
ensure that you are always using the same hardware configuration before you 
start a measurement. This is conditional on the use of motorized microscopes 
or microscope components, and digital cameras. These can be completely 
controlled via the software. 

In case of manual microscopes you need to do the correct settings manually. 
So-called coded components require a mixed approach. Their current statuses 
can be checked by the software, but the correct setting has to be done 
manually as required. If you are using coded components, the system will 
warn you if a setting is faulty and prompt you to establish the correct 
configuration. 

The most important settings include, e.g., the objective to be used, the 
brightness adjustment, the used contrasting method, camera resolution, 
exposure time, camera mode, etc. 

Note: 
 For detailed information on hardware settings, see Chapter 4.5 "The 

Settings Editor". 
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fã~ÖÉ=ëçìêÅÉ=

The image source defines where the image comes from. If you have already 
acquired images that you wish to analyze, select Folder or Gallery as the 
image source. In most cases, however, when an image is acquired and 
analyzed immediately, use the Camera setting as the image source.  

fåéìí=Ñçêãë=

Input forms allow the user to enter the necessary project and sample data 
during the measurement. You can freely define or adapt the data that you 
want to be entered. The necessary fields and their link to the archive are 
defined in layout mode. Layout mode is active as soon as editing is started.  

  

 Standard input form for project data 
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Note: 
 For detailed information on editing form templates, see Chapter 7.4 

"Templates for forms and reports". 

jçÇáÑóáåÖ=êÉéçêí=íÉãéä~íÉë=

In order to print the results of a measurement clearly, it is possible to structure 
the appearance of the results report individually. A report template may only 
be modified during the creation/editing of each test specification and is, 
therefore, not accessible for standard users. The predefined template is always 
used when you perform a measurement. 

Note: 
• For detailed information, see Chapter 6.4 "Creating data reports". 

qÜÉ=ãÉ~ëìêÉãÉåí=éêçÅÉÇìêÉ=

You can specify the measurement procedure by clicking on the Run button. 
This opens a wizard that guides you through the individual steps. All possible 
steps relating to image preparation, segmentation and classification are 
displayed here.  

mÉêÑçêãáåÖ=ãÉ~ëìêÉãÉåíë=

A measurement is performed via the Start Graphite Analysis function in the 
Graphite workflow: 
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 Starting dialog for graphite analysis 

A graphite analysis is always based on a previously defined test specification. 
This must have been created by a qualified user. No measurement can be 
started until a test specification has been created. 

During the course of the measurement, the function dialog for which the 
Interactive mode has been selected in the evaluation script will be displayed. 
All other functions run automatically in the background, if the check box 
Execute is selected. 

The program will stop at each function for which Interactive has been 
selected and the corresponding dialog will open. The predefined parameters 
can then be modified and optimally adapted to the image in question. The 
functions that are carried out interactively feature the additional parameter 
Always interactive during the execution of the program. This allows the 
user to decide whether or not the dialog should be opened again for the next 
image. This is particularly useful if you have set segmentation thresholds, for 
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example, and do not need to modify them again for subsequent images. The 
thresholds can therefore be set using one or more images and then applied 
automatically. 

This option is useful if you are measuring several images immediately after 
each other. Otherwise, this setting does not have any impact on the running 
of the program. 

qÜÉ=êÉëìäíë=ÇçÅìãÉåí=

At the end of the measurement the results window is displayed. Here, the 
results are displayed in the form of a table for all the images measured, as 
well as the image of the sample currently selected. Below the images are 
three tabs which you can use to switch between the input, output and 
processed image. If the image has been processed using image enhancement 
methods (e.g. sigma filter), you can therefore see the effect if you switch 
between the input and processed image.  
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dÉåÉê~íáåÖ=êÉéçêíë=

The data are not saved directly in a report, but are only displayed there. This 
avoids data being saved twice. As a result, the data must first be saved in the 
archive. Then you can generate the report, which, immediately upon being 
generated, is also saved automatically in the archive. Provided you do not 
delete any of the tables or images from the archive, the data are also 
displayed in the report. In order to display the report on other PCs too, you 
can export the report into PDF or RTF format (File menu -> Save as PDF or 
Save as RTF). 

`êÉ~íáåÖ=~åÇ=éÉêÑçêãáåÖ=~=Öê~éÜáíÉ=~å~äóëáë=

Now that the theoretical principles have been explained above, below you will 
find step-by-step instructions for creating and performing a graphite analysis. 

eçï=Çç=f=ÅêÉ~íÉ=~å=~êÅÜáîÉ\=

The Material Analysis Archive forms the basis for managing the data resulting 
from graphite analysis. All the data relating to the performance of a 
measurement are managed here. In order to perform a measurement, it is 
necessary for an archive to be opened in AxioVision. The creation and opening 
of an archive are therefore shown first. 

 Select the New function in the File menu. 

 On the Archives tab sheet, select the Material Analysis Archive and 
then click OK. 
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 The SQL based Archive dialog window will appear. Enter a name for the 
archive in the Name input field and confirm by clicking on OK. 

  

Notes: 
• An archive is created in the My Documents\My Pictures folder by default. 

If you wish to save the archive elsewhere, click on the  button. Select 
the location where you wish the archive to be saved in the Microsoft 
Windows standard dialog that then opens.  

• In the case of large data volumes in particular, we recommend that you 
save the archive to a local hard drive.  

• Only one archive can be opened at a time in AxioVision. 
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The newly created archive is now displayed in AxioVision.  

 

Opening an archive 

 Click on the Open icon in the menu bar and then on the Open Archive 
function: 
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eçï=Çç=f=ÅêÉ~íÉ=~=íÉëí=ëéÉÅáÑáÅ~íáçå\=

The test specification contains all the settings required for performing a 
measurement.  

 From the workflows, select the Graphite workflow.  

 Click on the Manage Test Specification function. 

  

This opens the Manage Test Specifications dialog. 
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 Select the test specification that you wish to use as a basis for the new 
test specification. If you have not yet created a test specification, you can 
select one of the standard test specifications "Sperolyte", "Lamellar" or 
"SinterCast", depending on which measurement method you require. 

Note: 
• In the Create New Test Specification mode, a copy is generated of the 

selected test specification, which you can then adapt. The original test 
specification that is used is not changed. If you only wish to make a 
modification to the test specification, change to the Modify Existing 
Test Specification mode. The standard test specifications of Graphite 
cannot be changed, but only used as the basis for a new test 
specification.  

 Click on the Change Test Specification button. This opens the Change 
Test Specification dialog. 

  

 You can now save the hardware settings, select the image source, set 
options or edit the input form and report template. It is recommended, 
however, that you modify the report template after running the program, 
because measurement data are then available. The report editor is 
displayed automatically after running the program.  
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Notes: 
• You will find more detailed information about the hardware settings in 

Chapter 4.5 "The Settings Editor" of this manual. 

• You will find more detailed information on modifying form templates in 
Chapter 7.4 "Templates for forms and reports" of this manual. 

• You will find more detailed information on editing a report template in 
Chapter 6.4 "Creating Data Reports" of this manual. 

 
 Once you have made all the necessary settings, click on the 

 button. This opens a wizard that guides you through 
the program. Using the Execute option, you can determine whether or 
not the processing step is carried out. If you activate the Interactive 
option, this step will also be displayed during the measurement. The user 
can also change the parameters here.  

 When you have made all the necessary settings, leave the Change Test 

Specifications dialog by clicking on the  button. 

 Save the test specification by clicking on the  button. This 
opens the Save Test Specification dialog. You can enter a name and a 
description of the test specification here. A description helps the user 
when starting the measurement, as he is unable to open the Manage 
Test Specifications area and does not, therefore, see the settings that 
have been made there.  

eçï=Çç=f=éÉêÑçêã=~=ãÉ~ëìêÉãÉåí\=

 From the workflows, select the Graphite workflow.  

 First of all you will need an open archive. To open one, click on the Open 
Archive function.  
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 This opens the standard dialog for opening a file in Microsoft Windows. 
Select a Material Analysis Archive.  

 Then click on the Start Graphite Analysis function in the workflow. 

This opens a wizard that guides you through the measurement. At the end of 
the measurement, you will be shown the results view: 
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 To generate a report, first click on the  button.  

 Then click on the  button that is now active and the 
report will be generated and displayed. It will already have been saved in 
the archive. 
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NNKNM i~óÉê=qÜáÅâåÉëë=jÉ~ëìêÉãÉåí=

The Layer Thickness Measurement module is used to measure simple and 
complex layers in individual or MosaiX images. Layers to be measured are 
detected using image-analysis techniques and measured with the help of 
chords. The result of this measurement is a clearly structured report 
containing images and measurement data. In the text that follows, the 
concept of Layer Thickness Measurement and its operation are described.  

Note: 
• Further explanations on all the functions described can be found in the 

online help. 

qÜÉ=ÅçåÅÉéí=

léÉê~íáçå=~åÇ=ÅçåÑáÖìê~íáçå=

The operating concept the Layer Thickness Measurement is designed to make 
it possible to achieve a reproducible result with as little interaction as possible. 
The performance of a measurement can be automated to such an extent that 
only the project data need to be entered and the entire analysis process can 
run automatically.  

To automate a measurement completely, you need extensive knowledge of 
systems engineering and the respective application. Carelessly made 
alterations of a setting can promptly lead to faulty measurement results. It is 
important, therefore, to prevent users not having such knowledge from 
changing the basic settings. This is achieved by dividing up the tasks involved 
into the definition of a measurement and the performance of a measurement. 

The performance of a measurement is always based on what is called test 
specification. All important settings are saved in a test specification. A test 
specification cannot be created or edited by a user. This is reserved to Power 
Users or Administrators. Access to the respective functions is governed by the 
access rights of the operating system: 
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Dialog for starting a Layer 
Thickness Measurement 

Dialog for editing a test specification 
(not available to standard users) 

mêçàÉÅíë=~åÇ=íÉëí=ëéÉÅáÑáÅ~íáçåë=

The configuration data of a measurement are saved to so-called test 
specification. A test specification contains all the information on the 
performance of a Layer Thickness Measurement in detail: from the 
configuration of the device and the type of image acquisition through to the 
determination of the size of the original data to be saved. 
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The test specifications are saved to the archive, together with the 
measurement projects, but they are not visible in the archive window. They 
can only be modified via the Manage Test Specification function. 

Data are saved and managed in a project-based archive. All the data 
generated (images, data tables, reports etc.) are saved by project: 

 

 Archive View 
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mêÉé~êáåÖ=íÜÉ=ëóëíÉã=

fåíêçÇìÅíáçå=

General 

The functionality of the Layer Thickness Measurement module is based on the 
basic functionality of AxioVision. Before you can work with Layer Thickness 
Measurement, you must, therefore, configure the basic settings for 
AxioVision. You will find further information you require in Section 8 
"Configuration" of this manual. 

Microscope configuration 

To be able to use your microscope together with AxioVision, you need to 
define once your individual system configuration via the separate MTB2004 
Configuration program. Should you be retrofitting Layer Thickness 
Measurement to your existing microscope system, you may have to do this 
configuration via the Microscope Configuration program. 

The configuration programs have their own icons and buttons on your 
Microsoft Windows Desktop: 

   

Note: 
• For detailed information, see Chapter 4 "Microscope Control". 
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dÉåÉê~ä=^ñáçsáëáçå=pÉííáåÖë=

Please make sure that the following settings have been made: 

Alignment of camera and motorized stage 

If you wish to acquire images of large areas using the MosaiX module, you 
must ensure that the camera and stage are aligned correctly with one another 
and that the stage’s direction of movement has been set correctly. Otherwise 
the individual component images will not be put together properly. The 
aligning and setting process may take quite some time with conventional 
camera adapters; therefore it is recommendable to use the adjustable Carl 
Zeiss camera adapter: 

  

Note: 
• For detailed information, see Chapter 9.7 "MosaiX" – "Setting up the 

camera and scanning stage"). 

 Scalings: Measurement in real units (e.g., µm) is only possible if there 
exist scaling files. Although AxioVision has a capability to compute a 
theoretical scaling on the basis of the current system configuration, it is 
urgently recommended to create, for measurement tasks, an individual 
scaling file by means of a stage micrometer. 

Note: 
• For detailed information, see Chapter 8.4 "Scalings". 

User settings 

Select the User tab in the Tools ⇒ Options menu. Enter the information 
about the respective user and select your corporate logo. This information is 
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administrated separately for each user. It is saved to the archive for each 
project or each measurement and, by way of default, used for the reports.  

Note: 
• For detailed information, see Chapter 8.6 "General settings". 

Configuration of the user interface 

AxioVision offers an extremely wide range of options with regard to user-
specific configuration. In particular, the fact that the interface is structured as 
simply as possible means that even inexperienced users are able to use the 
system to achieve accurate results both quickly and easily. 

It is recommendable to hide all controls not used for the purpose. 

Notes: 
• To show the main menu again, click the right mouse button on the title 

bar of the AxioVision window, or on a toolbar. This opens a context menu 
in which you can display everything again. 

• For detailed information, see Chapter 8.5 "Adapting the user interface". 

qÜÉ=j~íÉêá~ä=^å~äóëáë=~êÅÜáîÉ=

Data are saved and managed in an archive. There, all data (images, 
measurement data tables, reports, etc.) are saved by project.  

The test specifications are also saved in the archive together with the 
measurement projects. These are not visible in the archive window, and can 
only be modified using the Manage Test Specifications function. 

There are several types of archive in AxioVision. Besides the folder and asset 
archive, there are also specific archives for certain modules. The Material 
Analysis archive is intended for Grains. The measurements of the AxioVision 
Multiphase, Graphite and/or Comparative Diagrams modules can also be 
stored in this archive.  

In order to work with the Layer Thickness Measurement module, an archive 
must therefore exist and be opened in AxioVision. 
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Note: 
• The Layer Thickness Measurement can only be performed in the Material 

Analysis archive. No other types of archive are suitable for this!  

 

 Archive View 
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Opening the Material Analysis archive when starting 
AxioVision 

To start AxioVision always with the desired archive, you should establish a 
shortcut to the archive on the Microsoft Windows desktop: 

 Click the right mouse button on a free area on the desktop, and select 
New ⇒ Shortcut: 

 

 This opens the dialog Create Shortcut. Click on Browse… and select 
the Material Analysis Archive (file extension *.zva): 

 

 Click on Next and, in the next step, enter a name for the link. 

 To create the link, click on Finish. 
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Administrating several users 

The user management of AxioVision is directly based on that of the operating 
system. Each user with access rights works under a different AxioVision 
configuration. This means that, e.g., the configuration of the user interface, 
the entry of user data, etc., are managed separately for each user. 

Notes: 
• For detailed information on user and data management, see Chapter 8.3 

"User and data administration". 

• If you use a common account for all users but wish to use different 
configurations nevertheless, proceed as described in the following 
section. 

Separation of Layer Thickness Measurement and standard 
AxioVision 

It is a strong point of Layer Thickness Measurement that the system is 
completely based on the standard AxioVision software. Therefore, it can also 
be used for simple documentation jobs or other applications such as, e.g., 
particle analysis or analysis of non metallic inclusions in steel. To start 
AxioVision always with a special, application-specific configuration (e.g., 
specific toolbars, workflows, etc.), you can establish any number of links with 
separate icons on the Microsoft Windows Desktop. 

Note: 
• For detailed information on the creation of configurations, see Chapter 

8.8 "Creating various AxioVision configurations for a user". 
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In test specification, all settings and files for performing a Layer Thickness 
Measurement are saved. All subsequent Layer Thickness Measurements 
always are based on a test specification. When you start a measurement you 
are prompted to select the desired test specification first before you can 
actually start the measurement. 

The test specifications are managed via the Manage Test Specification 
dialog: 

  

In the Manage Test Specifications dialog you can edit, create and delete 
test specifications. Further, you can import and export test specifications. 
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To make the preparation and setup for Layer Thickness Measurement as easy 
as possible, you can simply import existing test specifications for special 
applications and use them right away. 

This is especially helpful if measurements are to be made in different places 
but with exactly the same specifications. Test specifications once created 
centrally can then be imported on any number of systems installed. 

Clicking the Import/Export… button starts the wizard that guides you 
through all the necessary steps: 
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Test specifications are created via the Change Test Specification function. 
All the dialogs used to set up a Layer Thickness Measurement are called up via 
this dialog: 

  

 Dialog for changing a test specification 

Each individual step can be modified entirely. The relevant dialog can be 

opened using the button . Here again you can, for each single item 
required for creating a test specification, load settings already existing in 
another template. For the management of template files, use the buttons on 

the right of the respective creation items: . 

Thus, you can directly copy device settings, settings of the image source, input 
forms, etc. from existing test specifications into the current test specification 
you are creating. Further, you can save your own settings to a new test 
specification in order to use them in further test specification. 
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The following chapters describe the procedure step by step. 
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If you want to test whether the settings of a test specification really produce 
the desired results, you can click on the Execute… button to run a complete 
measurement without having to create a project in the archive. It is important 
that you perform this step with a real sample, because all settings made in the 
functional dialogs during the test run are adopted by the test specification. 

e~êÇï~êÉ=ëÉííáåÖë=

The settings of microscope and camera are decisive for the reproducibility of 
measurements. Measurements will yield the same results only if they are 
always made with the same parameters. With the hardware settings you can 
ensure that you are always using the same hardware configuration before you 
start a measurement. This is conditional on the use of motorized microscopes 
or microscope components, and digital cameras. These can be completely 
controlled via the software. 

In case of manual microscopes you need to do the correct settings manually. 
So-called coded components require a mixed approach. Their current statuses 
can be checked by the software, but the correct setting has to be done 
manually as required. If you are using coded components, the system will 
warn you if a setting is faulty and prompt you to establish the correct 
configuration. 

The most important settings include, e.g., the objective to be used, the 
brightness adjustment, the used contrasting method, camera resolution, 
exposure time, camera mode, etc. 

Note: 
 For detailed information on hardware settings, see Chapter 4.5 "The 

Settings Editor". 
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Example: Setting the camera mode (color, gray levels) 

The camera setting has a decisive influence on the size of your files. Given the 
memory capacity of modern computers, the use of color images is considered 
a standard feature. However, color images require three times as much 
memory space as gray scale images. In most cases, though, color information 
is not required for the detection of layers; therefore, images should be 
acquired as gray scale images. This setting can be made in the camera control 
dialog, and it can be changed there by every user: 

  

By including the camera mode in the hardware settings you can ensure that 
you are always acquiring gray level images for a measurement, irrespective of 
the actual settings of the camera: 

 

If hardware settings have been activated, these can be checked immediately 
before the measurement on the sample to be measured.  
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The image source defines where the image comes from. If you have already 
acquired images that you wish to analyze, select folder or gallery as the image 
source. In most cases, however, an image is acquired and analyzed 
immediately. Select the Camera option to execute the analysis with single 
images. When you are acquiring images of large surfaces using the mosaic 
technique, the size and position of the acquisition region are defined using 
the MosaiX Acquisition dialog. To do so select the MosaiX option. 

To ensure unmistakable repositioning in the acquisition of MosaiX images, the 
z focus and the x and y settings of the motorized stage are calibrated after 
every restart of AxioVision.  

fåéìí=Ñçêãë=

The Input form allows the user to enter the necessary project and sample data 
during the measurement. You can freely define the data that you want to be 
entered. The necessary fields and their link to the archive are defined in layout 
mode. Layout mode is active as soon as editing is started. 
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 Standard input form for project data 

Note: 
 For detailed information on editing form templates, see Chapter 7.4 

"Templates for forms and reports". 
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General 

A preprocessing script defines which image processing steps will be 
performed in which sequence. You can choose which functions will be 
executed interactively, i.e. which functions will be opened while a 
measurement is being performed to allow the user to adjust parameters. 

Notes: 
• In order to display and modify the preprocessing script, you will need the 

Commander module. The Commander module however is NOT required 
for executing a Layer Thickness Measurement. 

• Since modification of the preprocessing script has dramatic consequences 
with regard to the quality of the analysis, this should only be performed 
by experienced users. It is essential that you read the chapter 13.1 
"Commander" section and the information in the online help before 
making any modifications. 

• The preprocessing scripts are not managed in the usual standard 
AxioVision folders. The New and Rename buttons are therefore inactive. 
The Save button only becomes active once you have made changes to 
the script. 

The following scripts are supplied when Layer Thickness Measurement is 
installed: 

• LT_Processing_Wizard: This script is activated by default. The image 
processing is set up in such a way that the edges of the layers are 
detected. It should be used for images in which the edges of the layers 
can be clearly detected. Name of the output document: 
"ScriptOutputContour". 

• LT_Multiphase_Segmentation: This script opens the standard 
Multiphase dialog. One phase is envisaged here for each layer. The result 
is a multi-level binary image with the name "ScriptOutputMask".  

AxioVision User's Guide, Release 4.8.2 11-235 



Modules  - Layer Thickness Measurement 

• LT_Draw_Contour: This script opens the Draw Layers dialog. It has 
been designed for cases in which automatic detection of the layers by 
means of segmentation, the Processing Wizard or other image 
processing techniques does not work. In this dialog, the layers are drawn 
in. There does not have to be a closed contour. Layer Thickness 
Measurement detects all regions between a minimum of two lines as a 
layer. In this script, the output document is called "ScriptOutputContour".  

  

 Preprocessing script in the Commander script editor 

11-236 M 60-3-0024 e / printed 06.2010 



Modules  - Layer Thickness Measurement 

Adapting the preprocessing script 

As long as you do not insert or delete any commands, you can modify the 
behavior of the script simply by switching the commands on the Commands 
tab on and off. 

  

You can incorporate any functions available in AxioVision into the script. After 
doing so, however, you must ensure that the input and output documents are 
correctly linked and labeled. 
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In order to print the results of a measurement clearly, it is possible to structure 
the appearance of the results report. A report template may only be modified 
during the creation/editing of each test specification and is, therefore, not 
accessible for standard users. The predefined template is always used when 
you perform a measurement. 

Note: 
• For detailed information, see Chapter 6.4 "Creating data reports". 

léíáçå~ä=ëÉííáåÖë=

General 

With optional settings you define essentially the following items: 

 Selection of the data to be saved (above all, image data) 
 Behavior during image acquisition 

It is imperative that you consult the Online Help function for information on 
*details of the parameters that can be set. 

Memory space required 

The quantity of data obtained in Layer Thickness Measurement is sometimes 
enormous, especially when you analyze several samples. The table below 
shows the memory requirements for different conditions: 

Image size in MB* 
Pixel scaling used 

Gray scale image Color image 

1.0 µm / pixel 1450 4350 

2.5 µm / pixel 232 696 

5.0 µm / pixel 58 174 

10.0 µm / pixel 15 44 

 
* Area approx. 1500mm², 8 bit gray levels 
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You should carefully consider which original data should actually be saved. 
Among others, the two factors outlined below may be a basis for decision: 

 If you want to ensure that a measurement can be reproduced at any time, 
you need to save the original data as they are. It is not permissible in this 
case to scale down the original image or to save it in a compressed 
format. 

 If you want to save the original image for documentation purposes, you 
should consider whether a scaled down version could be saved in a 
compressed format (e.g., ZVI or JPG). This will considerably reduce the 
amount of image data, but they will not be suitable for subsequent 
measurements. 

Number of gray levels or color values of the images acquired 

Another important consideration is the bit depth, i.e. the number of gray 
levels or color values used for image acquisition. In the past, the entire 
brightness or color range was captured 256 different gray levels (8 bit). Most 
modern digital cameras have more than 256 gray levels. But here, too, this 
means that the resulting image data files are exceedingly large; the great 
number of gray levels (possibly more than 65,000) is not needed for a 
measurement. It is possible, therefore, to enforce reduction to 256 gray levels: 

  

 Conversion of acquired images to 8 bit 
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A measurement is performed via the Start Layer Thickness Measurement 
function in the Layer Thickness Measurement workflow: 

  

An Layer Thickness Measurement is always based on a previously defined test 
specification. This must have been created by a qualified user. No 
measurement can be started until a test specification has been created. 

During the course of the measurement, the function dialog for which the 
Interactive mode has been selected in the preprocessing script will be 
displayed. All other functions run automatically in the background. 

The program will stop at each function for which Interactive has been 
selected and the corresponding dialog will open. The predefined parameters 
can then be modified and optimally adapted to the image in question. 

The functions that are carried out interactively feature the additional 
parameter Always interactive during the execution of the program. This 
allows the user to decide whether or not the dialog should be opened again 
for the next image. This is particularly useful if you have set segmentation 
thresholds, for example, and do not need to modify them again for 
subsequent images. The thresholds can therefore be set using one or more 
images and then applied automatically. 

This option is useful if you are measuring several images immediately after 
each other. Otherwise, this setting does not have any impact on the running 
of the program. After the measurement the data are saved automatically in 
the archive, a report will be created and displayed. 
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During the process of coating materials, quality is controlled by measuring the 
thickness of layers in accordance with the DIN V ENV 1071 standard. The 
Calotte Grinding Measurement module allows you to determine the thickness 
of calotte section layers.  To prepare the calotte section samples, a grinding 
ball with a defined diameter generates a calotte-shaped hollow in the coating 
of the sample. This results in circular or elliptical indentations, the diameters of 
which are determined by drawing in measurement circles. The layer thickness 
is calculated automatically from the diameters of the measurement circles and 
the diameter of the grinding ball. 

Both single and multilayer samples can be measured. 

The measurement results and sample information from the calotte grinding 
measurement are displayed in an image and stored. A report containing the 
image, measurement results and information about the sample can also be 
produced.  

mÉêÑçêãáåÖ=~=Å~äçííÉ=ÖêáåÇáåÖ=ãÉ~ëìêÉãÉåí=

 Place the sample you want to measure on the microscope stage. 
 Turn the nosepiece to the position with the desired objective. 
 Now check that the calotte section is positioned correctly, adjust its 

position if necessary. 
 Start AxioVision. 

Clicking on the Calotte Grinding Mesurement icon opens the wizard. This 
will guide you through the application. 

  

You can also call up the wizard from the Applications menu ⇒ Calotte 
Grinding Mesurement ⇒ Start Assistent. 
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The first page of the wizard is displayed: Sample description (Step 1 of 4). 
In the upper area, you will find a brief description of what you should do in 
this step. 

 Enter the sample data in the Batch Number field. 

 New layer types can be entered 
using the New button. The new 
layer type will then appear 
automatically in the list of layer 
types. 

 

 Select one of the available 
scalings from the list in the 
Available Scaling(s) field. 

 New scalings can be generated 
using the New button. The new 
scaling will then appear 
automatically in the scalings list. 

 

 Then click on the Next button in the bottom left-hand area of the wizard. 
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The second page of the wizard is displayed on the screen. Under the title 
Open image (Step 2 of 4) you will find a brief description of what you 
should do in this step. 

 Click in the field Source: Camera the button 
Live-Start to open the live image window of 
the active camera. Center the calotte section 
in the live window and focus it. 

 

 Click the corresponding camera button (in this 
case AxioCamMR5) to open the camera 
dialogue. Set the exposure time by clicking the 
Measure button. 

 

 The click the Snap button to acquire the 
active image.  

 If you would like to measure already saved 
images, click the Open Image button. You 
can open an image saved on the hard disk or 
any other storage medium. 

 

 Then click on the Next button in the bottom left-hand area of the wizard. 
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The third page of the wizard is displayed on the screen. Under the title Draw 
Circles (Step 3 of 4) you will find a brief description of what you should do in 
this step. 

 In the Method field, select the Single 
Layer function (if the sample only has 
one layer) or the Multi Layer function 
(if the sample has several layers). 

 

 Click on the tool that you wish to use to perform the measurement: 

 Use the Circle Points or Circle tools 
for circular indentations: 
 
If you use Circle Points, left-click on 
several points on the edge of the circle. 
Right-click to display the circle 
calculated from these points. 
 
If you use Circle, start from the edge 
of the circle and move inwards, holding 
down the left-hand mouse button, to 
drag out a circle the same size as the 
indentation. 

 

 

 Use the Ellipse tool for elliptical 
indentations. Start from the edge of 
the ellipse and move inwards to drag 
out a circle the same size as the 
indentation. 
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 The results of the measurement 
(diameter and layer thickness) are 
displayed in the Results field. 

 

 Click on the Remove circles button if 
you want to delete the circles that you 
have drawn in. If necessary, start 
drawing in the circles again. 

 

 In the Attributes field, you can 
change the Color and Line Width of 
the drawn-in circles. To do this, select 
the desired color or line thickness from 
the relevant drop-down list box. 

 

 Click on the Magnifier button to 
magnify individual areas of the image. 
To do this, position the cursor on the 
area of the image that you wish to 
magnify. When you are dragging out 
the circle, the magnifying glass can 
help you to position the start point of 
the circle extremely precisely. 

 

 Press the Ctrl key during dragging out the circle to position the border of 
the circle precisely. 

 Then click on the Next button in the bottom left-hand area of the wizard. 
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The fourth page of the wizard is displayed on the screen. Under the title 
Evaluation (Step 4 of 4) you will find a brief description of what you should 
do in this step. 

The results of the measurement are displayed together with the sample data 
in the Results field. 

 Click on the Show Results in Image 
button in the Annotations field to display 
sample information and measurement 
results in the image. 

 

 Select the desired color and font size for the Annotations from the 
appropriate list. 

 Then click on the Save Image As button 
to save the image in any directory on the 
hard drive or another storage medium. 

 

 The annotations are automatically burnt 
into the image when it is saved. To ensure 
that this takes place, please make sure that 
the Burn-in annotoations check box in 
the Save Image As dialog window is 
activated if the image is not being saved in 
the Carl Zeiss ZVI image format. 

 

 Click on the Create button in the Report 
field to see a preview of the report. You 
can print out the report by clicking on the 
Print button. 

 

 

 Then click on the Finish button in the bottom right-hand area of the 
wizard, to leave the wizard. 
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You can save the report using the function Save As in the File menu. 
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The Microhardness Measurement module allows you to control an MHT 
(microhardness tester), and measurements of the microhardness of a sample. 
Detailed information on the MHT and its use and functions can be found in 
the operating instructions for the MHT from Anton Paar GmbH. 

To perform a measurement, you require (in addition to the Microhardness 
Measurement module) a reflected light microscope with MHT controller and 
MHT sensor. 

Microhardness measurement is a method used to characterize materials and 
their surfaces. An indenter (a sensor with a diamond tip) is pressed into the 
sample with a certain force. The Microhardness Measurement module 
requires the following three entries: 

 Force in Newton (F). 

 Dwell time in seconds: To avoid plastic deformation or shrinkage of the 
material due to the sensor being removed too quickly, it is possible for the 
diamond tip to remain in the sample for a specified period of time. 

 Slope in Newton/second: The specified slope determines how quickly 
the applied force reaches the maximum value F from the moment of its 
first contact with the sample surface. With fragile samples, low slopes 
should be used to avoid microcracks. 

The size of the indent is then measured, and the hardness calculated from 
this: 

 
sizeIndent

appliedForce
Hardness =  
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A force of a few Newtons is applied, producing indents of a few micrometers. 
The form of the indent depends on the type of indenter used. 

 
 

Vickers indenter Knoop indenter 

In both cases, the size of the indent is determined on the basis of the 
diagonals of the rectangle produced. The formulae for calculating Vickers 
hardness and Knoop hardness are different, but produce the same 
microhardness results. 

The microhardness measurement results are presented in the following form: 

 

 
Dwell time in seconds 

Force applied in Newtons 

Method indicator (HV - Vickers,  HK - Knoop) 

Hardness value 
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MHT settings sets the parameters for the 
microhardness tester. 

Run indent starts the procedure for creating an 
indent. 

Live opens and closes the live window. 

Snap acquires an image using the active camera. 

Measure allows you to interactively measure the 
indent and display the results of the 
measurement in the image. 

Remove last deletes the last measurement 
performed. 

Remove all deletes all microhardness 
measurements in the image. 

Report generates a report consisting of the 
measured image and the results of the 
measurement. 
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 Place the sample you want to measure on the microscope stage. 
 Turn the nosepiece to the position with the MHT sensor. 
 Now check that the sample is positioned correctly for the indent, and 

correct its position if necessary. 

If you click on MHT settings, the MHT Settings dialog 
window is opened: 

  

 

Insert the data for the following values: 

 Force [N]: The force is limited to 2N for MHT4 or 4N for MHT10. 
 Time [s]: The dwell time should be 10s – 20s. 
 Slope [N/s]: The slope is limited to 0.999 N/s for MHT4 or 9.99 for 

MHT10. 

 If you click on Run indent, a flashing 
window appears: 

  

 

 The red light on the MHT control device flashes. Wait until the flashing 
window has disappeared. If you want to interrupt the process, click on 
the ABORT button. 
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 Turn the nosepiece to the objective with the desired magnification 
(normally 20x or 50x).  

 Click on Live. The live window is opened.  

 Position the indent at the center of the live window, 
and bring it into focus: 

 

  

 

 Adjust the brightness and exposure time etc. via the toolbar of the live 
window. 

 Select the scaling for the set objective from 
the List of available scalings under the 
live window. 

 You can make several indents at various positions on the sample in a 
single workflow. 

  

 Click on the camera icon  to acquire the 
image. 
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 Use the Name and Acquisition property pages (Tools menu ⇒ Options 
function) if you would like to save images automatically under a 
predefined name. A detailed description can be found in the online help 
(F1). 

 Click on  on the standard toolbar, and zoom to change the 
region you want to be measured: 

 Click on Measure, and draw in the two 
diagonals by clicking on the start and end 
points. The result of the measurement is 
displayed automatically. 

  

 

 Repeat this step for all indents in the image. 
A maximum of four indents per image can 
be measured. 

 

 Click on Remove last if you want to delete 
the diagonals you have drawn in step by 
step. 

   
 before after 
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 Click on Remove all to delete all the indent 
measurements you have made up to this 
point, and start again by clicking on 
Measure. 

 

 If you click on Report, a report is generated 
(see Appendix A). 

 

: 
You can also use the Microhardness Measurement tool bar  to perform the 
microhardness measurement. 

Additionally you will find another button  to configure the 
MHT control device. If you click on this button, the following dialog window 
opens: 

  

Select here the corresponding COM port for the MHT control device. 

Select further the type of the MHT device (MHT4 or MHT10), the indent type 
(Vickers or Knoop), the desired force unit (Newton, Pond, gram force) and the 
text color for displaying the measurement values in the image. 
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Microhardness: Hardness of the sample at the microscopic level. 

Indent: The impression resulting from the microhardness tester being pressed 
into the surface of the sample. 

MHT: Microhardness Tester – the name of the device used for the 
microhardness measurement. This can be obtained via Carl Zeiss. It is 
manufactured by Anton Paar GmbH, Graz, Austria. 

Sensor: For the microhardness measurement, a tiny diamond tip is pressed 
into the surface of the sample with a very small, defined force. The sensor is 
screwed into the nosepiece instead of an objective, and controls and moves 
the diamond tip. 
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You can save the report using the function Save As in the File menu. 
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TIC (Total Interference Contrast) is a method of measuring the heights of thin 
layers using optical interference. 

To perform TIC measurement, you require a reflected light microscope with a 
C-DIC reflector and a TIC slider, in addition to the AxioVision TIC 
Measurement module. The operating instructions of the Axioskop 2 MAT mot 
microscope contain a detailed description of the TIC method. 
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Scalings offers the calibration for the TIC 
measurement. 

Live opens and closes the Live window. 

Snap acquires an image using the active 
camera. 

Show Properties opens a dialog window 
with additional informations and settings 
for the current image. 

Navigator opens the window for zooming.

Settings allows the input of values for the 
phase shift object and phase shift 
substrate. 

Automatic TIC Measurement starts the 
TIC measurement. 

Distance measures the distance between 
two parallel lines. 

Save As saves the measured image in a 
folder. 

 Click on . 

 Activate the TIC scaling that corresponds to the selected objective and the 
selected camera resolution. 
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Please note that TIC Measurement requires TIC calibrations, and not the usual 
geometric calibrations. A description of how to generate a scaling can be 
found under "TIC scaling" at the end of section 7.2. 

If you do not intend to change the selected microscope and camera settings, 
you can now close the calibration window. 

 Click on . Set the illumination and contrast such that the 
image you can see is optimally illuminated. 

Check the camera resolution. This must correspond to the scaling you 
have loaded. 

 Set the image field to be measured on the sample and the direction of 
the interference fringes. 

The image should look something like the sample image below: 
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The thin-layer sample contains three regions: 

A: the top left-hand corner of the structure, which contains the height that 
you want to measure 
B: the surface underneath this 
C: the region with displaced interference fringes 

The fringe displacement is due to the difference in height between the surface 
of the structure to be measured (bottom left in image) and the surface 
underneath this (top right in image). 

The displacement of the zero-order interference fringe in the overlap region is 
now to be measured, i.e. the distance between A, B (outside the overlap 
region) and C (inside the overlap region). 

Please note that the color of the fringes changes symmetrically around the 
zero-order interference fringe, both inside and outside region C. The zero-
order interference fringe can be easily identified as the darkest fringe. 

 Click on the camera icon  to acquire the image. 

 Click on Navigator, and zoom to change the region you want to be 
measured: 
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 Click on . 

 If you move the mouse inside the image, the cursor symbol changes (from 
an arrow to a pipette) and indicates the x/y coordinates and color values 
of the pixel: 

  

 Move the mouse to the center of the zero-order interference fringe on 
the underlying surface of the sample and left-click. 
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 Move the mouse into the overlap region (containing the displaced 
interference fringes), and left-click again at the center of the zero-order 
interference fringe. 

  

The measured value is displayed: 

  

 Click on  to save the image and the measurement generated. 

 
fåíÉê~ÅíáîÉ=qf`=ãÉ~ëìêÉãÉåí=

 On the Measure menu click on the Distance function, or click on 

 in the menu toolbar. 
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 Position the cursor (shown here as a cross) 
at the starting point of the line. Left-click. 

 

 Move the cursor to the end point of the 
line. Left-click. You will now see the first 
line in the image. 

 Make sure that the line you have drawn 
corresponds to the center of the fringe. 

 

 If you move the cursor, you will see the 
second line and the current measurement 
result, which changes as you move the 
cursor. 

 

 Move the cursor until the second line 
corresponds to the center of the zero-order 
interference fringe. Left-click to end the 
measurement. The measurement value will 
be displayed. 

 

`~ìëÉë=çÑ=Éêêçêë=ÇìêáåÖ=áåíÉê~ÅíáîÉ=ãÉ~ëìêÉãÉåí=

The longer the line, the more precise the measurement. Set the starting point 
of the line at the center of the zero-order interference fringe, and the end 
point as far as possible from it. 

AxioVision User's Guide, Release 4.8.2 11-263 



Modules –TIC Measurement 

Below you will find four examples of errors that can occur while you are 
drawing in the line. 

  
The line is too short. The zero-order interference fringe has not 

been selected. 

  
The line is not parallel to the interference 
fringe. 

The line is not at the center of the 
interference fringe. 

Below you will find two examples of errors that can occur while you are 
determining the position of the displaced zero-order interference fringe. 
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The first-order interference fringe has 
been selected. 

The line is not at the center of the first-
order interference fringe. 

 
qf`=ëÅ~äáåÖ=

In order to perform the TIC measurement, you require a set of TIC scalings 
(for each magnification and camera combination). 

Start with a frequently used combination, such as the 10x objective and the 
AxioCam at the standard resolution. 

Just like any other scaling procedure, TIC requires a reference object. Any 
reflective surface is suitable for TIC. Focus on the surface, optimize the 

exposure time and acquire the image by clicking on . 

 From the Measure menu, select the Scalings function. 

 In the Scalings Control window click on New. The scaling wizard is 
started. 

 Right-click in the image. The image’s shortcut menu is displayed. Select 
the Normal View (1:1). 

 Magnify the window by clicking on . 
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 Move the scrollbars  at the bottom and right-hand 
edges of the image to set the desired frame. 

  

 Click on Next. 

 Activate Automatic line-detection. 

 Select the method Single parallel lines (X+Y). 
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 Click on Next. 

 Enter the value 275 into the Distance text field, and select the unit 
Nanometer (275 nm corresponds to half the wavelength of visible light). 

 Now determine the distance between two interference fringes by drawing 
in two lines between two dark fringes. To do this, click on the starting 
and end points at the center of the interference fringe. 
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 The distances are marked by red lines. The correct distance is determined 
automatically and displayed as a third line between the two lines you 
have drawn. 

  

 Click on Finish. 

 Enter a name for the scaling and click on OK. 

  

To avoid confusing this scaling with other scalings, you should use TIC as a 
prefix. 
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The new scaling now appears in the Scalings Control window, and is 
activated automatically. It is used for all images subsequently acquired. 

  

 

AxioVision User's Guide, Release 4.8.2 11-269 



Modules - SFM 

NNKNQ pcj=EpÅ~ååáåÖ=cäìçêÉëÅÉåÅÉ=jáÅêçëÅçéÉF=

Any AxioVision ZVI multichannel image and AxioVision CSV data table can be 
entered into the SFM Evaluation in order to generate histograms, scatter 
plots, image galleries or gated data tables. 
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To cut out objects as component images for the gallery view, the box 
coordinates of the objects must also be measured. In addition, the index 
region must be measured and entered in the data table. 

To reposition the microscope stage, the x and y coordinates and the focus 
position must be measured. In order to ensure precise positioning, the stage 
must be calibrated prior to image acquisition in the x and y direction. The 
focus position (z) must be set to 0 (zero) in the focus area. 

 

Scripts and macros are available for the special SFM Evaluation which 
combine corresponding multichannel data from identical regions for each 
channel with the relevant box and stage coordinates in a single file.   

Image acquisition takes place using the usual settings for multichannel MosaiX 
imaging. In the sample scripts and macros, the evaluation is limited to three 
channels. 
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Prerequisites 

For SFM evaluations, an image (AxioVision ZVI multichannel image) and the 
associated data table (AxioVision CSV table) containing the measured values 
must be available and loaded. 

If the selected image and the data table are not suitable for SFM Evaluation, 
the Methods cannot be selected and access to the SFM Results 
Presentation remains blocked (the functions under Methods are displayed in 
gray). If the files are suitable, then the Methods are accessible. 
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 Select Image: Selection of the image file. All image files opened in 
AxioVision are available in the drop-down list box. 
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 Select Datatable: Selection of the relevant data table. All results files 
opened in AxioVision are available in the drop-down list box. 

  

Note: 
• Make sure that the image and the data table belong together. Otherwise, 

the cut-out parts of the image in the SFM Gallery will not correspond. 

• Once both files have been selected, the data will appear in the table field 
of the window and the functions under Methods will become available. 

Experiment 

 : A series of evaluations (series of histograms, scatter plots, 
etc.) can be loaded from the Load settings dialog window that opens. 
These evaluations are executed immediately. 

 : This function becomes active as soon as the next 
evaluations are defined (histogram, scatter plot, etc.). The specified 
sequence can then be saved as an experiment. The experiments are 
stored as “INI” files with the path: "C:\Documents and Settings\All 
Users\Shared Documents\Carl Zeiss\Data\SFM 
Evaluation\Settings\Experiment".  

In this case, the Save function overwrites an experiment file that has 
already been opened. 
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Save as: Saves the settings under a new name. 

 Experiment: Displays the experiment file that has been opened. 

Methods 

  

In this field, the evaluation method that is to be used in the next step 
(Histogram, Scatter Plot, Gallery, Gated Data) is selected. The selection is 
made by clicking the selection box on the left.  

Buttons 

: If you click on this button, the selected method is called up 
and executed using the default settings. 

: Closes all open evaluation windows. If any of 
the results have not yet been saved, you will be asked beforehand whether 
these should be saved first. 

: Ends the entire SFM evaluation and returns 
to AxioVision. All SFM-specific windows are closed. You will be asked whether 
you want to save your data if there are any windows that have not yet been 
saved. 
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Input 

The headers display the names of the image file (Selected Image) and data 
table (Selected Datatable) being used. The evaluation path up to this point is 
displayed under History. 

 

Graphics 

The Graphics field first shows the numerical distribution of the standard 
parameter: 

X axis = parameter 
Y axis = number 
N = total number of objects available for this distribution 
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Gates: The gates show the delimited areas. The active gate is highlighted by 
two squares at the top end. The numbers indicate the percentage of objects 
within the gate in relation to the total number of objects present (N). 

 

Experiment 

Opportunity to save data and call up existing settings again. The file is located 
under the path: "C:\Documents and Settings\All Users\Shared Documents\Carl 
Zeiss\Data\SFM Evaluation\Settings\Histogram". 

 : Opens the Load settings dialog window containing the 
list of settings files available for histograms. Following selection, the 
settings are loaded and executed immediately. 

  
• Load default: The default setting can be adjusted to the user's 

requirements under the Save function. 

• Load factory default: This setting always contains the system’s basic 
setting and may not be changed by the user. 

 : This function becomes active as soon as changes have 
been made to the settings. In this case, the active file is overwritten with 
the changes to the settings. 

  
• Save as: Saves the settings under a new name. 
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• Save as default: The new settings can also be saved as the default 
setting. These can then be reloaded directly via the Load default 
function. 

 Name: Displays the name of the settings file currently being used for the 
histogram. The asterisk ( ) after the name indicates that any changes 
made have not yet been saved. 

 : Copies the histogram as an image to the clipboard. 

 Auto refresh: By activating this function, every change made to the 
setting is executed directly in the histogram. 

 Refresh: This button becomes active if changes have been made to the 
setting and Auto refresh is not active. The changes are only executed by 
clicking on the button. 

Gate settings 

  

 Gate Number: Selection of the number of possible gates from the drop-
down list (0...3). If no gates are selected, all the data of the histogram are 
transferred to the next method. If gates are selected, only those objects 
that are located within the defined gates will be selected. 

 Gated Particles: Number of objects within the defined gates. 

 Lower Value: Lower threshold value of the active gate. 

 Upper Value: Upper threshold value of the active gate. 
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The values may be entered using the keyboard or by moving the gate 
boundaries in the graph (clicking the left-hand mouse button). The gate 
boundaries are moved individually using the squares at the top end. If a 
gate boundary is selected, it is possible to move the entire gate. 

X Axis 

Settings for the measurement parameter. 

  

 Parameter: Selection of the measurement parameter from the drop-
down list. All the measured parameters of the data table are available. 

 Min. Value: Lower threshold value of the x axis. 

 Max. Value: Upper threshold value of the x axis. 

 : Automatic setting of the x-axis range using the smallest 
and largest parameter value in the table. 

 Linear / Logarithmic: Selection of the method for calculating the class 
width (linear or logarithmic). 

 Number of classes: Number of classes for the distribution. The 
maximum depends on the pixel count available on the x axis (approx. 
450). 
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Methods 

  

Selection of the evaluation method to be used in the next step (Histogram, 
Scatter Plot, Gallery, Gated Data). The selection is made by clicking in the 

selection box using the left-hand mouse button. Using the  
button, the selected method is called up and executed using the default 
settings. 

Buttons 

: Closes the histogram window and returns to the last method 
used (you will first be asked the question Should it be saved before 
closing?). 

: Saves the image of the histogram window via the Microsoft 
Windows Save Image File As dialog window. 

: Closes the histogram window (you will first be asked the 
question Should it be saved before closing?). 
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Input 

The headers display the names of the image file (Selected Image) and data 
table (Selected Datatable) being used. The evaluation path up to this point is 
displayed under History. 

 

Graphics 

Initially, the Graphics field shows the scatter plot with the standard 
parameters that correspond to the default settings: 

X axis = parameter 1 
Y axis = parameter 2 
N = total number of objects available for this distribution 
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Gates: The gates show the delimited areas. The active gate is highlighted by 
squares at the corner. The numbers indicate the percentage of objects within 
the gate in relation to the total number of objects present (N). 

Experiment 

Opportunity to save data and call up existing settings again. The file is located 
under the path: "C:\Documents and Settings\All Users\Shared Documents\Carl 
Zeiss\Data\SFM Evaluation\Settings\Scatterplot". 

  

 : Opens the Load settings dialog window containing the 
list of settings files available for scatter plots. Following selection, the 
settings are loaded and executed immediately. 

  
• Load default: The default setting can be adjusted to the user's 

requirements under the Save function. 

• Load factory default: This setting always contains the system’s basic 
setting and may not be changed by the user. 
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 : This function becomes active as soon as changes have 
been made to the settings. In this case, the active file is overwritten with 
the changes to the settings. 

  
• Save as: Saves the settings under a new name. 

• Save as default: The new settings can also be saved as the default 
setting. These can then be reloaded directly via the Load default 
function. 

 Name: Displays the name of the settings file currently being used for the 
scatter plot. The asterisk ( ) after the name indicates that any changes 
made have not yet been saved. 

 : Copies the scatter plot as an image to the clipboard. 

 Auto Refresh: By activating this function, every change made to the 
setting is executed directly in the scatter plot. 

 Refresh: This button becomes active if changes have been made to the 
setting and Auto Refresh is not active. The changes are only executed by 
clicking on the button. 

X Axis 

Settings for the measurement parameter. 
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 Parameter: Selection of the measurement parameter from the drop-
down list. All the measured parameters of the data table are available. 

 Min. Value: Lower threshold value of the x axis. 

 Max. Value: Upper threshold value of the x axis. 

 : Automatic setting of the x-axis range using the smallest 
and largest parameter value in the table. 

 Linear / Logarithmic: Selection of the method for subdividing the x axis 
(linear or logarithmic). 

Y Axis 

Settings for the measurement parameter. 

  

 Parameter: Selection of the measurement parameter from the drop-
down list. All the measured parameters of the data table are available. 

 Min. Value: Lower threshold value of the y axis. 

 Max. Value: Upper threshold value of the y axis. 

 : Automatic setting of the y-axis range using the smallest 
and largest parameter value in the table. 

 Linear / Logarithmic: Selection of the method for subdividing the y axis 
(linear or logarithmic). 
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Gate settings 

 (Selection): Using the cursor, an existing gate may be selected so that 
changes can be made to it. Changes to the size are made by using the cursor 
to move the corner points displayed; the gate can be moved using the 
Drag&Drop method by clicking with the cursor within the area of the gate.  

 (Rectangle): Allows a rectangular gate to be generated using the 
cursor. 

 (Ellipse): Allows an elliptical gate to be generated using the cursor. 

 (Polygon): Allows a polygonal gate to be generated using the cursor. 

Color : Assigns a color to the active gate. 

: Deletes the active gate from the scatter plot. 
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Methods 

  

Selection of the evaluation method to be used in the next step (Histogram, 
Scatter Plot, Gallery, Gated Data). The selection is made by clicking in the 

selection box using the left-hand mouse button. Using the  
button, the selected method is called up and executed using the default 
settings. 

Buttons 

: Closes the scatter plot window and returns to the last method 
used (you will first be asked the question Should it be saved before 
closing?). 

: Saves the image of the scatter plot window via the Microsoft 
Windows Save Image File As dialog window. 

: Closes the scatter plot window (you will first be asked the 
question Should it be saved before closing?). 
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Input 

The headers display the names of the image file (Selected Image) and data 
table (Selected Datatable) being used. The evaluation path up to this point is 
displayed under History. 
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Graphics 

The Graphics field shows all the objects that have been selected in the last 
gating step. The colored bar below each cell image corresponds to the 
relevant gate color for the last method used. 
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Image selection 

In the gallery, individual images or several images may be selected for further 
evaluation via Methods by using the left-hand mouse button in combination 
with the Shift or Ctrl key. The selection is indicated with a blue frame. All 
selected objects are highlighted in the scatter plot with a different color. In 
addition, individual objects can be labeled in the AxioVision MosaiX image by 
clicking with the right-hand mouse button on the gallery image. If a high 
zoom factor has been applied to the image, the object will appear with the 
selection frame in the upper left-hand corner of the image frame. 

 Display controls: In general, the color display for the channels can be 
switched On or Off via the color key. 

The contrast settings are only activated for the individual channels. To 
allow this, the color display must be switched off. Further explanations on 
the functions can be found in the AV help file menu View ⇒ Properties. 

 Move stage to: If this check box has been activated, the stage travels to 
the position of the object on the sample when you click on a gallery 
image using the right-hand mouse button. To ensure correct 
repositioning, the stage must have been calibrated in the x and y direction 
prior to image acquisition (Microscope menu ⇒ Stage). Furthermore, 
the z position at the focus position of the sample should be set to 0 (zero) 
(Microscope menu ⇒ Stage ⇒ Focus). 
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 : Copies the content of the gallery as an image to the 
clipboard. 

 Auto Refresh: By activating this function, every change made to the 
setting is executed directly in the gallery. 

 Refresh: This button becomes active if changes have been made to the 
setting and Auto Refresh is not active. The changes are only executed by 
clicking on the button. 

Methods 

  

Selection of the evaluation method to be used in the next step (Histogram, 
Scatter Plot, Gallery, Gated Data). The selection is made by clicking in the 

selection box using the left-hand mouse button. Using the  
button, the selected method is called up and executed using the default 
settings. 

 Zoom Factor: The zoom factor makes it possible to display the objects in 
the gallery windows in enlarged or reduced form (1:4 to 4:1). The 
selection is made via the drop-down list box. 

 Frame Size: The frame size can be adjusted to your requirements. This is 
entered into the input field in pixels using the keyboard. 
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Buttons 

: Closes the gallery and returns to the last method used (you will 
first be asked the question Should it be saved before closing?). 

: Saves the image of the Graphics window via the Microsoft 
Windows Save Image File As dialog window. 

: Closes the Gallery window (you will first be asked the question 
Should it be saved before closing?). 
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Input 

The headers display the names of the image file (Selected Image) and data 
table (Selected Datatable) being used. The evaluation path up to this point is 
displayed under History. 

 

Data Table 

The table shows the list of all parameter values for the objects that have 
survived all gating processes and selection in the gallery. 

The data may be delimited further in the table by clicking on individual lines or 
several lines of the list using the cursor (left-hand mouse button) in 
combination with the Shift or Ctrl key. 
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Methods 

  

Selection of the evaluation method to be used in the next step (Histogram, 
Scatter Plot, Gallery, Gated Data). The selection is made by clicking in the 

selection box using the left-hand mouse button. Using the  
button, the selected method is called up and executed using the default 
settings. 

 Auto Refresh: By activating this function, every change made to the 
setting is executed directly in the table. 

 Refresh: This button becomes active if changes have been made to the 
setting and Auto Refresh is not active. The changes are only executed by 
clicking on the button. 

Buttons 

: Closes the Gated Data window and returns to the last method 
used (you will first be asked the question Should it be saved before 
closing?). 

: Saves the Gated Data list as a new data table via the Microsoft 
Windows Save Datatable As dialog window. 

: Closes the Gated Data window (you will first be asked the 
question Should it be saved before closing?). 
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AxioVision’s operating concept is based on the principle that in most cases, 
rather than being faced with completely new tasks all the time, the user has 
to carry out a certain number of recurring routine activities. Even the basic 
system takes this into account, by offering the possibility of running through 
routine activities step by step using workflows, without having to check the 
last functions used – and their menu positions, each time. 

With the Commander module, this concept has been taken further, and 
enhanced in a consistent way. Essentially, the Commander offers the 
following possibilities: 

 Recording steps to be executed in sequence. 
 Adding to, editing and refining the sequence recorded ("script"). 
 Batch processing: automatically applying a script to several images. 

The Commander has numerous areas of application. As well as being a means 
of "simply" automating the process of retrieving functions, a script can also 
be regarded as an independent command in AxioVision, and can even be 
used in workflows (for example). If used in combination with the VBA module, 
you can even include VBA macros that you have created yourself in a script as 
commands. 

Note: 
• On the Product DVD you will find a selection of script examples. 
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Almost all of the functions available in AxioVision’s main menu can be 
included in a script.  

Once the process of recording the script has started, a button (which is 
otherwise hidden) will become available. The button can be used to adopt the 
command into the active script. Functions are not, therefore, "simply 
recorded", as numerous commands that you do not require would then be 
included too, and you would have to delete them. Often it is difficult to keep 
track of this once you are inside a script. 

Functions that do not have a function dialog (e.g. annotations and interactive 
measurement functions) actually have to be executed before they can be 
included in a script. Further information can be found in the Script Editor’s 
online help. 

_~íÅÜ=éêçÅÉëëáåÖ=J=~ééäáÅ~íáçå=çÑ=~=ëÅêáéí=íç=ëÉîÉê~ä=
áã~ÖÉë=

The automation of a number of commands is usually only one of the aspects 
involved in the creation of scripts. The next step is applying them to the 
desired number of images. With this in mind, the Commander module has a 
separate function for batch processing. This allows you to specify the number 
of images you want to process using a script, and where these images come 
from: 

 The first possibility involves acquiring the images directly via the camera, 
and executing the script for these images. The script is started after an 
image has been acquired. Once it has been executed, you can acquire the 
next image, and so on, until you want to end the processing. 

 The second possibility involves acquiring images first, and saving them on 
the hard disk before starting processing using a script. The function for 
automatically saving images after acquisition is useful here (Tools menu 
⇒ Options ⇒ Naming and Acquisition). 

 Another option involves processing all of the images that are currently 
open in AxioVision. 
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The aim of the Commander is to enable the user to execute the commands 
available in AxioVision automatically. It is therefore an aid to automation. The 
Commander should not be confused with a programming language, as the 
typical elements of programming (generation of function dialogs, variables, 
loops etc.) are not available. The VBA module should be used in such cases. 

rëÉ=çÑ=ëÅêáéíë=Äó=ëÉîÉê~ä=ìëÉêë=çÑ=~=ëóëíÉã=

Microsoft Windows XP and Microsoft Windows Vista, which are designed to 
allow several users to work on a system, are fully supported by AxioVision. 
More specifically, this means that each user can create his/her own AxioVision 
environment without other users of the system being able to access the 
configurations and files that he/she generates (see also section 8.3 "User and 
Data Administration"). 

AxioVision therefore saves scripts by default in the folder My Documents\Carl 
Zeiss\Data\Script. 

Frequently, however, you will want to make a script that has been created 
available to all users of a system. When you are saving a script, you therefore 
have the option of selecting whether you want to save the current script for 
yourself only, or for all users. 
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The scripts are now saved in the folder Shared Documents\Carl 
Zeiss\Data\Script. 

Icons in the list of scripts in the Script Editor or on the toolbar indicate 
whether a script has been saved for the current user only, or whether it may 
be accessed by all users: 
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Scripts can easily be transferred to other systems. The Commander module 
must not be present on the target system. The installed scripts can be 
executed at any time via the menu, or via the Commander toolbar. 

Commander scripts form part of an individual AxioVision configuration. They 
are therefore also saved when you save a configuration using the 
Import/Export Configuration function on the Tools menu. To avoid 
problems, we recommend that you use this function to save and transfer 
scripts to other systems. Further information on the use of this function can 
be found in section 8.7 "Exporting and Importing User Configurations". 

Note: 
• If functions that are part of a module are used within a script, you must 

ensure that the relevant module is also available on the target system, and 
has been activated in the Module Manager (Tools menu ⇒ Modules 
Manager). 

oÉÅçêÇáåÖ=~=ëÅêáéí=

In this exercise you will learn how to record and save a script using the script 
editor. A simple documentation task will be used as an example: acquire 
image, enhance contrast, draw in scale bar, save image. 

Specifically, the following steps are covered: 

 creating new scripts, entering a description 
 starting the recording of a script 
 behavior of the script editor during recording 
 adding commands to a script 
 saving a script 
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Notes: 
• The following example describes the selection of the commands to be 

used via the AxioVision main menu. You can, of course, also call up the 
appropriate commands via toolbars, workflows and your own customized 
dialogs. Please also read chapter 2 "Overview and Operating Concept". 

• Before you start to record a script, you can determine the behavior of the 
editor during recording with the function Commander – Options. 

Open the script editor. To do this, select the Script Editor function from the 
Commander menu. The script editor is the "control center" for creating and 
revising scripts. 
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 To record a new script, click on New 
under Script selection. 

 

 Enter a name in the New script 
dialog that describes the script as 
clearly as possible. You can also 
describe the content of the script in 
more detail in the Information field. 

 Via Location you can specify whether 
the script should be available only to 
you or also to all other users of the 
system (the Workgroup). 

 Click on OK, to create the new script. 

 

 An empty script window is now 
displayed. 
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 Now start recording the script by 
clicking on the Record button. 

 

 If you have activated the Minimize 
Script Editor while recording 
option in the function Commander - 
Options, the script editor is hidden 
and only a window with the buttons 
Record and Stop is displayed. This 
means that there is more space on 
your screen for working in AxioVision.

 

 You can now work entirely as normal 
in AxioVision: First open the live 
image via the Acquisition menu ⇒ 
Live function. 

 Select a scaling that is suitable for the 
objective you are using from the List 
of available scalings in the area at 
the bottom of the live window. 

 Close the Live window. 

Note: 
• The live window does not have to be 

adopted into the script. It is 
automatically displayed if you execute 
the Snap function interactively. 

 

 Now select the Snap function from the Acquisition menu. 
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 The image is acquired and the Add to 
script dialog is then displayed. Using 
this dialog, you can decide whether or 
not each command should be 
included. 

 

 Click on Yes to adopt the command into the script. This closes the Add 
to script dialog window. 

 Now execute the following functions 
in addition to the Live function, and 
adopt them into the script as 
described above: 

• Processing menu, Adjust group, 
Brightness/Contrast/Gamma 
function. 

• File menu, Save As function. 

 

 Then save the script by clicking on 
Save under Script selection.  

 Once the current version of the script 
has been saved, the Save button is 
displayed in gray. 

 

 

 Now stop recording the script. 
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Often, after recording a script, you will discover that the sequence does not 
meet your requirements. Perhaps commands are missing, or the commands 
that are included do not function as expected. 

This exercise describes how to expand a previously recorded script in the 
appropriate way: 

 executing a script step by step 
 inserting new commands 
 copying and moving commands 

Notes: 
• The following example describes the selection of the commands to be 

used via the AxioVision main menu. You can, of course, also call up the 
appropriate commands via toolbars, workflows and your own customized 
dialogs. Please also read chapter 2 "Overview and Operating Concept". 

• The "Documentation" script used in the following example is the result of 
the previous exercise "Recording a scrip". It is assumed that you have 
carried out the exercise as described and that the script is therefore 
available.  

 Open the script editor. To do this, select the Script Editor function from 
the Commander menu. 

 In the list under Script selection, 
select the script that you want to 
change. 
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 The selected script is immediately 
displayed in the script editor. 

 Below, you will incorporate the 
possibility of drawing in a scale bar 
and adding free annotations after the 
Brightness/Contrast/Gamma 
command. 

 

 To insert further commands, you 
should first execute the script up to 
the line after which the new 
command is to be inserted. 

 Highlight the first line Snap and then 
click on Single step. The image that 
is currently set is acquired. 

 

 

Note: 
• If the image is unsatisfactory, adjust it first via the live image. 

 Click again on Single step. The Brightness/Contrast/Gamma function 
is executed. 
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 After the execution of 
Brightness/Contrast/Gamma the 
last line is highlighted, as the cursor 
moves on automatically. When you 
insert functions, however, they are 
inserted after the position that is 
highlighted at that moment. 

 You should therefore activate the 
Brightness/Contrast/Gamma 
function by clicking on it. 

 

 Commands are inserted simply as a 
result of the desired functions being 
recorded. 

 

 If you have activated the Minimize 
Script Editor while recording 
option in the function Commander - 
Options, the script editor is hidden 
and only a window with the buttons 
Record and Stop is displayed. This 
means that there is more space on 
your screen for working in AxioVision.

 

 Now execute the following functions 
one after the other and adopt them 
into the script: 

• Annotations menu, Scale bar 
function 

• Draw the scale bar in the image. 

• Annotations menu, Draw 
Annotations function. 
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The new functions are now displayed after the Brightness/Contrast/ 
Gamma command. 

The script now contains all the commands required. However, to ensure 
smooth operation there are two settings that need to be done: 

1. The live window is not closed in every case, but only if the Close after 
Snap function in the live window’s shortcut menu has been activated.  

2. Documents may still be open. At the start you should therefore ensure that 
all documents have been closed. 

3. Start the recording again  and insert the Close all 
command from the Windows menu. 

 The Close all command is now 
displayed in the last but one line. It 
should, however, be executed at the 
start of the script. 

 To move it to the first position in the 
list, highlight the line and click on the 
Move up button until it moves to the 
first line in the script. 

 

 

Note: 
• You can also duplicate individual lines by using Ctrl C (copy) and Ctrl V 

(paste) keys. The line is then included twice in the script. 
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 Then save the script by clicking on 
Save under Script selection.  

 Once the current version of the script 
has been saved, the Save button is 
displayed in gray. 

 

 

 
`Ü~åÖáåÖ=íÜÉ=ï~ó=áåÇáîáÇì~ä=Åçãã~åÇë=~êÉ=ÉñÉÅìíÉÇI=
ëÉäÉÅíáåÖ=áã~ÖÉë=íç=ÄÉ=Çáëéä~óÉÇ=

This example shows you how to influence the way in which individual 
commands behave during the execution of the script. In addition, you will be 
shown how to specify which images are displayed/not displayed during and/or 
after execution: 

 displaying function dialogs during execution so that you can adapt 
parameters (interactive execution of commands). 

 switching individual commands on and off so that commands are not 
executed (useful for testing a script). 

 specifying which images should be displayed during execution, to prevent 
too many images from "blocking" the screen. 

Notes: 
• The following example describes the selection of the commands to be 

used via the AxioVision main menu. You can, of course, also call up the 
appropriate commands via toolbars, workflows and your own customized 
dialogs. Please also read chapter 2 "Overview and Operating Concept". 

• The "Documentation" script used in the following example is the result of 
the previous exercises "Recording a script" and "Inserting commands into 
an existing script". It is assumed that you have carried out the exercises as 
described and that the script is therefore available.  

In the following example the "Documentation" script is modified to meet the 
requirements described below. 
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The Close all function should simply close all images, including those that 
have not been saved, without asking whether the images should be saved. 

The execution of the script should be interrupted at the following commands 
so that settings and parameter values can be entered in dialogs: 

 Record, so that you can position the specimen correctly and focus. 

 Brightness/Contrast/Gamma, so that you can adapt the settings to the 
image that is currently being acquired. 

 Save As, so that you can change the folder, file name and image format. 

Only the resulting image should be displayed in AxioVision, not the acquired 
image. 

 Open the script editor. To do this, select the Script Editor function from 
the Commander menu. 

 In the list under Script selection, 
select the script that you want to 
change. 

 

 The selected script is immediately 
displayed in the script editor. 

 Click on the Close all function. 

 

 Under Parameters on the right-hand 
property page, switch the setting for 
Force close from No to Yes. 

 

The Close all function will now close all open documents without asking 
whether unsaved documents should be saved. 
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 Click on the Snap function and 
switch the Automatic parameter to 
Interactive. 

 Carry out the same action for the 
Brightness/Contrast/Gamma and 
Save As functions.  

 To specify which images are displayed 
during execution of the script and 
which are not, switch to the 
Documents property page. 

 If the Visible column is not displayed, 
move the slider at the bottom edge 
completely to the right. 

 

 

 Now deactivate the Visible option for 
the Snap command. 

 Only the resulting image is then 
displayed during automatic execution 
(see next exercise).  

 Then save the script by clicking on 
Save under Script selection.  

 Once the current version of the script 
has been saved, the Save button is 
displayed in gray. 
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This example shows you how to execute a script and how to influence the 
way in which individual commands are executed: 

 displaying the Commander toolbar. 
 executing a script automatically. 
 displaying script information. 

Notes: 
• The following example describes the selection of the commands to be 

used via the AxioVision main menu. You can, of course, also call up the 
appropriate commands via toolbars, workflows and your own customized 
dialogs. Please also read chapter 2 "Overview and Operating Concept". 

 The "Documentation" script used in the following example is the result of 
the previous exercises. It is assumed that you have carried out the 
exercises as described and that the script is therefore available.  

The simplest way to execute a script is via the Commander toolbar. If the 
toolbar is not displayed, select the Toolbars group from the View menu and 
there select the Commander entry. 

 Then select the script that you wish to execute under Select Script. 

  

 If you are not sure whether it is the right script, click on Info after making 
your selection. 
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 The Script Information window is 
then displayed.  This contains a more 
detailed description of the script (if 
this was entered by its creator).   

 

 Click on Run to start the execution of the script (the Script batch option 
is explained in the following exercise). 

  

mêÉé~êáåÖ=~=ëÅêáéí=Ñçê=Ä~íÅÜ=éêçÅÉëëáåÖ=

Processing several images using a single script is the real area of application of 
the Commander, or rather of the scripts that are created with it. This exercise 
shows you the conditions that a script has to meet in order to be executed via 
the Script batch function. 

 Preparing a script for batch processing 
 Executing the function for batch processing 
 Selecting the image source 
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Notes: 
• The following example describes the selection of the commands to be 

used via the AxioVision main menu. You can, of course, also call up the 
appropriate commands via toolbars, workflows and your own customized 
dialogs. Please also read chapter 2 "Overview and Operating Concept". 

 The "Documentation" script used in the following example is the result of 
the previous exercises. It is assumed that you have carried out the 
exercises as described and that the script is therefore available.  

 If you want to execute a script via the Script batch function, it must meet 
the following conditions: 

1. It must not include a function that opens an image file or acquires an 
image via the camera. 

2. The first function within the script that requires an image as input 
must use the image that is currently loaded. Since, however, at the 
time the script is created it is not known where this image will come 
from and what name it will have, a general place-marker must be 
used (what is known as the "active image"). 

 Open the script editor. To do this, select the Script Editor function from 
the Commander menu. 

 Select the script that you want to be 
changed in the Script selection 
drop-down list box. 

 

The selected script is immediately displayed in the Script Editor. In the Script 
field, select the Snap and Save As commands, one after the other, and 
delete them using the Remove button. 
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 The commands that are executed 
automatically by the Script batch 
function have now been removed. 

 

You must now ensure that the first image-processing command 
(Brightness/Contrast/Gamma) actually uses the loaded or acquired image 
as the input image. 

 On the Documents tab sheet select 
the Brightness/Contrast/Gamma 
command. 

 

 On the right side of the script editor 
page the parameters will be shown. 

 To change the input image, select the 

 button under Input documents 
to open a gallery for selecting an 
image. 

 

 If you have not previously loaded or acquired an image, the gallery will be 
empty, as shown in the illustration on the right. 
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 Here, select the ActiveImage command. The "active" image is then 
always used as the input image for the Brightness/Contrast/Gamma 
function – irrespective of the source from which it originates (camera, file) 
and its name. 

 Then save the script by clicking on 
Save under Script selection.  

 Once the current version of the script 
has been saved, the Save button is 
displayed in gray. 

 Close the Script Editor. 

 

 

Notes: 
• Before you save the script, think about whether you will only want to use 

it with the Script batch function in the future.   If not, you should use a 
different name. 

• In this case, click on the arrow to the right of Save, under Script 
selection, and select Save As. This function allows you to save the script 
under a new name. 

oÉéÉ~íáåÖ=ëÅêáéíë=

The Repeat function allows you to apply a script to any number of images.   
The images may already be available as files in a folder or may already have 
been loaded in AxioVision. You may, of course, also acquire them via the 
camera. In addition, you can specify, for each resulting image within the 
script, whether or not you want the image in question to be saved. The 
following steps are carried out in this exercise: 

 Executing the function for repetition 
 Selecting the image source 
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Notes: 
• The following example describes the selection of the commands to be 

used via the AxioVision main menu. You can, of course, also call up the 
appropriate commands via toolbars, workflows and your own customized 
dialogs. Please also read chapter 2 "Overview and operating concept". 

• Before you perform this exercise, you should ensure that you have 
worked through the previous example "Preparing a script for batch 
processing". 

 To execute the script for several images, select the Repeat script function 
from the Commander menu. 

 First, select where the images should 
originate from in the  Select source 
drop-down list box. In most cases you 
will presumably acquire them via the 
camera. 

 

 If you work with several cameras, select the ActiveAcquisition setting in 
the Camera drop-down list box. The camera activated in the Acquisition 
menu will then be used each time. 

 Finally, specify how many images you wish to acquire. If the number is 
not known, activate the Snap until user pressed cancel option.   

 Now select, under Script selection, 
the script that you wish to use. 

  

 

 Now select, under Script selection, the script that you wish to use. 
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 If you are not sure whether it is the right script, click on  
after making your selection. 

 The Script information window is 
then displayed. This contains a more 
detailed description of the script (if 
this was entered by its creator). 

 Start the execution of the script by 
clicking on Start. 

 

The commands are now run through as if you were selecting them 
interactively via the menu. At any time you can use the Cancel button to 
finish the script. 
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The VBA module enables you to simplify routine tasks with the help of 
macros, and to program your own applications. 

AxioVision contains the most recent version, VBA 6. In this version the 
language features of VBA are on a par with Visual Basic. 

If you have never done any programming before, we advise you to build up 
your knowledge in advance. As Visual Basic/Visual Basic for Applications is a 
very widely used standard, you will easily find a wide range of training 
programs and literature to meet the needs of people with almost any level of 
prior knowledge. 

Section 8.5 "Adapting the User Interface" describes how workflows, toolbars 
and shortcut keys can be used to adapt AxioVision to your personal work 
situations, and to make your work a great deal easier and more convenient. 
With the additional possibilities offered by the VBA module, you can let your 
imagination run free, as there are no longer any restrictions when it comes to 
configuring AxioVision to meet your individual requirements. 

cáêëí=ëíÉéë=

To make it easier to enter the world of programming in AxioVision, the 
following resources are available to you: 

 VBA online help (Microsoft Visual Basic Help, AxioVision Visual Basic Help) 

 AxioVision VBA website for support, downloads and forum: 
www.zeiss.de/vba 

 VBA user course for AxioVision (for detailed information please visit the 
website www.zeiss.de/vba) 

 AxioVision online help 

The VBA online help is supplied with the VBA module. An up-to-date version 
can be downloaded from the VBA website.  
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The VBA website and forum are a platform where customers, specialists and 
developers can discuss VBA for AxioVision. Here you will find information 
about programming in AxioVision, e.g. in the form of tutorials and tips & 
tricks. You can exchange information with other forum members and obtain 
support relating to specific questions and problems. 

The VBA user course for AxioVision offers you entry into the "VBA for 
AxioVision world". It will provide you with detailed basic information, such as 
an introduction to the AxioVision object model and how it is programmed. 

Lastly, the AxioVision online help is another useful source of information on 
programming, offering you a precise description of the parameters of image 
processing functions, for example. 

qÜÉ=s_^=çåäáåÉ=ÜÉäé=

In addition to a description of the general VBA functions (Microsoft Visual 
Basic Help), you will find an online help in the VBA Editor via the Help menu 
together with the documentation on the AxioVision objects (AxioVision Visual 
Basic Help). 

tÉäÅçãÉ=íç=pí~åÇ~êÇ=sáëì~ä=_~ëáÅ=ÇçÅìãÉåí~íáçå=

The documentation on Visual Basic is extremely diverse. Each individual 
component has been created to help you to familiarize yourself with particular 
aspects of the product. The documentation supplied with Visual Basic covers 
the components described below. 

eÉäé=ïáíÜ=íÜÉ=sáëì~ä=_~ëáÅ=ìëÉê=áåíÉêÑ~ÅÉ=

Here you will find information on interface elements of the Visual Basic Editor, 
such as commands, dialog boxes, windows and toolbars. 

sáëì~ä=_~ëáÅ=ÅçåÅÉéíë=

The context-sensitive help contains information that will help you build up 
your knowledge of programming in Visual Basic.  
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In this area of the help you will find useful information on general procedures, 
such as the use of the object catalogue or the specification of Visual Basic 
environment options. 

sáëì~ä=_~ëáÅ=ä~åÖì~ÖÉ=ÇáêÉÅíçêó=

In the language directory you will find information on the Visual Basic 
programming language, i.e. all of its methods, features, statements, 
functions, operators and objects. 

sáëì~ä=_~ëáÅ=~ÇÇJáå=ãçÇÉä=

If you want to adapt the Visual Basic Editor, in the language directory you will 
find information on the object model, which will enable you to expand the 
environment.  

oÉÑÉêÉåÅÉ=Ñçê=jáÅêçëçÑí=cçêãë=

Here you will find information on Userform objects and control elements, and 
on programming with Userform objects and control elements in Visual Basic. 

tÉäÅçãÉ=íç=^ñáçsáëáçå=sáëì~ä=_~ëáÅ=ÇçÅìãÉåí~íáçå 

You will find the AxioVision-specific online help on the Help menu ⇒ 
AxioVision Visual Basic Help. 

It has been devised to allow you to search quickly for code examples and 
offers you information as well as an overview of the main AxioVision classes. 
The AxioVision application and its modules consist of almost 60 class libraries 
(DLLs) containing several hundred classes. Only seven DLLs are elementary and 
relevant for programming. These form the basis of the AxioVision VBA online 
help. 

j~å~ÖáåÖ=~åÇ=êìååáåÖ=ã~Åêçë=

There are two ways to run macros that you have created in the Visual Basic 
Editor: 
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 The first is via macro management. From the Tools menu select the 
Macros function. Besides the possibility of running macros, here you will 
also find functions for deleting macros, starting the Visual Basic Editor etc. 

 The second possibility is via the function for running macros. From the 
Tools menu select the Run Macro function. A list of the macros you have 
created is then displayed. Select the desired macro and click on Start to 
run it. 

oìååáåÖ=ã~Åêçë=îá~=ïçêâÑäçïëI=íççäÄ~êë=~åÇ=ëÜçêíÅìí=
âÉóë=

A much more convenient option, however, is to integrate each macro into the 
user interface. 

Macros are treated in the same way as any other function in AxioVision, and 
can therefore be used via workflows, toolbars and shortcut keys, as required. 
In the Tools menu under the My AxioVision function you will always find a 
Macros branch on the corresponding property pages. The list of the macros 
you have created is also available. 
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Note: 
• Section 8.5 "Adapting the User Interface" describes how workflows, 

toolbars and shortcut keys can be used to adapt AxioVision to your 
personal work situations, and to make your work a great deal easier and 
more convenient. 

• To ensure that your macro appears in the list, the procedure behind it 
must in principle be declared as global, i.e. as “Public”, e.g. Public Sub 
MyMacro(); in addition, it must not have any parameters. 

• If a newly created procedure is not present in the Macros list, you should 
update the list using the Refresh function on the AxioVision View menu. 
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